Oracle Fusion Service

Implementing Service Center with the Redwood User Experience

22D
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Help</td>
<td>i</td>
</tr>
<tr>
<td><strong>1 About This Guide</strong></td>
<td>1</td>
</tr>
<tr>
<td>Audience and Scope</td>
<td>1</td>
</tr>
<tr>
<td>Related Guides</td>
<td>1</td>
</tr>
<tr>
<td><strong>2 Access Service Center</strong></td>
<td>3</td>
</tr>
<tr>
<td>Enable Service Center</td>
<td>3</td>
</tr>
<tr>
<td>Overview of Required Privileges and Roles</td>
<td>5</td>
</tr>
<tr>
<td><strong>3 Profile Options, Lookups, and Scheduled Processes for Service Requests</strong></td>
<td>7</td>
</tr>
<tr>
<td>What are Profile Options, Lookups, and Scheduled Processes?</td>
<td>7</td>
</tr>
<tr>
<td>Overview of Profile Options</td>
<td>7</td>
</tr>
<tr>
<td>Lookup Types</td>
<td>8</td>
</tr>
<tr>
<td>Modify Lookups</td>
<td>9</td>
</tr>
<tr>
<td>Modify Channel Type Visibility</td>
<td>10</td>
</tr>
<tr>
<td>FAQs for Lookups and Lookup Types</td>
<td>11</td>
</tr>
<tr>
<td>Overview of Scheduled Processes</td>
<td>12</td>
</tr>
<tr>
<td>Profile Options and Scheduled Processes for SR Management</td>
<td>13</td>
</tr>
<tr>
<td>Audit Trail for Service Requests</td>
<td>20</td>
</tr>
<tr>
<td>FAQs About SR Management</td>
<td>21</td>
</tr>
<tr>
<td><strong>4 Users and Security</strong></td>
<td>25</td>
</tr>
<tr>
<td>Enter Your Company Information and Corporate Currency</td>
<td>25</td>
</tr>
<tr>
<td>Overview of Defining Setup Users</td>
<td>26</td>
</tr>
<tr>
<td>Overview of Setting Up Users and Security</td>
<td>27</td>
</tr>
<tr>
<td>Overview of Resources and Resource Management</td>
<td>29</td>
</tr>
<tr>
<td>Setting Up Resource Teams</td>
<td>30</td>
</tr>
<tr>
<td>FAQs for Define Resource Team Information</td>
<td>32</td>
</tr>
<tr>
<td>About Security Roles</td>
<td>33</td>
</tr>
</tbody>
</table>
Set Up Service Request Visibility Based on Queue ................................. 35
Set Up Service Request Visibility Based on BU ........................................ 37
Data Security Policies on SRs ................................................................. 39
Set Up Read-Only Access to the Service Request Header ...................... 43
Set Up Read-Only Access to the Service Request Header and Service Request Messages ................................. 45

### 5 Set Up Activities Configurations

- What Service Request Activities Track and Display ............................ 47
- Overview of Activities Setup Tasks ...................................................... 48
- Required Job Roles and Privileges for Creating Activities Configurations ................................. 50
- How You Enable and Display Activities .............................................. 50
- Create and Activate a Service Request Activities Configuration ........... 51
- Before You Run Activities Initialization Jobs ........................................ 52
- Specify What Displays in Activities .................................................... 53
- Populate Activities in Existing Service Request Records .................... 55
- Run the Publish Feed Elements Job to Index Activities ...................... 55

### 6 Extend Service Center

- Overview of Extending Your Application ............................................ 57
- Set Up Visual Builder Studio ............................................................... 57
- Work with Dynamic UI ..................................................................... 58
- Work with Dynamic Forms ............................................................... 61
- Work with Dynamic Tables .............................................................. 70
- Work with Dynamic Containers ......................................................... 71
- Service Request Categories ............................................................... 74
- Preview, Share, and Publish an Application Extension ....................... 75

### 7 Catalog Management

- Define a Catalog for the Service Offering ........................................... 77
- Overview of Sales Catalogs ............................................................... 78
- Sales Catalog High-Level Setup Steps ................................................. 79
- Add Products to the Catalog .............................................................. 81
- Validate the Service Catalog ............................................................ 82

### 8 Configure Service Request Outcomes and Resolutions

- Outcomes and Resolutions ............................................................... 83
### 12 Import and Export

- Migrate Business Objects Between Different Business Units 142
- Associate Different Catalogs with Different Business Units 143

### 13 Real-Time Channels

- Computer Telephony Integration (CTI) 151
- CTI Media Toolbars APIs 160
- Configuration APIs 167
- Interaction APIs 170
- Event Listener APIs 176
- Configure Screen Pop Pages 193
- Call Flow Parameter Settings 209
- Configure Wrap Up 210

### 14 Interactions

- Interactions 213
- Configure Cross-Channel Interactions 214

### 15 Action Plans

- Set Up Action Plans 217
- Use Oracle Process Automation with Action Plans 228
- Configure Oracle Process Automation with Oracle Fusion Service 230

### 16 Integrate with Intelligent Advisor

- Oracle Intelligent Advisor 233
- Create a Fusion Sales and Fusion Service Connection in Intelligent Advisor 234
- Download and Install Policy Modeling 234
- Connect the Policy Modeling Project to Intelligent Advisor Hub 234
- Map Data to and from Fusion Sales and Fusion Service to Policy Modeling 235
## 17 Set Up Agent Insights

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of the Insights Panel</td>
<td>237</td>
</tr>
<tr>
<td>Set Up the Agent Insights Panel</td>
<td>239</td>
</tr>
</tbody>
</table>

## 18 Enable Productivity Tools

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Productivity Tools</td>
<td>241</td>
</tr>
<tr>
<td>How You Manage SmartText Entries</td>
<td>241</td>
</tr>
<tr>
<td>Create and Edit Private SmartText Entries</td>
<td>242</td>
</tr>
<tr>
<td>Create and Edit Public SmartText Entries</td>
<td>243</td>
</tr>
<tr>
<td>SmartText Naming Conventions</td>
<td>245</td>
</tr>
</tbody>
</table>

## 19 Channels for Collaboration

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control the Display of Channels Used Only for Internal Conversations</td>
<td>247</td>
</tr>
<tr>
<td>Create an Email Channel for Collaboration or Internal Conversations</td>
<td>248</td>
</tr>
<tr>
<td>Translate the Communication Channel Display Names</td>
<td>248</td>
</tr>
</tbody>
</table>

## 20 Slack Channels

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>251</td>
</tr>
<tr>
<td>Set Up a Slack Channel: Method 1</td>
<td>251</td>
</tr>
<tr>
<td>Set Up a Slack Channel: Method 2</td>
<td>255</td>
</tr>
<tr>
<td>Slack Notifications</td>
<td>263</td>
</tr>
<tr>
<td>User Credentials for Executing Commands</td>
<td>265</td>
</tr>
<tr>
<td>FAQs About Slack Integration</td>
<td>266</td>
</tr>
</tbody>
</table>

## 21 Collaborate with Slack

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How You Collaborate with Slack</td>
<td>267</td>
</tr>
<tr>
<td>Create a Collaboration Action for Slack</td>
<td>267</td>
</tr>
<tr>
<td>Create a Child Action for a Collaboration Action for Slack</td>
<td>269</td>
</tr>
<tr>
<td>Create a Second-Level Child Action for a Collaboration Action for Slack</td>
<td>271</td>
</tr>
<tr>
<td>Add an Event to Capture Messages Mentioning Your Slack App</td>
<td>272</td>
</tr>
</tbody>
</table>

## 22 Collaborate with Microsoft Teams

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisites for Setting Up a Microsoft Teams Channel for Fusion Service</td>
<td>273</td>
</tr>
<tr>
<td>How You Set Up a Microsoft Teams Channel</td>
<td>273</td>
</tr>
<tr>
<td>Create a Microsoft Teams App</td>
<td>274</td>
</tr>
</tbody>
</table>
Set Up a Bot User for Your Microsoft Teams App .................................................. 275
Register Your Microsoft Teams App in the Azure Portal ........................................ 275
Enable Collaboration With Microsoft Teams in Functional Setup Manager ............ 276
Update Functional Setup Manager with Credentials of Your Microsoft Teams App 276
Create a Microsoft Teams Channel ......................................................................... 277
Send and Receive Attachments from Microsoft Teams Channel Users .................. 277
Enable Notifications to Microsoft Teams ................................................................. 278
Create a Collaboration Action .................................................................................. 278
Create a Child Action for a Collaboration Action ..................................................... 280
Create a Child Action for the Reply to Request Child Action .................................... 282
Configure the FND_IDP_PROXY_USER_WHITELIST Profile Option ......................... 283
Upload Your Microsoft Teams App ........................................................................... 284
Install Your Microsoft Teams App and Add It to Your Team ..................................... 284

23 Configure Notifications ......................................................................................... 287
Set Notification Triggers and Preferences ................................................................. 287
Sample Groovy Scripts for Notifications .................................................................. 293
Set Push Notifications .............................................................................................. 298

24 Configure Service Request Similarity .................................................................. 299
Overview of Service Request Similarity .................................................................... 299
Configure Users for the Administrator’s Application ............................................... 299
Schedule the Processing Job .................................................................................... 303
Test and Evaluate Service Request Similarity ......................................................... 307
Enable Service Request Similarity ............................................................................ 308

25 Set Up Service Work Orders .................................................................................. 311
Enable Work Orders .................................................................................................. 311
Extend Work Orders UI Elements ............................................................................ 311

26 Set Up Survey Integration ..................................................................................... 313
Overview of Survey Framework ................................................................................ 313
Survey Requirements and Licensing ........................................................................ 313
Use the Survey Framework with Oracle Integration ............................................... 314
Create the Fusion Service Administrator User for Connecting to Oracle Integration 314
Download and Save the Oracle Integration Mapping Package ................................. 314
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure the Integration Connections</td>
<td>315</td>
</tr>
<tr>
<td>Configure the Decision Model</td>
<td>320</td>
</tr>
<tr>
<td>Activate the Survey Integration Flow</td>
<td>321</td>
</tr>
<tr>
<td>Note Your Integration Endpoints</td>
<td>321</td>
</tr>
<tr>
<td>Create Your Survey</td>
<td>322</td>
</tr>
<tr>
<td>Supported Survey Question Types</td>
<td>323</td>
</tr>
<tr>
<td>Enable Surveys in Fusion Service</td>
<td>323</td>
</tr>
<tr>
<td>Manage Survey Products</td>
<td>324</td>
</tr>
<tr>
<td>Manage Survey Objects</td>
<td>324</td>
</tr>
<tr>
<td>Manage Survey Configurations</td>
<td>325</td>
</tr>
<tr>
<td>Manage Survey Templates Task</td>
<td>326</td>
</tr>
<tr>
<td>Schedule Jobs for Sending Surveys and Collecting Survey Responses</td>
<td>327</td>
</tr>
<tr>
<td>Verify the Survey Integration is Working</td>
<td>327</td>
</tr>
<tr>
<td>How to Include an Administrator-Defined Attribute in the Decision Model</td>
<td>328</td>
</tr>
<tr>
<td>Export and Import the Functional Setup Data for Surveys</td>
<td>331</td>
</tr>
<tr>
<td>How to Change an Active Decision Model</td>
<td>332</td>
</tr>
<tr>
<td>Prerequisites for Survey Integration Using SurveyMonkey</td>
<td>333</td>
</tr>
<tr>
<td>FAQs About Survey Integration</td>
<td>334</td>
</tr>
<tr>
<td>How to View Analyses Using OTBI</td>
<td>339</td>
</tr>
<tr>
<td>Service Analytics Roles</td>
<td>339</td>
</tr>
<tr>
<td>Analytics Subject Areas</td>
<td>340</td>
</tr>
<tr>
<td>Overview of Parent and Child Interactions in Analytics</td>
<td>341</td>
</tr>
<tr>
<td>Service Analytics Saved Queries</td>
<td>341</td>
</tr>
<tr>
<td>Analytics Resources</td>
<td>342</td>
</tr>
<tr>
<td>Installed Base Assets</td>
<td>343</td>
</tr>
<tr>
<td>Case Management</td>
<td>344</td>
</tr>
<tr>
<td>Service Request Parts Ordering for Service Oracle Service Logistics</td>
<td>345</td>
</tr>
<tr>
<td>Copy Maps</td>
<td>346</td>
</tr>
<tr>
<td>Overview of Oracle Internet of Things Service Monitoring for Connected</td>
<td>349</td>
</tr>
<tr>
<td>Assets</td>
<td></td>
</tr>
</tbody>
</table>

Oracle Fusion Service
Implementing Service Center with the Redwood User Experience

27 Service Analytics
- How to View Analyses Using OTBI
- Service Analytics Roles
- Analytics Subject Areas
- Overview of Parent and Child Interactions in Analytics
- Service Analytics Saved Queries
- Analytics Resources

28 Set Up Additional Service Features
- Installed Base Assets
- Case Management
- Service Request Parts Ordering for Service Oracle Service Logistics
- Copy Maps

29 Integrate Oracle Internet of Things Service Monitoring for Connected Assets
- Overview of Oracle Internet of Things Service Monitoring for Connected Assets
Integrate Engagement Cloud with Internet of Things Service Monitoring for Connected Assets
Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons 📚 to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
1 About This Guide

Audience and Scope

If you're looking for information about getting up and running with your Service Center application, then this guide is for you. The information is primarily aimed at service administrators and managers in your service organization.

This guide describes how to:

- Enable the Redwood user interface in Functional Setup Manager
- Grant the required privilege to the roles of your users
- Use Visual Builder Studio to extend the layout of the user interface

Related Guides

To understand more about the information covered in this guide, refer to the list of guides in the following table.

<table>
<thead>
<tr>
<th>Guide Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Service Center in the Redwood User Experience</td>
<td>Contains information to help service personnel and other service end users to perform day-to-day business tasks using Service Center in the Redwood User Experience.</td>
</tr>
<tr>
<td>Extending Oracle Fusion Applications with Visual Builder Studio</td>
<td>Describes how to use Visual Builder Studio to extend your application.</td>
</tr>
<tr>
<td>Using Fusion Service</td>
<td>Contains information to help service managers, service personnel, and other service end users to perform day-to-day business tasks using Oracle Fusion Service.</td>
</tr>
<tr>
<td>Implementing Fusion Service</td>
<td>Describes how to set up Service Request Management.</td>
</tr>
<tr>
<td>Securing Fusion Sales and Service</td>
<td>Contains information to help setup users and sales administrators configure access to functionality and data.</td>
</tr>
<tr>
<td>Security Reference for Fusion Sales and Fusion Service</td>
<td>Lists the predefined security data that's included in the offering.</td>
</tr>
</tbody>
</table>
Chapter 2

2 Access Service Center

Enable Service Center

To enable Service Center, enter the promotion code, and enable the application.

| Note: If you don't have the promo code for Service Center in the Redwood UI, file an SR with Oracle Support.

Enter the Promotion Code

1. Sign in as an administrator with setup privileges.
2. Click Navigator > My Enterprise > Enterprise.
3. On the Enterprise Information page, click the Manage Promotion Codes link.
4. On the Manage Promotion Codes page, click Enter Promotion Code.
5. On the Enter Promotion Code dialog box, enter the promotion code and click Save and Close.

The application displays Redwood User Interface for Service in the list of names.

Enable the Redwood User Interface

To expose the new Redwood User Interface for Service to users, you now must enable the opt-in feature.

| Note: Once you opt in to the Redwood User Interface for Service feature to enable the Redwood UI make sure to then click the pencil icon to ensure that the Service Center sub-features are also enabled. There are two sub-features to review are Service Requests for Redwood User Interface and Work Orders for Redwood User Interface. These separate sub-features allow the administrator to control whether each set of object-related pages should be enabled in Redwood.

Here are the steps:

1. Sign in to the application as an administrator or setup user.
2. Click Navigator > My Enterprise > Offerings.

3. On the Offerings page, select the Service offering.
4. Click the Opt In Features button.
5. On the Opt In: Service page, review the functional areas, such as Service Requests, Channel Communication and so on.
6. Scroll through the list until you locate Redwood User Interface for Service.

7. Select Enable.
8. Click the Features (pencil) icon.
10. Click Done, and then on the Opt In: Service page, click Done again.

Your users can now access Service Center including Work Orders (Next Generation).
Overview of Required Privileges and Roles

The following privileges are ready-to-use with the following default job roles: Customer Service Representative and Customer Service Manager:

**Note:** The View Service Center privilege only grants users the ability to access each of the Redwood Service Center pages. Within each page, the more detailed functionality is controlled by existing functional privileges, most of which apply to both the Visual Builder and ADF UI pages concurrently. Any custom roles you may have created also require you to add the SVC_USE_SERVICE_BASE_APP privilege to allow that role access to Service Center.

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Privilege Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Service Center</td>
<td>SVC_VIEW_SERVICE_CENTER_PRIV</td>
</tr>
<tr>
<td>View Navigator Menu</td>
<td>ORA_ZCA_VIEW_NAVIGATOR_MENU_PRIV</td>
</tr>
<tr>
<td>View Smart Actions</td>
<td>ZCA_VIEW_SMART_ACTIONS_PRIV</td>
</tr>
<tr>
<td>View Named Routes</td>
<td>ORA_ZCA_GET_NAMED_ROUTES_PRIV</td>
</tr>
<tr>
<td>Manage Installed Base Assets</td>
<td>SVC_MANAGE_INSTALLED_BASE_ASSETS_PRIV</td>
</tr>
<tr>
<td>Use Service Base App</td>
<td>SVC_USE_SERVICE_BASE_APP</td>
</tr>
<tr>
<td>Navigate to Service Center Pages from Notification</td>
<td>SVC.Navigate_TO_SERVICE_CENTER_FROM_NOTIFICATIONS_PRIV</td>
</tr>
</tbody>
</table>

**Note:** If you're using custom roles, it's recommended that you add the following duty role as a child of your custom role: Conversation Message Management (ORA_SVC_CONV_MESSAGE_MANAGEMENT).

The privileges shown in the table enable users to access a new link in the Home Page and Navigator within the Service grouping called Service Center.

If you've previously created your own roles, you must use Security Console to add these four privileges to your roles. Refer to the About Security Roles topic in Related Topics.

To expose the **Cases** feature, use Security Console to provide the following roles to your users:

- Case Manager: ORA_SVC_CASE_MANAGER
- Case Worker: ORA_SVC_CASE_WORKER

**Related Topics**
- About Security Roles
3 Profile Options, Lookups, and Scheduled Processes for Service Requests

What are Profile Options, Lookups, and Scheduled Processes?

Profile options, lookup types, and scheduled processes let you configure application behavior and process data.

Briefly, here’s what profile options, lookup types, and scheduled processes do:

- Profile options: Let you configure the application behavior.
- Lookup types: Provide the lists of values in applications. Many lookup types can be modified to fit your business needs.
- Scheduled processes: Act on data in the applications.

Get additional information on profile options, lookup types, and scheduled processes in this chapter and in the related topics.

Related Topics

- Overview of Scheduled Processes
- How can I access predefined profile options?
- How can I access predefined lookups?

Overview of Profile Options

Profile options let you configure and control application data centrally. Administrators and setup users manage profile options in the Setup and Maintenance work area.

Profile options store various kinds of information. This table lists some examples:

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Profile Option Setting Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>User preferences</td>
<td>Set preferences at the user level</td>
</tr>
<tr>
<td>Installation information</td>
<td>Identify the location of a portal</td>
</tr>
<tr>
<td>Configuration choices</td>
<td>Change UI skins and actions</td>
</tr>
<tr>
<td>Processing options</td>
<td>Determine how much information to log</td>
</tr>
</tbody>
</table>
Profile Option Hierarchy Levels

Profile options can be set at different levels, such as site level or user level. The application gives precedence to certain levels over others, when multiple levels are set. The levels that are allowed to be set are preconfigured with the application.

In the predefined profile option levels, the hierarchy levels and their precedence are:

1. Site: This level affects all applications for a given implementation. The application gives it the lowest precedence when other levels are set. If no other levels are set, however, it’s the highest level.
2. Product: This level affects a product or product family. The application gives it priority over Site level. However, if the user level is set, the user level takes precedence.
3. User: This level affects only the current user. It has the highest precedence, over Site and Product.

As a best practice, set site-level profile option values before specifying values at any other level (where available). The profile option values specified at the site-level work as the default until profile option values are specified at the other levels.

This table shows an example of the predefined profile option hierarchy levels and their priorities.

<table>
<thead>
<tr>
<th>Level</th>
<th>Priority</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Lowest</td>
<td>Currency for a site is set to Euros.</td>
</tr>
<tr>
<td>Product</td>
<td>Supersedes Site</td>
<td>Currency for the product or set of products is set to UK pound sterling.</td>
</tr>
<tr>
<td>User</td>
<td>Highest, supersedes Product</td>
<td>Currency for a user is set to US dollars.</td>
</tr>
</tbody>
</table>

You can find additional information about profile options in the related topics.

**Related Topics**
- Set Profile Option Values
- How can I access predefined profile options?

Lookup Types

Lookup types provide the lists of values in application fields that are drop-down lists.

**Note:** You can’t create a new lookup with the name starting with ORA, to avoid any conflict with the lookups seeded in the application.
How You Modify Lookup Types

You can modify many lookup types during or after implementation.

The configuration level of a lookup type determines whether the lookups in that lookup type can be edited. The lookup configuration levels are: User, Extensible, and System.

Here's a table that shows which lookup management tasks are allowed at each modification level.

<table>
<thead>
<tr>
<th>Allowed Task</th>
<th>User</th>
<th>Extensible</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting a lookup type</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Inserting new codes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Changing the wording that displays on the page (Meaning field)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Updating start date, end date, and enabled fields</td>
<td>Yes</td>
<td>Yes, only if the code isn't predefined data</td>
<td>No</td>
</tr>
<tr>
<td>Deleting codes</td>
<td>Yes</td>
<td>Yes, only if the code isn't predefined data</td>
<td>No</td>
</tr>
<tr>
<td>Updating tags</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Updating module</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

If a product depends on a lookup type, the configuration level must be set to system or extensible to prevent deletion. Once the configuration level is set for a lookup type, it can't be modified. The configuration level for lookup types created using the Define Lookups page is by default set at the User level.

Modify Lookups

Administrators can modify lookups for . Optionally, you can map status values to status types. By default, the following five Status types exist for service requests:

- New
- In Progress
- Waiting
- Resolved
- Closed

A service request always has one of these status types. However, administrators might want to display different labels for status types or change the display sequence. For example, this might be useful in situations where you want to
distinguish between statues such as "In Progress - Troubleshooting" versus "In Progress - Repairing." This procedure maps one or more Statuses to status types.

The following tasks are used to modify the service request lookups:

- Manage Service Request Internal Priorities
- Manage Service Request Sources
- Manage Service Request Resolutions
- Manage Service Request Outcomes and Resolutions
- Manage Service Request Severities
- Manage Service Request Channel Types
- Manage Service Request Channel Type Visibility
- Manage Service Request Problem Types
- Manage Service Request Contact Relationship Types
- Manage Service Request Status Values
- Manage Service Request Profile Options
- Manage Service Request Categories
- Manage Service Request Knowledge Profile Options
- Manage Service Request Parts Order Disposition Options

To modify lookups:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Service Request
   - Task: Select all tasks and click the task you want to modify.
2. In Lookup Codes, click the lookup code that you want to modify.
3. Modify the fields to correspond to your needs.
4. Click Save and Close.
5. Repeat the procedure for all of the service request lookup tasks.

The service request lookup is modified.

**Related Topics**
- Update Existing Setup Data

**Modify Channel Type Visibility**

Customer administrators can disable the channels that should not be displayed in the application when an agent composes a message of type customer entry or response.

1. Sign in to Fusion application as a setup user or administrator.
2. In the Setup and Maintenance work area, go to the Tasks panel tab.
3. Search for and click the Manage Service Request Channel Type Visibility task.
4. On the Manage Service Request Channel Type Visibility page, if you don't see the channels you want to disable, click Sync on the toolbar of the table.
5. For any channel that you select, you see two rows with different values for Property Name:
Enabled for Collaboration: To enable the selected channel to collaborate with subject matter experts to resolve customer issues, set the Property Value for this property name to Yes.

Enabled for Customer Interaction: To enable using the selected channel for interaction of your service agents with your customers, set the Property Value for this property name to Yes.

**Note:** You can also use the drop-down list in the toolbar for the Property Name field to filter the list by each property name.

6. Set the Property Value to No to disable the selected channel.

7. **Note:** For messages of type Customer Entry and Response:
   - SMS and Slack channels are disabled by default because they aren't supported for customer communications. You can enable or disable the other channels.
   - Although the Social channel is disabled by default, Social channels are visible to agents if the SR is created for a social post using the social channel integration. For other SRs, the Social channels are disabled. Oracle recommends that you keep this channel disabled.

8. Click Save and Close.

The disabled channels aren't displayed when an agent composes a message.

### FAQs for Lookups and Lookup Types

#### Frequently Asked Questions (FAQs) for Lookups and Lookup Types

This section contains some frequently asked questions (FAQs) when setting up and maintaining Lookups and Lookup Types. Scroll or search to find answers to common questions.

### How can I edit lookups?

On any of the Manage Lookups pages, you can edit the existing lookup codes of a lookup type or add new lookup codes. You can edit lookups using the following tasks in the Setup and Maintenance work area:

- Manage Standard Lookups
- Manage Common Lookups
- Manage Set-enabled Lookups

Each task contains a predefined set of lookup types that are classified and stored. Open a task to search and edit the required lookup. However, you may not be able to edit a lookup if its configuration level doesn't support editing.
Why can't I see my lookup types?

Lookup types are classified using tasks that involve a group of related lookups, such as Manage Geography Lookups. Each task gives you access only to certain lookup types.

However, the generic tasks provide access to all lookups types of a kind, such as common lookups associated with the Manage Common Lookups task. If the lookup types in an application are available in the standard, common, or set-enabled lookups view, they're are central to an application. However, lookup types defined for a specific application are managed using the task for that application.

Can I create a new lookup name starting with ORA?

No, you can't create a new lookup with the name starting with ORA. The application validates the lookup names to avoid any conflict with the lookups seeded in the application.

Overview of Scheduled Processes

Scheduled processes do tasks that are too complex or time-consuming to do manually, for example importing data or updating many records. You can run scheduled processes on a recurring schedule and send notifications based on how the process ends.

Some scheduled processes give you printable output. Those processes might have Report in their name.

Use the Scheduled Processes work area to run all the processes you have access to and to manage submissions. If you need access to this work area, ask your security administrator to assign you a role that gives you access, for example a custom role with the Manage Scheduled Processes (FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege. Other than the Scheduled Processes work area, you might be also able to run certain processes from other work areas.

Jobs and Job Definitions

Each scheduled process that you run is based on a job. The job is the executable that controls what the process does. Each job needs a job definition, which, for example, determines the parameters and other options you have for the process. You or your administrator can create job definitions for Oracle Analytics Publisher reports so that users can run the reports as scheduled processes.

Process Sets

A process set is a scheduled process that contains multiple processes or even other process sets. So, when you submit a process set, you're running more than process.

**Note:** When you submit certain scheduled processes, the job logic causes other processes to automatically run. But in this case, you're not submitting a process set that includes those other processes.
Submission

When you submit a scheduled process, you can use its parameters to control how, and which records are processed. For example, a process includes only the transactions that were edited by the person you select for a Last Updated By parameter. Some scheduled processes don’t have parameters.

As part of the submission, you can also set up a schedule for the process, for example to run once a week for two months. Every time a process runs, there’s a unique process ID.

Output

Some scheduled processes provide output in PDF, HTML, and other formats. For example, a process can import records and also produce output with details about those records. There are many types of output, for example a tax document or a list of transactions.

Related Topics

• Submit Scheduled Processes and Process Sets
• View Status and Other Details for Scheduled Processes
• Cancel or Make Changes to Scheduled Processes
• View Output from Scheduled Processes
• Create Job Definitions to Run Reports as Scheduled Processes
• Best Practices for Scheduled Processes in Fusion Applications

Profile Options and Scheduled Processes for SR Management

SR Profile Options

Profile options let you configure and control application data centrally.

Administrators and setup users manage profile options in the Setup and Maintenance work area. You can set various profile options and schedule job processes for service requests. Some of the profile options must be used along with job processes to achieve the results you want. For example, after setting the profile value for closing a resolved SR after N number of days, schedule a job process that closes SRs.

Here’s a table that describes the various profile options for service request management:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_ASSIGN_TO_QUEUE_ON_CREATE</td>
<td>Assigns an SR to a queue automatically, when the SR is created.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The preferred way of assigning an SR to a queue is by using Omnichannel assignment. If Omnichannel is enabled, this profile option is ignored.</td>
</tr>
<tr>
<td>Profile Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| SVC_SR_IN_RESOLVED_DAYS | Defines the number of days after which any resolved SR is automatically closed. This profile option must be used along with the Auto-Close Service Requests job process. For more information, see Scheduled Processes for SR Management. Make sure the following two conditions are met:  
- The SVC_SR_IN_RESOLVED_DAYS profile value must be set to 1 or greater for the Auto-Close Service Request job to run.  
- The SVC_SR_IN_RESOLVED_DAYS profile value must be set to 0 to disable the Auto-Close Service Request job. |
| SVC_SR_IN_WAITING_DAYS | Defines number of days for which a service request must be in Waiting status before the SR is auto resolved. This profile option must be used along with the Auto-Close Service Requests job process. For more information, see Scheduled Processes for SR Management. Make sure the following two conditions are met:  
- The SVC_SR_IN_WAITING_DAYS profile value must be set to 1 or greater for the Auto-Close Service Request job to run.  
- The SVC_SR_IN_WAITING_DAYS profile value must be set to 0 to disable the Auto-Close Service Request job. |
<p>| SVC_AUTO_CLOSED_STATUS_CD | Defines the status code to use for auto-closing service requests that have been in Resolved status for at least the number of days specified by SVC_SR_IN_RESOLVED_DAYS. This profile option must be used along with the Auto-Close Service Requests job process. For more information, see Scheduled Processes for SR Management. |
| SVC_AUTO_RESOLVED_STATUS_CD | Defines the status code to use for auto-resolving service requests that have been in Waiting status for at least the number of days specified by SVC_SR_IN_WAITING_DAYS. This profile option must be used along with the Auto-Close Service Requests job process. For more information, see Scheduled Processes for SR Management. |
| SVC_PUID_FORMAT | Defines the format for the unique reference number on each SR. Every SR number consists of a prefix and radix. Let’s say that you select SR_ as the prefix and No alphanumeric conversion as the radix. Without this formatting profile option, the SR numbers are generated as SR_1, SR_2, and so on. Now suppose you use this formatting profile option and the value is 000000. Then the SR numbers are generated as SR_000001, SR_000002, and so on. For more information about configuring the prefix and radix, see “Configure the Prefix and Radix for Service Requests”. Note: The SVC_PUID_PREFIX profile option used earlier no longer exists. |
| SVC_SR_DEFAULT_SEVERITY_CD | Sets the default Severity value for a new SR. You can also set this value as blank, if you want the SRs to be created without a Severity value. |
| SVC_SR_DEFAULT_STATUS_CD | Sets the default Status code for a new SR. |
| SVC_SR_IN_DELETED_DAYS | Defines the number of days after which a deleted SR is purged. Although a soft deleted SR is in the database, it can't be retrieved or updated from the UI or REST APIs. Once purged, SRs are |</p>
<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile Option</strong></td>
<td>**Description</td>
</tr>
<tr>
<td>SVC_INBOUND_ENABLE_FAILED_MESSAGE_PURGE</td>
<td>Enables or disables purging of inbound messages that fail or aren't processed successfully. When the value is set to Yes, the purge job deletes the records corresponding to such messages from the inbound message tables.</td>
</tr>
<tr>
<td>SVC_EVENT_HISTORY_DAYS_TO_KEEP</td>
<td>Specifies the number of days for which the SR event history details such as update and create must be retained. The data beyond this value is purged.</td>
</tr>
<tr>
<td>SVC_INBOUND_MSG_RETENTION_DAYS</td>
<td>Specifies the number of retention days for successfully processed inbound messages. After the specified number of retention days, the successfully processed inbound messages are deleted from the inbound message tables.</td>
</tr>
<tr>
<td>SVC_ENABLE_MESSAGE_CORRECTION</td>
<td>Enables you to edit the text of the Internal Note and Customer Entry SR messages that you have previously created and posted.</td>
</tr>
<tr>
<td>SVC_ENABLE_RESOLVE_SR</td>
<td>Enables the ready-to-use workflow for resolving a service request. This profile option is disabled by default. When enabled, the Resolve link is displayed in the Actions menu. Clicking Resolve displays a dialog box that captures the service request outcomes and resolutions, and enables you to enter resolution notes. Note: If this profile option isn't enabled, you can still manually set the service request status to Resolved.</td>
</tr>
<tr>
<td>SVC_ENABLE_SEVERITY_COLOR_IN_SR</td>
<td>Enables the color code for the service request severity set up in the Manage Service Request Severities task, if set to Yes. The task Manage Service Request Severities allows you to add different severity levels for service requests and define different colors.</td>
</tr>
<tr>
<td>ORA_ENABLE_QUEUE_MEMBER_NOTIFICATIONS</td>
<td>Enables selecting all queue members as notification recipients, on the Notification Preferences page. Performance may be impacted if you have a large number of queue members and use this option.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td>SVC_ENABLE_SEVERITY_COLOR_IN_SR</td>
<td></td>
</tr>
</tbody>
</table>

**Configure the Prefix and Radix**

When a service request is created, a unique number or ID is generated for it by the application. Users can't easily read or use these unique IDs because of their length and complexity. As an administrator, you can configure the unique ID that's generated to make it more user-friendly, readable, and specific to your requirement. This user-friendly value called the public unique ID consists of a prefix and a radix, and you can configure both of them. For example, SR_0000027413 is a configured public unique ID, where SR_ is the prefix and 0000027413 is the radix or suffix.
To configure the prefix and radix for:

1. Sign in to the application as a setup user or administrator.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Productivity Tools
   - Task: Manage Public Unique Identifier Sequence Generation
3. On the Manage Public Unique Identifier Sequence Generation page, for the **Object Name**, specify a prefix of your choice in the **Prefix** column. For example:
4. Click in the **Radix** column for the object.
5. From the multiple options displayed in the drop-down list, select the type of radix that you want for your .

   This option determines the radix value of the request number. To format the autogenerated radix value, you can configure the **SVC_PUID_FORMAT** profile option as described in the topic.
6. Click **Save and Close**.

**Related Topics**
- Overview of Public Unique IDs

**Permit SR Contacts that Aren't Related to the Primary SR Account**

If you're using the application to serve a customer with an account hierarchy with multiple subsidiaries, it's possible that the primary contact on an SR may be from a different subsidiary than the primary customer account. Or, you may have a third party who has the permissions to report an SR and also interact with the SR. For example, an implementor or partner contact, or a private contractor.

In such scenarios, you would want to remove the built-in validation that requires the SR account and SR contact to be interrelated. And you can permit the following types of primary and secondary contacts on an SR:

- Contacts that belong to multiple accounts
- Contacts with no account
- Contacts associated with a partner account
- All of the above

You can do this by configuring the following profile options.

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_SVC_ALLOW_ANY_CONTACT_ON_SR</td>
<td>Specifies whether contacts that aren't related to the SR can be added to an SR. This includes contacts of other accounts, consumer contacts, and partner contacts. The default value is No.</td>
</tr>
<tr>
<td>ORA_SVC_DEF_ACCESS_FOR_3RD_PARTY_CONTACTS</td>
<td>Specifies the default access level for third party contacts to view the contents of an SR. The default value is No Access. If you set the value to Regular Access, third party contacts can view an SR. So, contacts who are added to the SR but don't belong to the SR account can view the SR in Digital Customer Service.</td>
</tr>
</tbody>
</table>
SR Management Scheduled Processes

You can set various profile options and schedule job processes for service request (SR) management.

You must use some of the profile options along with the job processes to achieve the results you want. For example, when you set the profile value for closing a resolved SR after N number of days, also schedule a job process that closes SRs. Run scheduled processes to manipulate a set of records for a specific business need, or to get printable output with information about certain records. Some processes do both, for example, to import records and provide a report about them.

Here's a table that describes the job processes you can schedule to manage SRs. For more information about SR scheduled processes, see the Understanding SR Scheduled Processes guide on Help Center.

<table>
<thead>
<tr>
<th>Job Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Close Service Requests</td>
<td>Closes service requests that were resolved a certain number of days ago, and resolves service requests that have been in waiting status for a certain number of days. The number of days for both the scenarios is set using the SVC_SR_IN_RESOLVED_DAYS and SVC_SR_IN_WAITING_DAYS profile options respectively.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When an SR is closed by this job process, the Status field on the SR can be audited.</td>
</tr>
<tr>
<td>Purge Deleted Service Requests</td>
<td>Purges service requests and their child records that were deleted a certain number of days ago. The number of days is set using the SVC_SR_IN_DELETED_DAYS profile option.</td>
</tr>
<tr>
<td>Purge Inbound Messages</td>
<td>Purges the successfully processed messages from the inbound message database tables, based on the retention days specified in the SVC_INBOUND_MSG_RETENTION_DAYS profile option. If the SVC_INBOUND_ENABLE_FAILED_MESSAGE_PURGE profile option to set to Yes, this job also purges inbound messages that failed or weren’t processed successfully.</td>
</tr>
<tr>
<td>Load and Update Cloud Metrics for Service</td>
<td>Performs incremental loading and updating of usage and business metrics that are targeted to cloud usage patterns.</td>
</tr>
<tr>
<td>Service Request Queue Assignment</td>
<td>Assigns queues to service requests. This job takes the following parameters:</td>
</tr>
<tr>
<td></td>
<td>- Work Object Code: Indicates business objects that get assigned to agents, such as, service requests.</td>
</tr>
<tr>
<td></td>
<td>* Expected Value: ORA_Service_Request_Work_Object</td>
</tr>
<tr>
<td></td>
<td>- Candidate Object Code: Indicates objects that are the possible pool of assignment candidates, such as queues.</td>
</tr>
<tr>
<td></td>
<td>* Expected Value: ORA_Queue_Candidate_Object</td>
</tr>
<tr>
<td></td>
<td>- Assignment Mode (List of Values: Classification, Matching, Scoring, Territory): Indicates the type of assignment processing. Matching is the only mode that’s supported.</td>
</tr>
<tr>
<td></td>
<td>- View Criteria Name: Indicates the view criteria used to identify the service requests to be assigned.</td>
</tr>
<tr>
<td></td>
<td>* Expected Value: OpenSRsUnassignedToQueueByStripeCd</td>
</tr>
<tr>
<td>Job Process Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Job Process Name</td>
<td>Description</td>
</tr>
<tr>
<td>• Bind Variable: Indicates the bind variables required for</td>
<td>Expected Value: BindStripeCd=ORA_SVC_CRM</td>
</tr>
<tr>
<td>the view criteria.</td>
<td>• Metrics Logging Interval (default value is 100): Indicates the number of work objects in a subprocess before logging assignment metrics, such as update metrics after processing 100 SRs. This is used if your object support Enterprise logging for assignment.</td>
</tr>
<tr>
<td>• Diagnostic Mode (check box): Indicates if the process</td>
<td>• Diagnostic Mode (check box): Indicates if the process must be run in diagnostic mode to view the details of assignment processing in an output log.</td>
</tr>
<tr>
<td>must be run in diagnostic mode to view the details of</td>
<td></td>
</tr>
<tr>
<td>assignment processing in an output log.</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td></td>
</tr>
<tr>
<td>Service Configuration Setup</td>
<td>Schedules service setup jobs, such as metrics. This job must be run once during implementation. Ensure that you run this job before you create service requests.</td>
</tr>
<tr>
<td>Aggregate Service Requests</td>
<td>Enables querying service request data for reporting, using the CRM - CRM Service Request Summary subject area. The recommended frequency for running this job is one hour.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you need faster data refreshes, increase the frequency. However, this impacts the performance of the transaction system.</td>
</tr>
<tr>
<td>Monitor Service Request Milestones</td>
<td>Ensures that the service request and milestone status are up-to-date and sends an email notification if compliance issues or warning flags are found.</td>
</tr>
<tr>
<td>Purge Service Event History</td>
<td>Evaluates the processed records and retains the data for the days specified in the profile option SVC_EVENT_HISTORY_DAYS_TO_KEEP, while it purges the rest. The recommended frequency for running this job is daily.</td>
</tr>
<tr>
<td>Monitor Action Plan Actions</td>
<td>Evaluates the status of an action plan.</td>
</tr>
<tr>
<td>Execute Incremental Load of Cross-Channel Interaction</td>
<td>Incrementally loads cross-channel interaction data, for reporting using the CRM - CRM Interaction Aggregate subject area. You must run this job daily to load and update the new data everyday.</td>
</tr>
<tr>
<td>Execute Full Load of Cross-Channel Interaction for</td>
<td>Fully loads cross-channel interaction data, or refreshes the data based on a particular date, for reporting using the CRM - CRM Interaction Aggregate subject area. This is an on-demand job. You must run this job in the following scenarios:</td>
</tr>
<tr>
<td>Reporting</td>
<td>• The first time data is loaded.</td>
</tr>
<tr>
<td></td>
<td>• Any time the data needs to be refreshed from a specific date.</td>
</tr>
</tbody>
</table>
Configure a Scheduled Process

Here’s how you configure a scheduled process:

1. Sign in to the application as an administrator.
2. From the Navigator, select Scheduled Processes. The Scheduled Processes Overview page is displayed.
4. Select Job as the Type option.
5. In the Name drop-down list, click Search to search and select the process that you want to configure.
6. In the Process Details dialog box for the selected job, click Advanced.
7. On the Schedule tab, select Using a schedule as the Run option.
8. Specify the Frequency for the job.
9. Select the Start Date and End Date for the job.
10. Click Submit.

| Note: The scheduled process is visible only to the user who creates the job. |
How a Request Is Closed

A request is closed automatically when the scheduled process runs as scheduled. This process closes requests that were resolved a certain number of days ago. The number of days for this scenario is set using the profile.

Related Topics
- SR Management Scheduled Processes

Audit Trail for Service Requests

Enable Creating an Audit Trail

You can create an audit trail of changes made to a request. By default, only certain fields of the object are audited. If you want more fields to be audited, you must add them. You can also do an audit for the child objects by doing some configuration. Similarly, you must enable the audit for any administrator-defined child objects that you create from Application Composer.

To enable the audit for additional fields or the child objects of the object:

1. Sign in to the application as a setup user or administrator.
2. Navigate to the Setup and Maintenance work area.
3. Open the Tasks panel tab and click Search.
4. In the Search window, search for and click the Manage Audit Policies task.
6. On the Configure Business Object Attributes page, select from the Product drop-down list.
7. Click Add.
8. In the Select and Add Audit Attributes dialog box, select the check box next to the attribute that you want to add, and click OK.
9. To add attributes to audit for each predefined or administrator-defined child object of the object, select the check box next to the object.
   
   **Note:** The predefined child objects and administrator-defined child objects of the Service Request object are displayed. For each of these child objects, one or more attributes are audited by default.
10. Repeat steps 7 and 8 to add more attributes.
11. Click Actions > Synchronize.
12. Click Save and Close.
FAQs About SR Management

Frequently Asked Questions (FAQs) for SR Management

This section contains some frequently asked questions (FAQs) when setting up and maintaining SR Management. Scroll or search to find answers to common questions.

What happens if two contacts are merged, and how does it impact service requests?

If two contacts are merged, you may see a change in the primary contact of a service request (SR).

This change occurs because the contact remaining after the merge is now associated with the SR, as it replaces the merged contact. However, no data is lost since the records are merged.

When two contacts are merged:

- The SRs associated with the merged contact are now associated with the remaining contact.
- If two contacts associated with the same SR are merged, you can see only the remaining contact in the SR.
- All the SR messages point to the remaining contact after merging.
- The SR shows all the interactions with both the merged contact and the remaining contact.
- Interactions for the remaining contact also show the interactions for the merged contact.

Note:

- You must select All functional areas as the merge scope when setting up Customer Hub using the Manage Customer Data Management Options task. It’s necessary to select this merge scope for the service objects to be included in the scope.
- If you have defined an Application Composer rule that doesn’t permit the primary contact on an SR to be updated, then the contacts don’t merge.

Related Topics

- Survivorship Rules
- How You Merge Duplicate Records
- Automerge
What happens if two accounts are merged, and how does it impact service requests?

If two accounts are merged, you may see a change in the account displayed in the Account field of the Summary subtab in a service request (SR). That's because the account remaining after the merge is now associated with the SR, as it replaces the merged account. However, no data is lost, as the records are merged.

When two accounts are merged:

- The SR objects associated with the merged account are associated with the remaining account.
- The merged account is no longer associated with the SR. Instead, the remaining account is associated with the SR.
- All the contacts associated with the merged account are now associated with the remaining account. So if the SR had a contact from the merged account, that contact is still associated with the SR.
- The SR shows all the interactions with both the merged account and the remaining account.
- Interactions for the remaining account also show the interactions for the merged account.

**Note:**

- You must select All functional areas as the merge scope when setting up Customer Hub using the Manage Customer Data Management Options task. It's necessary to select this merge scope for the service objects to be included in the scope.
- If you have defined an Application Composer rule that doesn't permit the update of the account on the SR, then the accounts don't merge.

**Related Topics**

- Survivorship Rules
- How You Merge Duplicate Records
- Automerge

Why are some service request reference numbers missing from the sequence?

Service request (SR) reference numbers aren't guaranteed to be in sequence. That's because they're generated as soon as the user clicks the Create Service Request button on the Service Requests page.

If the user decides to cancel the SR, then that SR reference number is lost because the same number isn't used again by the application.

SR reference numbers could be missing because of the following reasons:

- The SR reference numbers are based on a document sequence which has a cache size of 1000. So whenever a database server is restarted, it pulls the next 1000 numbers, even if the last set of 1000 numbers weren't all used up.
• If you have a couple of missing SR reference numbers within the set of 1000 numbers, the reason could be any of the following:
  o The SR was deleted.
  o An error occurred when the SR was being created.
  o The SR was canceled midway while creating it.

Why can’t I set some service request fields by using groovy scripts or object workflow?

Sometimes, you may be unable to set a service request field by using groovy scripts or object workflow. If this happens, you must verify in the Application Composer whether it's a read-only field. You can't set a read-only field on a service request by using groovy scripts or object workflow.
4 Users and Security

Enter Your Company Information and Corporate Currency

These steps are required if you haven’t previously configured Fusion Sales in your instance.

What you have to do is enter basic information in the Sales: Setup page about your company and specify your corporate currency. Your entries are required for internal application purposes only and are required for your instance of Fusion Service. The information you enter creates a rudimentary enterprise structure and isn’t visible to service organization users or customers.

When you finish this procedure you will have:

- Created a rudimentary enterprise structure required for internal application purposes only.
  - The enterprise structure isn’t visible to service organization users or their customers.
- Created a set of automatic role-provisioning rules that provision users with the required security roles.

This is a one-time setup. After you enter the information on the Create Company Information page, the page becomes read-only and the title changes to Review Company Information.

So, enter your company information and corporate currency by doing the following:

1. Open the task from the Setup: Sales page by clicking the Quick Setup icon for the Company Profile functional area (the gears icon highlighted by callout 1 in the following figure). If any changes are required after your initial setup, you can open the appropriate tasks in the Task area.
2. In the Create Company Information page, enter your company name in the Enterprise Name field.
3. Enter the country where your company is located.
4. Enter your company street address. Don’t enter city or state and other information.
5. The first and last name fields list the names of the user who signed into the application. You can edit the entries.
6. When you’re satisfied that the information is correct, click Submit.
   The application runs a background process to create the enterprise structure and create the role-provisioning rules.
7. Optionally, click Refresh to monitor the progress of the process.
   When the process completes, the Review Company Information page appears. The page displays both the information that you entered and the information that the process created for you. You can’t edit any of the fields except Corporate Currency. None of the names you see are visible to salespeople, so they don’t have to correspond to any actual entities in your organization. The following table lists and describes the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Name</td>
<td>The name you entered.</td>
</tr>
<tr>
<td>Address</td>
<td>The street address you entered.</td>
</tr>
</tbody>
</table>
Overview of Defining Setup Users

One of your first tasks when setting up the application is the creation of users who can perform setup tasks.

Oracle creates an initial user for you when your environment is provisioned. This initial user is configured to perform security tasks, such as creating other users and granting additional privileges. As an initial user you can create users, known as setup users, to help with application setup. The setup user performs the tasks in implementation projects, sets up enterprise structures, creates application users, and administers security.
Use the Manage Users task in the Setup and Maintenance work area to create setup users. You can access this task in the Setup and Maintenance work area by selecting these options:

- Offering: Customer Data Management
- Functional Area: Users and Security
- Task: Manage Users

For information about creating setup users, see the *Implementing Sales* guide.

### Overview of Setting Up Users and Security

Since you followed the *Implementing Sales* guide steps to set up your initial set of users, then you already know that Oracle applications use a role-based access control security model to secure access to functionality and data.

In a role-based access control security model, users are assigned roles, and roles are assigned access privileges to protected system resources.

Sales users who access the transactional UI, for example sales representatives working in leads and opportunities, are created as resources and are known as sales resources.

### Default Preferences

To set up default preferences for users and roles, access the Security Console as a setup user or other user with the IT Security Manager job role. Only setup users, or other users with the IT Security Manager job role, can access the Security Console. See the *Securing Fusion Sales and Service* guide for more information.

### User Identity Store

The Lightweight Directory Access Protocol (LDAP) identity store is a repository of user identity data. Your LDAP directory stores definitions of LDAP user accounts. In general, changes you make to user accounts are automatically synchronized between the sales application and your LDAP directory server. However, you must also run processes on a daily basis to manage the information exchange between your application and the LDAP directory server. For information, see the chapter about setting up application security in the *Securing Fusion Sales and Service* guide.

### Setup Tasks in the UI and Other Setup Options

As a setup user, you use multiple different tasks in Setup and Maintenance to create and maintain users. You also have additional setup options to consider. The following table describes these tasks and setup options.

<table>
<thead>
<tr>
<th>Setup Task or Option and Navigation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Job Roles Task</td>
<td>Oracle provides many predefined job roles. The relevant sales roles are listed in the <em>Implementing Sales</em> guide.</td>
</tr>
<tr>
<td><strong>Navigation:</strong> Setup and Maintenance &gt; Sales Offering &gt; Users and Security functional area</td>
<td>You perform the Manage Job Roles task to:</td>
</tr>
<tr>
<td></td>
<td>• Review the role hierarchy of a job or abstract role.</td>
</tr>
<tr>
<td></td>
<td>• Create custom job and abstract roles.</td>
</tr>
<tr>
<td></td>
<td>• View the roles assigned to a user and list the users who have a specific role.</td>
</tr>
<tr>
<td>Setup Task or Option and Navigation</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Manage Duties Task</strong></td>
<td>This task opens the Roles tab of the Security Console.</td>
</tr>
<tr>
<td>Manage Sales and Service Access Management Task</td>
<td>You perform the Manage Duties task to:</td>
</tr>
</tbody>
</table>
| Navigation: Setup and Maintenance > Sales Offering > Users and Security functional area |  - Review the duties of a job or abstract role.  
  - Manage the duties of a custom job or abstract role.  
  - Create custom duty roles.  
  This task opens the Roles tab of the Security Console. |
| **Manage Data Security Policies Task** | You use the Manage Data Security Policies task to manage the data security policies that determine grants of entitlement to a user or role on an object or attribute group. This task opens the Roles tab of the Security Console. |
| Manage Sales and Service Access Task | You can also use the Manage Sales and Service Access task to review and configure data security. This task opens the Sales and Service Access Management work area. For information, see the Securing Fusion Sales and Service guide. |
| Navigation: Setup and Maintenance > Sales Offering > Users and Security functional area | **Navigation:** Navigator > Users and Roles item or Setup and Maintenance > Sales Offering > Users and Security functional area | You create application users in the UI using the Manage Users task. A user with the IT Security Manager job role performs the Manage Users tasks.  
  **Note:** You can also create sales users by importing users. For information on the user import options available, see the Understanding Import and Export Management for Fusion Sales and Service and Implementing Sales guides. |
| **Manage HCM Role Provisioning Rules Task** | Oracle provides predefined role mapping rules for provisioning many of the standard job roles included with the application. However, using the Manage HCM Role Provisioning Rules task, you can create any additional role mappings you need to, to control the provisioning of roles to application users. For example, you can create a role mapping to provision the Channel Sales Manager role automatically to specific sales managers. |
| Navigation: Setup and Maintenance Sales Offering > Users and Security functional area | **Import and Export Management** | You can import users in bulk using data files. For information on the user import options available, see the Understanding Import and Export Management for Fusion Sales and Service and Implementing Sales guides. |
| **Import Partner Users Task** | You can also import partner contact data using the Import Partner Users task. For more information, see the Getting Started with Your Partner Relationship Management Implementation guide. |
| **Single Sign-On Authentication** | Single sign-on authentication is optionally available for user authentication. If your enterprise has moved from a traditional on-premises environment to an Oracle Cloud implementation, you might want to use your existing identity management solution for authenticating your employees, and you might also want to provide a single sign-on experience. Implementing federated single sign-on lets you provide users with single sign-on access to applications and systems located across organizational boundaries. For additional information, see Oracle Applications Cloud Service Entitlements (Doc ID 2004494.1) on My Oracle Support at https://support.oracle.com. |
| **Resetting User Passwords** | Setup users provisioned with the IT Security Manager job role can use the Users tab in the Security Console work area to reset passwords for all application users. Users who can't access the Security Console can reset only their own passwords using the Set Preferences link in the Settings and Actions menu available by clicking their user name in the application or by using the Forgot Password link on the sign-in page. See the Implementing Sales guide for more information. |
### Setup Task or Option and Navigation

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the Users tab in the Security Console work area to change user email addresses. You can use the procedure described in this topic to update addresses of both setup users and sales users. If you're updating the email addresses of sales users, then you can also use the same import process you use to create them. See the <em>Implementing Sales</em> guide for more information.</td>
</tr>
</tbody>
</table>

**Note:** Other data security tasks listed in the Users and Security functional area task list don’t apply to the sales applications. Follow the guidance in the *Implementing Sales* and *Securing Fusion Sales and Service* guides.

---

### Related Topics
- Set General Preferences for All Users
- Subject Areas for Adoption and Usage Reporting

---

### Overview of Resources and Resource Management

Here’s an overview of resources and the different ways that you can logically group them. See the related links for more information on each.

#### Resource

A resource is an application user who participates in business processes, such as Customer Service Manager or Help Desk Agent. You must identify or import resources before you can associate them with resource organizations or work objects.

#### Resource Role

You use resource roles to define role provisioning rules. For example, using a provisioning rule, you can assign the Customer Service Manager job role to a user with the Customer Service Manager resource role. Oracle Applications Cloud includes some predefined resource roles. Use these predefined, out of the box, resource roles, or create your own resource roles.

#### Resource Directory

The Resource Directory gives you detailed information about all the resources within a deploying organization. You can also use the Resource Directory to find and communicate with other resources, and to network and collaborate with them. Access the Resource Directory using the following path: Navigator > Resource Directory. You can also perform some of the functions of the resource directory using the Manage Resources setup task.

#### Resource Organization

You create resources and provision the permissions that the resources need to do their jobs. In the process, you also build the organization chart of your organization. You can assign organization usage information to resource organizations to classify them based on how on how you want to use them. For instance, you can assign resource
organizations engaged in customer service activities to the Customer Service Organization usage. You can then sort organizations based on their usage.

A resource organization becomes a primary resource organization by usage for a resource, if you meet the following criteria:

- The resource must be a member of the concerned organization.
- The resource organization must be classified as an organization with the specific usage.

For example, if you classify the resource organization as a customer service organization by usage, then the resource organization becomes the primary resource organization for the resource for customer service.

Resource Team

A resource team is a temporary group of resources formed to complete a business task. A resource team can be made up of resource organizations, resources, or both. A resource team is neither hierarchically structured nor intended to implement an organization structure. You can use resource teams as a quick reference to groups of related resources to which you can quickly assign work objects.

Related Topics
- Overview of Setting Up Users and Security
- About Resource Role Assignment
- Overview of Resource Organizations and Organization Usages

Setting Up Resource Teams

Manage Resource Teams

This procedure describes how to manage resource teams. A resource team is a temporary group of resources formed to complete a business task. A resource team can't be hierarchically structured and isn't intended to implement an organization.

Create Resource Teams

To create resource teams:

2. Click the Create action menu option or button.
   
   The Create Team page appears.
3. Enter an appropriate team name.
4. Optionally, enter a team description and specify team usage, resource members, and organization members.
5. Click Save and Close.
Edit Resource Teams

To edit resources teams:

2. Search for the resource team that you want to edit.
   You can search by entering criteria such as the team name, number, and usage. You can also use the saved searches.
3. Select the resource team you want to edit from the Search Results region and click its name to navigate to the Edit Team page.
4. On the Edit Team page, you can edit the team's details such as the team name, description, usage, resource members and organization members.
5. Click Save and Close.

How Resources Work Within a Team

This topic explains how resources work within a team.

You can include resources from different resource organizations to work together on a work object as members of the same resource team. You can also include the entire resource organization into a resource team. The resource organization membership and their hierarchy determine what a resource can do. Resource teams provide a flexible way of bringing resources together without any organizational or hierarchy-based restrictions.

Assigning Resources to Teams

You can assign identified resources to teams and assign them roles within the team. Each resource can have a specific role within a team. A resource may play different roles in different teams.

How Resource Team Membership and Role Assignment Components Work Together

This topic explains the team membership and role assignment for resources.

Resources who are team members can be assigned different roles within the team. These roles don't necessarily reflect the roles these resources might play in resource organizations. Depending on the task requirements of the team, roles are assigned to resources. Based on the role assignment, resources can access data related to the tasks in the team. You can manage the resources in a team using the Manage Resource Teams task. You can access the Manage Resource Teams task as follows: Click Navigator > Resource Directory > Tasks > Manage Resource Teams.

Resource Team Membership

A resource can belong to multiple teams depending on the requirements of these teams and the skills that the resource offers. This doesn't affect the resource's membership with organizations within the deploying company.
Role Assignment

Resources have specific roles to play in the team to which they belong. Each of these roles can be different. Also, these roles can be different from the roles assigned to the same resources in resource organizations. Thus, a resource can be a manager in one team and a member in another simultaneously.

FAQs for Define Resource Team Information

Frequently Asked Questions (FAQs) for Resource Team

This section contains some frequently asked questions (FAQs) when setting up and maintaining a Resource Team. Scroll or search to find answers to common questions.

What's a resource team?

A resource team is a group of resources formed to work on work objects. A resource team can comprise resource organizations, resources, or both. A resource team is neither hierarchically structured nor intended to implement an organization structure.

You can use resource teams as a quick reference to groups of related resources to which you can quickly assign work objects.

Note: You can either individually assign the members of a team to a task or assign entire teams to tasks.

What's the difference between a resource organization and a resource team?

A resource organization is an organization whose members are resources. Resource organizations are used to implement sales organizations, partner organizations, and so on.

A resource team is a temporary group of resources formed to work on work objects. A resource team may contain a resource organization or resources or both. A resource team can't be hierarchically structured and isn't intended to implement an organization.
Can I assign multiple resource roles to a team member at the same time?

Yes. Resources within resource teams can have multiple resource roles. You can add roles to a resource in a resource team using the Manage Resource Teams task. Select the resource and click the Edit button to assign additional roles to the resource.

About Security Roles

Many job roles and duty roles are predefined in the Service offering. The following table lists the main predefined job roles specific to this product area.

For a more complete list of job roles, refer to the Related Topics area for a link to the Security Reference for Fusion Sales and Service guide.

<table>
<thead>
<tr>
<th>Job Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service Manager</td>
<td>Manages a group of Customer Service Representatives. The person in this job role manages the queues of open service requests. Also, this person ensures that work is being assigned and resolved by the pool of resources. This individual also monitors incoming service requests.</td>
</tr>
<tr>
<td>Customer Service Representative</td>
<td>Responds to a variety of customer requests. The person in this job might receive requests to help with a product or service problem or to clarify a pricing or ordering question. This individual is usually assigned to one or more queues of service requests that are used to categorize incoming service requests by customer type, category, or product.</td>
</tr>
<tr>
<td>Knowledge Analyst</td>
<td>Creates, curates, and maintains knowledge articles. The person in this job supports the work of Customer Service Managers and Customer Service Representatives as they manage customer issues.</td>
</tr>
<tr>
<td>Knowledge Manager</td>
<td>Manages a knowledge instance. The person in this job manages the administration and operations of a knowledge program. In addition, this person ensures that knowledge can be created and maintained by analysts and found by knowledge users.</td>
</tr>
</tbody>
</table>

In addition to the job roles, the following table lists the duty roles specific to the Service offering.

<table>
<thead>
<tr>
<th>Duty Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Request Troubleshooter</td>
<td>Manages all aspects of the Service Request object. A customer service representative is typically given this duty role</td>
</tr>
<tr>
<td>Service Request Contributor</td>
<td>Creates or adds information to service requests. This person has basic Service Request Management capabilities. This person can't respond to customers, assign service requests to a user, or delete attachments from service requests.</td>
</tr>
</tbody>
</table>
### Duty Role

#### Description

- **This role is typically given to non-service users, for example, sales representatives, product managers and engineers.**

- **Service Request Power User**
  Do all the tasks that a troubleshooter can, with the added privileges to manage queues. Customer service managers are typically given this duty role.

- **Service Request Administrator**
  Do all the tasks that a power user can do. Additionally, this person can administer all aspects of the application, including the setup. CRM application administrators are typically given this role.

- **Service Request Channel User**
  Manages all aspects of a service request that is associated with a partner account. This duty is similar to the service request troubleshooter.

- **Service Request Partner User**
  Submits service requests to get assistance with partner sales or support issues. This duty is granted to a contact from a partner account.

### Resource Roles and Provisioning Rules for Service

Oracle provides resource roles for the Service offering which are used to provision the standard service job roles. Oracle also provides the role provisioning rules for these resource roles so that service users are automatically assigned the job and abstract roles they need.

These are the service role provisioning rules provided by Oracle, the condition that triggers the provisioning, and the job and abstract roles each rule provisions.

<table>
<thead>
<tr>
<th>Provisioning Rule Name</th>
<th>Condition</th>
<th>Job or Abstract Roles Provisioned</th>
</tr>
</thead>
</table>
| Service Vice President | HR Assignment is Active  
Resource Role is Service Vice President | Customer Service Manager  
Resource |
| Service Administrator  | HR Assignment is Active  
Resource Role is Service Administrator | Customer Relationship Management Application Administrator  
Resource |
| Service Manager        | HR Assignment is Active  
Resource Role is Service Manager | Customer Service Manager  
Resource |
| Service Representative | HR Assignment is Active  
Resource Role is Service Representative | Customer Service Representative  
Resource |

**Note:** If you didn't use the Create Company Information quick setup task to set up your company information, then the predefined role provisioning rules aren't created; you must create the provisioning rules yourself. For information about creating provisioning rules, see the topic Create Rules to Automatically Provision Job Roles to Sales Users.
Set Up Service Request Visibility Based on Queue

How You Set Up Visibility Based on Queue

When users view lists of service requests (SRs) or create user-defined searches, their access is based on the cumulative set of data security policies assigned to all the roles associated with them.

You can restrict their user access based on their queue membership. This ensures users see only the SRs that are in their queue by completing the following processes in the Security Console:

- "Remove Data Security Policies from Users": If the users have been assigned other data security policies that grant them access to a larger set of SRs, then you must remove such data security policies from the users.
- "Assign Data Security Policies Based on Queue": Grant queue-based visibility to SRs for specific roles. This ensures that users with these specific roles can see only the SRs assigned to the queues where they're a resource member.

With this data security policy, your company has the additional option to ensure that all predefined and user-defined searches are limited only to queue membership for a set of users.

Related Topics
- Edit Data Security Policies on the Security Console
- Create Job and Abstract Roles
- Copy and Edit Duty Roles
- Copy Job or Abstract Roles

Remove Data Security Policies from Users

If your users have existing service duty roles and you don’t want them to view all the service requests that they can currently view, you must remove those data security policies from the users.

To remove the data security policies from your users:

1. Copy the predefined duty roles given to your users.
   
   For more information about copying roles, see "Copying and Editing Duty Roles" in the Oracle Fusion Securing Sales and Service guide.

2. Remove the data security policies that you don’t want these users to have.

   For more information about removing or creating data security policies, see "Managing Data Security Policies" in the Oracle Fusion Securing Sales and Service guide.
Assign Data Security Policies Based on Queue

The predefined roles don't have queue-based service request (SR) visibility. Let's say you assign the queue-based data security policies to your users. Then, users with these specific roles can see only the SRs assigned to the queues where they're a resource member.

To assign the queue-based data security policies to your users:

1. In the Security Console, create a new job role and click Next.

   For more information about creating or editing a job role, see "Creating Job or Abstract Roles" in the Oracle Fusion Securing Sales and Service guide.

2. For the new job role created in the previous step, create a new data security policy by specifying the following attributes:
   - Give an appropriate name to the policy.
   - Select the following Data Resource: Service Request Header.
   - Select the following Data Set: Select by instance set.
   - Select the following Data Condition Name: Access the service request header for table SVC_SERVICE_REQUESTS where the customer relationship management service request is assigned to a queue that they're a member of.
   - Select the appropriate actions. Typically, you must select all actions except Delete.

3. Click OK and continue to the Users section of the process for creating a job role.
4. Add the users to whom you want to assign this data security policy.
5. Save the job role.

Related Topics
- Edit Data Security Policies on the Security Console
- Create Job and Abstract Roles
- Copy and Edit Duty Roles
- Copy Job or Abstract Roles
Set Up Service Request Visibility Based on BU

How You Set Up Visibility Based on BU

When users view lists of service requests (SRs) or create user-defined searches, their access is based on the cumulative set of data security policies assigned to all the roles associated with them.

You can restrict users’ access based on their Business Unit (BU) membership, ensuring that the users see only the SRs that are assigned to the BUs where they’re a resource member. To do so, you must complete the following processes in the Security Console:

- "Remove Data Security Policies from Users": If the users have been assigned other data security policies that grant them access to a larger set of SRs, then remove such data security policies from the users.
- "Assign Data Security Policies Based on BU": Grant BU-based visibility to service requests for specific roles. This ensures that users with these specific roles can see only the SRs assigned to the BUs where they’re a resource member.

With this data security policy, your company has the additional option to ensure that all predefined and user-defined searches are limited only to BU membership for a set of users.

Related Topics

- Edit Data Security Policies on the Security Console
- Create Job and Abstract Roles
- Copy and Edit Duty Roles
- Copy Job or Abstract Roles

Remove Data Security Policies from Users

If your users have existing service duty roles and you don’t want them to view all the service requests that they can currently view, you must remove those data security policies from the users.

To remove the data security policies from your users:

1. Copy the predefined duty roles given to your users.
   For more information about copying roles, see "Copying and Editing Duty Roles" in the Oracle Fusion Securing Sales and Service guide.
2. Remove the data security policies that you don’t want these users to have.
   For more information about removing or creating data security policies, see "Managing Data Security Policies" in the Oracle Fusion Securing Sales and Service guide.
Assign Data Security Policies Based on BU

The predefined roles don't have service request visibility based on business unit (BU).

To assign the data security policies based on BU to your users:

1. In the Security Console, create a new job role and click **Next**.

   For more information about creating or editing a job role, see "Creating Job or Abstract Roles" in the Oracle Fusion Securing Sales and Service guide.

2. For the new job role created in the previous step, create a new data security policy by specifying the following attributes:
   - Give an appropriate name to the policy.
   - Select the following Data Resource: .
   - Select the following Data Set: **Select by instance set**.
   - Select one of the following data condition names:
     - **Access the service request header for table SVC_SERVICE_REQUESTS where the customer relationship management service request is associated with my business units or the application default business unit.**
     - **Access the service request header for table SVC_SERVICE_REQUESTS where the partner service request is associated with my business units or the application default business unit.**

3. Select the appropriate actions. Typically, you must select all actions except **Delete**.

4. Click **OK** and continue to the Users section of the process for creating a job role.

5. Add the users to whom you want to assign this data security policy.

6. Save the job role.

**Related Topics**

- Edit Data Security Policies on the Security Console
- Create Job and Abstract Roles
- Copy and Edit Duty Roles
- Copy Job or Abstract Roles
Data Security Policies on SRs

Define Access-Group-Based Data Security Policies

As a Customer Relationship Management Application Administrator or Sales Administrator, you can define access-group-based data security policies on service requests. Though predefined data security policies are available, you have the option to define additional data security policies based on access groups.

As compared to SQL-based data security policies, access groups are an alternative way of granting data permissions to users. Instead of creating security policies using SQL, you can use object-sharing rules in the sales and service access management UI to define your visibility criteria.

For more information about creating data security policies, see the Access Groups chapter in the Oracle Fusion: Securing Sales and Service guide.

If you're replacing existing SQL-based data security policies with policies based on access groups, then remember to set an end date for those policies.

Related Topics
• Create a Custom Access Group
• Add Members to Custom Access Groups Using the UI
• Create Custom Object Sharing Rules

Define System-Access-Group-Based Data Security Policies

Let's say you're a Customer Relationship Management Application Administrator or IT Security Manager. Then you can use system access groups and predefined rules to support service request data security for your users.

Every standard job role provided by Oracle has a corresponding system access group. The predefined object-sharing rules assigned to each system access group provide the same access to service request data as provided by the standard job roles.

Note: System access groups provide you an alternative way to manage a user's access to service request data. You can also create access extension rules to extend the access provided by the predefined rules to related objects.

System access groups are active by default. But the predefined object-sharing rules associated with each system access group are inactive by default. So you must activate these rules before you can use them. The association between system groups and predefined rules is also disabled by default. So for each system group, you must also enable the predefined rules you want to apply to the group.

For more information about:
• How to enable the predefined rules for a system access group: See the Oracle Fusion Securing Sales and Service guide.
Managing system access groups for service requests: See “Overview of System Access Groups” in the Oracle Fusion Securing Sales and Service guide.

The following table lists the predefined object-sharing rules for system access groups along with their descriptions.

<table>
<thead>
<tr>
<th>S. no.</th>
<th>Predefined rule name</th>
<th>This rule provides access to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>All Service Requests</td>
<td>All service requests.</td>
</tr>
<tr>
<td>2</td>
<td>All CRM Service Requests</td>
<td>Access to all CRM service requests.</td>
</tr>
<tr>
<td>3</td>
<td>CRM Business Unit Service Requests</td>
<td>All CRM service requests associated with the user’s business units.</td>
</tr>
<tr>
<td>4</td>
<td>CRM Partner Service Requests</td>
<td>All CRM partner service requests.</td>
</tr>
<tr>
<td>5</td>
<td>CRM Business Unit Partner Service Requests</td>
<td>CRM partner service requests associated with the user’s business units.</td>
</tr>
<tr>
<td>6</td>
<td>CRM Service Request Queue Member</td>
<td>All CRM service requests assigned to queues that the user is a member.</td>
</tr>
<tr>
<td>7</td>
<td>CRM Service Request Queue Member Hierarchy</td>
<td>All CRM service requests assigned to queues that the user’s subordinates are a member.</td>
</tr>
<tr>
<td>8</td>
<td>CRM Service Request Team</td>
<td>All CRM service requests where the user is on the SR team.</td>
</tr>
<tr>
<td>9</td>
<td>CRM Service Request Team Hierarchy</td>
<td>All CRM service requests where the user’s subordinates are on the SR team.</td>
</tr>
<tr>
<td>10</td>
<td>CRM Service Request Assignee</td>
<td>All CRM service requests where the user is the assignee.</td>
</tr>
<tr>
<td>11</td>
<td>CRM Service Request Assignee Hierarchy</td>
<td>All CRM service requests where the user’s subordinates are the assignee.</td>
</tr>
<tr>
<td>12</td>
<td>CRM Service Request Creator</td>
<td>All CRM service requests where the user created the SRs.</td>
</tr>
<tr>
<td>13</td>
<td>CRM Service Request Creator Hierarchy</td>
<td>All CRM service requests where the user’s subordinates created the SRs.</td>
</tr>
<tr>
<td>14</td>
<td>CRM Service Request Partner Account</td>
<td>All service requests where the SR is associated with the user’s partner account.</td>
</tr>
<tr>
<td>15</td>
<td>CRM Service Request Contact</td>
<td>All CRM service requests where the user is an SR contact.</td>
</tr>
</tbody>
</table>
### Predefined SQL-Based Data Security Policies

Every predefined rule was created to match an existing predefined SQL-based data security policy. So if you're enabling predefined rules, you must end date the matching predefined SQL-based data security policy.

Here's what you must do:

1. Navigate to Security Console.
2. Edit the role for which you're enabling predefined rules.
   The service request data security policies are given to duty roles such as Service Request Troubleshooter, Service Request Power User, and Service Request Contributor. So, you would edit the roles that you copied from these predefined roles.
3. Go to Step 3, Data Security Policies, in the wizard where you're editing the role.
4. Find the matching SQL-based data security policy for your predefined rule.
5. Edit the data security policy and set a past date as the end date for the data security policy.
Note: Let’s say you’re using the predefined service duty roles such as Service Request Troubleshooter. Then you must first copy those roles because the predefined roles can’t be edited.

Related Topics
- Create a Custom Access Group
- Add Members to Custom Access Groups Using the UI
- Create Custom Object Sharing Rules

Define Access Group-Based Data Security Policies for Messages
As a Sales Administrator or Customer Relationship Management Application Administrator, you can define access group-based data security policies on SR messages.

Access groups are an alternative way of granting data permissions to users, compared to SQL-based data security policies. You can use object-sharing rules in the Sales and Service Access Management UI to define your visibility criteria.

To define access-group-based data security policies for SR messages:
If you don’t want to use an existing access group, complete the following tasks:

1. Create a new access group.
2. Add members to the access group.
3. Create an object-sharing rule to grant access to SR messages for all the access group members.

Note: For more detailed information about the above steps, see the Oracle Fusion Securing Sales and Service guide.

Related Topics
- Create a Custom Access Group
- Add Members to Custom Access Groups Using the UI
- Create Custom Object Sharing Rules

Define Access Group-Based Data Security Policies for Categories
can define access group-based data security policies on service categories.

Access groups are an alternative way of granting data permissions to users as compared to the SQL-based data security policies. You can use object-sharing rules in the Sales and Service Access Management UI to define your visibility criteria.

To define access-group-based data security policies for service categories:

1. Create a new access group if you don’t want to use an existing access group.
2. Add members to the access group.
3. Create an object-sharing rule to grant the access group members access to service categories.
Note: For more detailed information about the above steps, see the Oracle Fusion Cloud Customer Experience Securing Sales and B2B Service guide.

Related Topics
- Create a Custom Access Group
- Add Members to Custom Access Groups Using the UI
- Create Custom Object Sharing Rules

Enable Viewing of Updates to SRs Secured Using Access Groups in Near Real Time

You can access service requests (SRs) that are secured using access groups in near real time. When an SR is created or updated, users can access the new or updated SR immediately.

You don't have to run the Perform Object Sharing Rule Assignment Processing scheduled process for users to access the SRs.

To implement near-real-time processing for service requests, you must enable the following profile options:

- Near Real-Time Transaction Tracking for Access Groups Enabled (ORA_ZCA_ACCESS_GROUPS_NEAR_REAL-TIME_TRACKING_ENABLED)
  
  This option is enabled at the site level by default.
- Common CRM Signals Active (ORA_ZCA_ENABLE_SIGNALS)
  
  This option is disabled by default.

For more information, see Configure Real-Time and Near Real-Time Access for Access Group Object Records in the Oracle Fusion Securing Sales and Service guide.

Related Topics
- Configure Real-Time and Near Real-Time Access for Access Group Object Records

Set Up Read-Only Access to the Service Request Header

How You Set Up a Role With Read-Only Access to a Service Request Header

Here's how you set up a role that has read-only access to a service request (SR), but still be able to add SR messages such as Customer Entry, Response, Forward to the SR.
To make the SR read-only for a user, remove the Edit Service Request privilege from the user. After you remove the Edit Service Request privilege from a user’s role:

- The user won’t be able to edit these elements of the SR:
  - SR contacts
  - SR team members
  - Add or delete attachments
- The user won’t be able to take the following actions on the SR List pages:
- The following actions will be available through the Action Bar:
  - Copy
  - Internal Note
  - Response

**Note:**
- A user won’t be able to search for Knowledge articles or link articles to the SR. But if the user has the privilege to compose messages on the SR, the user would be able to insert existing linked articles to an SR message.

**Related Topics**
- Create Job and Abstract Roles
- Copy and Edit Duty Roles
- Copy Job or Abstract Roles

**Set Up a Role With Read-Only Access**

Here’s how you set up a role with read-only access to the service request (SR) header alone, or both the SR header and SR messages:

1. Sign into the application as an administrator.
2. Navigate to **Security Console**.
3. Copy a service duty role, such as **Service Request Troubleshooter**.
   - When copying the role, select the **Copy Top Role** option.
4. Remove the privileges that you don’t want to assign, from the copied role.
5. Copy a service job role, such as **Customer Service Representative**
   - When copying the role, select the **Copy Top Role** option.
6. Delete the **Service Request Troubleshooter** child role from the copied job role.
7. Associate the copied version of the **Service Request Troubleshooter** duty role to the copied job role.
8. Associate the copied job role with the users who need read-only access to the SR header alone, or both the SR header and SR messages.
Set Up Read-Only Access to the Service Request Header and Service Request Messages

How You Set Up a Role With Read-Only Access to Service Request Header and Service Request Messages

Here's how you set up a role that has read-only access to the service request (SR) header and SR messages.

To make the SR header and SR messages read-only for a user, remove the following privileges from the user:

- Edit Service Request
- Compose Customer Message
- Compose Internal Note
- Compose Response

After you remove these privileges from a user's role, the following actions won't be available on the SR (in addition to the SR header read-only restrictions):

- Internal Note
- Response

Set Up a Role With Read-Only Access

Here's how you set up a role with read-only access to the service request (SR) header alone, or both the SR header and SR messages:

1. Sign into the application as an administrator.
3. Copy a service duty role, such as Service Request Troubleshooter.

When copying the role, select the Copy Top Role option.
4. Remove the privileges that you don't want to assign, from the copied role.
5. Copy a service job role, such as **Customer Service Representative**

   When copying the role, select the **Copy Top Role** option.

6. Delete the **Service Request Troubleshooter** child role from the copied job role.
7. Associate the copied version of the **Service Request Troubleshooter** duty role to the copied job role.
8. Associate the copied job role with the users who need read-only access to the SR header alone, or both the SR header and SR messages.

**Related Topics**
- Create Job and Abstract Roles
- Copy and Edit Duty Roles
- Copy Job or Abstract Roles
5 Set Up Activities Configurations

What Service Request Activities Track and Display

Activities track and display actions performed on individual service request records. The activities can include email exchanges, call logs, past and future tasks and appointments, as well as recent updates to the record itself.

Activities Configurations enable you to show only those objects, events and attributes that you want to display in the Activity Stream of your Service Center application.

Activities are designed to track important updates, but they don’t function as an audit trail. For example, the list of activities for a service request may show that the SR was reassigned to a different agent. But the activities list may not show that someone uploaded an attachment or changed the value of an unimportant field. Administrators determine what information is displayed.

You can specify which attributes display in the Activities Stream, such as when certain values are updated, by creating an activities configuration and making it active. You create an activities configuration by duplicating an existing one.
The screenshot shows both pending activities and the record of recent updates for a service request. The items shown are all the important changes Matt Hooper made to the SR. Each time you save, you create another entry with a time stamp.

**Overview of Activities Setup Tasks**

Here’s a summary of the steps to set up activities in your environment.
### Activities Setup Tasks

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Navigation</th>
<th>Where to Get More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>You must create and activate an activities configuration for each object you use. You create an activities configuration by duplicating an existing one. Oracle provides a predefined configuration for each object. If you want to use the predefined configuration, just copy it and activate it. If you want to change what gets displayed in Activities for an object, you can edit your copy before activating it.</td>
<td>Navigator &gt; Configuration &gt; Configure Activities Display</td>
<td>Refer to the topic: <a href="#">Create and Activate a Service Request Activities Configuration</a></td>
</tr>
<tr>
<td>2</td>
<td>Make sure the profile option Set the Common CRM Signals Active (ORA_ZCA_ENABLE_SIGNALS) is set to No. This profile is set to the value you want by default, so you may be able to skip this step.</td>
<td>From Setup and Maintenance, choose Service. Then click the Tasks icon and select the Search link. Search for Manage Administrator Profile Values.</td>
<td>Refer to the Related Links topic: Set Profile Option Values.</td>
</tr>
<tr>
<td>3</td>
<td>Optionally, populate the Activities tabs and pages with recent activities by running the Generate Feed Elements process. If you don’t run this process, all Activities panels and pages will be blank.</td>
<td>Navigator &gt; Tools &gt; Scheduled Processes</td>
<td>Refer to the topic: <a href="#">Populate Activities in Existing Service Request Records</a></td>
</tr>
<tr>
<td>4</td>
<td>Run the Publish Feed Elements process to create the index required by Adaptive Search.</td>
<td>Navigator &gt; Tools &gt; Scheduled Processes</td>
<td>Refer to the topic: <a href="#">Run the Publish Feed Elements Job to Index Activities</a></td>
</tr>
<tr>
<td>5</td>
<td>After the Publish Feed Elements process completes, set the Common CRM Signals Active (ORA_ZCA_ENABLE_SIGNALS) profile option to Yes.</td>
<td>From Setup and Maintenance, choose Service. Then click the Tasks icon and select the Search link. Search for Manage Administrator Profile Values.</td>
<td>Refer to the Related Links topic: Set Profile Option Values.</td>
</tr>
</tbody>
</table>

**Related Topics**
- [Set Profile Option Values](#)
Required Job Roles and Privileges for Creating Activities Configurations

To create activities configurations you need to have the following job roles and privileges.

Here are the required job roles:

- Sales Administrator (ORA_ZBS_SALES_ADMINISTRATOR_JOB)
- Application Implementation Consultant
- Customer Service Representative (ORA_SVC_CUSTOMER_SERVICE_REPRESENTATIVE_JOB)

Here are the required privileges:

**Required Privileges for Creating Activities Configurations**

<table>
<thead>
<tr>
<th>Privilege Title</th>
<th>Privilege Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Feed Element Generations</td>
<td>ORA_ZCA_GENERATE_FEED_ELEMENTS</td>
<td>Allows generation and publishing of feed elements.</td>
</tr>
<tr>
<td>Access Feed View</td>
<td>ORA_ZCA_ACCESS_VIEW_FEEDS</td>
<td>Allows access to view feeds.</td>
</tr>
<tr>
<td>Access View Feed Configurations</td>
<td>ORA_ZCA_ACCESS_VIEW_FEED_CONFIGURATIONS</td>
<td>Allows access to view feed configurations.</td>
</tr>
<tr>
<td>Manage Feed Configurations</td>
<td>ORA_ZCA_MANAGE_FEED_CONFIGURATIONS</td>
<td>Allows create, delete and update of feed configurations.</td>
</tr>
<tr>
<td>Manage Signal Definitions</td>
<td>ORA_ZCA_MANAGE_SIGNAL_DEFINITIONS</td>
<td>Allows creating and updating signal definitions</td>
</tr>
</tbody>
</table>

How You Enable and Display Activities

You enable activities on the Configure Activities Display page.

Configurations generate and display content that you have chosen in the Activity Stream. By default, the Oracle-provided configuration is not activated. Create your configuration by duplicating the provided configuration and using it as a basis for your own activities configurations.

Let's look at the following screenshot to see the different parts of the Configure Activities Display page.
Configure What Displays in the List of Activities

What object do you want to configure?

Object: Service Request

Activities configurations (3/10)

<table>
<thead>
<tr>
<th>Configuration Name</th>
<th>Active</th>
<th>Creation Date</th>
<th>Created By</th>
<th>Last Updated By</th>
<th>Last Updated Date</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Request Seed Config Clone</td>
<td>✔</td>
<td>2022-07-18</td>
<td>MHoope</td>
<td>MHoope</td>
<td>2022-07-18</td>
<td></td>
</tr>
<tr>
<td>SR Feed Config Cloned Copy</td>
<td></td>
<td>2022-06-06</td>
<td>SALES_ADMIN</td>
<td>SALES_ADMIN</td>
<td>2022-06-06</td>
<td></td>
</tr>
<tr>
<td>SR Feed Config Cloned Copy</td>
<td></td>
<td>2022-06-07</td>
<td>MHoope</td>
<td></td>
<td>2022-07-18</td>
<td></td>
</tr>
<tr>
<td>Standard Service Request Activities Configuration</td>
<td></td>
<td>2021-03-11</td>
<td>SEED_DATA_FROM_APPLICATION</td>
<td>SEED_DATA_FROM_APPLICATION</td>
<td>2021-03-22</td>
<td></td>
</tr>
</tbody>
</table>

Configure: Service Request Seed Config Clone

Objects you can configure for display
Select an object to configure the display attributes.

- Action Plan
- Activity/Task
- Activity/Appointment
- Attachments
- Conversation Message

Object attributes available for display

ServiceRequest: Select attributes for display

- Account ID
- AccountPartyId
- AccountPartyUniqueName

Here’s the different part is the Configure Activities Display page:

- **Callout 1**: Here’s where you click the drop-down list and select the object you want to configure.
- **Callout 2**: Here are the list of available configurations. You can created 10 configurations per object. SEED_DATA_FROM_APPLICATION is the configuration that’s provided by Oracle. You use this configuration as the basis for creating new configurations. You can’t delete it, but you can duplicate and edit it.
- **Callout 3**: Click the Action field to display the various actions you can perform on the configuration, such as edit, activate delete, and duplicate.
- **Callout 4**: Here’s where you can view an objects attributes.
- **Callout 5**: Here’s where the selected and the available attributes for an object are displayed.

Create and Activate a Service Request Activities Configuration

You must create and activate an activities configuration for each object you use in Service Center. You create an activities configuration by duplicating an existing one.
Oracle provides a predefined configuration for each object. If you want to use the predefined configuration, just copy it and activate it. If you want to change what activities get displayed for an object, you can edit your copy before activating it.

You must have the Manage Feed Configurations duty role to be able to duplicate, edit, delete, and activate a configuration. Users with the Access View Feed Configurations duty role can only view the configurations.

Note:
- You can't edit or delete configurations provided by Oracle.
- You can have only one active configuration for each object.
- You can't delete an active configuration.
- You can create a maximum of 10 custom configurations for each object.
- You can enable Monitor for Changes for a maximum of 50 attributes for each object in a configuration.

1. Click **Navigator > Configuration > Configure Activities Display**.
2. Select the **Service Request** object.
3. In the Activities configurations section, select an existing configuration. Oracle provides one standard configuration for each object. Look for **SEED_DATA_FROM_APPLICATION** in the Created By column.
4. In the Action column (the last column on the right), click **Actions** (three dots) and select **Duplicate**.
5. In the Duplicate dialog, enter a name for your configuration and an optional description.
6. Click **Duplicate**.
7. Click on the new configuration name to display its attribute setup.
8. If you want to use the configuration provided by Oracle, in other words, if you don't want to change any about the provided configuration you just copied, then skip steps 9 through 11 and activate the configuration as described in step 12.
9. If you want to change the way attributes display first, then click **Actions** and select **Edit**.
10. Configure the attributes:
   a. Select one of the objects you want to configure for display on the left pane.
   b. In the right pane, locate the attribute you want to update and set the two parameters:
      - **Make Available for Display**: makes a field available for display on the UI.
      - **Monitor for Changes**: monitors the field for updates.
11. When you're done, click **Update**.
12. To make your configuration active, click Actions (the three dots) and select **Activate**. You must then confirm that you want to activate.

Use **Actions** (the three dots) menu to activate, delete, duplicate, and update your configurations.

Before You Run Activities Initialization Jobs

Here are the jobs roles and privileges you must have to run this initialization job.

- Job roles with the Manage Feed Element Generations privilege can do the following:
Generate and publish activities which populate the activities stream data for users. The Sales Administrator, Service Administrators, and Application Implementation Consultant job roles have this privilege by default.

- User roles with the Access Feed View privilege can do the following:
  - Access the activities REST services to view the activities of the object. This Sales Administrator, Service Administrators, and Application Implementation Consultant job roles have this privilege by default.

You also want to make sure users meet the following prerequisites before invoking the activities initialization job:

- Make sure the job is available for the Sales Administrator and Application Implementation Consultant job roles.
- Once the job is run, refer to Create and Activate a Service Request Activities Configuration.
- Make sure the ORA_ZCA_ENABLE_SIGNALS profile option is disabled, as shown in Overview of Activities Setup Tasks.
- Generate import and export artifacts for the Activities-enabled objects then makes sure the generation of the artifacts is complete.

Specify What Displays in Activities

You can specify what information displays in Activities for each record by creating an activities configuration in the Configure Activities Display page and activating it. You must create and activate a separate activities configuration for each object.

In the configuration, you can make information visible by checking two check boxes:

- Make Available for Display: Displays the attribute in activities.
- Monitor for Changes: Tracks changes in the attribute.

You must check both check boxes for the information to be visible. For many attributes, you check both check boxes for the same attribute. For example, note text is stored in the NoteTxt attribute. So, to display notes salespeople create any subsequent updates to the note text, you select both check boxes for the NoteTxt attribute:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Unique Name</th>
<th>Make Available for Display</th>
<th>Monitor for Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>NoteTxt</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

To display information from certain fields, including dynamic choice list fields and fixed choice list fields, you must check the check boxes for different attributes. That's because the information that displays in the UI comes from the name column while the tracking of changes comes from the ID column. For example, if you're displaying the owner of a task, a dynamic-choice list field, there are two attributes at play:

- Owner
- Owner Party ID

The Owner field stores the name of the person identified by the Owner Party ID. You want to display the owner name in the UI, but you have to monitor the Owner Party ID to see if a new owner has been assigned. Here are the settings you make for displaying the owner:
Some information displayed in the UI, such as the postal address, come from aggregating multiple fields. The attribute FormattedAddress displays the address in the UI. FormattedAddress is composed of many elements including country, state, city, province, street address, and so on. There are different fields involved in different formats for each country, which you can review using the setup task Manage Formatted Addresses. Presumably, you want to display the changed address if any of address elements are updated. For that to happen, you must check the Monitor for Changes check box for all the address elements you’re using and check the Make Available for Display check box for the FormattedAddress attribute. Here are the settings for just some of the available address fields:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Unique name</th>
<th>Make Available for Display</th>
<th>Monitor for Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Line 1</td>
<td>AddressLine1</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Address Line 2</td>
<td>AddressLine2</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Building</td>
<td>Building</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>City</td>
<td>City</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Country</td>
<td>Country</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Postal Code</td>
<td>County</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>State</td>
<td>State</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Address</td>
<td>FormattedAddress</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

If you check Make Available for Display for any of the address components, then you’d also see an entry for that component as well. Suppose, for example, you check Make Available for Display for City:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Unique Name</th>
<th>Make Available for Display</th>
<th>Monitor for Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>City</td>
<td>City</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Address</td>
<td>FormattedAddress</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

The Activities would display two lines when the city is updated. For example:
- Address changed to 100 Main Street, New York, NY 10021
- City changed to New York
Populate Activities in Existing Service Request Records

At first, activities for all existing records are blank.

You can populate the records by running the **Generate Feed Elements** job, which populates each record with the date and time the record was created.

**Note:** Running this job is optional step for your activities setup. If you choose not to run it, your existing records just won’t be populated with activities. If you do run the Generate Feed Elements job, you must wait for it to complete before you run the Publish Feed Elements job which is described in the next topic.

Here’s the criteria that the Generate Feed Elements job uses to determine which activities are populated for Service Requests:

- Status = New or In Progress, or Waiting (no time limit).
- Status Type = Resolved or Closed and Last Updated date in the past 365 days.

Now you run the Generate Feed Elements job:

**Note:** To run this job, you must set the ORA_ZCA_ENABLE_SIGNALS profile option to No. For more information, refer to *Overview of Activities Setup Tasks*.

1. Click **Navigator > Tools > Scheduled Processes**.
2. On the Scheduled Processes Overview page, click **Schedule New Process**.
3. In the Schedule New Process pop up window, leave the type as **Job**.
4. In the **Name** field, type **Generate Feed Elements** and press **Enter**.
5. Click **OK**.
6. In the Process Details dialog box, enter the required parameters, if any.
7. Optionally, click **Process Options** to change any options to the process, then **Basic** and **Advanced** to change any of those parameters.
8. When finished, click **Submit**.

Run the Publish Feed Elements Job to Index Activities

You must run the Publish Feed Elements process to create and publish the indexes required for the Adaptive Search to track activities. You can only run this process only once in each environment.
**Note:** If you ran the Generate Feed Elements process, you must wait for it to complete successfully before running this process.

1. Click **Navigator > Tools > Scheduled Processes**.
2. On the Scheduled Processes Overview page, click **Schedule New Process**.
3. In the Schedule New Process pop up window, leave the type as **Job**.
4. In the **Name** field, type **Publish Feed Elements** and press **Enter**.
5. Click **OK**.
6. In the Process Details dialog box, enter the required parameters, if any.
7. Optionally, click **Process Options** to change any options to the process, then **Basic** and **Advanced** to change any of those parameters.
8. When finished, click **Submit**.

**Note:** After this process has completed, you must set the ORA_ZCA_ENABLE_SIGNALS profile option to Yes. for more information, refer to **Overview of Activities Setup Tasks**.
6 Extend Service Center

Overview of Extending Your Application

Your application is built using Oracle Visual Builder Studio and Oracle JET components. Visual Builder Studio is a single place where organizations can manage projects, environment and repositories; a Visual Builder Designer is where you can extend your application. From VB Studio, you can open many different designers.

Visual Builder Studio is the browser-based tool that your organization can use to make modifications and extensions to the Redwood user interface. Using the extension framework, you can make changes to the user interface such as displaying custom fields on forms, creating dynamic layouts for a form, or embedding custom content in a dynamic container in a page.

Your VB Studio instance is paired with your Test instance of Fusion Applications. This means that your design time experience will be based on data in the Test instance database and a sandbox in the Test instance (if you’re working within a sandbox).

The changes you make using VB Studio are stored in an artifact called an application extension. An application extension can be something as simple as a field added to a cloned, custom, or new form, or a new container of forms. You can create extensions, then preview them to see how they look in your UI. To create a extension that impacts the data model, you must use a sandbox within Application Composer, then use the Edit Pages in Visual Builder option to expose your changes in the UI.

You navigate to the VB Studio Designer directly from within the Redwood application. VB Studio is a design at runtime tool, which allows you make UI changes and then immediately preview the results before publishing the changes to other users.

VB Studio is just one tool that administrators can use to make application changes. As previously mentioned, you extend the underlying object model used by the Redwood application with Application Composer. The model changes you make in Application Composer are reflected in the RESTful API for those objects, and thereby become available to the VB Studio Designer for use in UI extensions.

Related Topics
- Configuring Applications Using Application Composer
- How Do I Use Visual Builder Studio to Extend Oracle Cloud Applications?

Set Up Visual Builder Studio

Before your team can start creating application extensions, you must first set up Visual Builder Studio and configure it. For more information on setting up VB Studio, refer to the Using VB Studio guide listed in the Related Topics.
Provision a Project

After you set up your VB Studio environment, you can then provision a project to extend your Service Center instance. The workflow is as follows:

- You get access to VB Studio.
- You provision a project based on the Service Center template that’s included with VB Studio.
- You then drill down on the project to use the Visual Builder Designer to extend Service Center.

Related Topics

- Using VB Studio
- Video: Setting Up Visual Builder Studio for Oracle Cloud Application Extensions
- Set Up VB Studio Users
- Set Up the Project to Deploy for Production

Work with Dynamic UI

Get to Know Layouts

After you launch VB Studio, VB Studio Designer displays the form you were examining in Service Center.

You can extend components within the Create Service Request page, the Edit Service Request page, and other pages within the application. For this example we’ll work with the **Create Service Request** page.

The following image shows the various components of the VB Studio UI:

Here’s the various elements of the UI:

- The navigator (callout 1): Use the explorer to view your project artifacts.
There are two ways to navigate to dynamic UI:

**Method One: Directly Editing the Dynamic UI**

Here's an overview of how you edit directly in the dynamic UI.

1. When you're on a Redwood page, such as Create Service Request, click the Settings and Actions menu and select **Edit Page in Visual Builder**.
2. In VB Studio, expand App UIs > Oracle Fusion Service UI Extension App > Service > ec > sr.
3. All the sub-components are displayed under the service requests component.

   **Note:** This is where you would go to extend the service request header dynamic forms.

**Method Two: Using the Page Designer**

Here's an overview of how you navigate layouts using the Page Designer.

1. In Service Center, click the Settings and Actions menu and then select **Edit Page in Visual Builder**.
2. Choose your project and click **Select**.

   The Page Designer displays.
3. In the application extension explorer, expand **Oracle Fusion Service UI Extension App > service > ec > sr > create**.

   The Create Service Request form displays in the Page Designer with the corresponding artifacts shown in the Components area of the Properties pane.
4. Click the **serviceRequests - Create Service Request** component.
5. Click the **Create Service Request** rule set link.
6. In the Properties pane, click the **Open Rule Set Editor** link.

   The Rule Set is displayed. The Rule Set is where you define how the fields in a given component will appear at runtime.
7. Duplicate the rule set, then click the **Open** icon.

   Extensible parts of the form are highlighted and you can view the corresponding component in the Properties pane.

**Related Topics**

- What are Dynamic Components?
- Understand the Designer

**Dynamic Forms That You Can Extend**

As described in the preceding topic, the Service Center UI is highly extensible. This topic gives you an overview of what layouts in the Service Center Service Request UI then you can extend using Visual Builder Studio.
The following two tables list many of the dynamic forms that you can configure, and many of the dynamic tables, used for service requests, that you can extend.

<table>
<thead>
<tr>
<th>Dynamic Form Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Service Request</td>
<td>Use this to extend the Create Service Request form.</td>
</tr>
<tr>
<td>Copy Service Request</td>
<td>Use this to extend the Copy Service Request form.</td>
</tr>
<tr>
<td>Service Request Spotlight</td>
<td>Use this to extend the SR Summary Region of the SR.</td>
</tr>
<tr>
<td>Service Request Contact Summary Layout</td>
<td>Use this to extend the SR contacts section in the SR Summary Region the SR.</td>
</tr>
<tr>
<td>View Service Request Contact Collapsed</td>
<td>Use this to extend the Contacts Summary form in the related panel section of the SR.</td>
</tr>
<tr>
<td>Layout</td>
<td></td>
</tr>
<tr>
<td>View Service Request Contact Expanded</td>
<td>Use this to extend the Contacts Details form in the related panel section of the SR.</td>
</tr>
<tr>
<td>Layout</td>
<td></td>
</tr>
<tr>
<td>Service Request Attachments Layout</td>
<td>Use this to extend the SR Attachments section in the SR Summary Region of the SR.</td>
</tr>
<tr>
<td>Service Request Team Summary Layout</td>
<td>Use this to extend the Service Request Teams section in the SR Summary Region of the SR.</td>
</tr>
<tr>
<td>View Service Request Team Layout</td>
<td>Use this to extend the SR Team Members dynamic form in the related panel section of the SR.</td>
</tr>
<tr>
<td>Service Request Linked Articles Summary</td>
<td>Use this to extend the SR linked articles section in the SR Summary Region of the SR Details form.</td>
</tr>
<tr>
<td>Layout</td>
<td></td>
</tr>
<tr>
<td>Service Request Details (View Mode)</td>
<td>Use this to extend the read-only SR Details form.</td>
</tr>
<tr>
<td>Service Request Summary (Edit Mode)</td>
<td>Use this to extend the editable SR Details form.</td>
</tr>
<tr>
<td>Service Request Source and History (Edit</td>
<td>Use this to extend the editable form of the Source and History section in the SR Details form.</td>
</tr>
<tr>
<td>Mode)</td>
<td></td>
</tr>
<tr>
<td>Category Details</td>
<td>Use this to add custom fields the Categories List form.</td>
</tr>
<tr>
<td>Create Category</td>
<td>Use this to add custom fields the Create Category form.</td>
</tr>
<tr>
<td>Update Category</td>
<td>Use this to add custom fields the Update Category form.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dynamic Table Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Service Request Contact Layout</td>
<td>Use this table to extend the SR Contact list in the SR details page.</td>
</tr>
<tr>
<td>Team Section Table Layout</td>
<td>Use this table to extend the SR Teams list table in the SR details page.</td>
</tr>
</tbody>
</table>
Dynamic Table Name | Description
--- | ---

**Work with Dynamic Forms**

**Duplicate a Form**

This example, using the Create Service Request form, will show you how to extend or modify a form.

*Note:* It's highly recommended that you duplicate any form that you work with before you modify or extend it.

1. Click the App UIs tab, then `Oracle Fusion Service UI Extension App > service > ec > sr > create`.
2. In the Properties pane, click the `Components` tab, and select `serviceRequests - Create Service Req`, and then click the `Open Rule Set Editor` link.
3. In the Designer, you'll see the available layouts, along with the display logic of that layout.
4. Select a layout.
5. In the Built-in layouts area, hover in the default layout, and select the `Duplicate` button.

6. In the `Duplicate Layout` dialog box, enter a name for the layout and click `Duplicate`.

**View Form Properties**

Now let's just look at some of the properties of the new form. The Rule Set properties list the form's properties along with a list of templates.

1. After you duplicate the form, select it in the Designer.
2. Click the `Fields` tab to view available fields for the form.
Add Conditions to a Form

In this example, we'll add a condition that specifies that a form displays only if a certain SR severity level is reached. First duplicate the layout, or choose your layout, then do the following:

1. Click the Click to add condition link.
   ![Display Logic](image1)
2. From the Attribute drop-down list, select the severity code value: `$fields.SeverityCd.value()`, then in the Value field, enter: ORA_SVC_SEV1 as shown in the following example:
   ![Rule](image2)
3. Now the layout will only display when a service request has a severity code value of 1.

Add, Hide, or Rearrange Fields

This topic show you how to work with form fields in VB Studio. As with previous examples, we'll use Create Service Request.

1. In the Rule Set editor, from the Dynamic Form list, select the Create Service Request form.
2. Duplicate the layout, then select the duplicate record.
3. Click the Open icon.
   The layout is displayed with its included fields, and in the explorer, all available fields.
4. To add a field, click the check box of any field shown in the field explorer. The added fields, including custom fields added with Application Composer, will appear at the end of the layout.
5. To reorder fields, click the control beside the field, and drag and drop the field to where you want it to go in the layout order.
The following screen capture shows the control you use to drag and drop fields in the layout.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CategoryId</td>
<td>(Category Picker Template(Create))</td>
</tr>
<tr>
<td>InventoryItemId</td>
<td>(Product Picker Template(Create))</td>
</tr>
<tr>
<td>SeverityCd</td>
<td></td>
</tr>
<tr>
<td>AssigneeResourceId</td>
<td>(Assignee Person Name Template(Create))</td>
</tr>
</tbody>
</table>

6. To hide a field either deselect the field in the field list, or hover in the field in the layout and click the X.

Create a Custom Field

You create custom fields that retain changes to the database using Application Composer. Custom fields that you create in VB Studio are read only.

This example shows you how to create a custom field using Application Composer.

We'll create a new field for the Service Request Category object. Say you want to extend this object with a custom field that's specific to your business needs. In addition to creating the custom field in Application Composer, you will also need to add the custom field to the appropriate layout which is described in the following section. When both of these steps are performed, then the new field can be exposed in the Manage Service Request Categories List page.. You might also want to make the content entered into this custom field searchable. Here's how you do it:

**Note:** You will need to create and activate a sandbox to perform this task. Use the same sandbox used for this task when you add the field in VB Studio, which is described in the next task.

1. Sign in to your application as an administrator.
2. Click **Navigator > Configuration > Application Composer**.
3. Expand the **Standard Objects** list, then expand the **Category** object node.
4. Click **Fields**.
5. On the Fields screen, click the **Custom** tab, then click the **Action** drop-down list and select **Create**.
6. Select **Text** because for this example, we'll just create a text field.
7. Click **OK**.
8. In the Create Text Field screen enter the field name into the **Display Label** field.
   - The Display Label field displays the field name in the UI. The Name field autofills after you complete the display label, and is only for internal use. It won't be displayed in your UI.
9. Choose the number of characters you want to allow in the new text field.
   - The default number of characters is 30, but you can set it for less or for more.
10. If you want the field to be searchable, select the **Searchable** check box in the Constraints area.
11. Click **Save and Close**.
Add a Custom Field Created in Application Composer

Use this topic to add a field that you created in Application Composer. Fields that you create in Application Composer allow you to retain changes to the database, whereas custom fields created in VB Studio are read only.

This topic shows you how to add a custom field that you created in Application Composer to a layout in VB Studio.

**Before you start**
Make sure VB Studio is connected to the same sandbox that you used when creating the custom field.

**Here's what to do**

1. In VB Studio, click the **Layouts** icon in the explorer.

2. Locate the object you want to add the field to.
3. In this example, we'll use the **Categories** object, so click that object.
4. Display the rule sets, and then choose the one you want to add the field to.
5. For this example, choose **Category Details**.

6. Duplicate the form using the following task: **Duplicate a Form**.
7. Open the duplicate you created.
8. The workspace displays the fields that are contained in the form, and those that can be added.
9. From the list of available fields, locate your new field, using the filter field to search if necessary.
10. Drag the new field to the form, and position it in the order you want. You can use *Add, Hide, or Rearrange Fields* for reference.

11. The field is now added to the form. Click the **Preview** button to view your changes in the application UI.

## Add a Read Only Custom Field Using VB Studio

Now, we'll create and add a custom field in VB Studio then add it to a layout. For this example, we'll be creating a custom field based on the SR severity.

**Note:** Custom fields created in VB Studio are read only. To create a custom field that will retain changes to the database, you must use Application Composer. To create a custom field in Application Composer, refer to *Create a Custom Field*.

1. In the Applications Extensions explorer, navigate to **App Uls > Oracle Fusion Service UI Extension App > Service > ec > sr > edit**.

   Remember, we're using the Service Request layout for this exercise.

2. Click the **Fields** tab.

3. Click the **+ Custom Field** button.

4. In the **Custom Field** pop up window, enter the field name that you would like reflected in the UI.

5. Click **Create**.

6. From the list of fields, select the newly created custom field.

7. In the Properties pane, add referenced fields by doing the following:
   
   - Click the **Add** link for the Referenced Fields property.
   - In the **Referenced Field** text field, start entering the word and then choose the **SeverityCd** field from the results that appear and then click **Add Field**.
8. Now, click the Expression editor:

![Expression Editor](image)

9. Now in the Expression Editor, set the conditions that govern when the field is displayed by doing the following:

   a. From the Context explorer, expand the fields list.

   ![Context Explorer](image)

   b. Locate the **SeverityCd** field in the list, expand it, and drag and drop **value** into the editor.

   c. Add the following to the expression:

   ```
   $fields.SeverityCd.value()=='ORA_SVC_SEV1'?'High Severity SR':'Not a high Severity SR'
   ```

   d. Click **Save**.

   Now the custom field will only display if and value has a severity code of 1.

10. Click **Rule Sets** to return to the layout.

11. In the Fields explorer, enter the name for the custom field.

12. Click the check box to include the field in the layout.

13. Drag and drop the field to where you want it to appear in the UI.

14. Use the Field properties window to choose one of the default templates from the **Template** drop down list.

15. Click the **Create** link if you want to create your own template.

16. Click the **Preview** button to view your changes.

   Details on creating a template are in the **Create Your Own Field Template** topic in this chapter.
Make Fields Conditionally Required or Read Only

This topic gives you an overview of read only and required properties for dynamic forms. For this example, we'll use the Create Service Request layout.

**Note:** Required and Read Only are only available if a field in a layout isn't associated with a template.

First duplicate the default form if necessary, or choose your own layout, and then do the following:

1. Select the layout.

   The layout is displayed with the fields shown.

2. Note the **Read Only** and the **Required** check boxes in the Form properties area.

3. To make the field read only, simply click the **Read Only** check box.

4. To make the field required, just click the **Required** check box.

5. To make a field conditionally required, do the following:

   a. Hover over, and then click the **Expression Editor**.
   b. Select a variable from the drop down list.
   c. To edit the conditions of the variable, hover over then, select the **Expression Editor**.
   d. In the Expression Editor, expand the **fields** variable list.
   e. Expand the SeverityCd variable and drag and drop **value** on to the editor workspace as shown in the following example:

   ![Expression Editor](image)

   f. Add the following value to the expression: `=== 'ORA_SVC_SEV1'`.
   g. Click **Save**.

   Now the field only displays when severity level 1 is reached.
Field Groups

Field groups are a way for an application developer to group multiple fields. A field group can have properties such as column span, maximum columns, label, and so on. These properties apply to the whole group.

Field groups can also be conditionally hidden. These conditions apply to all the fields in the group.

To create a field group, just do the following:

1. Select a Dynamic form layout.
2. Click the Open icon for the layout.
3. Click the New Group icon as shown in the following graphic.

The field group is added to the layout.
4. Enter a name for the new field group, then click the check mark.
5. In the Properties window, enter values for the label of the group along with other properties such as maximum columns and colspan which determines the width of columns in your layout.
6. Add any fields you want into the group by dragging and dropping them from the explorer:

Create Your Own Field Template

You use field templates to configure how certain fields are rendered at runtime in a dynamic form or table.

You can use a combination of HTML and VB components to control how you want to display a field. A simple example for this would be: You want to display a red banner on the top of the SR if the SR is marked critical.

Here’s how you do it:

1. Duplicate the Service Request Summary (View Mode) dynamic form (if you haven't done that already.)
   
   Note: This form is the read only SR details form that you see when you click on the SR details icon on the SR summary region.

2. Since we want to display the banner at the top of the form, let’s move the CriticalFlag field to the top of the layout.
3. In the field properties pane, click the Override link.
   This link lets you override the field template of the CriticalFlag field. In other words, the override makes the template property editable. A Create link is also now visible.
4. Click the Create link to create the new template.
5. Enter a name for the template in the Label field. The ID field will auto-populate.
   VBStudio designer opens. This is where you can design the template.
6. Click Create.
   Note that there are tabs called Live, Design and Code. For this exercise we’ll click on Code tab.
   If you go to the Design tab, you can use the editor to drag and drop VB components to define your template.
7. Click Code, and note that VBStudio has created a default template for you. We are going to remove the code that’s inside your template tag, and paste the following code inside the template tag:

```html
<of-bind-if test="[[value]]">
<oj-label-value colspan="6">
<div slot="value" style="background:red">
<span id="criticalBadge" style="color:white;padding:2px">
```

```html
69```
8. Note that we've used the `<ob-bind-if>` VB element, `<oj-label-value>` VB element, the `<div>` HTML element, and the `<span>` HTML element.

9. Now, click the Design tab, and then click Return to layout.

10. Note the criticalFlag is now associated with the newly created template.

---

**Work with Dynamic Tables**

**Extend Dynamic Tables**

You might want to extend a dynamic table, such as the SR Contacts table or the Team Members table to add or remove new fields or other elements.

Let's say that you want to remove the Job Title field and add the DoNotContactFlag field to the SR Contacts Dynamic table. Here's how you do it:

1. In the Application Extension explorer, click Layouts, then expand Oracle Fusion Service UI Extension app > ServiceRequests > Contacts.
2. Click the Edit Service Request Contact Layout dynamic table.
   
   The layout rule set editor appears.
3. Duplicate the default layout if you haven't already done so.
4. Open the copied layout.
   
   The layout editor appears displaying all the attributes currently displayed in the SR contacts table.
5. Delete the Job Title field by hovering over the field and clicking the X icon.
6. Use the explorer to locate the DoNotContactFlag field in the list of available fields.
7. Select the field by clicking the check box.
   
   The field is added to the table. You can now move the field to where you want it to reside in the table.
8. Test your changes by clicking the Preview button.
Work with Dynamic Containers

What's a Dynamic Container?

A dynamic container displays content in individual sections or logical regions of the page.

Each section maps to a template, which defines the content displayed within that section. Within Service Center, the Edit SR Details page has a dynamic container. The SR Edit page has multiple sections and templates in it:

The display logic for determining what's displayed in a dynamic container is defined using cases. A case is similar to the rule set layouts used in dynamic forms and tables, but instead of selecting which fields to display, you select which UI elements or components to display. When you define a case, you specify the conditions for the case, and the templates you want displayed in the container when that condition is met. The template defines the content you want to display. Each template in a case is rendered as a section in the container, so if a case defined three templates, you would see three sections in the container.

A dynamic container holds a collection of display templates. The display logic for determining what's displayed in a dynamic container is defined using cases. A case is similar to the rule sets used in dynamic forms and tables, but you select display templates containing UI elements instead of selecting fields. You configure what's displayed in a container by creating cases, and then specifying the conditions and templates for each case.

Related Topics

• Configure a Dynamic Container
Configure a Dynamic Container

The SR Edit Details page has seven sections. Let's say we have a requirement for a specific role. We don't want to show the Attachments section (Attachments template) to anyone with the Sales Representative role. Here's how you do it:

1. In the explorer, navigate to: **App Uls > Oracle Fusion Service Extensions App > Service > ec > sr > edit.**
2. In the properties pane, click the **Components** tab to view the dynamic container, form, and table used.
3. Click **Container rule for case details panel.**
4. Click the **Duplicate** icon.
5. Enter a name for the new rule.
6. Click the Expression editor icon and add the following condition:
   
   ```
   $application.user.roles.includes('ORA_ZBS_SALES_REPRESENTATIVE_JOB')
   ```
7. Delete the **documentsSectionTemplate. Attachments Template** from the case.
8. Test to make sure a sales representative won't see the attachments component in the **SR Edit Details** form.

   **Note:** The other details in VB will remain the same.

Work With Templates in a Container

Now we'll look at an overview of containers.

You can easily relocate or remove a template from a container. You can also add templates to the default set. You can also have more than one container for a given page layout and add conditions for the page layout by user role.

Move or Remove a Template in a Container

Let's first look at how you move or remove a template in a container.

For this example, we'll use the Service Request dynamic container.

1. In the VB Studio explorer, navigate to **App Uls > Oracle Fusion Service UI Extension App > Service > ec > sr > edit.**
   
   The dynamic container is displayed.
2. In the Dynamic Container explorer, you can view the following:
   
   - Extension: View the different layouts contained in the container. Each case represents a layout.
   - Templates: View the different templates in the container view.
3. Choose a case from the list, and in the display templates area, hover over a template.
4. Move a template by clicking the up or down arrow.
5. Remove an item by clicking the **Remove Item** icon.
6. Preview the layout by clicking the **Layout Preview** icon:

   ![Layout Preview Icon]

7. Add, relocate or remove templates as you see fit.
Add a Container

Now we'll add a new case, or container then add templates to it.

1. In the Dynamic Container explorer, click the + Case button.
2. A new case appears in the properties page similar to the following:

The case properties are as follows:

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>What You Can Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the Edit icon to create your own title.</td>
</tr>
<tr>
<td>2</td>
<td>Hover over each icon to view the task you can perform.</td>
</tr>
<tr>
<td></td>
<td>- Duplicate the container.</td>
</tr>
<tr>
<td></td>
<td>- Delete the container.</td>
</tr>
<tr>
<td></td>
<td>- Preview the layout.</td>
</tr>
<tr>
<td></td>
<td>You can also click the up or down arrows to move the position of the container in the layout.</td>
</tr>
<tr>
<td>3</td>
<td>Click the Expression Editor icon to write an expression for the container, or click the Select Variable drop down list and choose from a list of out of the box variables.</td>
</tr>
<tr>
<td>4</td>
<td>Click the Add Template icon (+) to select from a list of provided templates.</td>
</tr>
</tbody>
</table>
Service Request Categories

Manage Parent and Child Service Request Categories

Use the Service Request Categories setup page to move child categories between different parents, and promote child categories to a parent level. Also, you can use different attributes to search the categories.

Here's how you create service request categories:

1. Navigate to Home > Service > Service Request Categories (quick action).

   The Categories page is displayed.

2. Create a top-level category:

   a. Click Create.

      The Create Category dialog box is displayed, with the Create Top-Level Category option selected.

   b. Enter a name in the Category Name field.

   c. Modify the Category Code, if needed.

   d. From the Business Unit drop-down list, select the business unit (BU) to which you want to associate the category.

      The Business Unit field is displayed only if the HZ_ENABLE_MULTIPLE_BU_CRM profile option is enabled. By default, the BU that's set in the scope is displayed. However, you can change the BU.

   e. Specify if the category must be active, by using the Active switch.

      The Active switch is enabled by default.

   f. Click Create.

   g. Create additional top-level categories, as needed.

3. Create child categories:

   a. From the categories list, select the top-level category for which you want to create child categories.

   b. Click Create.

      The Create Category dialog box is displayed.

   c. Select the Create Child Category option.

   d. Enter a name in the Category Name field.

   e. Modify the Category Short Name, if needed.

   f. Specify if the category must be active, by using the Active switch.

   g. Click Create.

   h. Create additional child categories, as needed.

      The child categories appear indented under the top-level category.

   **Note:** You can set the BU only for the top-level category. The BU on the child categories is automatically set based on the BU of the root category.
Here's how you update existing service request categories:

1. From the categories list, select the child category you want to update, and then click **Update**.
   
   The **Update Category** dialog box is displayed.
   
   - To make a child category a parent category, use the **Promote to Top-Level Category** switch.
   - To move a child category to a different parent category, select a new category from the **Parent Category Name** drop-down list.
   - To modify the parent or child category name, update the name in the **Category Name** drop-down list.
   - To set the category as active or not, use the **Active** switch.

2. Click **Update**.

Here's some other tasks you can do:

- To see only the active categories on the page, use the **Show Active Only** switch.
- To search for a category, specify the search criteria under the **Search Categories** section, and then click **Search Categories**.
- To delete a category, select the category and click **Delete**.

---

**Preview, Share, and Publish an Application Extension**

Use the Preview and Share actions to view or have your team view your application extensions.

Publish your extensions using the Publish action. For information on all three actions, refer to the Related Topics links.

**Related Topics**

- How Do I Create and Publish an App Extension?
- Preview and Share Your Application Extension
- Publish the Application Extension
7 Catalog Management

Define a Catalog for the Service Offering

In most implementations, you must create a catalog of products and services. If you have already defined a catalog with
the Base usage for Sales, it can be used in the Service offering.

Alternatively, you have the option to create and manage a distinct catalog for the Service offering.

Before deciding whether to create a distinct catalog for the Service offering, consider that using the same catalog
as Sales means you have the same hierarchy of product groups used to categorize service requests. For some
implementations, you can use the same catalogs. However, in other implementations, the Sales catalog might not have
the right granularity to properly categorize service issues. In these situations it would be appropriate to create a separate
hierarchy of product groups and products, specifically for the Service offering.

Using an Existing Sales Catalog for the Service Offering

To use the same catalog for your Service offering that you use for your Sales implementation, you must add the root
product group for the Sales catalog in the Service offering.

To use an existing Sales catalog in your Service offering:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Service Catalog
   - Task: Manage Product Group Usage

   The Manage Product Group Usage page appears.

2. Click the Service usage.

3. In the Service: Details section, on the Product Groups tab, add the root product group for the sales catalog.

4. Save the record.

Defining a Distinct Catalog for the Service Offering

Defining a catalog for the Service offering is the same procedure that you use for Sales. The only difference is that for
Product Group Usage, Sales uses the Base usage, whereas Service uses the Service usage.

To define a distinct catalog for the Service offering:

1. Define a product catalog specific to Service.

   For more information about defining a product catalog, see "Sales Catalog: Overview".

2. In the Manage Product Group Usage page, click the Service usage.

3. Associate the product catalog that you created to the Service usage, as described in the previous section.
Related Topics
- Overview of Sales Catalogs
- Update Existing Setup Data

Overview of Sales Catalogs

Using sales catalogs lets you:

- Use product group as a territory dimension so assignments can be made based on product.
- Give salespeople a mechanism to add product revenue to opportunities.
- Let salespeople add products to leads.
- Have product revenue available in forecasting and salesperson quota.

Note: While you can include individual products (also known as inventory items) in your catalog, they’re not required unless you’re integrating with a product application downstream, such as Oracle Configure, Price, and Quote Cloud (Oracle CPQ). For information on the setup of individual products, see the topics on sales products.

Sales Catalog Key Features

Here are the key features of the sales catalog:

- Import your inventory list using standard import or import macros.
- Quickly build and deploy sales catalogs in a single administration UI.
- Build product groups in a hierarchy.
- Translate product group display name and description into different languages.
- Use the sales Products UI to create individual products that you add to the product catalog.
- Use price books and the default pricing region in the Products UI to price "standalone" products outside of the catalog hierarchy.

Product Group Hierarchy Example

The following figure shows an example of a product group hierarchy.

In the example: At the top of the product group hierarchy is the root product group, named Special Deals. The nested groups begin with the child groups of the Special Deals root group. These include: Men, Women, and Kids. Within the Kids group, more nested groups appear, including Girls and Boys. Within the Girls group, a child group called Apparel appears. Within the Apparel group, further nesting occurs, with the groups Pants, T-shirts,
and Dresses. Together, the root group and configuration of parent and child groups make up the sample hierarchy.

Related Topics

- Sales Catalog High-Level Setup Steps
- Add Products to the Catalog
- Validate the Sales Catalog
- Run the Refresh Denormalized Product Catalog Table Process
- Example of Creating a Sales Catalog

Sales Catalog High-Level Setup Steps

Creating your sales catalog involves a number of steps.

This table shows the high-level setup steps and where to find more information about the step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Where to Find More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure prerequisites are set up</td>
<td>Ensure that your prerequisite structures are set up before starting to create the catalog.</td>
<td>See the Prerequisite Setups for Sales Products topic in this chapter</td>
</tr>
<tr>
<td>Create the root product group</td>
<td>Create the root product group. The root catalog or root product group is the top of the product group hierarchy. All other product groups are nested underneath.</td>
<td>See the Create the Root Product Group topic in this chapter</td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
<td>Where to Find More Information</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Create the product group hierarchy | Add additional product groups to create the catalog hierarchy of product groups and subgroups. Once your hierarchy is set, you can add the product groups manually in the product groups pages, or you can import them. Importing products lets you use quick import macros or Import Management to create the entire product group and product hierarchy all at once. | See:  
  - Create the Product Group Hierarchy topic in this chapter  
  - The topic, Options for Importing Data Into Your Application, as well as additional topics about importing products, in the Implementing Sales guide  
  - Note: If you're not integrating with an order management application or doing quoting, you can simply use a product group hierarchy without products. There's no need to use individual products unless you need to for downstream applications. |
| Create or import products     | If you're going to use individual products in the catalog, add products to the application. You can create products using the sales Products UI or the product model available with Oracle Supply Chain Management Cloud. You can also import products and the product hierarchy all at once. Or, you can use Import Management to import products and the hierarchy. | See:  
  - If using the sales Products UI, see the Products chapter in this guide  
  - If using Oracle Supply Chain Management (SCM) Cloud product model see these guides:  
    - Oracle SCM Cloud Implementing Product Management  
    - Oracle SCM Cloud Using Product Master Data Management  
  - The topic, Options for Importing Data Into Your Application, as well as additional topics about importing products, in the Implementing Sales guide  

| Add products to the catalog   | If you're going to use individual products in the catalog, add products to the product group hierarchy.                                                                                                                                               | See the Add Products to the Catalog topic in this chapter  

| Publish the sales catalog    | Publish the product group hierarchy that makes up the sales catalog. Perform this step in the product groups pages in Setup and Maintenance. When you publish a catalog, the scheduled process, Refresh Denormalized Product Catalog Table for BI, runs automatically to update the current view of the product group hierarchy in consuming applications. | See:  
  - Publish the Sales Catalog topic in this chapter  
  - Run the Refresh Denormalized Product Catalog Table topic in this chapter  

| Enable the sales catalog     | To enable a sales catalog for use in the applications, you associate it with a "usage" called the Base usage.                                                                                                                                              | See the Enable the Sales Catalog by Setting the Base Usage topic in this chapter  

Add Products to the Catalog

Now that you have created products following the steps in the Products chapter of this guide, or, if you have imported them, your next step is to add them to the product groups that make up the sales catalog hierarchy.

Here’s how to manually add products to the sales catalog product group hierarchy.

1. In Setup and Maintenance, go to:
   - Offering: Sales
   - Functional Area: Sales Catalog and Products
   - Task: Manage Product Groups
2. In the Manage Product Groups page, in the product group hierarchy, select the product group that you want to add products to.
3. Lock the product group for editing by clicking the Lock button.
4. Click the Products tab for the product group you selected.
5. In the View filter, ensure that the Administration view is selected.
6. In the products table, select Actions > Select and Add.
7. In the Select and Add: Products screen, search for and select the product you're adding.
8. Click **Apply** and then **OK** in the select and add window.

   The application returns to the Manage Product Groups page with the product added to the product group.

9. Click the **Publish** button to publish the product group.

10. Finally, click **Yes** in the Confirm Publish dialog window and then dismiss the confirmation message. The application publishes the product group.

11. Save your changes.

To select the organization that provides the set of products available for marketing and sales activities, select an option in the QSC_SALES_PRODUCTS_INVENTORY_ORG_ID profile value.

For more information about how to create products manually in the sales UI, see the Products chapter in this guide. To understand how to import products and the product hierarchy, see the product import topics in the Implementing Sales guide.

Of course, if you're integrating with Oracle Supply Chain Management (SCM) Cloud, you may be creating product in that application's Products screens. To understand this integration a little more see the Products chapter in this guide.

**Related Topics**
- Overview of Sales Products
- Data Import Options

---

### Validate the Service Catalog

Here's how you validate that the product groups are displayed on your SRs after you have published and enabled your catalog:

1. Sign into Service Center as a service manager or service representative.
2. Navigate to **Service Requests** and create a service request.
3. In the Create Service Request page, click the **Product** drop-down list, and click **Search**.
4. Ensure that your product catalog is displayed in the Select: Product page.

**Related Topics**
- Sales Catalog High-Level Setup Steps
- Run the Refresh Denormalized Product Catalog Table Process
- Best Practices for Sales Catalog Setup

---

82
8 Configure Service Request Outcomes and Resolutions

Outcomes and Resolutions

Oracle Fusion Service provides ready-to-use outcomes and resolutions. Administrators can configure additional outcomes and resolutions.

Oracle recommends that you use the task if you want to associate the outcomes, and display the configured items as drop-down list menu in the Resolve Service Request dialog box.

The Manage Service Request Outcomes and Resolutions task is used when administrators want to create new resolutions and map them to outcomes. The task must only be used when administrators want to create new resolutions and don't want to map them to outcomes.

Manage Outcomes and Resolutions

The Manage Service Request Outcomes and Resolutions tasks are used when administrators want to create new outcomes, resolutions, and map resolutions to outcomes.

Follow these steps to configure Outcomes and Resolutions, and map them:

Step 1: Configure Outcomes

To add an outcome:

1. Sign in to the application as an administrator.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Service Request
   - Task: Manage Service Request Outcomes and Resolutions.
3. In the Manage Service Request Outcomes and Resolutions page, select the Outcome tab.
4. Click the Add icon to add a new outcome.
5. In the new row that displays, enter the fields such as lookup code, display sequence, meaning, description, and so on to correspond to your needs.
   - Note: Oracle recommends that you name the outcome lookup code starting with SVC_ to differentiate between customer-created outcomes and ready-to-use outcomes.
6. Click Save and Continue.

If you have selected the Enabled check-box, the outcome is added to the Outcomes list under the Map Resolutions to Outcomes section, else the new outcome is only listed in the Outcomes list.

Step 2: Configure Resolutions.
Administrators can configure new resolutions in the Manage Service Request Outcomes and Resolutions task.

To add resolutions:

1. In the Manage Service Request Outcomes and Resolutions task page, select the Resolution tab.
2. Click the Add icon to add a new resolution.
3. In the new row that displays, enter the fields such as lookup code, display sequence, meaning, description, and so on to correspond to your needs.
4. Click Save and Continue.

If you have selected the Enabled check-box, The resolution is added to the Available Resolutions list under the Map Resolutions to Outcomes section.

Step 3: Map Outcomes to Resolutions.

Administrators can map the outcomes to the available resolutions in the Map Resolutions to Outcomes section in the page.

To manage the outcomes and resolutions:

1. In the Map Resolutions to Outcomes section, do the following to map the outcomes to resolutions.
   - Select an outcome in the Outcomes list.
   - Select the resolutions from Available Resolutions list and move them to the Selected Resolutions list.
   - To remove an existing mapping, select the resolutions from the Selected Resolutions list and move them to the Available Resolutions list.
2. Click Save and Close.

The outcomes are now mapped to the resolutions.

Once the outcomes and resolutions have been configured, these appear in the Resolve Service Request dialog box in the Outcome and Resolution Code list, and the user can enter simple and consistent resolution information about the SR.

Ready to Use Outcomes and Resolutions

The following table lists the ready to use outcomes and resolutions.

<table>
<thead>
<tr>
<th>Outcomes</th>
<th>Resolutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution Provided</td>
<td>Knowledge Article</td>
</tr>
<tr>
<td></td>
<td>FAQ</td>
</tr>
<tr>
<td></td>
<td>Workaround identified</td>
</tr>
<tr>
<td>Unable to Solve Defect Logged</td>
<td>Enhancement Logged</td>
</tr>
<tr>
<td></td>
<td>Training Required</td>
</tr>
<tr>
<td></td>
<td>No Fault Found</td>
</tr>
</tbody>
</table>
Outcomes | Resolutions
---|---
Customer Abandoned | Failed attempts to contact
| Resolved by Customer

### Manage Resolutions

The administrator uses the Manage Service Request Resolutions to add resolutions only when they don't want to associate them to outcomes.

To add, edit, or delete resolutions without associating them with outcomes:

1. Sign in to the application as an administrator.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Service Request
   - Task: Manage Service Request Resolutions.
3. In the Manage Service Request Resolutions page, all resolutions for the lookup type `ORA_SVC_SR_RESOLUTION_CD` are displayed.
4. Click **Add** to add an outcome under the relevant lookup type. You also modify or delete the outcomes here.
5. Click **Save and Close**.
# Work Assignment and Routing

## Overview of Assignments, Mappings, and Rules

For more information about assignment mappings, assignment rules, and configuring assignment, see the following topics in the Oracle Fusion Cloud Sales Automation Implementing Sales guide:

<table>
<thead>
<tr>
<th>Topic in the Oracle Fusion Cloud Sales Automation Implementing Sales guide</th>
<th>What the topic covers</th>
</tr>
</thead>
</table>
| Considerations for Configuring Assignment                                 | • Phases of assignment  
• Setup tasks used for an assignment configuration  
• Assignment objects  
• Attributes  
• Mapping sets and mappings  
• Rule categories, rule sets, and rules                                     |
| Assignment Mapping Set Components                                         | How the mapping set components work together in assignment processing.                                                                                                                                                  |
| Examples of Creating Assignment Mappings                                  | How to create different types of assignment mappings: attribute, dimension, and literal.                                                                                                                                   |
| Assignment Rule Components                                                | How the following assignment rules components work together: rule categories, rule sets, and rules.                                                                                                                        |
| Examples of Creating Assignment Rules                                     | How to create assignment rules using rule sets, rules, conditions, and actions.                                                                                                                                          |

**Related Topics**

- Considerations for Configuring Assignment
- Assignment Mapping Set Components
- Examples of Creating Assignment Mappings
- Assignment Rule Components
- Examples of Creating Assignment Rules
Implementation Concepts for Work Assignment

Overview of Work Assignments
You use the assignment engine to assign resources (for example, service personnel or territory owners) to the business objects they must work on, such as a service request. Being assigned to business objects gives resources and their manager's visibility into the business object.

You also use rule-based assignment to assign additional resources to objects.

Candidate and Work Objects
When setting up assignments, you must be familiar with two types of assignment objects: candidate objects and work objects.

- Work objects are the business objects that are assigned, for example, .
- Candidate objects are the possible pool of assignment candidates, for example, resources.

Rule-Based Assignment
Rule-based assignment lets you set up additional rules that are used to assign resources to work objects. After you set up the rules containing the conditions that records must meet when resources match the rule conditions, they're assigned to the object.

For example, you use rules to assign a certain agent to a certain queue when the customer is located in a specific state or region.

Rule-based assignment requires that you plan your rules, create the rules using the rules UI, and set profile options to configure the assignment behavior, in addition to any scheduled processes that must be run.

Assignment Profile Options
Each of the business objects available in assignment has its own set of profile options that enable you to further configure the application behavior.

Scheduled Processes
Scheduled processes are batch jobs that capture data and permit business objects to act on that data. You must schedule several processes when using assignment. See the Service Request Queue Assignment topic in the Oracle Fusion Cloud Sales Understanding Scheduled Processes guide.

Assignment Reports
You use the Diagnostic Dashboard to generate reports about the assigned objects and the volume of territory data involved in assignment.
Assignment Resources

To learn more about assignment, refer to the following resources:

- Online help: Use the keyword assignment to search for the relevant topics.
- Assignment Resource Center: See the Assignment Manager Resource Center page on My Oracle Support (Doc ID 1522958.1) for more resources.

Assignment Mappings

How You Export and Import Assignment Objects and Rules Setup Data

You can understand how to export and import assignment objects and rules setup data, along with the points to consider while moving the setup data in this topic.

Almost all application implementations require moving functional setup data from one instance into another at various points in the life cycle of the applications. For example, in an enterprise application implementation, a development or test instance is first deployed before deploying a production instance. You can move functional setup configurations for assignment objects or assignment rules from one application instance into another by exporting and importing configuration packages from the Manage Configuration Packages page.

To export and import assignment setup data, start by defining an implementation project for the required assignment setup task. The following are some of the examples of assignment tasks:

- Manage Customer Center Assignment Objects
- Manage Service Assignment Manager Objects

The Manage Configuration Packages setup task exports the assignment objects or rules setup data.

A configuration package contains the setup import and export definition. The setup import and export definition is a list of setup tasks and their associated business objects that identifies the setup data for export as well as the data itself. You generate the setup export and import definition by selecting an implementation project and by creating a configuration package. The tasks and their associated business objects in the selected implementation project define the setup export and import definition for the configuration package. In addition, the sequence of the tasks in the implementation project determines the export and import sequence.

You can export a configuration package once you create it, or at any time in the future. During export, appropriate setup data is identified based on the setup export definition, and is added to the configuration package. The setup data in the configuration package is a snapshot of the data in the source application instance at the time of export. Therefore, publish the assignment objects and rules before exporting them.

After the export completes, you can download the configuration package as a zipped archive of multiple XML files, move it to the target application instance, and upload and import it. Review and publish the assignment objects and rules setup data in the target application instance to make them available for assignment processing.

For more details, see the chapter about importing and exporting setup data in the Oracle Fusion Using Functional Setup Manager guide.
Points to Consider to Export and Import Setup Data

Based on your implementation, you can follow different approaches while exporting and importing assignment setup data.

Consider the following points:

- Because your implementation is using rule-based assignment, the implementation project must include both the Assignment Objects and Assignment Rules setup tasks.
- Retain the default sequence for the tasks and business objects.

The application lets you delete assignment objects, assignment attributes, rule categories, rule sets, rules, and conditions in an environment, for example test. If that setup data is exported, and then imported into another environment, for example production, the data in the target database isn't removed.

If your implementation plans to import and export setup data for assignment objects and assignment rules, ensure not to delete assignment objects, rule categories, rule sets, and rules. Set them to inactive in case you want to delete them. Additionally, don't delete assignment rule conditions. Instead, set the rule to inactive and then recreate the rule excluding the condition that's no longer needed.

Assignment Rules

How You Define Queue Assignment Rules

You can use assignment rules to automatically assign to queues when they are created or updated. And these assignment rules can be run on a schedule.

- are treated as work objects and queues are treated as candidate objects. You can define your rules to select the best candidate (queue) for each work object.

Note: assignment rules are defined using rule-based assignment. Territory-based assignment doesn't apply to.

Defining assignment rules requires some forethought. Consider the following before you define these rules:

- The attributes of queues that you want to use as criteria for your rule assignments.
- The attributes of that you want to use as criteria for your rule assignments.
- The rule sets you want to create.
• The rules to include in each rule set.

**Note:** You must define queue candidate objects before you start defining rules for assignment objects.

**Related Topics**
- Assignment Rule Components
- Update Existing Setup Data
- Create a Queue
- What Happens When You Change Queue Properties

## Manage Assignment Objects

You need to select attributes from the assignment object that you want to make available in your rules. But note that this procedure is optional, because ready-to-use fields are already provided for all the objects.

**Note:** You must not modify the configuration for any of the ready-to-use objects. If you modify the configuration, the Queue Assignment process can't run successfully. But you can add new attributes or new child entities for the objects.

(Optional) To manage assignment objects:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Service Assignment Objects

2. On the Manage Service Assignment Objects page, add the queue attributes that you want to be available when you're setting up your rules:
   a. Click Queue.
   b. Click the Attributes tab.
   c. Add attributes to the list by clicking the **Plus** icon, and then selecting the **View Object Attribute** from the drop-down list.
   d. Click **Save**.

3. Add the attributes that you want to be available when setting up your rules:
   a. Click .
   b. Click the **Attributes** tab.
   c. Add attributes to the list by clicking the **Plus** icon, and then selecting the **View Object Attribute** from the drop-down list.
   d. Click **Save**.

**Related Topics**
- Assignment Rule Components
- What Happens When You Change Queue Properties
Manage Assignment Rules

Let’s go over how you define the rules for service assignment.

Here are some guidelines that you need to follow when you’re defining matching rules for assigning work items to queues:

- You must define the rule set with Number of Candidates = 1. The application enables only one queue to be assigned to a.
- You have the option to select or deselect the Use Score option on a rule set. If you select Use Score, then for every rule in the rule set, you must indicate the amount to increase the score when the rule is true. You must then associate the rule set to queues that receive that score. All the rules in a rule set are executed, and the queue with the highest total score is selected.
- If the rule set has multiple rules and you didn’t select the Use Score option, you must define the criteria for each rule to be mutually exclusive from other rules in the rule set. This ensures that the resulting queue assigned by the application is predictable in all situations.

You can use the operators listed in this table to define the conditions for SR assignment rules.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Value</th>
<th>Used in hierarchy?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equals</td>
<td>The value of a field equals a specific value.</td>
<td>Single</td>
<td>No</td>
<td>If the rule condition is set as Service Request Severity Equals High, only an SR with the severity value of High matches the condition.</td>
</tr>
<tr>
<td>Does not equal</td>
<td>The value of a field doesn’t equal a specific value.</td>
<td>Single</td>
<td>No</td>
<td>If the rule condition is set as Service Request Severity Does not equal High, an SR with severity value of Low or Medium matches the condition.</td>
</tr>
<tr>
<td>In</td>
<td>The value of a field is one of a list of values.</td>
<td>Single or Multiple</td>
<td>No</td>
<td>If the rule condition is set as Service Request Problem type Code In Docs, Product, an SR with the problem type code value of Docs or Product matches the condition.</td>
</tr>
<tr>
<td>In including children</td>
<td>The value of a field is one of a list of values. Indicates that the rule applies if an attribute value matches to any of the attributes in the parent-child hierarchy of the current attribute.</td>
<td>Single or Multiple</td>
<td>Yes</td>
<td>If the rule condition is set as Service Request Product Group In including children Apple, any SR with the Apple product group or any of its children, such as iPhone, iPhone 6s, iPhone 7, iPad, iPad1, and iPad 2 match the condition.</td>
</tr>
</tbody>
</table>
## Work Assignment and Routing

### Operator | Description | Value | Used in hierarchy? | Example
--- | --- | --- | --- | ---
Not in including children | The value of a field isn't in a list of values. This value is only relevant for category or product fields that are hierarchical. Indicates that the rule applies if the specified attribute value matches the top level of the attribute. This option doesn't include the attribute values of the children of the current attribute. | Single or Multiple | Yes | If the rule condition is set as Service Request Product Group Not in including children iPad, an SR with the Product Group value of iPad or any of its children, such as iPad1 or iPad2 doesn't match the condition. However, an SR with the Product Group value of Apple, iPhone, or iPhone 6s matches the condition.

Not in | The value of a field isn't in a list of values. | Single or Multiple | No | If the rule condition is set as Service Request Problem Type Code Not in Docs, Product, an SR with the problem type code value of User doesn't match the condition. However, an SR with a problem type code of Docs or Product is a match.

Is blank | The value of a field doesn't contain a value. | N/A | No | If the rule condition is set as Service Request Internal Priority Code Is blank, an SR without an internal priority code value is a match.

Is not blank | The value of a field contains any value. | N/A | No | If the rule condition is set as Service Request Account Is not blank, an SR with an associated account is match, but not an SR without an account.

---

To manage SR assignment rules:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Service Assignment Rules
2. On the Manage Service Assignment Rules page, select a Category based on the following.
   - **Generic Queuing Rules**: Rules set for all types of work items.
   - **HR Service Request Queuing Rules**: Rules set for HR Help Desk SR.
   - **Service Request Queuing Rules**: Rules set for CRM SR.
3. Create a new rule set by clicking the Plus icon in the Rule Sets work area, and then enter the required information.
4. Create rules for the rule set by clicking the Plus icon in the Rules work area.
5. In the **Create Rule** window, enter a name for the rule in the **Name** field.
6. From the **Rule Applies If** drop-down list, select **Any conditions met**.
7. Add a condition by clicking the **Plus** icon in the **Conditions** work area, and then define the required attribute. If an attribute is hierarchical, such as Category Name and Product Group, **Not In Including Children** and **In Including Children** operators are displayed as choices. For more information about the operators, see the table with the list of operators.
8. (Optional) Add additional conditions.
9. In the Action: **Assign Queue** region, click the **Plus** icon to select a queue.
10. In the **Select and Add Queue** window, search for and select a queue.
11. Click **OK**.
12. Click **Save and Publish** to publish the assignment rules.

The service assignment has been defined.

**Note:** You must republish the assignment rules each time the rule is changed. Also republish the rules each time the associated queue is deleted, enabled, or disabled.

**Related Topics**
- Assignment Rule Components
- Update Existing Setup Data
- What Happens When You Change Queue Properties

**Set Rules for Queue Assignment**

You can create assignment rules by using rule sets, rules, conditions, and actions.

The assignment engine uses your rules to evaluate and recommend candidate assignments for specified work objects.

**Note:** A particular work item can be assigned only to a single queue. So it's good to be careful while defining rules. You can't define different rules that assign the same work item to different queues.

To create a service assignment rule:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Service Assignment Rules
2. On the Manage Service Assignment Rules page, select from the **Category** drop-down list:
3. Do one of the following:
   - Create a rule set by clicking the **Plus** icon and specifying the required values.
   - Select an existing rule set.
4. Create a rule within the rule set by completing the following steps:
   a. Click the **Plus** icon in the **Rule set: Rules** region.
   b. On the Create Rule page, specify a rule name.
c. (Optional) Specify a description, an effective start date, and an end date for the rule. If you don't select an effective start date and end date, the rule comes into immediate effect and lasts indefinitely.

d. (Optional) Select the Inactive option if you want to enable the rule at a later date.

Note: You can create multiple rules within a rule set.

5. Specify an assignment condition as described later in this topic, in the "Specify a Condition and an Action" section.
   This assignment condition is evaluated before a rule-based assignment is made.
6. Select a queue to which is assigned if the condition is met.

Specify a Condition and an Action

To specify a condition and an action:

1. Select an option from the Rule Applies If drop-down list.
   You can choose to perform the action if all of the conditions are met or if one of the conditions is met.
2. Click the Plus icon to add a condition.
   Note: If you don't add a condition, all your work items are assigned to the queue that you add in step 4.
3. Select the object, an attribute, an operator for the condition, and a value.
4. Add an action to be performed when the condition is satisfied. Click the Plus icon to select and add a queue.
   CAUTION: Oracle recommends that you always add an action. If you don't add an action, the assignment engine acts unpredictably and you may face issues in the assignment of work items to queues.
5. Search for a queue, select the required queue from the list, and click Done to add the queue to the action.
6. Click Save and Close.

Related Topics
- Update Existing Setup Data

Tips for Creating Assignment Rules and Rule Sets

Summary of Tips for Creating Assignment Rules and Rule Sets

To maximize the effectiveness of your assignment rules, Oracle recommends that you follow these tips while creating them. Each of them is described in detail in separate topics:

- Add a condition and an action for every rule.
- Create unique rules.
- Create minimum number of rule sets.
- Publish rules after you rename them.
• Set incomplete rules and rule sets to inactive.

Add a Condition and an Action for Every Rule

It’s important to remember that you always add a condition and an action for every rule. Any rule without a condition or action can lead to unpredictable results.

• If you don’t add a condition, any work item will match this rule. This type of rule will conflict with other well-defined rules. This situation results in a work item matching multiple rules, so it’s randomly assigned to any queue that matches any of these rules.
• Add an action to be performed when the condition is satisfied. You add a queue as part of the action. If you don’t add an action, the Assignment Manager acts unpredictably and you may face issues in the assignment of work items to queues.

Note: Some examples of incomplete rules that you must avoid:
• If no condition, then assign the work item to the Q1 queue.
• If severity of the work item is high, then you don’t specify any queue.

For more information, see Set Rules for Queue Assignment.

Related Topics
• Set Rules for Queue Assignment

Create Unique Rules

Here are some pointers for creating unique rules:

• You must create unique rules in such a way that two different rules don’t match the same work item. If multiple rules match the same work item, the Assignment Manager randomly picks one of those matching rules.
• You must also ensure that you don’t have duplicate or identical rules. Duplicate or identical rules doesn’t mean identical conditions. It means that multiple rules match the same incoming work item, even if the rules are defined on different fields or a combination of fields.
• If you can’t create unique rules, you must put the rules in the same rule set and use scoring to determine which queue is picked by the Assignment Manager. You have the option to select or deselect the Use Score option on a rule set. If you select Use Score, then for every rule in the rule set, you must indicate the amount to increase the score when the rule is true. You must also set Filter as Top X and Number of candidates as 1. All the rules in a rule set are executed, and the queue with the highest total score is selected.

For more information, see Manage Service Assignment Rules.

Note: Scoring applies only inside a rule set. But you may have scenarios where identical rules are present in different rule sets, and multiple rules from different rule sets match a work item. In such cases, the Assignment Manager randomly picks one of those identical rules.
Let's see a few examples of how you can make a rule unique:

**Example 1 for Making a Rule Unique**

Let's say you write the following rules:

- **Rule 1**: Variable A=1 and Variable B=2 (Action: Assign work item to Q1)
- **Rule 2**: Variable A=1, Variable B=2, and Variable C=3 (Action: Assign work item to Q2)

Then the Variable A=1 and Variable B=2 part is common in both the rules. When an incoming work item satisfies Rule 2, it also satisfies Rule 1. And the Assignment Manager randomly picks one of the two.

To make these two rules unique, you can add a condition about variable C in Rule 1. For example, you can add the following condition to Rule 1: C isn't equal to 3.

**Note:** Rule 1 and Rule 2 are identical if you get a work item with all 3 variables and both rules are matching.

**Example 2 for Making a Rule Unique**

Let's consider the following example involving different rule sets. In Rule Set 1, you have a rule with the condition C1=A. In Rule Set 2, you have a rule with the condition C2=B. Here, C1 and C2 are different fields.

Now let's say you have a work item where C1=A and C2=B. These two rules aren't unique, and they both match the work item. In such a scenario, any one of the rules is randomly picked, and a queue is selected. But suppose you want the work item to be assigned only to a queue called Q1 because it has C1, and you want C2 to be ignored. Then you must make the rules unique by setting conditions such as the following:

- **Rule 1**: If C1 equals A and C2 isn't equal to B, then assign to Q1.
- **Rule 2**: If C1 equals A and C2 equals B, then assign to Q2.

**Note:** If the matching rules are in different rule sets, you can't apply scoring. If the matching rules were in the same rule set, scoring would help. For example: You set the scoring of Rule 1 to 10 and Rule 2 to 5.

**Create Minimum Number of Rule Sets**

The Assignment Manager is designed to return only one queue for every work item.

If two rules from different rule sets match a work item, then the Assignment Manager randomly picks between the rules. So the work item may not be assigned to the queue that you would want. To avoid such situations, it's good to have only one rule set if possible. And you can apply scoring for the rules if required. That way, only one rule matches a work item. Regardless of the company size, Oracle recommends deploying only one rule set.

**Note:** You can still have multiple rule sets if you ensure that the rules within these rule sets are all unique. And within each rule set, you can have scoring for the rules. But if you have the same or similar rule in different rule sets, two rules from different rule sets can match the same work item.
Here's what the Assignment Manager does when you have multiple rule sets:

1. The Assignment Manager checks all rule sets. In one round of assignment, it checks all the rules under Rule Set 1, all the rules under Rule Set 2, and so on.
2. It finds some matching rules. Let's say the matching rules are Q1 and Q2 under Rule Set 1, and Q3 under Rule Set 2.
3. It randomly picks a rule among Q1, Q2, and Q3.

**Note:** You must not create more than the maximum limit of 500 rule sets. The Assignment Manager selects only 500 rule sets alphabetically to process them. But within every rule set, you can have any number of rules. An upper limit doesn't apply to the number of rules.

**Publish Rules After You Rename Them**

Oracle recommends that whenever you rename a rule, you must publish it immediately.

Let's say you create or rename a rule, and you don't publish it immediately. Sometimes, another administrator may delete it or create another rule with the same name. This causes confusion for the Assignment Manager while publishing. For the same reason, you must also avoid renaming a rule and deleting a rule in the same operation. You must publish the rule after every individual operation.

**Set Incomplete Rules and Rule Sets to Inactive**

You must set any incomplete rules or rule sets to inactive. While creating a rule or rule set, you must set the initial status to inactive.

This way, you avoid the risk of incomplete rules being published. You must first complete adding all the conditions and actions to a rule. After that's done and you're confident that the queue works as required, you can set it to active and publish it.

Here's why you must be careful. Suppose you created a rule and saved it, but you couldn't complete the rule for some reason. So you may not have added a condition and action to determine the queue for assignment. And let's say another administrator publishes the rules. Whenever any administrator publishes the rules, all active rules and rule sets that are saved until then are published, irrespective of who has created them. Incomplete rules that are set to active status are also published. When this happens, the Assignment Manager may pick a rule other than what you would prefer.

**Work Assignments**

**Agent Capacity**

Capacity indicates the maximum number of open work items of a certain type that an agent can handle. Capacity is configured at a global level for various types of work items by using the Manage Capacities page.
For example: If the global capacity for is 30, an agent who's working on 30 open requests is considered to be 100 percent occupied.

If a queue has multiple agents, the work item is assigned to the agent with the maximum free capacity of the relevant type. If more than one agent has the same capacity, the work item is assigned to the agent with the maximum overall free capacity.

Agent Presence

Presence indicates whether an agent who has signed in to the application is interacting with the application. Agents set their presence through the Settings and Action menu.

An agent can be online, but may not be available to handle work items. If an agent isn't signed in, then the presence is set to offline.

Agent Availability

Agent availability indicates whether an agent is available.

**Note:** Based on the SVC_OMNI_DISABLE_WORK_ITEM_AVAILABILITY_SELECTION profile option setting, the application restricts agents from blocking new work assignments. The application assigns new work to agents until their maximum capacity is reached.

**Related Topics**
- Enable Omnichannel
- Configure Presence and Availability Privilege

Severity and Age of Requests

Severity indicates the priority of a is assigned to an agent based on its severity.

This means that with a higher severity is taken up earlier for resolution. An administrator can set the values for severity.

The age of is also a factor while assigning work. A that's waiting in the queue for a longer period of time is given higher priority.

**Related Topics**
- Add Severity Values to Requests
- Prevent Starvation of Low Priority Work Requests
Default Queue

If you have enabled Omnichannel, there's a ready-to-use queue named Default. You can set the Default queue to manual or automatic, depending on your company's requirement.

Be aware that the Default queue contains work items that you can't place in any other queue because they don't match any of the defined assignment rules. You can add agents and teams to the Default queue and also modify the queue properties, but you can't disable or delete this queue.

Note:
- that don't match any rules are assigned to the Default queue only when Omnichannel is enabled. When Omnichannel is enabled, here's what happens:
  - If you set the Default queue to automatic, then the work items are automatically assigned to the agents who are available and have free capacity.
  - If you set the Default queue to manual, then the agents must manually assign the work items to themselves.

Here's what Oracle recommends:
- The preferred way of assigning to a queue is by using Omnichannel assignment. Let's say you have enabled Omnichannel for assignments. And you may be assigning to the Default queue either manually or automatically by using assignment rules or groovy scripts. Either way, it's important and highly recommended that you assign active agents to the Default queue, so that can be assigned to the agents.
- If you set the Default queue to automatic and you don't assign agents to it, assigned to the Default queue could remain unattended and eventually impact performance. You could miss the SLAs and your don't get responses on time.
- If you don't assign any agents to the Default queue, then you must set the Default queue to manual. But if you set it to manual, you must ensure that the are answered.
- Let's say you assign agents to the Default queue, but you prefer to use it as a catch-all queue and not for automatic assignment of to agents. In such cases, you can set the default queue to manual. This would depend on your company's requirement.

Related Topics
- Enable Omnichannel

How You Assign Work to Agents

Work assignment refers to interactions or work items such as being assigned to queues for processing.

Work items are assigned to a queue and an agent is assigned to one or more queues. All work items in a queue are handled by the assigned agents.

A work item can be assigned to an agent manually or automatically based on whether the associated queue is automatic or manual.
Note: In automatic queues, the priority of is calculated based on severity and wait time. with highest severity are assigned first. If there are multiple with the same severity, those that have been in the queue for the longest time are assigned first. But this rule applies only to bigger volumes of and a large number of agents and not on a small scale.

Work assignment in an automatic queue is done based on the following aspects:

- Agent capacity
- Availability of the agent
- Presence of the agent
- Severity of the work item
- Age of the work item

Note: Omnichannel must be enabled to use the settings for presence of the agent, availability of the agent, and agent capacity.

Here are the various ways can be assigned to an agent:

- Manually set the Assigned To field in the Summary tab of the Details page.
- Click Assign to Me from the Actions menu on the Details page.
- Enable Omnichannel.

Related Topics
- Enable Omnichannel
- Order in Which Requests are Assigned
- How to Assign Agents to Work Items

Order in Which Requests are Assigned

Here's how in an automatic queue are assigned to agents.

The application calculates the priority of based on severity and waiting time. with the highest severity are assigned first. If there are multiple with the same severity, that have been in the queue for the longest time are assigned first.

Note: It's possible that you may see exceptions to this rule when you're testing with a small number of agents. That's because the application is designed to work with millions of and thousands of agents per day. And to do that, it has massive parallel processing power.

There are multiple servers in your production environment. Each server tries to assign , competing with other servers to assign all the work among all available agents. are assigned on multiple servers in parallel, otherwise the assignment tends to lag behind the incoming work.

Suppose your production environment has 15 servers. The application would act as if it's assigning in batches of 15. The from 1 to 15 would be assigned before the 16 to 30. But the order within each batch isn't guaranteed. The first server that finds an available agent makes the assignment.
How You Assign Work to a Queue

Here are the various ways in which you can assign a service request (SR) to a queue:

- Open an SR. From the Queue drop-down list, manually select the queue to which you want to assign the SR.
- Enable Omnichannel, which runs the queue assignment rules when the SR is created or when the queue is deleted from the SR.
- Click Run Queue Assignment from the Actions menu, which runs the queue assignment rules.
- Enable the Assign Service Request to Queue on Create profile option, which runs the queue assignment rules when the SR is created. The process is described below.
- Schedule the Queue Assignment job that runs the queue assignment periodically and processes all the open SRs that aren't assigned to a queue.

The preferred way of assigning an SR to a queue is by using Omnichannel assignment. Enabling Omnichannel has the following advantages:

- Enabling Omnichannel provides more features than queue assignment. It also enables the automatic assignment of agents. But if your business only requires queue assignment, you must carefully evaluate whether you need to enable Omnichannel.
- Only if you enable Omnichannel, the SR is assigned to the Default queue when the Assignment Manager rules haven't been defined or when the selected SR doesn't satisfy any active rule.
- When Omnichannel is enabled, automatic assignment of SRs to agents is always enabled on the Default queue.

Suppose you're assigning SRs to an automatic queue either manually or automatically by using assignment rules or groovy scripts. If you enable Omnichannel, Oracle recommends that you also assign active agents for the automatic queue, so that SRs can be assigned to the agents.

Note: If you don't assign agents for the automatic queues, SRs assigned to those queues could grow exponentially over time. And this causes the application to slow down.

Enable the Assign Service Request To Queue On Create Profile Option to Assign an SR to a Queue

Here's how you enable the Assign Service Request To Queue On Create profile option:

1. Sign in to the application as an administrator.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Service Request
   - Task: Manage Service Request Profile Options

   | Note: Alternatively, you can open the Tasks panel tab and search for the Manage Service Request Profile Options task.

3. On the Manage Service Request Profile Options page, click SVC_ASSIGN_TO_QUEUE_ON_CREATE.
4. Navigate to the SVC_ASSIGN_TO_QUEUE_ON_CREATE: Profile Values region of the page.
5. In the Profile Value drop-down list for the Site Profile Level, select Yes.
6. Click **Save and Close**.

**Note:** If Omnichannel is enabled, this profile option is ignored.

### Add Severity Values to Requests

Severity indicates the priority of a request. A higher severity bypasses other requests of lower priority in a queue, and is taken up for resolution sooner.

As an administrator, you can set the severity values in the application.

1. In the Setup and Maintenance area, go to the following:
2. The lookup for the lookup codes. To add a new severity value, specify the following values:
   - **Lookup Code**: Enter the new lookup code. For example, High Priority. **Note:** The **Lookup Code** is a text value and must be used for display purpose only. The value that you specify in the **Lookup Code** field doesn't affect the actual severity of a request. The actual severity is determined by the **Severity Ranking** field.
   - **Severity Ranking**: Enter a value that depicts the priority level. A severity with a lower severity ranking is considered as having higher priority when they are routed to agents. For example, a severity ranking of 2 is considered higher in priority when compared to a severity ranking of 5.
   - **Enabled**: Select to enable the severity value. Disabled severity values aren't displayed on the page.
   - **Start Date** and **End Date**: Specify a date range within which the severity value is valid. If you don't specify a date, the severity value remains valid forever.
   - **Meaning**: Enter an optional meaning for the severity value. For example, for Priority 1, specify the **Meaning** as Critical.
   - **Description**: Enter an optional description.
   - **Tag**: Specify a tag that's used to differentiate a certain severity from the others. For example, specify **Tag** for Priority 1 as COLOR=#ff0000,#FFFFFF to change the color of a Priority 1 request. In this case, a Priority 1 request is displayed in red text with a white background.
3. Add more lookup codes as required.
4. After you finish, click **Save and Close**.

### Related Topics
- How You Assign Work to Agents
- Update Existing Setup Data

### Omnichannel

#### Enable Omnichannel

Automatic routing of work to agents is done through Omnichannel. So, if you want the work assignments for agents to be automatically routed, you must enable Omnichannel.
Note: To view the Omnichannel tasks, you must enable the Omnichannel Routing feature under the Communication Channels offering.

Here’s a list of profile options you must configure to enable Omnichannel.

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_ENABLE_OMNI</td>
<td>Enables Omnichannel.</td>
</tr>
<tr>
<td>SVC_INTERACTION_RETENTION_DAYS</td>
<td>Specifies the number of days to retain interactions before they're purged from the database. Must be set to 1 or greater for the job to run.</td>
</tr>
<tr>
<td>SVC_EVENTS_RETENTION_DAYS</td>
<td>Specifies the number of days to retain events before they're purged from the database. Must be set to 1 or greater for the job to run.</td>
</tr>
<tr>
<td>SVC_INTERACTION_DISPLAY_DAYS</td>
<td>Specifies the number of days from the past since when the interactions can be viewed.</td>
</tr>
</tbody>
</table>

To enable Omnichannel and its notifications:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Omnichannel Profile Options
2. In the Manage Omnichannel Profile Options window, complete the following steps for each of the listed profile options:
3. Click the profile option name.
4. Navigate to the Profile Values region of the page.
5. Set the Profile Value for the Site Profile Level as follows:
   - For the first three profile options in the table, set the value to Yes to enable the profile option.
   - For the remaining profile options in the table, specify a suitable value as described.
6. Click Save.

Related Topics
- Overview of Configuring Offerings
- Configure Offerings
- Update Existing Setup Data

Set Channel Capacity

Channel capacity indicates the maximum number of active interactions in a channel that can be handled by an agent.

To set channel capacity:

1. In the Setup and Maintenance work area, go to the following:
2. To provide queue owners and managers the ability to modify the channel capacities for individuals by overriding the global default capacities:

In the Override Individual Capacities region, select the Enable Channel Capacities to Be Overridden for Individuals check box.

3. To change the capacity of a non-real-time work:

   a. In the Work Assignments region, modify the default value in the Capacity field to a new value.
   
   b. The status in the Qualifying Status Values column indicates the status of the work items that determine the capacity. For example, if the status is set to New, In Progress, only the work items that are in the specified status add up to the total capacity. To specify the active statuses, click the status value.
   
   c. In the Qualifying Status Values window, select a status from the No Effect on Workload list and move it to the Adds to Workload list to qualify the status as active.
   
   d. Click Apply.

4. Click Save and Close.

Note: When you export or import the functional setup data for the Service offering by using the export and import feature in Functional Setup Manager, the Manage Capacities setup is also exported or imported. But the value of the Override Individual Capacity check box isn’t exported or imported. You must select or deselect the check box manually.

**Related Topics**
- How You Assign Work to Agents
- Update Existing Setup Data
- Why You Override Individual Capacity Settings

### Configure Presence and Availability Privilege

To set the presence and availability, an agent must be given the Manage Omnichannel Presence and Availability privilege.

This privilege is available by default to the following job roles:

To grant the Manage Omnichannel Presence and Availability privilege to any other role, do one of the following in the Security Console:

- Create a role and provide the privilege to the role.
- Copy one of the default job roles with the privilege and create a role to add the privilege.

For more information about copying job roles, see the Oracle Fusion Cloud Customer Experience Securing Sales and Fusion Service guide.

Note: After you add the privilege to the new role, you must associate a user to the new role.

**Related Topics**
- Copy and Edit Duty Roles
Prevent Work Starvation

Prevent Starvation of Low Priority Work Requests

Sometimes, a burst of high priority requests may prevent the low priority requests from being assigned to an agent for a long time.

Although high priority requests may come in later, they're assigned first, and the low priority requests are repeatedly kept waiting. That's because the agents are unable to keep up the pace to serve both.

As an administrator, you can dynamically raise the priority of low priority requests after a certain wait time. The benefits are as follows:

- The wait time for lower priority items is reduced, and this ensures a balance between high priority and low priority requests.
- Lower priority requests are served fairly, thereby improving satisfaction.

Configure Profile Options to Prevent Work Starvation

To prevent starvation of work requests having a lower priority, you must configure profile options.

The following table shows the profile options to configure for preventing work starvation.

<table>
<thead>
<tr>
<th>Profile Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_ENABLE_STARVATION_PREVENTION</td>
<td>Enable prevention of work starvation to avoid work requests having a lower priority from being ignored while assigning work items to an agent. The default value is No.</td>
</tr>
<tr>
<td>SVC_STARVATION_PREVENTION_NRT_INTERVAL</td>
<td>Specify the number of minutes after which the priority of an unassigned, non-real-time work request is increased for assigning to an agent. The default value is 180 minutes. Note: You must specify a value greater than the average handle time for a non-real-time work request in your company. For more information, see “Set a Profile Value Greater Than the Average Handle Time”.</td>
</tr>
<tr>
<td>SVC_STARVATION_PREVENTION_NRT_STEP</td>
<td>Specify the step size to increase the priority of a non-real-time work request. The default value is 1.</td>
</tr>
<tr>
<td>SVC_STARVATION_PREVENTION_RT_INTERVAL</td>
<td>Specify the number of seconds after which the priority of an unassigned, real-time work request is increased for assigning to an agent.</td>
</tr>
<tr>
<td>Profile Options</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>The default value is 30 seconds.</td>
</tr>
<tr>
<td></td>
<td>Note: You must specify a value greater than the average handle time for a</td>
</tr>
<tr>
<td></td>
<td>real-time work request in your company. For more information, see “Set a</td>
</tr>
<tr>
<td></td>
<td>Profile Value Greater Than the Average Handle Time”.</td>
</tr>
<tr>
<td>SVC_STARVATION_PREVENTION_RT_STEP</td>
<td>Specify the step size to increase the priority of a real-time work request.</td>
</tr>
<tr>
<td></td>
<td>The default value is 1.</td>
</tr>
</tbody>
</table>

To configure the profile options for preventing starvation of work requests having a lower priority:

1. In the Setup and Maintenance work area, go to the following:
2. In the Manage Work Starvation Profile Options page, click **SVC_ENABLE_STARVATION_PREVENTION**.
3. In the SVC_ENABLE_STARVATION_PREVENTION: Profile Values region, set the **Profile Value** for the Site **Profile Level** as **Yes**.
4. Click **Save**.
5. Complete the following steps for the remaining four profile options in the table:
   a. Select a profile option.
   b. In the Profile Values region, select the Site **Profile Level**.
   c. In the **Profile Value** field, retain the default value or modify the value according to your company’s requirement.
   d. Click **Save**.

### Set a Profile Value Greater Than the Average Handle Time

The average handle time is the average duration of one interaction of an agent with .

You must set the profile for the **SVC_STARVATION_PREVENTION_NRT_INTERVAL** to a much higher value than the respective average handle times.

**Related Topics**
- Configure Profile Options to Prevent Work Starvation
FAQs About Service Requests and Queues

Frequently Asked Questions (FAQs) for Service Requests and Queues

This section contains some frequently asked questions (FAQs) when setting up and maintaining service requests and queues. Scroll or search to find answers to common questions.

Why aren’t some service requests being assigned to the Default queue?

Let’s say you’re creating groovy scripts within Application Composer to perform validation checks, including user permission checks to determine who has access to update the fields in a service request (SR). Then you must ensure that you permit the internal user FUSION_APPS_CRM_ESS_APPID to update SRs.

The FUSION_APPS_CRM_ESS_APPID internal user performs operations on behalf of Omnichannel. If the internal user isn’t given permission to update SRs from within the groovy script, then Omnichannel is unable to set the Default queue as the target queue. As a result, SRs aren’t assigned to the Default queue.

Related Topics
• Default Queue
• Overview of Groovy Scripts

What happens if a newly created request isn't assigned to a queue?

If a is created without an associated queue, and Omnichannel is enabled, then the routing feature selects a queue.

If the queue is automatic, then the routing feature assigns the associated agent for the . If is created with an associated queue, then the routing feature selects only the agent.

What happens if an associated agent is removed from an open request?

If an associated agent is removed from an open that's in a status of New or any other active statuses specified in the Manage Capacities page, then the following happens:
• The routing feature selects a new agent for the request from the resource pool of that queue, based on the capacity of the associated agent.

**Note:** A new agent is selected only if Omnichannel is enabled and the queue is automatic.

**Related Topics**
- Set Channel Capacity

### What happens if an open request is disassociated from the current queue?

If an open is disassociated from the current queue, then the routing feature assigns the request to a new queue, provided the following conditions are true:

- Omnichannel is enabled.
- The **Assigned To** value of the request is empty.

The request is subsequently assigned to an associated agent if the queue is automatic and any assignment rules are rerun. If the disassociated request is in a New status or any other active status specified in the Manage Capacities page, then the agent capacity is calculated before assigning the request to an agent.

**Note:** If you disassociate from the current queue, then you must clear the **Assigned To** value to ensure that rerouting takes place.

### What happens if a request is reopened?

Here’s what happens when a request is reopened:

- If the reopened is already associated with an agent, then the request is reassigned to the same agent.
- If the reopened isn’t assigned to any agent, and Omnichannel is enabled, then the request is assigned to a queue based on the associated assignment rules.

If the queue is automatic, then the request is assigned to an associated agent. Requests are assigned based on the set channel capacity for an agent. Only if an request is in the New, In Progress, or other statuses specified in the **Qualifying Status Values** column in the Manage Capacities page in Setup and Maintenance, it counts for capacity. If the request isn’t in one of these statuses, it doesn’t count for capacity, and the request isn’t assigned to the agent.

**Note:**
- If the status of changes, then it counts for capacity for the agent to whom it’s assigned. For example, when the status changes from Waiting for to In Progress.
- If the request isn’t assigned to an agent, the routing service starts looking for an agent.
What happens if I mark an assignment object or one of its attributes as inactive?

When you mark an assignment object as inactive, the selected work or candidate assignment object isn't available for assignment processing. When you mark an assignment attribute as inactive, the selected work or candidate object attribute isn't available for assignment processing.

**Note:** The object or attribute can't be set to inactive if there is a mapping set, mapping, or rule defined using the object or attribute.
10 Service Entitlements

Overview of Service Entitlements

Entitlements Background and Terminology

Service entitlements are benefits or privileges you provide to when you extend service to them.

A milestone is a type of entitlement that identifies service levels your organization has committed to its , and is tracked when providing service in the context of a request.

Here's the ready-to-use milestones you get with the application:

- First Response Metric: Tracks how quickly you agree to respond to after the request is received.
- Resolution Metric: Tracks how quickly you must resolve the request for the .

In addition, you can also set up administrator-defined milestones that define other service levels you want to track for your .

When you create a request for , milestones are automatically assigned to the request based on the defined service coverages. You can apply milestones to a request by defining the coverages as follows:

- Standard Coverages, which act as templates.
- Default Coverages, specify a standard coverage template as a global default that's applicable to all requests.
- Subscription Coverages (or Service Contracts), which you can optionally create to apply coverages only to specific assets or products owned by a customer.

**Note:** New customers are automatically opted-in to use Subscription Management instead of Service Contracts. For existing customers implementing service entitlements for the first time, Oracle recommends the use of the subscription coverages. Customers already using Service Contracts are still supported, however new features such as product-based service level agreements (SLAs) are only available with Subscriptions. For more information, see Enable Subscription Coverages for Entitlements.

When the same milestone exists in coverages at multiple levels, the subscription (or contract) values take priority over customer-level default values, which in turn take priority over global default values.

Overview of the Milestone Lifecycle

Once milestones are assigned to a service request, they begin countdown to their respective due dates, and are monitored by the application automatically based on the configuration you have set up.

The Milestone object includes a Status field that indicates whether the milestone is being actively tracked, is paused, complete, or has been canceled. The Milestone object also includes two flags that are commonly used to trigger object
workflow according to your business needs, for example to send an email notification to proactively notify the agent, or escalate the service request:

- The **WarnedFlag** is updated to **Y** when the milestone's time to expiration is within the warning threshold specified in the standard coverage.
- The **ComplianceFlag** is updated to **N** when the milestone reaches the due date or the time before completion, representing a milestone that has expired (it's no longer compliant).

In case you’re wondering where you can get more details about the setup and configuration of milestones and coverages:

- The topic "Set Up Milestones and Coverages" provides the details to set up milestones and coverages using the delivered milestones and coverage criteria.
- The topic "Configure Milestones and Coverages" describes how to expand milestones and coverages to adapt them to your business needs.

## Milestones and Coverages

### How You Set Up Milestones and Coverages

You must set up milestones and coverages so that the ready-to-use milestones are automatically applied to service requests and monitored.

New customers are automatically opted-in to use Subscription Management instead of Service Contracts. For existing customers implementing service entitlements for the first time, Oracle recommends the use of the subscription coverages. Customers already using Service Contracts are still supported, however new features such as product-based service level agreements (SLAs) are only available with Subscriptions. For more information, see [Enable Subscription Coverages for Entitlements](#).

Here’s the steps you require for this set up:

1. Manage milestone configuration (optional)
2. Create a coverage schedule (optional)
3. Create a standard coverage
4. Apply the standard coverage as global and customer defaults
5. Configure the scheduled process to monitor milestones
6. Add current milestone fields to the layout (optional)
7. Configure email notifications or other event actions from an object workflow (optional)

### Overview of Milestones and Coverages Configuration

The First Response Metric and Resolution Metric milestones are preconfigured for every implementation.

These milestones have predefined criteria that specify when the milestone starts, pauses, and completes. You can review these criteria and modify them if required, to match your business rules.

After you set up the milestones and coverages using the standard process steps described in the "How You Set Up Milestones and Coverages" topic, you can cover a wider variety of scenarios and adapt milestone functionality to...
your specific business needs. Here's where you can get detailed information about the advanced configuration for milestones and coverages:

- The "Set Up Additional Condition Columns for Standard Coverage Entitlement Rules" and "Set Up Administrator-defined Milestones" sections provide information about managing milestone conditions, as well as creating your own milestones.
- The "Configure Milestones for Multiple Business Units" section provides information about how to configure milestones for multiple business units.
- The "Troubleshoot with Milestone Diagnostics" section provides information about reviewing milestone diagnostics for troubleshooting.

Overview of Coverage Schedule

A coverage schedule is a service calendar containing detailed time intervals that identify when a request is expected to be worked.

Coverage schedules provide flexibility to define business hours and specific intervals during the year when different operating hours are offered. For example, you can define a specific interval such as a particular week or seasonal time period where you may extend service hours on specific days. You can also treat holidays or exceptions more specifically, such as offering shortened hours on some holidays, instead of a full day inclusion or exclusion.

To determine the due date and time for a milestone, time outside the specified intervals is skipped. For example, if your coverage schedule interval is 9:00 a.m. to 5:00 p.m. Monday through Friday, a milestone that started Friday at 4:00 p.m., which is due in 120 minutes, would be due 10:00 a.m. on Monday.

Coverage schedules can also contain holidays, nonworking times, or extended working hours, which identify days to be skipped or hours to be added when determining the due date. You must configure the coverage schedule exceptions before you create or modify a coverage schedule. In the previous example, when a milestone started 4:00 p.m. Friday and had 120 minutes until due, if Monday was identified as a holiday, the milestone would be due at 10:00 a.m. on Tuesday instead.

Here's how the application calculates the **Due Date** and **Time Remaining** fields that are displayed on the Service Request Milestone Details page:

- **Due Date**: The due date for a milestone is calculated using the schedule that's associated with the applicable entitlement or coverage rule. The schedule defines whether there are any hours of the day or week when the clock isn’t running for the organization, such as evenings, holidays, lunch breaks, and so on.

  When a service request is updated, the application looks at the coverage rules and the associated schedule, calculates the date and time the milestone expires, and assigns the milestone to the service request. The milestone due date is calculated based on the time the milestone starts, which may not be the same as the time the service request was created. The application displays this due date for that milestone on the Service Request Milestone Details page.

  If the SR attributes change so that the milestone goes into a paused state, the clock stops running. The application captures the time spent on the milestone up until the milestone was paused, for future use. The due date for the milestone is no longer displayed, because it can't be determined until the milestone resumes the countdown. After the pause is lifted and the countdown resumes, the application recalculates the milestone due date. The recalculation is based on the original time you specified for that milestone when the was created, minus the cumulative time spent by the agent up to that point.
• **Time Remaining**: The **Time Remaining** field displays one of two different values, depending on whether the milestone is actively counting, or paused. The application doesn't show time remaining for milestones that are complete or canceled.

When the milestone is actively counting down, the exact due date is known. The **Time Remaining** field shows an approximation of the amount of time between the due date and the current time. This approximation is expressed in the largest indivisible unit of time and rounded down. For example, if the current time is 3:00 PM and the milestone is due at 4:05 PM, the time remaining shows 1 hour. If the current time is 10:00 AM and the milestone is due the next day at 11:00 PM, the time remaining shows 1 day.

When the milestone is paused and the due date can't be determined, the **Time Remaining** field identifies only the time left in the milestone. The time left is determined by calculating the total time specified in the coverage, minus the time spent so far. For example, a milestone that was set for 24 hours (based on the coverage rules), and that was active for 10.5 hours before it paused, will have 13.5 hours remaining for the duration of the time it's paused. The **Time Remaining** field uses the same approximation method as described for active milestones, so 13.5 hours is rounded down to show 13 hours. Again, the actual due date isn't in 13 hours, because it's unknown when the counting will resume and therefore how the schedule might affect the due date. The 13 hours is given as an approximation of the working time you will have once the milestone restarts.

A schedule named **24 by 7** is preconfigured for all implementations. This schedule doesn't specify holidays or downtime, so the due date for a milestone that uses this schedule, is calculated without skipping any time.

### Enable Subscription Coverages for Entitlements

Oracle recommends the use of the subscription coverages.

The **Manage Service Entitlements Using Subscription Coverages** feature is enabled by default for new instances. If this feature is enabled, the application uses Oracle Subscription Management Cloud to define entitlement calendars, coverages, and associated setup, and uses this setup at runtime to determine service request milestones.

Here's how you can enable this feature:

1. In the Setup and Maintenance work area, go to the following:
2. Click **Change Feature Opt In**.
   - Select the **Enable** check box in the Service Entitlements row.
3. Click **Done**.

**Related Topics**

- Create a Coverage Schedule
- Create Standard Coverages

### Create a Coverage Schedule

To create your own coverage schedule calendars with the intervals and holidays specific to your business, do the following:

1. Sign in to the application as a sales administrator.
2. On the **Navigator**, click **Subscription Management**.
The Subscriptions page is displayed.

3. Click **Subscription Configuration**.

The Subscription Configuration page is displayed.

4. To create a coverage schedule, click **Entitlements Management > Manage Availability**.

The Manage Availability page is displayed.

**Note:** If you’re using Service Contracts, then you navigate to this page by clicking **Navigator > Contract Management > Contracts > Tasks > Manage Availability**.

5. (Optional) To add the holidays, nonworking times, or extended working hours that are applicable to the coverage schedule, click the **Exceptions** tab.

   a. Click **Create** in the **Exceptions** pane to create a new coverage schedule exception, or select an existing entry and click **Duplicate** to copy and update it.
   
   b. In the **Availability Exceptions** section, click **Add Event**.
   
   c. Enter the name of the exception event, the date and times of the event, and the availability during the event.
   
   d. Click **Save**.
   
   e. (Optional) To delete an exception, click **Delete** in the **Exceptions** pane.

6. On the **Schedules** tab, click **Create** in the **Schedules** pane to create a new coverage schedule, or select an existing entry and click **Duplicate** to copy and update it.

7. Specify the following details:

   o **Schedule Name**: Name of the coverage schedule.
   
   o **Time Zone**: Time zone for which you’re creating the coverage schedule.

8. In the **Date Intervals** section, create a coverage schedule interval with details of when the coverage schedule starts, ends, and the days of the week that are part of the interval.

   o **Start Date** and **End Date**: Start and end dates for the coverage schedule interval.
   
   o **Availability**: Working days, hours, and times, and break times for the selected days.

9. (Optional) To include exceptions in the coverage schedule, select an exception from the **Exceptions** drop-down list.

10. (Optional) To delete a schedule, click **Delete** in the **Schedules** pane.

11. Click **Save**.

You can create multiple coverage schedules and use them as needed in the standard coverage templates. For example, you might have a high severity request milestone worked using a 24 by 7 schedule, but a lower severity service request milestone might use a different schedule that's only worked during normal business hours. For more details about using coverage schedules in standard coverages, see the “Create Standard Coverages” topic.

---

**Create Standard Coverages**

The standard coverage acts as a template that contains entitlement rules, which specify when milestones are due and for what conditions.
For example, high severity requests may have earlier milestone times, and use a schedule with longer work hours and fewer holidays, than lower severity requests.

1. **On the Subscription Configuration page, click Entitlements Management > Standard Coverage.**

   The Manage Standard Coverage page is displayed.

2. **Create a new coverage and select as the Entitlement Type.**

   The Edit Standard Coverage page is displayed.

   **Note:** If you’re using Service Contracts, then you navigate to this page by clicking Navigator > Contract Management > Contracts > Tasks > Standard Coverage. Then select Contracts Service Entitlements as the Entitlement Type.

3. **Select Actions > Add Entitlements to configure the entitlement rules structure. The Entitlement Rules dialog box is displayed.**

   request severity is automatically included as a condition column. If you want to vary milestones based on the request channel, optionally, select Channel Type as an optional condition column.

   a. **Click Next, and select all optional results columns to display all available metrics and thresholds.**

   You can optionally select only one of the milestones and its threshold if applicable. For example, if requests that apply to this coverage shouldn’t have a first response milestone tracked, you can deselect First Response Metric and First Response Warning Threshold from Optional Results Columns.

   b. **Click Finish to apply the entitlement options and complete the configuration of the entitlement rules.**

   The Edit Standard Coverage page is displayed.

4. **Add entitlement rules for this coverage.**

   a. **In the Entitlement Rules section, click the Add Row icon.**

   b. **Specify the Condition Columns (Severity, and if selected, Channel Type).**

      This row is applied when the request values match the condition column values specified here.

      The algorithm applying milestones to requests requires that coverages never have more than one row with condition columns that match the request. If you leave a condition column value blank, the null value acts as a wildcard, and then is matched against any request value. While there are valid scenarios where this can be used, it’s important to avoid having two lines that could match the same request.

      The following table shows an example of a valid use of a null value in standard coverage condition columns:

      - In this valid example, a request with high severity will only match line 1, regardless of the channel.
      - A request with low severity will only match line 5, regardless of the channel.
      - The medium severity request can only match one of lines 2 through 4, depending on the channel type.

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Severity</th>
<th>Channel Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High</td>
<td>Blank</td>
</tr>
<tr>
<td>2</td>
<td>Medium</td>
<td>Phone</td>
</tr>
</tbody>
</table>
The following table shows an example of an invalid use of a null value in standard coverage condition columns:

- This invalid example shows a situation where the medium severity request with a phone channel matches lines 2 and 4.
- Similarly, a medium severity request with the email channel matches lines 3 and 4.
- In both cases, the request won’t have any milestones applied because more than one line from a single coverage matches the request.

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Severity</th>
<th>Channel Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High</td>
<td>Blank</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Medium</td>
<td>Phone</td>
<td>Medium, Phone would match this line</td>
</tr>
<tr>
<td>3</td>
<td>Medium</td>
<td>Email</td>
<td>Medium, Email would match this line</td>
</tr>
<tr>
<td>4</td>
<td>Medium</td>
<td>Blank</td>
<td>Medium, Phone would also match this line, Medium, Email would also match this line</td>
</tr>
<tr>
<td>5</td>
<td>Low</td>
<td>Blank</td>
<td></td>
</tr>
</tbody>
</table>

To configure the behavior of null values in a coverage, select the **Allow Null** and **Null is Wildcard** check boxes for the selected matrix class. You will find these check boxes on the Edit Matrix Class: Subscription Entitlements page, **Condition Columns** section. For more information about using these properties on condition columns, see the section “Set Up Additional Condition Columns for Standard Coverage Entitlement Rules”.

---

### Service Entitlements

**Chapter 10**

Implementing Service Center with the Redwood User Experience
c. Specify the **Result Columns** (*Calendar*, along with the metric and threshold values for each milestone).
   
   i. From the **Calendar** drop-down list, select the coverage schedule to use for calculating the milestones' due date.
   
   ii. For each milestone, enter the metric in minutes, which is used with the schedule to identify when the milestone is due.
   
   iii. Enter the corresponding threshold value in minutes. This threshold specifies the number of minutes before expiration that the milestone's *WarnedFlag* is set to *Y*.

d. Click **Save**.

e. Optionally, you can add multiple entitlement rules to a standard coverage.

Each entitlement rule row is checked against the request values, and if a request matches all condition column values, that rule's milestone results (values and schedule) are used to calculate the milestone due date.

## Create Default Coverages

You use default coverage to apply a standard coverage template to specific customers, or globally to all customers.

When a request is evaluated to assign milestones, the application considers all global coverages, and default coverages setup for the specified on the request. If a milestone is applicable from both a global default and a default coverage, the application uses the default coverage values over the global defaults.

1. On the Subscription Configuration page, click **Entitlements Management > Default Coverage**.

   The Manage Default Coverage page is displayed.

   **Note:** If you're using Service Contracts, then you navigate to this page by clicking **Navigator > Contract Management > Contracts > Tasks > Default Coverage**.

2. Click **Create** to add a new coverage.

3. Select the **Default Level** for the coverage:
   
   o Select **Global** to assign the coverage to all.
   
   Then select the standard coverage in the **Coverage** column that you want to apply to all.

   o Select **Customer** to assign the coverage to a specific.
   
   Then select the customer in the **Default Level Value** column, and then select the standard coverage in the **Coverage** column that you want to apply to that.

4. Enter the start and end date for the coverage.

5. Click **Save**.

## How You Monitor Milestones

You configure the Monitor Service Request Milestones scheduled process to monitor the request milestone status, and set the job frequency to run the job after the specified time interval.
This process ensures that the request and milestone status are up-to-date and sends an email notification if compliance issues or warning flags are found. The recommended frequency for running this job is 10 minutes.

How You Expose Milestones in the SR Layout

You can modify the service request layout to show the milestones as a part of the service request details.

Fields shown at the service request level represent the next milestone due for the service request. To expose current milestone fields on the service request layout, create a user-defined layout in Application Composer, and add the MilestoneID field to the Service Request Summary page.

Configure Email Notifications to Monitor Milestones

After you set up the scheduled process, you can configure object workflows to perform actions when a milestone's WarnedFlag is set to Y or ComplianceFlag is set to N (when the milestone expires).

For example, you can configure emails to be sent out to warn required teams and managers that a milestone is about to expire, or escalate a request when a milestone expires.

1. Sign in to the application as an administrator.
2. Navigate to Application Composer and then click Common Setup > Email Templates. The Email Templates page is displayed.
3. Click Create to create a new template. The Create Email Template page is displayed.
4. From the Object drop-down list, select Milestone.
5. Specify the Name, Email Subject, and Email Body for the content of the email you want to send.
6. Click Save and Close.
7. After you create the template, Click Navigator > Configuration > Sandboxes.
8. Select and enter a sandbox.
9. In Application Composer select CRM Cloud in the Application drop-down list, and then select Service as the Object Tags option.
10. Click Object Workflows. The Object Workflows page is displayed.
11. Click Create to create a new object workflow. The Create Object Workflow page is displayed.
12. From the Object drop-down list, select Milestone.
13. Enter the Name and Description for the object workflow.
14. Specify the Event Point and Condition for the milestone object workflow. For example, to trigger a workflow action when the WarnedFlag is set to Y:
   a. For the Event Point option, select When a record is updated.
   b. In the Condition field, enter the following expression:
      
      ```java
      if (isAttributeChanged('WarnedFlag') && WarnedFlag=='Y')
      return true;
      ```
15. Select the action you want to perform as part of the workflow. You can set up Email Notification and Field Updates for the milestone.
   a. In the Email Notification section, click Create to add a new notification.
   b. Specify the schedule and addresses to which you want to send the notifications.
   c. Click Save to save the milestone object workflow.
16. Republish the sandbox in which you created the object workflow. You can create a script for specific aspects of the workflow, such as looking up the assignee and assignee manager details for sending the notification. Here’s an example script you can use to get the assignee and assignee manager details and populate the **Address** field for the email notification.

```java
def resourceVO = newView('Resource')
resourceVO.appendViewCriteria("PartyId = \$\{AssigneePartyId\}\" //party id of SR assignee
resourceVO.executeQuery()

def mgrPartyId
while (resourceVO.hasNext()) {
    def curResourceRow = resourceVO.next()
    mgrPartyId = curResourceRow.ManagerPartyId
}
return mgrPartyId

if (mgrPartyId != null) {
    def resourceMgrVO = newView('Resource')
    resourceMgrVO.appendViewCriteria("PartyId = \$\{mgrPartyId\}\")
    resourceMgrVO.executeQuery()

    def mgrEmailId
    while (resourceMgrVO.hasNext()) {
        def curResourceMgrRow = resourceMgrVO.next()
        mgrEmailId = curResourceMgrRow.EmailAddress
    }
    return mgrEmailId
}
```

**Related Topics**
- Overview of Sandboxes
- Publish Sandboxes
- Create and Activate Sandboxes

**Expired Milestone**

This is sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when a milestone expires.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Service Request > Milestone > Server Scripts.

**Note:** This example uses **WarnedFlag**. However, you can also use **ComplianceFlag** for similar results.

```java
/* DISCLAIMER: This trigger is provided only as a reference.  
* TRIGGER TYPE: Before Update in Database  
* OBJECT: Milestone (child of Service Request)  
* Use Case: Send a notification to the assignee when an SR milestone is expiring.  
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.  
*/

if (isAttributeChanged('WarnedFlag') && WarnedFlag=='Y') {
    try {
        def recipientPartyId = SrAssigneePartyId
        def messageText = 'An SR milestone notification (default message).'

        if (recipientPartyId) {
            //Call to send notification
            adf.util.sendNotification(adf, messageText, recipientPartyId)
        }
    }
```
Set Up Additional Condition Columns for Standard Coverage Entitlement Rules

Overview of Condition Columns

The application has a default entitlement type called Subscription Entitlements (or Contracts Service Entitlements), which is a matrix class, and a corresponding service mapping that you select when you create your standard coverage.

This default matrix class defines the structure of the entitlement rules for the standard coverage, including the condition columns (Severity and Channel Type), and result columns (Calendar, and milestone values and warning thresholds). Condition columns in the coverage are compared to field values in a request to determine which line is applicable, and the result columns display the schedule, milestones, and thresholds that are applied.

You can use other columns from the request as condition columns in coverages, by editing the service mapping and creating your own matrix class. To do this, first modify the service mapping to add the intended attribute. After you modify the service mapping, create a matrix class including the attributes, and then select the matrix class as the entitlement type for a standard coverage.

Create a Service Mapping

Here's how you create a service mapping:


   The Manage Service Mappings page is displayed.
2. Click **Subscription Entitlements**.

The Edit Service Mapping: Subscription Entitlements page is displayed.

| Note: If you’re using Service Contracts, then you navigate to this page by clicking Navigator > Contract Management > Contracts > Tasks > Manage Service Mappings > Contracts Service Entitlements. |

3. On the **Entities** tab, select .

4. In the **ServiceRequest: Details** section, click **Add Row** to add your attribute and select the details, for the mapping.

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>- All attribute names must have the suffix _Custom.</td>
</tr>
<tr>
<td>- Ensure that <strong>Write</strong> is disabled for the selected attribute.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

6. Click the **Sources** tab (on the same page, Edit Service Mapping: Subscription Entitlements).

7. In **Source**, select .

8. Select **ServiceRequest** in the tab.

9. On the **Entitlement: Details > Attribute Mappings** tab, click **Add Row** to create the mapping for the new attribute.

10. Select the attribute that you created in step 4 from the **Attribute** drop-down list and enter the related **View Object Attribute** of the .

| Note: Ensure that **Write** is disabled for the selected attribute. |

11. Click **Save**.

12. Click the **Services** tab (on the same page, Edit Service Mapping: Subscription Entitlements).

13. Select **ServiceRequest** in the **GetSubscriptionEntitlements: Details > Entities** tab.

14. In the **ServiceRequest: Entities** section, click **Add Row** to create the mapping for the new attribute.

15. Select the attribute that you added in Step 4 from the **Attribute** drop-down list and enter the values.

| Note: Ensure that **Write** is disabled for the selected attribute. |

16. Click **Save and Close**.

### Add Condition Columns to a Matrix Class

Here's how you create a matrix class and add additional conditional columns.

1. On the Subscription Configuration page, click **Dynamic Matrix Configuration > Manage Matrix Classes**.

   The Manage Matrix Classes page is displayed.

   | Note: If you’re using Service Contracts, then you navigate to this page by clicking Navigator > Contract Management > Contracts > Tasks > Manage Matrix Classes. |

2. Duplicate the (or **Contracts Service Entitlements**) matrix class. You can also edit a matrix class you previously created, or create a new matrix class.
3. On the Edit Matrix Class page for the selected matrix class, in the **Condition Columns** section, click **Add Row** to add a new condition column for the mapping that you created in the previous service mapping procedure. This condition column displays in the entitlement rules along with the default columns.

4. Enter the **Name** of the column and the **Source Code Name**.

5. In the **Compare to Attribute** column, select the attribute that you created in the previous service mapping procedure.

6. In the **Domain** column, click **Edit Domain** and select a domain value corresponding to the attribute you’re mapping.

7. To allow null values to be specified in the coverage for this column, select the **Allow Null** check box, and optionally, select the **Null is Wildcard** check box.

Then select the appropriate value for the **Null is Wildcard** option, based on the intended behavior described in the following table. The **Severity** condition column is used as an example in the following table.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>N</td>
<td>Not possible</td>
<td>No rows applied</td>
<td>When explicit match between and coverage row.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Blank row applied</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>○ If the severity isn’t defined in a row, the blank coverage row is applied.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>○ If the severity is defined in a coverage row, an error occurs and no values are applied. Both the blank row and the matching row are considered a match, but coverages must be set up so that only one row from a specific coverage can ever be matched. If two rows match, it results in an error condition and no rows are being applied. For more information, see the step 5b in the topic “Create Standard Coverages”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>No rows applied</td>
<td>When explicit match between and coverage row.</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------</td>
<td>-------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Blank row applied</td>
<td>When explicit match between and coverage row.</td>
</tr>
<tr>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>No rows applied</td>
<td>When explicit match between and coverage row.</td>
</tr>
</tbody>
</table>

8. Click **Save and Close**.
The matrix class displays in the **Entitlement Type** drop-down list when you create a standard coverage.

## Set Up Administrator-Defined Milestones

### Overview of Administrator-Defined Milestones

In addition to using the predefined milestones for First Response and Resolution, you can also define additional milestones to track requests. This lets you configure the application effectively, based on your own business processes and service standards.

The section "Set Up Additional Condition Columns for Standard Coverage Entitlement Rules" described how you can use other columns from the request as condition columns for coverages, by editing the service mapping and creating your own matrix class. You can also add result columns to a matrix class to represent the administrator-defined milestones. In addition to adding new result columns to the matrix class, you must also do the following:

1. Modify the algorithm that specifies the entitlements to include the new columns you add.
2. Add the new milestone to the **Manage Service Milestone Configuration** task in **Setup and Maintenance**.

### Add the Result Columns to the Matrix Class

Here's how you can add the result columns to the matrix class:

1. On the Subscription Configuration page, click **Dynamic Matrix Configuration > Manage Matrix Classes**.

   The Manage Matrix Classes page is displayed.

   **Note:** If you’re using Service Contracts, then you navigate to this page by clicking **Navigator > Contract Management > Contracts > Tasks > Manage Matrix Classes**.

2. Duplicate the (or **Contracts Service Entitlements**) matrix class. You can also edit a matrix class you previously created, or create a new matrix class.
3. On the Edit Matrix Class page for the selected matrix class, in the Result Columns section, click Add Row to add the administrator-defined metric and its corresponding warning threshold.

4. Enter names for the administrator-defined metric and its corresponding warning threshold.

   Code values are automatically populated in the Source Code Name field. The names and codes must be unique for each milestone and its corresponding threshold value (Milestone Code and Threshold Code must be unique and should not be used already in existing milestone configurations). You should copy and save these values, because you need Source Code Name in the Manage Algorithms page and Name in the Manage Service Milestone Configuration task page.

5. In the Domain field, retain the default value Number because it denotes the time in minutes.

6. Click Save and Close.

Modify the Algorithm to Include the New Milestone and Threshold Columns

Here’s how you can modify the algorithm to include the new milestone and threshold columns you created:


   The Manage Algorithms page is displayed.

   **Note:** If you’re using Service Contracts, then you navigate to this page by clicking Navigator > Contract Management > Contracts > Tasks > Manage Algorithms.

2. Select the Get Subscription Entitlements (or Contracts Get Service Entitlements) row, with the algorithm version 1 and status Published.

3. Select Actions > Create Version. A new version of the algorithm is created, with the status In Progress.

4. Select the new version of the algorithm. The Edit Algorithm page is displayed.

5. On the Algorithm tab, select Look up matching Entitlement Rule.

6. In the First Row Actions section, click in the Actions field.

7. Copy the existing algorithm and append it. For example:

   ```java
   if (Matrix.hasProperty("NextResponseMetricCode")){
     rule= EntitlementResults.insert({EntitlementResultId: getNextId()})
     rule.EntitlementId=Entitlement.EntitlementId
     rule.ScheduleId=Matrix.CalendarCode
     rule.ResultName= "NextResponseMetricCode" 
     rule.ResultValue= Matrix.NextResponseMetricCode 
     rule.ResultThresholdValue=Matrix.NextResponseWarningMetricCode
   }
   ``

   **Note:** If you’re using Service Contracts, use rule.CalendarId=Matrix.CalendarCode instead of rule.ScheduleId=Matrix.CalendarCode.

8. Replace the Source Code Name values with the values of the administrator-defined metric and its corresponding warning threshold you saved in the previous procedure for adding the result columns to the matrix class.

   In this example, NextResponseMetricCode and NextResponseWarningMetricCode are the names defined in the matrix classes.

9. Click Save and Close.

10. Navigate to the Manage Algorithms page.
Add the Milestone to the Manage Service Milestone Configuration Task

Here's how you can add the milestone to the Manage Service Milestone Configuration task:

1. In the Setup and Maintenance work area, go to the following:

   The Manage Milestone Configuration page is displayed.

2. Click Create Milestone and specify the following milestone details:

   - **Milestone Label**: Enter the name of the milestone that should be displayed on the request.
   - **Milestone Code**: Select the name of the milestone result column you added to the matrix class. These names are defined in the matrix classes and can't be modified.
   - **Milestone Type**: Select from the following types, which determine whether milestones are reopened or repeated once complete.
     - **Can be reopened**: A milestone that can be reopened is set back to In Progress status when the complete criteria is no longer true, and continues the countdown to expiration when reopened. The Resolution Metric milestone is of this type.
     - **Can be repeated**: A milestone that can be repeated can't be reopened once closed, but another one is created when the start criteria is valid. For example, suppose you configure a Next Response Due milestone that should be repeated each time update is posted to the request. Once a response is sent, the milestone is complete, but upon receiving a new update, another Next Response Due milestone is created and tracked.
     - **Can't be repeated**: A milestone of this type can't be reopened or repeated once it's marked complete. The First Response Metric milestone is of this type.
   - **Threshold Code**: Select the name of the threshold result column corresponding to the milestone, which you added to the matrix class. This determines the threshold value that's applied to the milestone. The names are defined in the matrix classes and can't be modified.
   - **Business Unit Name**: Leave as the default business unit (BU) unless you're configuring milestones for multiple business units. For more information, see the "Configure Milestones for Multiple Business Units" in this guide.
   - **Allow Due Date Override**: Select this check box to let agents modify a milestone's due date on the Service Request Milestone Details page (in the Due Date field).

   **Note**: If a customer wants to audit agent updates to the due date, the administrator must enable audit on the Overridden Due Date attribute.

   - **Allow Agent Completion**: Select this check box to let agents manually acknowledge that they have completed a milestone and close it. On the Service Request Milestone Details page, if an agent selects the Agent Completed check box and saves the milestone, the milestone status is updated to Complete. Milestones that can be reopened are reopened if the start condition is met again.

   The administrator can specify which milestones allow due date updates and which allow the update to specify a milestone has been completed. These attributes are independent of each other, so that some
milestones can allow only moving the due date, others might allow the agent to mark it complete but not move the due date, and still others may allow both types of updates.

3. Enter the milestone conditions. Each milestone (both prebuilt and administrator-defined) has conditions that determine when the milestone starts, pauses, and completes. For each condition, you can define multiple attribute and value pairs that determine when the condition is applied to the milestone.

- Each tab has a text box that enables you to provide a common description that's displayed in the request details when the milestone is applied to the request. This description enables an agent to understand when a milestone starts counting, when it pauses, and when it's considered complete.
- Add conditions using the Create button in the tab. Use the Attribute column to indicate a field to compare to a value using the operator. The Attribute column lists administrator-defined fields and a subset of the service request fields that are available to use as conditions. Alternately, you can specify a static condition that doesn't require an operator or value. You can also use object functions written in Groovy, to express more complex start, pause, and stop criteria for milestones.

  - For example, if you specify the field Problem Type Code, you must specify the operator (Is One Of, Is Not One Of) and the values that make this criteria true.
  - Alternately, if you specify a static condition such as Immediate, no operator or value is required. In this case, the criteria is considered true as soon as the service request is evaluated.
  - You can specify a logical condition in the form <attribute> <comparison> <operator values>.

    For example, you can specify Status Type (attribute) Is One Of (operator) Closed, Resolved (values) as the completion criteria for Resolution Milestone. You can also specify a static predefined condition such as User Sends Response, which evaluates to true as soon as any user sends a response message.

When an object function is written on the request object in Application Composer to return a Boolean value, the function is available as start, pause, and completion criteria. Similar to the static conditions, when an administrator-defined object function is selected, the operator and values aren't required. When the function returns true, the start, pause, or completion criteria specifying that function is triggered.

- When multiple rows are added as conditions, the results are combined logically using the AND operator, so all rows must evaluate to true for the criteria to be true.

*Related Topics*
- Update Existing Setup Data

## Configure Milestones for Multiple Business Units

### Overview of Milestones for Multiple BUs

You can configure milestones using the Manage Service Milestone Configuration or Manage Service Milestone Configuration for Business Unit task.

As an administrator, you can create and manage milestones for service requests using the Manage Service Milestone Configuration task in Setup and Maintenance. However, when the Business Units feature of Service Offering is enabled, milestones must be defined for each business unit (BU) that intends to track them.
Here’s how milestones are applied when BUs are enabled:

- If a service request is assigned to a BU, and milestones are defined for that BU, then the milestones are applied.
- If a service request is assigned to a BU, but no milestones are defined for that BU, then the milestones aren’t applied.
- If a service request isn’t associated with any BU, and a default BU is defined for that organization, then the milestones defined for the default BU (if any) are applied.

How You Configure Milestones for Multiple BUs

In a multiple BU environment, you must configure milestones for each BU that intends to track them. This gives each BU the flexibility to track a different set of milestones, or to track the same milestone using different start, pause, and stop criteria, depending on the business requirements. You can configure milestones for each BU in the following ways:

- To apply an existing milestone to a new BU, or to create a new milestone for a BU, use the Manage Service Milestone Configuration task in Setup and Maintenance. Using this task, you create a new milestone configuration, and specify the existing or new milestone code with the new BU. You can specify the same or different start, pause, and stop criteria, depending on the requirements of the BU.
- To define multiple milestones for a specific BU, use the Manage Service Milestone Configuration for Business Unit task in Setup and Maintenance. When using this task, you must specify the Scope using the Select Scope dialog box. As you create each milestone, the BU specified in the Scope is automatically set as the milestone BU.

Note: Before configuring milestones for the first time in a newly-provisioned multiple BU environment, the administrator must associate the default BU with the ready-to-use milestones, as described in the following topic.

Configure Milestones for the First Time in a Newly-Provisioned Environment

When you’re first configuring milestones in your newly provisioned, multiple BU environment, after the default BU has been set up for your organization, you must associate the default BU with the ready-to-use milestones. This required association is a one-time task to enable milestones to be configured for multiple BUs.

1. In the Setup and Maintenance work area, select the Manage Service Milestone Configuration or Manage Service Milestone Configuration for Business Unit task. The Select Default Business Unit page is displayed.
2. From the Business Unit Name drop-down list, select the default business unit to assign to the ready-to-use milestones, and click Apply. Milestone configurations corresponding to the selected business unit are displayed.
Troubleshoot with Milestone Diagnostics

Overview of Milestone Diagnostics

Administrators can use the Request Milestone Diagnostics page to validate or troubleshoot your milestone rules. The administrator can run a milestone diagnostics report for a specific request and view the full evaluation of milestone rules.

The milestone diagnostics report provides the following information:

- Which milestones were applied?
- Which milestones and coverages were considered but not applied?
- From which coverage did an applicable milestone originate?
- Did the milestone apply or not apply based on the associated business unit?

Review Milestone Diagnostics

Here’s how you can view the milestone diagnostics report:

1. In the Setup and Maintenance work area, go to the following:
2. On the Manage Milestone Configuration page, click Actions > View Milestone Diagnostics.

The Service Request Milestone Diagnostics page is displayed.
3. Enter the request number in the Service Request field.
4. Click Check Milestones.

The milestones that are applicable to the specified request are displayed in a table, with the corresponding metrics and the following details:

- **Defined for BU**: Indicates whether the milestone configuration definition was created for the applicable business unit.
- **Applicable to SR**: Indicates whether the milestone from the specified coverage would be applied to the request.
- **Notes**: Provides additional information when the milestone isn't applicable to the request.
11 Set Up Service Business Units

How Business Units for Service Are Set Up

With business units (BUs) for Service, you can deploy more than one service center within a single instance of your service application. This topic gives an overview of the steps that you must perform to complete the business units setup.

You can use multiple BUs in the following ways:

- Segment SRs between BUs so that users can search and identify SRs from multiple BUs.
- Use product catalogs, categories, channels, and email templates specific to a BU.
- Assign SRs to queues by writing rules based on BU.
- Create service request BI reports specific to a BU.

Currently, the following objects aren’t supported by multiple BUs in Service: accounts and contacts, users, resources, and lookups.

For more detailed information about BUs, see the “Setting Up Multiple Business Units” chapter of the Oracle Fusion Automation Implementing Sales guide.

For more detailed information about users and security, see the Oracle Fusion Getting Started with Service Logistics Implementation guide.

To set up business units in Service, you must perform the following tasks in the given order.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up Business Units for Service</td>
<td>Add the Manage Business Unit functional area to the Service offering by using the Change Feature Opt In link in Setup and Maintenance.</td>
</tr>
<tr>
<td>Manage Common Profile Options</td>
<td>Set the profile options to enable the multiple-BU functionality in the Manage Common CRM Business Unit Profile Options task.</td>
</tr>
<tr>
<td>Manage Internal Resource Organizations</td>
<td>Define internal resource organizations to be associated with the BU.</td>
</tr>
<tr>
<td>Manage Resource Organization Hierarchies</td>
<td>Add the internal resource organizations to the internal resource organization hierarchy.</td>
</tr>
<tr>
<td>Create Business Unit</td>
<td>Create a BU to be associated with the resource organization in the Manage Business Unit Task.</td>
</tr>
<tr>
<td>Associate Resource Organization to Business Unit</td>
<td>Associate the internal resource organization to the BU you created. Use the Resource Directory.</td>
</tr>
<tr>
<td>Create Employees</td>
<td>Add users to the organization in the Users, Roles and Delegations task, and make one of the resources a manager for the organization.</td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Reset Passwords for Users</td>
<td>Reset the password for the users.</td>
</tr>
<tr>
<td>Set the Scope in Service Setup Tasks and complete Service Setup tasks.</td>
<td>Set the scope for Service tasks and set up the remainder of the Service offering.</td>
</tr>
<tr>
<td>Add additional BU fields in the SR if users are associated with multiple BUs.</td>
<td>Change the layouts of the SR pages if required. Use Application Composer to include multiple BU fields in the SRs. <strong>Note:</strong> Only required if a user is associated with multiple business units.</td>
</tr>
<tr>
<td>Configure Multiple Business Units with Digital Customer Service</td>
<td>If you implement multiple business units for Digital Customer Service, you must complete some additional configuration. For more information, see the Oracle Fusion Service Implementing Digital Customer Service guide.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Configure Multiple Business Units with Digital Customer Service

**Manage Common CRM BU Profile Options for Service BUs**

To enable multiple business units (BUs) for Service, you must set the following profile options:

1. Multiple Business Units Enabled (HZ_ENABLE_MULTIPLE_BU_CRM): Set this profile option to **Yes**. The default value is **No**.
2. Customer Relationship Management Business Unit Default (HZ_DEFAULT_BU_CRM): Set this to the default business unit for your service application.

**Note:** You must ensure that the value of the HZ_DEFAULT_BU_CRM profile option doesn't remain blank, and the value is set to a BU. Otherwise, agents may see an error while creating SRs.

To set the profile options for Service BUs:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Company Profile
   - Task: Manage Common CRM Business Unit Profile Options

The Manage Common CRM Business Unit Profile Options page shows the two profile options.
2. Click the HZ_ENABLE_MULTIPLE_BU_CRM profile option.
3. In the HZ_ENABLE_MULTIPLE_BU_CRM: Profile Values region, set the Profile Value for the Site Profile Level to Yes.
4. Click Save and Close.
5. Click the HZ_DEFAULT_BU_CRM profile option.
6. In the HZ_DEFAULT_BU_CRM: Profile Values region, specify the Profile Value for the Site Profile Level.
7. Click Save and Close.

Related Topics
- Update Existing Setup Data
- Set Up an Offering with Scope

Manage Internal Resource Organizations for Service BUs

For every business unit (BU) that you set up, you can define internal resource organizations to be associated with the BU.

A resource organization represents the internal organization and structure for the business unit. Resource organizations are hierarchically structured, and the organization hierarchy helps to derive the reporting relationships.

To define the internal resource organization for a Service BU:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Users and Security
   - Task: Manage Internal Resource Organizations
2. Click Create to add a new resource organization.
3. Select the Option 2: Create New Organization option to create a new organization.
4. Click Next.
5. On the Create Organization: Enter Basic Information page, enter a Name for the organization.
6. In the Organization Usages region, click Add Row.
7. From the Usage drop-down list, select Service Organization.
8. Click Finish.

Related Topics
- Update Existing Setup Data
- Set Up an Offering with Scope
Manage Resource Organization Hierarchies for Service BUs

After you define internal resource organizations to be associated with business units (BUs), you must add them to the internal resource organization hierarchy. A resource organization hierarchy is a hierarchically structured representation of the way resources are grouped within a resource organization.

To add internal resource organizations to the resource organization hierarchy:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Users and Security
   - Task: Manage Resource Organization Hierarchies
2. In the Manage Resource Organization Hierarchies page, search for the resource organization that you created in the "Manage Internal Resource Organizations for Service BUs" procedure.
3. Click the link for the resource organization that you want to edit.
4. Select Edit This Hierarchy Version from the Actions menu.
5. Expand the organization list in the Internal Resource Organization Hierarchy region.
6. Select the organization that you created in the "Manage Internal Resource Organizations for Service BUs" procedure, to add it to the organization hierarchy.
7. Click Add.
8. In the Add Tree Node window, click Search.
9. In the Search Node window, search for the organization that you created in the Manage Internal Resource Organizations task.
10. Click OK to add the organization.
    To add more organizations, select the parent node to add a child node. Repeat the steps to search and add as many times as needed.
11. Click Save and Close.
12. Click Yes on the warning message, which states that the hierarchy version is to be updated and the corresponding reporting hierarchy regenerated.

Related Topics
- Update Existing Setup Data
- Set Up an Offering with Scope

Create a Business Unit for Service

You can use a business unit (BU) to separate or share the following:

- Service setup data such as product catalog
- Transactional data such as service requests
To support the multiple-BU features, you must first create the required BUs.

To create a BU for the Service offering:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Company Profile
   - Task: Manage Business Unit
2. In the Manage Business Unit page, click **Create**.
3. In the Create Business Unit page, enter a name for the BU.
4. In the **Default Set** drop-down list, click **Search**.
5. In the **Reference Data Set Name** field, search for **Common**.
6. Select **COMMON** from the search results.
7. Click **OK**.
8. On the Create Business Unit page, click **Save and Close**.
   To add another BU, select the **Manage Business Unit** task again and repeat the steps.

**Related Topics**
- Update Existing Setup Data
- Set Up an Offering with Scope

## Associate Resource Organizations with Business Units

You can associate a resource organization with multiple business units (BUs). By associating resource organizations with BUs, you can control access to the transactional data available to service resources in business objects such as service requests.

**Note:** If you enable multiple BUs, ensure that each user is associated with a resource organization, and the resource organization is associated with one or more BUs. Otherwise, the default BU set on the HZ_DEFAULT_BU_CRM profile option is associated with SRs.

To associate a resource organization with business units:

1. Sign in to the application as an administrator or a setup user.
2. In the Navigator, select **Resource Directory**.
4. In the Resource Organizations region, click **View Organizations**.
5. On the View Organizations page, search for the organization that you created.
6. In the Search Results region, click the link for the organization.
7. Select the Business Units tab.
8. Click **Add Row**.
9. Select the business unit from the drop-down list.
   **Note:** The first BU with which you associate the resource organization becomes the primary BU. If you associate the organization with more BUs, you can change the primary BU as required.
10. To add more business units, click **Save**, and then click **Add Row**.
11. After you add the business units, click **Save and Close**.
12. Click **Done**.

## Create Employees for a Service BU

You can add resources to the resource organizations that you associate with business units (BUs). When you add a resource to an organization, the resource becomes a member of the organization and a part of the organization hierarchy.

You must first create a manager for the organization. To create application users, use the Users and Roles task:

1. Sign in to the application as an administrator or a setup user.
2. In the navigator, select **Users and Roles**.
3. On the Search Person page, click **Create**.
4. On the Create User page, enter the **Last Name** and **First Name**.
5. Enter the **Email**.
6. In the **User Details** region, enter a **User Name**.
7. In the **Employment Information** region, select **Employee** from the **Person Type** drop-down list.
8. Select a **Legal Employer** from the drop-down list.
9. Select the **Business Unit** of the employee from the drop-down list.

   **Note:** This BU that you select is the BU of the employee, and not the BU of the resource organization. They both may be different. What BU you select for the employee information depends on how employees are organized.

10. In the **Resource Information** region, select the **Resource Role** from the drop-down list.
11. Search for and select an organization from the **Organization** drop-down list.

   This organization is the one that you created earlier. The agent is associated with the BU through this organization.
12. Click **Autopropvision Roles**. This gives the user any predefined job roles.
13. Click **Save and Close**.

   Repeat the steps to create another user who is the employee of the manager. The steps are the same except that in the Resource Information region, you search for and add the Reporting Manager that you already created.

14. When you have added all the users, click **Autopropvision Roles**.
15. Click **Save and Close**.

You can view everyone you created in the Resource Directory by using the Navigator.

## View Employees in the Resource Directory

To view the employees that you created in the Resource Directory:

1. In the Navigator, click **Resource Directory**.
2. Click the Tasks panel tab.
3. In the Resource Organizations region, click **View Organizations**.
4. On the View Organizations page, in the **Organization** field, type the name of the organization for which you want to view the employees.
5. From the displayed list of organizations matching your search, click the organization that you want.
The list of employees is displayed in the Members tab.

For more information about the Resource Directory, see the Oracle Fusion Automation Using Customer Data
Management for Sales and Service guide.

Related Topics
• Overview of Setting Up Users and Security
• About Security Roles
• Resource Directory

Set the Scope in Service BU Setup

When you opt in to the business units (BUs) feature for Service, the Scope column in the Business Units tasks list
contains links to set the scope of the task.

Let’s learn how to set the scope for tasks when setting up BUs for Service.

To set the scope for tasks when you set up BUs for Service:

1. Sign in to the application as an administrator or a setup user.
2. Navigate to Setup and Maintenance.
3. From the Setup drop-down list, select the Service offering.
4. Select the Business Units functional area.
5. From the Show drop-down list, select All Tasks.
6. In the Scope column for any task in the task list, click the displayed link.

The Select Scope dialog box is displayed, and the task for which you are setting the scope is already selected.

**Note:** When you go to the task list for the first time, the scope may not be set and the Scope column displays
the Select link. After you set the scope once, that BU appears as a link in the Scope column.

7. From the Business Unit drop-down list in the Select Scope dialog box, select Select and Add.
8. Click Apply and Go to Task.
9. On the Select and Add: Business Unit page, search for and select the BU that you want to set for the scope.
10. Click Save and Close.

The page opens for the task you’re working with. On this page, you can choose to use the default Site Level
Value or select the Business Unit Profile Value.
11. To select a Business Unit Profile Value:
   a. Deselect the Use Site Value check box.
   b. In the Business Unit Profile Value field, enter the profile value for the BU.
   c. Click Done.

The task closes and now on the Setup page, the BU that you set for the Scope is populated for all tasks. Each task you
open now is the setup for the BU in the Scope column.

To set up additional BUs, repeat the same steps.
Overview of Optional Setup Tasks for Service BU

Once the preliminary steps for setting up Service business units (BUs) are done, you can set up BU-specific tasks. All the BU-specific tasks are grouped under the Business Units functional area.

For multiple BUs in Service, the setup tasks are the same as in a normal Service setup. The only difference is that with most tasks for multiple BUs, you can do one of the following:

- Use the default site-value profile option.
- Set or select the business unit profile value.

However, the previous statement isn't true for some tasks for multiple BUs. The following multiple-BU tasks aren't related to profile options, so you must configure these tasks for each BU separately:

- Manage Service Categories for Business Units
- Manage HR Help Desk Service Categories for Business Units
- Manage Communication Channels for Business Units

Categories and channels are restricted based on the BU set as the scope.

- When a new category or channel is created, it's automatically associated with the BU set in the scope. For more information about setting the scope for tasks when setting up BUs, see "Set the Scope in Service BU Setup".
- You can set the BU only for the top-level category. The BU on the child categories is automatically set based on the BU of the root category.

Here's a list of the other Service optional setup tasks and the help topics that provide more information.

<table>
<thead>
<tr>
<th>Service Task</th>
<th>Related Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Business Unit</td>
<td>Define Business Units</td>
</tr>
<tr>
<td>Manage Service Product Groups Usage for Business Unit</td>
<td>Define a Catalog for the Service Offering</td>
</tr>
<tr>
<td>Manage HR Help Desk Product Group Usage for Business Unit</td>
<td>Associate Different Catalogs to Different Business Units</td>
</tr>
<tr>
<td>Manage Service Categories for Business Unit</td>
<td>Manage Service Request Categories</td>
</tr>
<tr>
<td></td>
<td>Manage Service Request Categories and Product Usage Groups for HR Help Desk</td>
</tr>
</tbody>
</table>
Secure the Business Unit Field on a Service Request

Let's say you want to restrict users with certain job roles from changing the business unit (BU) while editing a service request (SR). You can secure the BU field on the SR object by using the Update Service Request Business Unit privilege.

If you remove this privilege from the listed job roles, users with these roles can't change the BU of the SR.

The following predefined job roles can change the BU when they edit an SR:

- Customer Service Representative
- Customer Service Manager
- Sales Manager
- Sales Representative
- Sales VP
- Customer Relationship Management Application Administrator
Remove the Update Service Request Business Unit Privilege

If you remove the Update Service Request Business Unit privilege from the job roles mentioned in the previous list, users with those roles can't change the BU of the SR when editing.

**Note:** You can remove the Update Service Request Business Unit privilege from a user's job role only if you had granted one of the predefined service job roles from the previous list to each of your users.

To remove the Update Service Request Business Unit privilege from a user's job role, perform the following steps in Security Console:

1. From the previous list of job roles, copy the predefined job role that's granted to the user. This predefined job role should have one of the following duty roles:
   - Service Request Administrator
   - Service Request Power User
   - Service Request Troubleshooter
   - Service Request Contributor
   - Service Request Channel User
2. Copy the duty role that's already granted to the copied job role.
3. Edit the copied duty role and remove the Update Service Request Business Unit privilege from the role.
4. Edit the previously copied job role. Remove the service duty role that you copied to create a custom duty role.
5. Add the custom duty role to the copied job role.
6. Remove the previously granted predefined service job role from the user.
7. Grant the new custom job role to the user.

If you have custom roles for your users, complete the following steps to remove the Update Service Request Business Unit privilege from the user's job role:

1. Identify the custom role that has the Update Service Request Business Unit privilege.
2. Remove the Update Service Request Business Unit privilege from the role.

**Related Topics**

- Guidelines for Copying Roles

---

Export and Import the Functional Setup Data for Business Units

You may have created the functional setup data for all business units (BUs) in the Service offering in your test environment. After testing it, you may want to export the data to your production environment.
You can export or import the functional setup data by using the export and import feature in Functional Setup Manager. You can complete this process by using either an implementation project or the implementation method based on offering.

When you use the method based on offering, all the functional setup data for the Service offering is exported or imported, including the setup data for all the BUs. You can also export and import the functional setup data for a specific BU by using an implementation project. This way, you have additional management flexibility in scenarios where each BU manages its own set of configurations.

For more information about the following features in Functional Setup Manager, see the Oracle Fusion Using Functional Setup Manager guide.

- Using implementation projects
- Export and import feature
- Implementation method based on offering

To export the functional setup data for BUs in the Service offering by using an implementation project:

1. Sign in as a setup user.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Select Manage Implementation Projects.
4. On the Manage Implementation Projects page, create a new implementation project to export the functional setup data for one of the following:
   - A specific business unit
   - All business units
5. Save and open the implementation project.
6. In the Task Lists and Tasks area, ensure that you add the Define Business Units for Service task list to the project.
7. Determine whether you want to export the setup data for a specific BU or all BUs.
   - If you want to export the setup data for all BUs, then go to step 12.
   - If you want to export the setup data for a specific BU, then complete all the remaining steps.
8. Expand the task list.
9. Navigate to the first task that has a Select link in the Selected Scope column. Click the Select link.
10. From the Business Unit list, select Select and Add.
11. Click Apply and Go to Task.
12. In the Select and Add Business Unit window, search and add the specific BU.

The selected BU appears in the Selected Scope column for all the tasks in the task list.
13. Click Done for the implementation project.
14. Continue to create the configuration package as described in the "Exporting Setup Data Using Implementation Project" process in the Oracle Fusion Using Functional Setup Manager guide.

When you export the configuration package:

- If you select all BUs in step 3, the export data includes the functional setup data for all BUs in the Service offering.
- If you select a specific BU in step 3, the export data includes the functional setup data only for the selected BU.

**Note:** To import the functional setup data for BUs, follow the steps described in the Using Functional Setup Manager guide.
Overview of BU-Based Service Request Visibility

When users view lists of service requests (SRs) or create user-defined searches, they can typically see all SRs. But you can restrict their access based on their business unit (BU) membership, if required. The predefined roles don't have SR visibility based on BU.

In the Security Console, you can assign BU-based visibility for SRs to specific roles. Consequently, users with these specific roles can see only the SRs assigned to the BUs where they're a resource member.

With this data security policy, your company can ensure that all predefined and user-defined searches are restricted only to BU membership for a set of users.

For more information about assigning the data security policies based on BU to your users, see Set Up Service Request Visibility Based on BU.

Related Topics
- How You Set Up Visibility Based on BU

Migrate Business Objects Between Different Business Units

Sometimes, you may want to migrate some business objects between business units (BUs). But not all objects can be migrated.

You can migrate only the following business objects from one BU to another:
- Category
- Channel
- Milestone Configuration
- Service Request

Note: You can migrate only one business object at a time.

To migrate the listed business objects from one BU to another:
1. In the Navigator, click Scheduled Processes.
In the **Schedule New Process** dialog box, select **Job** as the **Type** option.

4. Click the **Name** drop-down list and click **Search** at the end of the displayed list.

5. In the **Search and Select: Name** dialog box, type **Migrate** and click **Search**.

6. From the displayed list of jobs, select **Migrate Service Business Unit Data** and click **OK**.

The **Schedule New Process** dialog box displays the name of the selected job.

7. Click **OK**.

8. In the **Business Object** field in the **Process Details** dialog box, select the business object that you want to migrate.

9. From the **From Business Unit** drop-down list, select the BU from which you want to migrate the business object.

   **Note:** If some existing records aren’t associated with any BU, you can leave the **From Business Unit** field blank.

10. From the **To Business Unit** drop-down list, select the BU to which you’re migrating the business object.

11. Click **Submit**.

### Associate Different Catalogs with Different Business Units

When you have multiple BUs, you must create multiple usages, one for each BU. You can then associate a different catalog with each usage. This way, each BU is associated with a separate catalog.

If you have two BUs and you want to associate two different catalogs with the two BUs:

1. Create two different catalogs.
   
   For more information about creating catalogs, see "Sales Catalog High-Level Setup Steps".

2. Create two usages for the two BUs.
   
   a. In the Setup and Maintenance work area, go to the following:
      
      - Offering: Service
      - Functional Area: Service Catalog
      - Task: Manage Product Group Usage
   
   b. In the Manage Product Group Usage page, go to the Product Group Usage region.
   
   c. Click the **Actions** drop-down list.
   
   d. Click **Create**.
   
   e. In the **Create Product Group Usage** dialog box, in the **Usage** field, specify a name. For example, **BU_1_Usage**.
   
   f. In the **Usage Code** field, specify a code.
   
   g. Deselect the **Allow Duplicate Content** check box.
   
   h. Click **OK**.
   
   i. To create a second usage for the second BU, repeat steps c to h.

3. Associate a catalog with a usage.

   For more information about associating a catalog with a usage, see "Define a Catalog for the Service Offering".
4. Associate a BU with a usage.
   a. In the Setup and Maintenance work area, go to the following:
      - Offering: Service
      - Functional Area: Business Units
      - Task: Manage Service Product Group Usage for Business Unit
   b. For the first BU, deselect the **Use Site Value** check box.
   c. In the **Business Unit Profile Value** column, specify the usage code of the first usage that you created.
      
      **Note:** You must specify the usage code, and not the usage name.

5. Click **Done**.
6. Repeat steps 3 to 5 for the second usage and the second BU.

**Related Topics**
- Sales Catalog High-Level Setup Steps
- Define a Catalog for the Service Offering
12 Import and Export

Overview of Import and Export Management

You can import and export a wide range of application data using import and export management in your service application.

For example, you can use the export management feature to export object data so that you can then import it into another instance. You can also import records to the applications so that you don’t have to create the records in the user interface. Only users with the service request administrator duty role can import and export objects. For more information, see the Oracle Fusion Understanding Import and Export Management for Sales and Service guide.

Overview of Import Objects

You can import several objects into the application using the import management framework.

To import objects, Click **Tools > Import Management > Import Objects**.

The following is a sample list of top-level and sublevel objects that you can import into the service application. For more information on these and other objects available for import, see the Oracle Fusion Understanding Import and Export Management for Sales and Service guide.

- **Service Requests**
  - Messages
  - Contact Members
  - Resource Members
  - References

- **Queues**
  - Queue Party Resources
  - Queue Team Resources

- **Categories**

  **Note:**
  - Since the service request data is dependent upon queues and categories, you must import the queues and categories before importing your service requests.

- **Interactions:** You can’t import interactions into the application, but you can export the interactions for the service requests.
- **Inbound email**
- **Inbound Message Filters:** You can import the inbound message filters through Setup and Maintenance.
- **Milestone Configuration:** You can import and export milestone configurations only through Setup and Maintenance.
• Channels
  ○ Channel Resources

• Standard Text Folders: The import facility doesn't support importing hierarchical data directly. To import folders hierarchies, such as parent and child relationships, you must import the standard text folders data twice. The first time you import the file, the object data is added, and the second time you import the same file, the relationships are created.

• Standard Text Variables
• Standard Text
  ○ Standard Text Relations

• Self-Service Roles

Overview of Export Objects
You can extract large volumes of data from the application using bulk export. You can either extract a full set of records for an object, or perform incremental extracts. For example, you can extract the complete set of service requests data or extract an updated set of records every week.

To export objects, Click Tools > Export Management > Export Objects. For more information, see the Oracle Fusion Understanding Import and Export Management for Sales and Service guide.

Related Topics
• Overview of Bulk Data Export
• How You Import Custom Objects

Use Functional Setup Manager to Import, Export, and Compare Categories Between Environments

Your users can import, export, and compare service categories between environments using Functional Setup Manager. Users to create or update setup service category data in bulk as well as compare differences between two environments.

For example, a user wants to import service category data into a production environment that has been exported from a test environment after making changes to the setup data. Before the user imports the data, the user can compare the exported data of the test environment with the existing production data, and preview how the setup data in production will change after the data is imported.

Any implementation usually requires migrating setup data from one environment to another at various points in the subscription lifecycle. For example, a subscribed offering is typically set up in the test environment first, and is moved to the production environment only after proper testing and verification. Setup export and import processes help you migrate setup data from test to production.

Note: You must have the Application Implementation Consultant role (ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB) to export, import, and compare setup data.
For more information, refer to the Related Topics section for a link to the Oracle Fusion Using Functional Setup Manager guide.

Related Topics
- Export and Import CSV File Packages

Before You Import

Since the service request data is dependent upon queues and categories, you must import the queues and categories before importing your service requests. Before you import service requests, queues, or categories, you must first import the following dependent objects:

- **Accounts**: The list of accounts that can be associated with the SR. Selecting an account is required when creating an SR. For more information about importing accounts, see "Import Your Account Data" in the guide specified in Related Topics.

- **Contacts**: The list of contacts for each account that can be associated with the SR. For information about importing contacts, see "Import Your Contact Data" in the guide specified in Related Topics.

- **Resources**: The list of resources to which you can assign work objects in the SR. For information about importing resources, see "Import Resource Data" in the guide specified in Related Topics.

- **Partners**: The list of partner accounts that you can associate with an SR. For information about importing partners, see "Import Your Partner Data" in the guide specified in Related Topics.

- **Product Groups**: A product group is a group of related products. For information about importing product groups, see "Import Your Product Group Data" in the guide specified in Related Topics.

- **Products**: List of products against which you can raise an SR. For information about importing products, see "Import Your Product Data" in the guide specified in Related Topics.

- **Asset**: List of assets associated with the account. For information about importing assets, see "Import Your Asset Data" in the guide specified in Related Topics.

- **Categories**: The categories associated with the SRs. For information about importing categories, see "Import Your Service Request Data" in the guide specified in Related Topics.

- **Queues**: The queues to which your SRs are assigned. For information about importing queues, see "Import Your Queue Data" in the guide specified in Related Topics.

- **Channels**: Import the channels that are already associated with your SRs. For information about importing channels, see "Import Your Service Request Data" in the guide specified in Related Topics.

- **Tags**: The administrator-defined tags to be associated with SRs. For information about importing tags, see "Import Your Service Request Data" in the guide specified in Related Topics.

Related Topics
- **Oracle Fusion Understanding Import and Export Management for Sales and Service**
Import Objects

After you import the dependent objects, create an import activity to upload details of objects you want to upload. Here’s how you import an object:

1. Set up the import options.

   You select the object you’re importing, specify the file format and different import options, and upload the file with your data. The options that are available depend on the object that you’re importing. Some import objects, for example, permit you to upload a ZIP or Java archive (JAR) file of attachments. These attachments are then attached to the records in the application after the import is complete.

2. Map the fields.

   For this task, you create a mapping of the data in your file and the attributes in the application. You can also reuse a mapping that you have created in past import activities. Any mapping you create in an activity is automatically saved. This mapping can be reused in subsequent imports and can be managed using the Manage Mapping page.

3. Schedule the import.

   You can schedule to run the import at a time you specify or run it immediately.

4. Review and activate the import activity.

   Review your import details and click **Activate** to activate the import activity.

You can use predefined .csv templates for your requests, queues, and categories that are provided in the application. You can also import user-defined objects.

Overview of Bulk Data Export

You can extract large volumes of data using bulk export. You can either extract a full set of records for an object, or perform incremental extracts.

For example, you can extract complete set of account data or extract updated set of records every week. Bulk export creates comma separated or tab delimited files, which are attached to the export process.
Chapter 12
Import and Export

Oracle Fusion Service
Implementing Service Center with the Redwood User Experience

Setup and Schedule Export (Export Process Definition)

Customer System

Request and Retrieve Data

ADF

Schema

Data File
13 Real-Time Channels

Computer Telephony Integration (CTI)

Overview of Computer Telephony Integration (CTI)

Computer telephony integration (CTI) enables integration of third party media toolbars with Fusion Sales and Fusion Service. You can display a media toolbar by enabling the Partner CTI Service, and by giving your signed-in users the Access Partner Media Toolbar privilege which allows access to the toolbar.

Use CTI to:

- Make an outbound call using Click to Dial and skip manual dialing.
- Receive phone calls on the Digital Sales app and automatically view the caller's Contact record or Lead record.

Integrating with CTI gives you the following features:

- Notifications of incoming calls and ability to accept or reject the call
- Automatic caller identification
- Ability to search for a contact
- Optional caller verification
- Display of administrator-defined screen pop with caller or service details
- Automatic interaction recording
- Optional call wrap up

Related Topics

- How You Configure the Media Toolbar
- How You Configure Screen Pop Pages
- Configure Screen Pop Pages

Configure Profile Options to Enable Partner Media Toolbar

The profile option SVC_PARTNER_MEDIA_TOOLBAR_ENABLED controls the visibility of the partner media toolbar. If you don't enable the profile option, the partner media toolbar is hidden. You can set this profile option either at a site level or at a user level.

To configure the profile options for enabling the partner media toolbar:

1. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
2. Click Search from the list of displayed tasks.
3. In the Search field, type Manage Admin.
4. From the displayed list of tasks, click Manage Administrator Profile Values.
5. In the Manage Administrator Profile Values page, navigate to the Search: Profile Option region.
6. In the Profile Option Code field, type `SVC_PARTNER_MEDIA_TOOLBAR_ENABLED`.
7. Click **Search**.

The Search Results: Profile Options region displays the list of profile options.

8. In the Profile Values region, specify the values in the **Profile Value** column for the **Site** Profile Level to 'Yes' if you want the partner media toolbar to be visible to all users.
9. Alternatively, set the Site level value to 'No' and add a new row for a user for whom the partner media toolbar must be visible.
10. Click **Save and Close**.

**Note:** Ensure that the user is assigned the privilege `Access Partner Media Toolbar` (`SVC_ACCESS_PARTNER_MEDIA_TOOLBAR_PRIV`) before trying to access the toolbar.

### Configure Multichannel Architecture (MCA) Profile Options

Profile options let you configure and control application data centrally. Use the Multichannel Architecture (MCA) profile options to manage the MCA run time profile option values. Administrators and setup users manage MCA profile options in the Setup and Maintenance work area.

To configure the MCA Profile Options:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage MCA Profile Options
2. Click the name of the profile option you want to set.

   This displays the **Manage MCA Profile Options** page for the selected profile option code.
3. In the Profile Values section for the profile option code, set the **Profile Value** for the Site **Profile Level**.
4. In the selected profile value, click the **New** icon to add a profile value.
5. Click **Save** or **Save and Close** to save the configuration.

#### MCA Profile Options

The following table lists the various MCA profile options that you can configure:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>SVC_MCA_DISABLE_JWT</code></td>
<td>Enables or disables the JSON Web Token generation.</td>
</tr>
<tr>
<td><code>SVC_MCA_DISABLE_OUTBOUND_CONTACT_VERIFY</code></td>
<td>Enables or Disables automatic display of contact verification screen for outbound calls. If enabled, it will override the call flow parameter configurations.</td>
</tr>
<tr>
<td><code>SVC_MCA_DISABLE_OUTBOUND_WRAP_UP</code></td>
<td>Enables or disables automatic display of the wrap-up screen for outbound calls. If enabled, it will override the call flow parameter configurations for wrap up.</td>
</tr>
</tbody>
</table>
### MCA Profile Options

The following table lists the various MCA profile options that you can configure:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_MCA_DISABLE_JWT</td>
<td>Enables or disables the JWT token generation.</td>
</tr>
<tr>
<td>SVC_MCA_DISABLE_OUTBOUND_CONTACT_VERIFY</td>
<td>Enables or Disables automatic display of contact verification screen for outbound calls. If enabled it will override the call flow parameter configurations.</td>
</tr>
<tr>
<td>SVC_MCA_DISABLE_OUTBOUND_WRAP_UP</td>
<td>Enables or disables automatic display of the wrap-up screen for outbound calls. If enabled it will override the call flow parameter configurations for wrap up.</td>
</tr>
<tr>
<td>SVC_MCA_RECORD_ACTIVITIES_YN</td>
<td>Indicates whether activities must be logged for real time interactions.</td>
</tr>
<tr>
<td>SVC_MCA_RT_CHECK_EVENT_DISPATCH_INTERNAL_MS</td>
<td>Sets the number of milliseconds the user must wait for the start communication event. We recommend that you don’t modify this value unless instructed by support.</td>
</tr>
<tr>
<td>SVC_MCA_RT_EVENT_DISPATCH_MAX_RETRIES</td>
<td>Sets the number of times the user must wait for reverse lookup to return before running the start communication event. We recommend that you don’t modify this value unless instructed by support.</td>
</tr>
<tr>
<td>SVC_MCA_SHOW_CONTACT_ON_WRAP_UP</td>
<td>Indicates whether to show the contact information during the wrap up process.</td>
</tr>
</tbody>
</table>
Related Topics
   • Set Profile Option Values
   • Enter or Edit Translated Text

MCA Lookups

There are two MCA lookups which apply to Phone interactions.

The lookups are:
   • ORA_SVC_MCA_COMM_REASON_CD
   • ORA_SVC_MCA_RESOLUTION_CD

You access these lookups using the Manage Standard Lookups in Functional Setup Manager. If you want to add additional values to the default values of either lookup, use this task.

The following table lists the default values of each lookup.

<table>
<thead>
<tr>
<th>Lookup</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_SVC_MCA_COMM_REASON_CD</td>
<td>• General question</td>
</tr>
<tr>
<td></td>
<td>• Other</td>
</tr>
<tr>
<td></td>
<td>• Technical Issue</td>
</tr>
<tr>
<td>ORA_SVC_MCA_RESOLUTION_CD</td>
<td>• Left message</td>
</tr>
<tr>
<td></td>
<td>• Postive outcome</td>
</tr>
<tr>
<td></td>
<td>• Provided information</td>
</tr>
<tr>
<td></td>
<td>• Answered question</td>
</tr>
<tr>
<td></td>
<td>• Call answered</td>
</tr>
<tr>
<td></td>
<td>• Known Issue</td>
</tr>
<tr>
<td></td>
<td>• Documentation issue</td>
</tr>
<tr>
<td></td>
<td>• At risk</td>
</tr>
</tbody>
</table>

Import and Export Data in CSV Format

This topic describes how to import and export data from and into .CSV format files.
To import and export data:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
2. Go to the relevant task, and click the **Actions** menu next to it. The tasks that you can perform are:
   - Configure Call Flow Parameters
   - Manage Application Classifications
   - Manage Media Toolbar Configuration
   - Manage Screen Pop Configuration
3. Click **Export Data > Create New** to export the data in a .CSV file format.
4. Click **Export Data > View All** to view all the exported .CSV files.
5. Click **Import Data > Create New** to import the data in a .CSV file format.
6. Click **Import Data > View All** to view all the imported .CSV files.

**Related Topics**

- How You Configure Screen Pop Pages
- How You Configure the Media Toolbar
- Overview of Computer Telephony Integration (CTI)
- Update Existing Setup Data

### How You Configure the Media Toolbar

An administrator can configure both the horizontal toolbar and vertical media toolbar. Live Window is an alternative to the media toolbar. For more information about the live window, see the Configure Live Window and Companion Tab for CTI topic in the Related Topics list.

The media toolbar is displayed in the following ways:

- If the company has enabled partner Computer Telephony Integration (CTI) service.
- When the signed-in user has the access privileges to a toolbar.

An administrator can configure multiple media toolbars, and specify a default.

The default toolbar gets assigned to all users.

**Tip:** Set the toolbar with the greater number of users as the default toolbar.

An administrator can also set other users to the non-default toolbar, or alternatively the agents can do this themselves.

An administrator can set the alternative toolbar for users by using the SVC_OVERRIDE_PARTNER_TOOLBAR_SELECTION profile option and creating a user row with the alternative toolbar for each user.

Agents can set an alternative toolbar by doing the following:

1. Click the **Settings and Actions** menu, and select **Set Preferences**.
2. Click Media Toolbar, and then click the Override Media Toolbar drop-down list and select the alternative toolbar.

3. Click Save and Close, then log out and log back in.

While configuring the toolbars, you can also configure incoming call notification window. The notification window displays basic details about the incoming call.

Related Topics

- Configure Screen Pop Pages
- Overview of Computer Telephony Integration (CTI)
- Configure Business Objects
- How You Configure Screen Pop Pages
- Configure Live Window and Companion Tab for CTI

Configure the Media Toolbar

To configure the media toolbar, do the following:

1. In the Setup and Maintenance work area, click the Tasks icon.
2. Select Search.
3. Search for the following string: Manage Media Toolbar Configuration
4. Click the Manage Media Toolbar Configuration link.
   This displays the Manage Media Toolbar Configuration page
5. Click the Add New icon to add a toolbar.
6. Enter a toolbar name.
7. From the Status options, select Enabled to make the toolbar active. If a default toolbar is already specified, this field is disabled by default.
8. Select the layout as Redwood. The layout is selected as Embedded (Horizontal) by default.
9. Enter the domain name. This configuration entry will help you in URL redirection. If you enter the domain name in the Domain Name field, then the application allows cross-origin requests from hosts within the same primary domain or any sub-domain. For example, if you have set the Domain Name to provider.com, then requests from the following URLs are allowed:

10. Select the newly added toolbar from the list of toolbars and click Default to set the toolbar as the default one for all enabled users.
11. Click Save, and then Save and Close.

Related Topics

- Configure Screen Pop Pages
- Overview of Computer Telephony Integration (CTI)
- Configure Business Objects
- How You Configure Screen Pop Pages
Configure Screen Pop Pages for Redwood User Experience

This topic describes how to configure screen pop pages.

Configuring a screen pop page includes the following steps:

1. Configuring a business object
2. Creating a token
3. Mapping a page
4. Defining rules

To configure a screen pop page:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Screen Pop Configuration

   **Note:** You may have to select All Tasks from the Show drop down list to view this task.

The Screen Pop Configuration page is displayed.

Create a Business Object

Business object configuration enables you to specify the business objects that can be used for reverse lookup and for screen pop. You can configure a standard business object or a user business object. A standard object is based on a ready-to-use business object and a user business object is based on a user-defined business object that’s created using the Application Composer. For more information about creating user business objects using Application Composer, see Oracle Fusion Extending Sales and Fusion Service guide.

A standard business object is based on a preconfigured business object, such as Service or Queue.

To view a standard business object:

1. Click the **Business Objects** tab.

   Business Objects tab lists standard and user-defined business objects. The standard or the predefined objects cannot be modified or deleted.

2. Click the **Systems Objects** tab.
3. View the mapped system objects.
4. Click **Save** or **Save and Close**.

To create a user business object, you must first create a user object in the application by using the Application Composer. Create the fields, pages, and security settings for the new object. For example, create an object called SRTickets in the Service application. For more information about creating a user business object, see Oracle Fusion Extending Sales and Fusion Service guide.
To create a user business object:

1. Click the Business Objects tab. Business Objects tab lists standard and user-defined business objects. The standard or the predefined objects cannot be modified or deleted.
2. Click the User Business Objects tab.
3. Click the add icon.
4. Select object type as User-Defined.
5. Select the application in which you created an object. For example, select Service application.
6. Type the name of the user-defined object that you created and click Validate. For example, type SRTickets. If the object name is valid, the object full path is displayed.
7. Click Add.
8. Click Save or Save and Close.

Create a Token
To create a token:

1. Click the Tokens tab. Tokens tab lists standard and user-defined tokens. The standard or the predefined tokens cannot be modified or deleted.
2. Click the User-Defined Tokens tab.
3. To add a token, click the add icon.
   A token consists of the following details:
   - Name: Any alphanumeric value that represents the token
   - Token Code: Unique code that's used to represent a token
   - Description: String to provide extra information about the token
   - Object Name: Business object to which the token is associated. Object Name is an optional value.
   - Object Attribute: Attribute of a business object that's associated with the token. Attribute is an optional value.
4. Specify the values for the token and click Save.

Map Screen Pop Page
After creating the token, map a screen pop page to an existing page of the associated business object.

1. On the Screen Pop Page Configuration page, click the Pages tab.
2. To create a page mapping, click the add icon.
3. Click the User Interface Type drop down list and select Redwood.
4. Make the optional selections, such as Business Object, Page Type, and Page Key.
5. Enter a Page Name.
6. Enter a Page Title for the screen pop page. A title can contain a title prefix, the name of the token, and a title suffix. One of these values is mandatory.
7. Enter the page URL in the Page Path field.
8. In the Page Parameters Mapping section, associate required parameter with a token or a user-defined value. Based on the input that's passed to one or more page parameters, the information is displayed in the page. For example, based on the invoice number parameter, the invoice details screen is displayed.
9. Click Save.
Define Screen Pop Rules

Screen pop configuration rules determine which set of rules must be applied when a screen pop logic is invoked. Different screen pop rules can be invoked based on a number of different variables, such as application classification and channel. Based on the input parameters, you can choose from a number of different pages to screen pop to the agent. For example, pages such as the Contact Edit, Account Edit, and Service Request edit pages can be displayed to the customer. Additionally, you can choose to create an object, such as a service request. This framework also allows for user-defined objects to be presented to the agent as part of the screen pop process.

Define rules in order of priority to display a screen pop page, when an associated token value is available. If a rule in a higher priority isn't satisfied, the next in the order is checked. To define rules:

1. On the Screen Pop Page Configuration page, click the Rules tab.
2. First, create a rule set.

   A rule set consists of one or more rules that are defined in an order of priority. To create a rule set:

   a. Click the New (+) icon. You can also select Duplicate from the Actions menu to duplicate an existing rule set.
   
      Note: The application classification values and the user interface types must be unique for each rule set. In other words, if a rule already exists that's classified under Service with a Redwood user interface type, you must deactivate that rule before you can save your new one.
   
   b. Enter a Rule Set Name.
   c. Select an Application Classification to which the rule set belongs. For instance, choose Service.
   d. Click the User Interface Type drop-down list, and select Redwood. You can select Application Development Framework if that's your implementation.
   e. A rule set is Active by default. To deactivate a rule set, clear the Active option.
   f. Enter a description for the rule set.

3. Next, add rules to the rule set.
   a. Click the New (+) icon.
   b. The priority column displays the order of priority in which the rules are checked. You can change the priority by clicking up arrow and down arrow icons.
   c. A rule is enabled by default. Clear the Enable option to disable a rule.

4. Click the Channels drop-down list and select the communication channel to which the rule is applied.

   For example, a rule is applied only when an agent receives a service phone call from a customer. You can add or modify the channels list by modifying the associated lookup values.

5. Select a Token name.
6. Click the Page to Pop drop-down list and select a page to display.

   Note: When you create a Redwood rule set, only VB pages are displayed. If you choose Application Development Framework, a different set of pages are available to choose from.

7. Click Save.
8. When you're finished creating the rule sets, click Done.
CTI Media Toolbars APIs

Overview of the Media Toolbar API

Media toolbar APIs are a set of JavaScript functions delivered by Oracle to enable Computer Telephony Integration (CTI) partners to integrate their media toolbars with ServiceCenter. These APIs facilitate communication between the media toolbar and ServiceCenter to exchange the following in response to inbound or outbound interaction requests:

- Configuration information
- Events
- Payload data

When enabled, ServiceCenter loads the toolbar and the media toolbar APIs in an iFrame within the browser.

How You Load the Media Toolbar API

Find toolbar API modules under the svcMca.tlb.api namespace to enable quick and clear identification, and to avoid conflicts with similar JavaScript functions. To load the API JavaScript file, concatenate the following two parameters to the iFrame source toolbar URL:

- **oraParentFrame**: Represents the origin of the Oracle instance, including the protocol and the port. For example, `https://mypodinstance.oraclecloud.com:12345`.
- **oraApiSource**: Represents the path from where the toolbar API JavaScript file can be loaded, including the leading slash. For example, `/service/js/mcaInteractionV1.js`.
- **oraTbStyle**: Indicates whether the toolbar is displayed on a Live Window. `oraTbStyle=LiveWindow` indicates the Toolbar is Displayed in the Live Window, otherwise the value is set to Embedded to indicate the display is on the Applications page.

Here’s an example to load the MCA Javascript dynamically:

```html
<script type="text/javascript"
 id="dynamicLoadScript">
(function () { 
 window.dynamicLoadCompleted = false;
 window.staticLoadCompleted = false;
 console.log("##DLS: Running DynamicLoadScript to load the Oracle API JS...");
 function getParameterByName(name) {
```
var match = RegExp('[?&]' + name + '=[^&]*)').exec(window.location.search);
    return match && decodeURIComponent(match[1].replace(/\+/g, ' '));

    var oraApiPath = '';
    var oraOrigin = getParameterByName('oraParentFrame');
    var oraApiSource = getParameterByName('oraApiSource');
    console.log('##DLS: PageParameters - oraParentFrame: ' + oraOrigin + '
oraApiSource: ' + oraApiSource);
    try {
        if (oraApiSource && oraApiSource.startsWith("http")) {
            oraApiPath = oraApiSource; // handle case where apiSource is loaded from external CDN
        } else {
            oraApiPath = oraOrigin + oraApiSource;
        }
        console.log('##DLS: Oracle API JS URL: ' + oraApiPath);
    } catch (e) {
        console.log('##DLS: Error ' + e);
        console.error(e);
    }

    function onDynamicLoadComplete() {
        /* TODO INSERT ANY INIT PROCESSING HERE */
    }

    if (typeof define === 'function' && define.amd) {
        try {
            require([oraApiPath], function (mcaTlb) {
                window['svcMca'] = {};
                window.svcMca['tlb'] = mcaTlb;
                window.dynamicLoadCompleted = true;
                console.log('##DLS: Successfully loaded Oracle API JS');
                onDynamicLoadComplete();
            });
        } catch (e) {
            console.log('##DLS: Error loading ORACLE API JS from URL: ' + oraApiPath);
            console.error(e);
        }
    } else {
        var currentNode = document.getElementById('dynamicLoadScript');
        var node = document.createElement('script');
        node.type = 'text/javascript';
        node.charset = 'utf-8';
        node.async = true;
        node.src = oraApiPath;
        node.addEventListener('load', function(evt) {
            window.dynamicLoadCompleted = true;
            console.log('##DLS: Successfully loaded Oracle API JS');
            onDynamicLoadComplete();
            }, false);
        node.addEventListener('error', function(e) {
            console.log('##DLS: Error loading ORACLE API JS from URL: ' + node.src);
            }, false);
        currentNode.parentNode.insertBefore(node, currentNode.nextSibling);
    }}();
</script>
Media Toolbar API Methods

Media toolbar APIs are divided into these methods:

- Configuration methods: Enable the toolbar and the application to exchange configuration information, and saves changes in application for retrieval by the toolbar when needed.
- Interaction methods: Provide notification on the events occurring on the toolbar, as well as exchange information used by the toolbar or ServiceCenter.
- Toolbar windows management methods: Manage the toolbar windows and facilitate communication between windows.
- Event listeners: Allow the toolbar to register listeners for events triggered by ServiceCenter.

The APIs provide a non-blocking interaction between the toolbar and ServiceCenter. Each method has a callback function parameter that’s invoked when a method on ServiceCenter is complete, notifying the toolbar of the outcome.

Media Toolbar APIs

Use the media toolbar APIs with all toolbars that handle communication between agents and customers. The toolbar loads the APIs which are implemented in a JavaScript file format.

**Note:** Although media toolbar APIs are generic to all media channels, the 11.13.0.0 release supports only Phone and integration with CTI partner systems.

API Classification

The media toolbar APIs facilitate the initial configuration of the loaded toolbar. Use them to set up functionality for both the partner toolbar and ServiceCenter. There are three main flows of the toolbar interaction:

- Initial configuration of the partner toolbar and communication with Service Center.
- Inbound communication handling.
- Outbound communication handling.

The APIs are independent of communication channels, but use channel information as a parameter, passing it to Service Center to determine whether a toolbar supports multiple channels. You define and configure the channels using Functional Setup Manager. The APIs support both preconfigured and user-defined channels.

Data Flow Methods

The following figures show the flow of the methods that are called by the toolbar. The method calls can be mandatory or optional. If a call is mandatory, the toolbar implementation must make one call for each communication event, unless you specify otherwise. If a call is optional, the toolbar implementation can make a call whenever necessary, depending on the action needs.
The following figure shows the configuration workflow.
This figure shows the inbound call workflow.
This figure shows the outbound call workflow.

1. Click to Dial

2. onOutboundEvent()

3. Create Payload for Outbound Call

4. onOutgoingEvent()

5. Show Initial Outbound Call

6. initiate outbound call

7. Make Outbound Call

8. response

9. Update Toolbar to "Ringing"

10. newCommEvent()

11. Start Interaction

12. callback

13. Call Is Answered

14. Update Toolbar to "Answered"

15. startCommEvent()

16. callback

17. Contact Verification (optional)
And this figure shows the end of call workflow.
Configuration APIs

Overview of Configuration APIs

The configuration APIs enable the toolbar and Service Center to exchange configuration data. They're listed in the following table.

<table>
<thead>
<tr>
<th>Method</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>getConfiguration</td>
<td>Sets up the toolbar. The method retrieves a list of features that are supported by ServiceCenter.</td>
</tr>
<tr>
<td>disableFeature</td>
<td>Disables a feature that the toolbar doesn't support.</td>
</tr>
<tr>
<td>readyForOperation</td>
<td>Notifies ServiceCenter that the toolbar is ready for use, and that the agent is logged on to the toolbar, and ready to handle communication.</td>
</tr>
</tbody>
</table>

getConfiguration Method

Call this mandatory method to get configuration information that enables the toolbar to evaluate the features supported by ServiceCenter. Based on the evaluation, the toolbar informs ServiceCenter of any features that must be disabled. For more information, see the disableFeature API method.

Here's a list of the getConfiguration method parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>callback</td>
<td>Returns results to the caller toolbar, and retrieves configuration information in the form of a JSON formatted string.</td>
</tr>
<tr>
<td>configtype</td>
<td>The type of configuration information returned by ServiceCenter. Possible values are TOOLBAR, TOKENS, PAGES, LOOKUP_OBJECTS, ALL, or FA_TOKEN. This is an optional parameter with a default value of TOOLBAR.</td>
</tr>
</tbody>
</table>

The return value is based on what the configType parameter passes. It includes the agent name along with the other information listed in the following table:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOOLBAR</td>
<td>Returns a list of features supported by ServiceCenter. It also returns information about the toolbar, such as whether it's enabled, and if so, its dimensions. These values are preconfigured, but you can set up and modify them using Functional Setup Manager.</td>
</tr>
<tr>
<td>TOKENS</td>
<td>Returns information about both system and user-defined tokens. You can set up and modify these values using Functional Setup Manager.</td>
</tr>
<tr>
<td>PAGES</td>
<td>Returns information about both system and user-defined screen pop pages, including code, name, parameters, and associated tokens. You can set up and modify these values using Functional Setup Manager.</td>
</tr>
<tr>
<td>LOOKUP_OBJECTS</td>
<td>Returns information about business objects that are used to perform reverse lookup. Returns information about both system and user-defined screen pop pages, including code, name, parameters, and associated tokens. You can set up and modify these values using Functional Setup Manager.</td>
</tr>
<tr>
<td>ALL</td>
<td>Returns all of information as the other configType values, except that of FA_TOKEN type.</td>
</tr>
<tr>
<td>FA_TOKEN</td>
<td>Returns a JWT token to be used by toolbar implementation to authenticate against ServiceCenter when calling the REST APIs. A specific call to this configType is required to obtain the JWT token.</td>
</tr>
</tbody>
</table>

Here's sample code to call the `getConfiguration` method

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
<script type="text/javascript">
function callGetConfiguration() {
  svcMca.tlb.api.getConfiguration(function (response) {
    if (response.result == 'success') {
      alert('Success! Configuration is: ' + response.configuration);
    } else {
      alert('Operation finished with error: ' + response.error);
    }
  });
</script>
</head>
<body>
<input type="button" value="Configuration" onclick="callGetConfiguration()"/>
</body>
</html>
```

Here's a sample response for configuration data with configType LOOKUP_OBJECTS

```json
{
  "lookupObjects": [
    {"name":"ServiceRequest"},
    {"name":"Account"},
    {"name":"Contact"}
  ]
}
```

Here's a sample response for configuration data with configType FA_TOKEN

```json
{
}
```
disableFeature Method

This method informs ServiceCenter that a subset of available functionality must be disabled because the toolbar hasn't implemented it.

By default, the features sent by the getConfiguration API method are considered enabled. There's no return value with this method. The method parameters are described in the following table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>features</td>
<td>A string that contains the comma-separated feature names. For a list of features, see API Features.</td>
</tr>
<tr>
<td>callback</td>
<td>A method callback which returns results to the toolbar.</td>
</tr>
</tbody>
</table>

Here's sample code used to call the method:

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
</head>
<script type="text/javascript">
function disableOutgoingCall() {
    svcMca.tlb.api.disableFeature('OUTBOUND_CALL', function (response) {
        if (response.result == 'success') {
            alert('Success! Feature disabled!');
        } else {
            alert('Operation finished with error: ' + response.error);
        }
    });
</script>
<body>
<input value="Disable outgoing call" onclick="disableOutgoingCall()"/>
</body>
</html>
```

readyForOperation Method

This method notifies ServiceCenter that the toolbar is ready for operation. A minimum of one call to this method is mandatory. The toolbar is disabled by default, and is enabled when this method is called with the readiness parameter set to TRUE.
## Interaction APIs

### Overview of Interaction APIs

Interaction API facilitate communication between the toolbar and ServiceCenter during an interaction.

The API triggers customer identification by using reverse lookup, screen pop and user-defined tokens. All methods of the interaction API have a channel for which they make the call as a parameter. You configure the channels with Functional Setup Manager. For a list of provided channel names, see Channel Type Data. The following table lists the Interaction API methods.

<table>
<thead>
<tr>
<th>Method</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>newCommEvent</td>
<td>Notifies the application that the toolbar has received a new CommEvent. This means that new communication has been assigned to or was initiated by the current agent. This call is mandatory.</td>
</tr>
<tr>
<td>startCommEvent</td>
<td>Notifies the application that the toolbar has started a CommEvent, where an agent has accepted the event.</td>
</tr>
<tr>
<td>Method</td>
<td>Usage</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>closeCommEvent</td>
<td>Notifies the application that the toolbar has closed the CommEvent.</td>
</tr>
<tr>
<td></td>
<td>This call is mandatory.</td>
</tr>
<tr>
<td>transferCommEvent</td>
<td>Called by the toolbar to inform Service Center that a transfer of the</td>
</tr>
<tr>
<td></td>
<td>communication has been initiated.</td>
</tr>
<tr>
<td>upgradeCommEvent</td>
<td>Notifies Service Center that a new channel was added to an existing</td>
</tr>
<tr>
<td></td>
<td>engagement. For instance, an agent is talking on the phone with a</td>
</tr>
<tr>
<td></td>
<td>customer and decides to start a video conference with the customer.</td>
</tr>
<tr>
<td>downgradeCommEvent</td>
<td>Notifies Service Center that a channel was removed from an existing</td>
</tr>
<tr>
<td></td>
<td>engagement. For instance, an agent talking on the phone and video</td>
</tr>
<tr>
<td></td>
<td>conferencing with a customer disconnects the video conference. Note</td>
</tr>
<tr>
<td></td>
<td>that if a closeCommEvent is received for the initial or primary</td>
</tr>
<tr>
<td></td>
<td>channel of communication it’s assumed that any attached</td>
</tr>
<tr>
<td></td>
<td>communications are disconnected as well.</td>
</tr>
<tr>
<td>getCustomerData</td>
<td>Retrieves customer or related data.</td>
</tr>
</tbody>
</table>

**newCommEvent Method**

This method is called by the toolbar to inform ServiceCenter that a new communication event has started.

This is the first API call that the toolbar makes for a communication event. This method must provide through the eventId parameter, either a unique identifier or the media event identifier to be used for the communication event. For both inbound and outbound calls, it’s important to specify the direction of the interaction. The newCommEvent must contain the following inData token to indicate the direction of the call: “SVCMCA_COMMUNICATION_DIRECTION”. Valid values are: “ORA_SVC_INBOUND” and “ORA_SVC_OUTBOUND”. This method call is mandatory.

For inbound calls, the primary purpose of the call is to identify customers by using reverse lookup functionality and to trigger the incoming call notification. The toolbar uses tokens to pass all the information from the Interactive Voice Response systems. All customer information retrieved is sent back to the toolbar using system tokens.

Here’s a list of the newCommEvent parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel</td>
<td>Name of the channel for which the method is called. For more information on what channels are available, see Channel Type Data.</td>
</tr>
<tr>
<td>appClassification</td>
<td>Name of the application classification defined for the current toolbar. If this parameter is passed as null, it’s assumed that there’s no</td>
</tr>
<tr>
<td></td>
<td>application classification. For a list of preconfigured values, see Application Classification Code.</td>
</tr>
<tr>
<td>eventId</td>
<td>A toolbar-generated media event identifier. The same parameter value must be used for all method invocations for a communication. This</td>
</tr>
<tr>
<td></td>
<td>parameter is stored with the internal interaction record.</td>
</tr>
<tr>
<td>inData</td>
<td>An object containing information about incoming events for customer identifiable data, along with attributes containing the names of</td>
</tr>
<tr>
<td></td>
<td>system or user-defined defined tokens.</td>
</tr>
</tbody>
</table>
Implementing Service Center with the Redwood User Experience

Chapter 13
Real-Time Channels

Parameter | Description
---|---
To specify a timeout value for an incoming call notification, add the following pair to this parameter: `SVCMCA_OFFER_TIMEOUT_SEC, #OFSECOND`  
Replace the `#OFSECONDS` value with the actual number of seconds where you want to start the timer. When the timer expires the `onDataUpdated()` method is invoked with the `updateType` parameter set to `OFFER_TIMEOUT`. The toolbar then invokes the `closeCommEvent()` method to end the interaction.

callback | Returns results to the caller toolbar.
lookupObject | A business object used to run the reverse lookup. Use this optional parameter to get customer information. The default value of Contact. For more information about the list of system lookup objects, see [System Business Objects](#).
channelType | The type of channel for which the method is being called. Note that if, for example, the channel is PHONE but the channelType isn't provided, the default value is set to ORA_SVC_PHONE. For more information, see [Channel Type Data](#).

Here’s a list of member attributes of the response object. The object has no return value.

<table>
<thead>
<tr>
<th>Member Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>The server side running status. Result values are success or error.</td>
</tr>
<tr>
<td>outData</td>
<td>Represents an object containing possible identified data from ServiceCenter for the contact or for the organization. This attribute contains the names of system tokens.</td>
</tr>
<tr>
<td>error</td>
<td>Contains error message if the result value is an error. If not, then the value is undefined. For more information about error message codes, see <a href="#">Error Messages</a>.</td>
</tr>
</tbody>
</table>

**Note:** The newCommEvent method triggers the creation of an interaction object. This object contains information related to communication, and objects that are related to communication. The identifier for the interaction is passed back with the callback response as the value for the `SVCMCA_INTERACTION_ID` token. Subsequent invocations of the method must send this token and its value, along with other IVR data to ServiceCenter.

When the newCommEvent method is invoked for a transfer, the toolbar uses the `SVCMCA_PARENT_INTERACTION_ID` token to send IVR data and the originating communication interaction ID to ServiceCenter which associates the communication events. In addition, you must also specify the `SVCMCA_2NDARY_CALL_TYPE` token to indicate whether this call is a Transfer, a Consultation, or a Conference.

Here’s an example of code used to call this method.

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
</head>
<script type="text/javascript">
function inboundCallNotification() {
  var inData = {};
  inData.SVCMCA_ANI = '5551234';

  // Rest of the function...
</script>
```
startCommEvent Method

The toolbar makes this mandatory method call when an agent accepts a new communication that was triggered by the newCommEvent() call.

This method invokes the Identify Contact flow, then triggers the Customer Validation flow, and then runs the screen pop which the following explains:

1. The method first triggers the Customer Validation flow.

   This flow queries the communication data to determine if a contact has already been identified. If not, the Contact Search window is displayed allowing the agent to search for or create a contact. Once found, the contact information is returned to the toolbar. Toolbars can bypass this flow by identifying the contact prior to the startCommEvent call or by passing the SVCMCA_BYPASS_IDENTIFY_CONTACT token. Toolbars can then use the getCustomerData() method to manually request contact identification.

2. The method then triggers the Customer Verification flow, an optional flow that opens the customer verification page. If the agent doesn't verify the caller, no screen pop is performed. Customer verification can be bypassed by passing in the SVCMCA_BYPASS_CUSTOMER_VERIFICATION token in the call data.

3. Finally, the method runs a screen pop using your predefined rules. If you want the toolbar to prevent the screen pop, you can add the SVCMCA_BYPASS_AUTO_SCREENPOP token into the call data, and use the invokeScreenPop() method to manually trigger the pop.

**Note:** A callback passed with the startCommEvent method can be invoked multiple times if the Identify Contact and Customer Verification flows triggered. The outData information from the response can contain updated customer information.

Here's the method details:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel</td>
<td>The name of the channel for which the method is called. For more information on what channels are available, see Channel Type Data.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>appClassification</td>
<td>The name of the application classification defined for the current toolbar. If this parameter is passed as null, it's assumed that there is no application classification. For a list of preconfigured values, see Application Classification Code.</td>
</tr>
<tr>
<td>eventId</td>
<td>The toolbar generated media event identifier. The same parameter value must be used for all method invocations for a communication. This parameter is stored with internal interaction record.</td>
</tr>
<tr>
<td>inData</td>
<td>An object containing information about incoming events for customer identifiable data, as well as attributes containing the names of system or user-defined defined tokens.</td>
</tr>
<tr>
<td>callback</td>
<td>Returns results to the caller toolbar.</td>
</tr>
<tr>
<td>channelType</td>
<td>The type of channel for which the method is being called. Note that if, for example, the channel is PHONE but the channelType isn't provided, the default value is set to ORA_SVC_PHONE. For more information, see Channel Type Data.</td>
</tr>
</tbody>
</table>

Here's the member attributes of the response object. The object has no return value.

<table>
<thead>
<tr>
<th>Member Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>The server side running status. Result values are success or error.</td>
</tr>
<tr>
<td>outData</td>
<td>Represents an object containing possible identified data from ServiceCenter for the contact or for the organization. This attribute contains the names of system tokens.</td>
</tr>
<tr>
<td>error</td>
<td>Contains the error message if the result value is an error. If not, then the value is undefined. For more information about error message codes, see Error Messages.</td>
</tr>
</tbody>
</table>

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
<script type="text/javascript">
function startCommEvent() {
  var inData = {};
  inData.SVCMCA_ANI = '5551234';
  inData.SVCMCA_CONTACT_ID = '1234567890';
  inData.SVCMCA_CONTACT_NAME = 'John Smith';
  inData.createSr = 'yes';
  svcMca.tlb.api.startCommEvent('PHONE', 'ORA_SERVICE', '12345-1234-67890', inData, function (response) {
    if (response.result == 'success') {
      console.log('Created service request: ' + response.SVCMCA_SR_NUMBER);
      alert('Success! Results available in log. ');
    } else {
      alert('Operation finished with error: ' + response.error);
    }
  }, 'ORA_SVC_PHONE');

</head>
<body>
<input type="button" value="Call started" onclick="startCommEvent()"/>
</body>
</html>
```
closeCommEvent

The toolbar calls this method when communication ends. The parameter reason is used to indicate how the communication ended and provide additional information. Value reason values are shown in the following list:

- ABANDONED: The communication attempt timed out.
- ENDCOMMUNICATION: Indicates that the communication ended and if ServiceCenter is in wrap-up mode it then must close the wrap-up page.
- MISSED: The communication attempt couldn't be established for another reason.
- REJECT: When an agent rejects a communication.
- TIMEOUT: The communication attempt timed out.
- WRAPUP: Displays the Wrap Up window to indicate to the agent that the communication must come to a close.

Here's the parameters for this method:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel</td>
<td>The name of the channel for which the method is called. For more information on what channels are available, see Channel Type Data.</td>
</tr>
<tr>
<td>appClassification</td>
<td>The name of the application classification defined for the current toolbar. If this parameter is passed as null, it’s assumed that there is no application classification. For a list of preconfigured values, see Application Classification Code.</td>
</tr>
<tr>
<td>eventId</td>
<td>Toolbar generated media event identifier. The same parameter value must be used for all method invocations for a communication. This parameter is stored with internal interaction record.</td>
</tr>
<tr>
<td>inData</td>
<td>An object containing information about incoming events for customer identifiable data, along with attributes containing the names of system or user-defined defined tokens.</td>
</tr>
<tr>
<td>reason</td>
<td>ABANDONED, ENDCOMMUNICATION, MISSED, REJECT, TIMEOUT, OR WRAPUP.</td>
</tr>
<tr>
<td>callback</td>
<td>Returns results to the caller toolbar.</td>
</tr>
<tr>
<td>channelType</td>
<td>The type of channel for which the method is being called. Note that if, for example, the channel is PHONE but the channelType isn't provided, the default value is set to ORA_SVC_PHONE. For more information, see Channel Type Data.</td>
</tr>
</tbody>
</table>

Here’s the member attributes of the response object. The object has no return value.

<table>
<thead>
<tr>
<th>Member Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>result</td>
<td>The server side running status. Result values are success or error.</td>
</tr>
</tbody>
</table>
### Member Attribute

<table>
<thead>
<tr>
<th>Member Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>outData</td>
<td>Represents an object containing possible identified data from ServiceCenter for the contact or for the organization. This attribute contains the names of system tokens.</td>
</tr>
<tr>
<td>error</td>
<td>Contains the error message if the result value is an error. If not, then the value is undefined. For more information about error message codes, see Error Messages.</td>
</tr>
</tbody>
</table>

Here's sample code for this method:

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
</head>
<body>
<input type="button" value="End call" onclick="closeCommEvent()"/>
</body>
</html>
```

### Event Listener APIs

#### Overview of Event Listener APIs

The event listener API allows the toolbar register listeners to track events that are triggered by Service Center. This allows Service Center to initiate outbound interaction events and send updates to the toolbar.

Here's a list of the Event Listener APIs and their usage.

<table>
<thead>
<tr>
<th>Method</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>agentStateEvent</td>
<td>Notifies Service Center of changes in a user's signed in or availability status for the specified channel.</td>
</tr>
<tr>
<td>onDataUpdated</td>
<td>Registers a callback for customer data update events to be transmitted to the media toolbar with the updated information.</td>
</tr>
<tr>
<td>Method</td>
<td>Usage</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>focusInteractionEvent</td>
<td>Notifies Service Center that the toolbar has changed the previously active interaction slot to a different interaction slot.</td>
</tr>
<tr>
<td>onOutgoingEvent</td>
<td>Registers a toolbar-initiated callback for the start of an outgoing event triggered from Service Center.</td>
</tr>
<tr>
<td>outboundCommError</td>
<td>Notifies Service Center that an error occurred during initiation of the outbound event.</td>
</tr>
<tr>
<td>onToolbarAgentCommand</td>
<td>Registers a listener with Service Center to provide agent control functionality.</td>
</tr>
<tr>
<td>onToolbarInteractionCommand</td>
<td>Registers a listener with Service Center to provide interaction control functionality.</td>
</tr>
</tbody>
</table>

**agentStateEvent Method**

This method notifies Service Center of a change in the user's signed in or availability status for the specified channel.

**Note:** In order to properly reflect the agent state on the phone icon at the top of the application window, it's important to inform Service Center of the agent's current state: logged in, logged out, available, or on break. Upon establishing the initial connection to the toolbar, be sure to call agentStateEvent() passing the correct values for isLoggedIn and isAvailable. All state changes must be conveyed using the same method.

Here's a list of the method parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel</td>
<td>Name of the channel. (Required.)</td>
</tr>
<tr>
<td>eventId</td>
<td>Unique identifier for the event. (Required.)</td>
</tr>
<tr>
<td>isAvailable</td>
<td>Boolean to indicate if the user is available to receive routed assignments for the specified channel. (Required.)</td>
</tr>
<tr>
<td>isLoggedIn</td>
<td>Boolean to indicate if the user is signed in to the specified channel. (Required.)</td>
</tr>
<tr>
<td>stateCd</td>
<td>System code to indicate the current availability status of the user. (Optional.) For future use.</td>
</tr>
<tr>
<td>stateDisplayString</td>
<td>Translatable string to indicate the user's current channel activity state in the Service Center UI, such as idle, busy, on break on so on. This must be translated to the user's language. (Required.)</td>
</tr>
<tr>
<td>reasonCd</td>
<td>System code to indicate the reason for the current availability status. (Optional.) For future use.</td>
</tr>
</tbody>
</table>
Parameter | Description
--- | ---
reasonDisplayString | Translatable string to display the reason for the current status on the Service Center UI. (Optional.) For future use.
inData | Object containing the name value pairs if additional details are required.
callback | Function on the toolbar to indicate event receipt by Service Center Service.
channelType | The type of channel. (Required.)

The following is sample code to call this method.

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
</head>
<body>
<input type="button" value="Fire agentStateEvent" onclick="agentStateEvent()"/>
</body>
</html>
```

**onDataUpdated Method**

The toolbar calls this method to register the callback listener for a data update which occurred in Service Center which must be transmitted to the toolbar.

Using this listener, Service Center can send notifications about updates of Service Center contact information which will then be reflected in the toolbar. Additionally, Service Center can use this method to notify the toolbar that Service Center actions, such as a Wrap-up, have been completed.

Here's the parameters for this method:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel</td>
<td>Name of the channel for which the method is called.</td>
</tr>
<tr>
<td>appClassification</td>
<td>Name of the application classification defined for the current toolbar. If this parameter is passed as null, it's assumed that there are no application classifications. For a list of ready to use values, see Application Classification Code.</td>
</tr>
</tbody>
</table>
Oracle Fusion Service
Implementing Service Center with the Redwood User Experience

Chapter 13
Real-Time Channels

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>callback</td>
<td>Method callback to inform the caller toolbar of the results.</td>
</tr>
<tr>
<td>channelType</td>
<td>The type of channel for which the method is being called. For instance, if the channel is PHONE and the channelType isn't provided, the default value is set to ORA_SVC_PHONE. For more information, see Channel Type Data.</td>
</tr>
</tbody>
</table>

The response object has the following member attributes.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>updateType</td>
<td>Type of update. The values can be CUSTOMER_DATA or WRAPUP_CLOSED or OFFER_TIMEOUT.</td>
</tr>
<tr>
<td>eventId</td>
<td>Media event identifier that's used to identify which communication event is targeted by this update.</td>
</tr>
<tr>
<td>outData</td>
<td>Object that has attributes with the names of system token, such as SVCMCA_CONTACT_ID, SVCMCA_CONTACT_NAME, SVCMCA_ORG_ID, and SVCMCA_ORG_NAME.</td>
</tr>
</tbody>
</table>

Here's sample code to call the method:

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js">
</script>
<script type="text/javascript">
function onDataUpdated() {
    svcMca.tlb.api.onDataUpdated('PHONE','ORA_SERVICE', function (response) {
        console.log('Media Event: ' + response.eventId);
        console.log('Contact number: ' + response.outData.SVCMCA_CONTACT_ID);
        console.log('Contact name: ' + response.outData.SVCMCA_CONTACT_NAME);
        console.log('Organization number: ' + response.outData.SVCMCA_ORG_ID);
        console.log('Organization name: ' + response.outData.SVCMCA_ORG_NAME);
        alert('Customer data got updated, see in the log.');
    },'ORA_SVC_PHONE');
}
</script>
</head>
<body>
<input type="button" value="Register data update listener" onclick="onDataUpdated()"/>
</body>
</html>
```

onOutgoingEvent Method

The toolbar calls this method to register the callback listener for Service Center which triggers an outgoing communication event. Using this callback Service Center passes the information required for the toolbar to perform the outgoing event.

Here's the parameters for this method:
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel</td>
<td>Name of the channel for which the method is called.</td>
</tr>
<tr>
<td>appClassification</td>
<td>Name of the application classification defined for the current toolbar. If this parameter is passed as null, it's assumed that there are no application classifications. For a list of ready to use values, see Application Classification Code.</td>
</tr>
<tr>
<td>callback</td>
<td>Function used by Service Center on the toolbar which indicates receipt of an Service Center event.</td>
</tr>
<tr>
<td>channelType</td>
<td>The type of channel for which the method is being called. For instance, if the channel is PHONE and the channelType isn't provided, the default value is set to ORA_SVC_PHONE. For more information, see Channel Type Data.</td>
</tr>
</tbody>
</table>

The response passed in the callback has attributes with system token names, such as SVCMCA_ANI, SVCMCA_EMAIL, SVCMCA_CONTACT_ID, and SVCMCA_CONTACT_NAME. There are no returns.

Here's sample code to call the method:

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
</head>
<body>
<input type="button" value="Register outcall listener" onclick="onOutgoingEvent()"/>
</body>
</html>
```

### outboundCommError Method

The toolbar calls this method to notify Service Center that an error occurred during initiation of the outbound event. The error occurs if the identifier of the event, such as phone number, or email can't be used to establish a connection.

Here's the parameters for this method:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel</td>
<td>Name of the channel for which the method is called.</td>
</tr>
<tr>
<td>commUuid</td>
<td>A unique identifier sent from Service Center to the toolbar containing the outgoing event notification.</td>
</tr>
</tbody>
</table>
Parameter | Description
--- | ---
errorCode | Code to identify the exception that can be used by the agent to identify the nature of the error to contact toolbar support.
errorMsg | Error message displayed to the user.
callback | Function used by Service Center on the toolbar which indicates receipt of an Service Center event.
channelType | The type of channel for which the method is being called. For instance, if the channel is PHONE and the channelType isn’t provided, the default value is set to ORA_SVC_PHONE. For more information, see Channel Type Data.

The response object has the following member attributes. There are no returns.

Attribute | Description
--- | ---
result | Represents the status of the method on the server side. Values are success and error.
error | Contains error messages. If there’s no error, the value is undefined. For more information about error message codes, see Error Messages.

Here’s sample code to call the method:

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
</head>
<body>
<input type="button" value="Register data update listener" onclick="onTestError()" />
</body>
</html>
```

**onToolbarAgentCommand Method**

This method registers a listener with Service to give the agent control functionality. The method is only called once during initialization.

Here’s the parameters for this method:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>channel</td>
<td>Name of the channel for which the method is called.</td>
</tr>
<tr>
<td>channelType</td>
<td>The type of channel for which the method is being called. For instance, if the channel is PHONE and the channelType isn’t provided, the default value is set to ORA_SVC_PHONE. For more information, see Channel Type Data..</td>
</tr>
<tr>
<td>executor</td>
<td>The function implemented by the toolbar which is used by the <code>agentCommandPrototype</code> object.</td>
</tr>
</tbody>
</table>

The `agentCommandPrototype` object has these attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>eventId</td>
<td>Represents the status of the method on the server side. Values are success and error.</td>
</tr>
<tr>
<td>command</td>
<td>Contains error messages. If there is no error, the value is undefined. For more information about error message codes, see Error Messages.</td>
</tr>
<tr>
<td></td>
<td>The following commands are available:</td>
</tr>
<tr>
<td></td>
<td>• getcurrentState</td>
</tr>
<tr>
<td></td>
<td>• getActiveEngagements: The outData must contain the activeCount number and the engagements array value. For example: <code>{ activeCount:1, engagements:[ {eventId:&quot;1234&quot;} ] }</code>. If there are no active engagements, the engagements parameter must be an empty array.</td>
</tr>
<tr>
<td></td>
<td>• makeAvailable</td>
</tr>
<tr>
<td></td>
<td>• makeUnavailable</td>
</tr>
<tr>
<td>channel</td>
<td>The channel name.</td>
</tr>
<tr>
<td>channelType</td>
<td>The type of channel.</td>
</tr>
<tr>
<td>inData</td>
<td>The object containing the name value pairs for the command parameters.</td>
</tr>
<tr>
<td>result</td>
<td>Populated by the toolbar after the command process has completed successfully. If there was a failure, the reason will be displayed.</td>
</tr>
<tr>
<td>resultDisplayString</td>
<td>Error displayed to the user, and populated by the toolbar.</td>
</tr>
<tr>
<td>outData</td>
<td>Populated by the toolbar if the command required output data.</td>
</tr>
<tr>
<td>sendResponse</td>
<td>Callback function used upon completion of the command processing. The sendResponse method must be passed to the command object with the result populated. Also the outData and resultDisplayString attributes must be populated if required.</td>
</tr>
</tbody>
</table>

Here's sample code to call the method:

```html
<html>

```
onToolbarInteractionCommand Method

Registers a listener with Service Center to provide interaction control functionality. This must be called once during initialization. The executor function is used with an interactionCommandPrototype object.

The interactionCommandPrototype object has the following attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>eventId</td>
<td>Unique media item identifier supplied by the toolbar during the newCommEvent.</td>
</tr>
<tr>
<td>command</td>
<td>Name of the command to execute. The following commands are available:</td>
</tr>
<tr>
<td></td>
<td>- accept: Accepts the incoming engagement.</td>
</tr>
<tr>
<td></td>
<td>- reject: Rejects the incoming engagement.</td>
</tr>
</tbody>
</table>
### Attribute Description

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>setActive</td>
<td>Discloses the specified engagement slot to the toolbar.</td>
</tr>
<tr>
<td>slot</td>
<td>An optional toolbar identifier supplied by the toolbar during the newCommEvent.</td>
</tr>
<tr>
<td>inData</td>
<td>The object containing the name value pairs for the command parameters.</td>
</tr>
<tr>
<td>result</td>
<td>Populated by the toolbar after the command process has completed successfully. If there was a failure, the reason will be displayed.</td>
</tr>
<tr>
<td>resultDisplayString</td>
<td>Error displayed to the user, and populated by the toolbar if the command</td>
</tr>
<tr>
<td>outData</td>
<td>Populated by the toolbar if the command required output data.</td>
</tr>
<tr>
<td>sendResponse</td>
<td>Callback function used upon completion of the command processing. The sendResponse method must be passed to the command object with the result populated. Also the outData and resultDisplayString attributes must be populated if required.</td>
</tr>
</tbody>
</table>

The following is sample code to call the method:

```html
<html>
<head>
<script type="text/javascript" src="http://domain:port/ora_support/js/mcaInteractionV1.js"></script>
</head>
<body>
<input type="button" value="Register interaction command listener" onclick="registerInteractionCommandListener()"/>
</body>
</html>
```
API Features

Features are functionality or sets of functionality that are supported by Service Center, and can be implemented by a toolbar. Features are supported by the API and underlying Service Center implementation. The following table lists the features of the API:

<table>
<thead>
<tr>
<th>Feature Code</th>
<th>What you can do with the Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>INBOUND_CALL</td>
<td>Handle messages related to inbound calls.</td>
</tr>
<tr>
<td>OUTBOUND_CALL</td>
<td>Handle messages related to outbound calls. The API notifies the toolbar to initiate the call using the supplied information.</td>
</tr>
<tr>
<td>TRANSFER_CALL</td>
<td>Handle messages related to a call transfer.</td>
</tr>
<tr>
<td>CONFERENCE_CALL</td>
<td>Handle messages related to a call conference.</td>
</tr>
<tr>
<td>OUTBOUND_CALL_EXTENSIONS</td>
<td>Handle messages related to outbound calls. The API notifies the toolbar to initiate the call with the specified phone number and extension.</td>
</tr>
</tbody>
</table>

System Tokens

System tokens include the following tokens types.

- Data tokens: Represent data values in the Multichannel Application
- Control tokens: Control the flow of an interaction

The following table lists the data tokens.

<table>
<thead>
<tr>
<th>Data Token Name</th>
<th>Token Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Id</td>
<td>SVCMCA_ASSET_ID</td>
<td>Asset Identifier.</td>
</tr>
<tr>
<td>Asset Name</td>
<td>SVCMCA_ASSET_NAME</td>
<td>Asset Name.</td>
</tr>
<tr>
<td>Asset Number</td>
<td>SVCMCA_ASSET_NUM</td>
<td>Asset Number.</td>
</tr>
<tr>
<td>Channel Id</td>
<td>SVCMCA_CHANNEL_ID</td>
<td>Channel Identifier which is populated from Channel Name to be passed for page parameters.</td>
</tr>
<tr>
<td>Data Token Name</td>
<td>Token Code</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Communication direction</td>
<td>SVCMCA_COMMUNICATION_DIRECTION</td>
<td>Communication direction, which can either be inbound or outbound. Set the value to ORA_SVC_INBOUND for inbound and ORA_SVC_OUTBOUND for outbound direction. These values are defined in the ORA_SVC_IM_DIRECTION_CD Lookup Type.</td>
</tr>
<tr>
<td>Communication Reason</td>
<td>SVCMCA_WRAPUP_COMM_REASON</td>
<td>Communication Reason of the Interaction</td>
</tr>
<tr>
<td>Contact First Name</td>
<td>SVCMCA_CONTACT_FIRST_NAME</td>
<td>Contact’s first name.</td>
</tr>
<tr>
<td>Contact ID</td>
<td>SVCMCA_CONTACT_ID</td>
<td>Contact person identifier. This ID value may be available on the customer documentation or it can be retrieved from the application for use.</td>
</tr>
<tr>
<td>Contact Job Title</td>
<td>SVCMCA_CONTACT_JOB_TITLE</td>
<td>Contact’s job title.</td>
</tr>
<tr>
<td>Contact Last Name</td>
<td>SVCMCA_CONTACT_LAST_NAME</td>
<td>Contact’s last name.</td>
</tr>
<tr>
<td>Contact Name</td>
<td>SVCMCA_CONTACT_NAME</td>
<td>Contact name. Obtained from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Contact Organization ID</td>
<td>SVCMCA_CONTACT_ORG_ID</td>
<td>Contact’s primary organization ID.</td>
</tr>
<tr>
<td>Contact Organization Name</td>
<td>SVCMCA_CONTACT_PRIM_ORG_NAME</td>
<td>Contact’s primary organization name.</td>
</tr>
<tr>
<td>Contact Phone Number</td>
<td>SVCMCA_CONTACT_PRIMARY_PHONE</td>
<td>Contact’s primary phone number.</td>
</tr>
<tr>
<td>Display Name</td>
<td>SVCMCA_DISPLAY_NAME</td>
<td>Contact name or other identifying contact information to be displayed in supplier toolbars.</td>
</tr>
<tr>
<td>Email</td>
<td>SVCMCA_EMAIL</td>
<td>Contact email. Can be obtained from IVR or from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Interaction identifier</td>
<td>SVCMCA_INTERACTION_ID</td>
<td>Interaction identifier. Obtained from the application for use. Can be sent from the application using the APIs to prevent creating duplicate interactions.</td>
</tr>
<tr>
<td>Interaction Notes</td>
<td>SVCMCA_WRAPUP_INTERACTION_NOTES</td>
<td>Notes of the Interaction</td>
</tr>
<tr>
<td>Lead ID</td>
<td>SVCMCA_LEAD_ID</td>
<td>Lead Id. Can be obtained from IVR system or from FA module and reused subsequently.</td>
</tr>
<tr>
<td>Lead Name</td>
<td>SVCMCA_LEAD_NAME</td>
<td>Lead name. Usually, will be obtained from FA module and reused subsequently.</td>
</tr>
<tr>
<td>Data Token Name</td>
<td>Token Code</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Loyalty Member ID</td>
<td>SVCMCA_LOYALTY_MEMBER_ID</td>
<td>Loyalty Member Identifier</td>
</tr>
<tr>
<td>Loyalty Member Name</td>
<td>SVCMCA_LOYALTY_MEMBER_NAME</td>
<td>Loyalty Member Name</td>
</tr>
<tr>
<td>Loyalty Member Number</td>
<td>SVCMCA_LOYALTY_MEMBER_NUMBER</td>
<td>Loyalty Member Number</td>
</tr>
<tr>
<td>Mobile Phone Area Code</td>
<td>SVCMCA_MOBILE_AREA</td>
<td>Mobile Phone Area Code. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Mobile Phone Country Code</td>
<td>SVCMCA_MOBILE_CC</td>
<td>Mobile Phone Country Code. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Mobile Phone Local Number</td>
<td>SVCMCA_MOBILE_LOCAL</td>
<td>Mobile Phone Local Number. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Object ID List</td>
<td>SVCMCA_OBJ_ID_LIST</td>
<td>Object Id List for filtered display of specific objects.</td>
</tr>
<tr>
<td>Opportunity ID</td>
<td>SVCMCA_OPPORTUNITY_ID</td>
<td>Opportunity Id. Can be obtained from IVR system or from FA module and reused subsequently.</td>
</tr>
<tr>
<td>Opportunity Name</td>
<td>SVCMCA_OPPORTUNITY_NAME</td>
<td>Opportunity name. Usually, will be obtained from FA module and reused subsequently.</td>
</tr>
<tr>
<td>Organization ID</td>
<td>SVCMCA_ORG_ID</td>
<td>Account or organization ID. The ID may be available on the customer documentation. The ID can be identified by Interactive Voice Response (IVR) or can be retrieved from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Organization Name</td>
<td>SVCMCA_ORG_NAME</td>
<td>Account name. Obtained from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Phone Area Code</td>
<td>SVCMCA_PHONE_AREA</td>
<td>Work Phone Area Code. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Phone Country Code</td>
<td>SVCMCA_PHONE_CC</td>
<td>Work Phone Country Code. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Phone Extension</td>
<td>SVCMCA_PHONE_EXT</td>
<td>Work Phone Extension. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Data Token Name</td>
<td>Token Code</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Phone Local Number</td>
<td>SVCMCA_PHONE_LOCAL</td>
<td>Work Phone Local Number. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>SVCMCA_ANI</td>
<td>Automatic Number Identification value sent from telephony provider.</td>
</tr>
<tr>
<td>Resolution Code</td>
<td>SVCMCA_WRAPUP_RESOLUTION_CODE</td>
<td>Resolution Code of the Interaction</td>
</tr>
<tr>
<td>Service Request Identifier</td>
<td>SVCMCA_SR_ID</td>
<td>Service request identifier. Obtained from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Service request Number</td>
<td>SVCMCA_SR_NUM</td>
<td>Service request number to be passed whenever the number is available.</td>
</tr>
<tr>
<td>Service Request Title</td>
<td>SVCMCA_SR_TITLE</td>
<td>Service request title. Obtained from the application for use.</td>
</tr>
<tr>
<td>Task ID</td>
<td>SVCMCA_TASK_ID</td>
<td>Task ID.</td>
</tr>
<tr>
<td>Transfer Reason</td>
<td>SVCMCA_WRAPUP_TRANSFER_REASON</td>
<td>Transfer Reason of the Interaction</td>
</tr>
<tr>
<td>Universal Work Object Identifier</td>
<td>SVCMCA_UWO_ID</td>
<td>Specifies the universal work object identifier.</td>
</tr>
<tr>
<td>Work Order Id</td>
<td>SVCMCA_WORK_ORDER_ID</td>
<td>Work Order Identifier.</td>
</tr>
<tr>
<td>Work Order Number</td>
<td>SVCMCA_WORK_ORDER_NUM</td>
<td>Work Order Number.</td>
</tr>
</tbody>
</table>

The following table lists the data tokens for HR HelpDesk use.

<table>
<thead>
<tr>
<th>Data Token Name</th>
<th>Token Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Email</td>
<td>SVCMCA_PER_EMAIL</td>
<td>Person Email address</td>
</tr>
<tr>
<td>Person Id</td>
<td>SVCMCA_PER_PERSON_ID</td>
<td>Person Unique Identifier</td>
</tr>
<tr>
<td>Person List Name</td>
<td>SVCMCA_PER_LIST_NAME</td>
<td>Person last name, first name</td>
</tr>
<tr>
<td>Person Name</td>
<td>SVCMCA_PER_NAME</td>
<td>Person display name</td>
</tr>
<tr>
<td>Person National Id Number</td>
<td>SVCMCA_PER_NAT_ID_NUM</td>
<td>Person's National Id Number</td>
</tr>
<tr>
<td>Person Number</td>
<td>SVCMCA_PER_NUMBER</td>
<td>Person Number</td>
</tr>
</tbody>
</table>
The following table lists the control tokens.

<table>
<thead>
<tr>
<th>Control Token Name</th>
<th>Token Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent interaction identifier</td>
<td>SVCMCA_PARENT_INTERACTION_ID</td>
<td>Parent interaction identifier in the case of a transfer. Expected to be sent along a new communication event data of the second call.</td>
</tr>
<tr>
<td>Secondary Call Type</td>
<td>SVCMCA_2NDARY_CALL_TYPE</td>
<td>A type of secondary party call, which can be one of Transfer, Conference, and Consult. This value must be sent by the toolbar on a new communication event when transferring to the second agent.</td>
</tr>
<tr>
<td>Skip customer identification step</td>
<td>SVCMCA_BYPASS_IDENTIFY_CONTACT</td>
<td>Skips automatic customer identification upon receiving an inbound interaction. This token can be used with the startCommEvent() call.</td>
</tr>
<tr>
<td>Skip customer verification step</td>
<td>SVCMCA_BYPASS_CUSTOMER_VERIFICATION</td>
<td>Skips automatic customer verification screen to be made available to the agent. This token can be used with the startCommEvent() call.</td>
</tr>
<tr>
<td>Skip Reverse Lookup</td>
<td>SVCMCA_BYPASS_REVERSE_LOOKUP</td>
<td>Skip automatic reverse lookup of contact.</td>
</tr>
<tr>
<td>Skip the auto screen pop engine</td>
<td>SVCMCA_BYPASS_AUTO_SCREEN_POP</td>
<td>Skips the automatic run of screen pop engine upon accepting the interaction by the agent. This token can be used with the startCommEvent() call.</td>
</tr>
<tr>
<td>Timeout</td>
<td>SVCMCA_WRAPUP_TIMEOUT</td>
<td>Specify the time, in seconds, before the Wrap Up window is automatically closed, by adding the following pair to this parameter: SVCMCA_WRAPUP_TIMEOUT, #OFSECONDS. Replace the #OFSECONDS value with the actual number of seconds before the wrap up is automatically closed. This token can be used with the newCommEvent() call.</td>
</tr>
</tbody>
</table>
System Pages

The following table lists the pages that are available for screen pop. Use the page codes with the invokeScreenPop() method to open a screen pop page. For more information about the method, see "Interaction API."

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Page Code</th>
<th>What does it do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Account</td>
<td>Create_Account</td>
<td>Accepts details of an account.</td>
</tr>
<tr>
<td>Create Contact</td>
<td>Create_Contact</td>
<td>Accepts details of a contact.</td>
</tr>
<tr>
<td>Create Lead</td>
<td>Create_Lead</td>
<td>Accepts details for a lead.</td>
</tr>
<tr>
<td>Create Opportunity</td>
<td>Create_Opportunity</td>
<td>Accepts details for an opportunity.</td>
</tr>
<tr>
<td>Create Service Request</td>
<td>Create_Service_Request</td>
<td>Accepts details of a service request.</td>
</tr>
<tr>
<td>Create Work Order</td>
<td>Create_Work_Order</td>
<td>Accepts details of a work order.</td>
</tr>
<tr>
<td>Edit Account</td>
<td>Edit_Account</td>
<td>Displays the details of an account or organization information. The displayed page information can be changed based on the rights associated with agent role.</td>
</tr>
<tr>
<td>Edit Asset</td>
<td>Edit_Asset</td>
<td>Displays details of an asset.</td>
</tr>
<tr>
<td>Edit Contact</td>
<td>Edit_Contact</td>
<td>Displays details of a contact or customer information. The displayed information can be changed based on the rights associated with agent role.</td>
</tr>
<tr>
<td>Edit Contact - Leads</td>
<td>Edit_Contact_Leads_Tab</td>
<td>Displays details of a lead for a given contact or customer.</td>
</tr>
<tr>
<td>Edit Contact - Opportunities</td>
<td>Edit_Contact_Opportunities</td>
<td>Displays details of an opportunity for a given contact or customer.</td>
</tr>
<tr>
<td>Edit Contact - Service Requests</td>
<td>Edit_Contact_Service_Requests</td>
<td>Displays details of a service request for a given contact or customer.</td>
</tr>
<tr>
<td>Edit Lead</td>
<td>Edit_Lead</td>
<td>Displays details of a lead.</td>
</tr>
<tr>
<td>Edit Loyalty Member</td>
<td>Edit_Loyalty_Member</td>
<td>Displays details of a Loyalty member.</td>
</tr>
<tr>
<td>Page Name</td>
<td>Page Code</td>
<td>What does it do</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Edit Service Request</td>
<td>Edit_Service_Request</td>
<td>Shows details of a service request. Page information can be edited according with the rights associated with agent role.</td>
</tr>
<tr>
<td>Edit Service Request - Work Order</td>
<td>Edit_Work_Order_From_SR</td>
<td>Shows details of a work order for a given service request.</td>
</tr>
<tr>
<td>Edit Work Order</td>
<td>Edit_Work_Order</td>
<td>Shows details of a work order.</td>
</tr>
<tr>
<td>Opportunity List</td>
<td>Opportunity_List</td>
<td>Shows details of an opportunity.</td>
</tr>
<tr>
<td>Service Request List</td>
<td>Service_Request_List</td>
<td>Shows details of a service request.</td>
</tr>
<tr>
<td>Work Order List</td>
<td>Work_Order_List</td>
<td>Shows details of a work order.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Overview of Interaction APIs

**System Business Objects**

The following table lists the business objects.

<table>
<thead>
<tr>
<th>What would you like to do?</th>
<th>How to do it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Describe account or organization information.</td>
<td>Select Account</td>
</tr>
<tr>
<td>Describe activity information</td>
<td>Select Activity</td>
</tr>
<tr>
<td>Describe asset information.</td>
<td>Select Asset</td>
</tr>
<tr>
<td>Describe the contact or customer information.</td>
<td>Select Contact</td>
</tr>
<tr>
<td>Describe lead information.</td>
<td>Select Lead</td>
</tr>
<tr>
<td>Describe loyalty member information.</td>
<td>Select Member</td>
</tr>
</tbody>
</table>
### Channels Code

Channels are configured using the Functional Setup Manager within Oracle Service Center. The following table lists the channel codes:

<table>
<thead>
<tr>
<th>Channel Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHONE</td>
<td>Phone channel.</td>
</tr>
<tr>
<td>EMAIL</td>
<td>Email channel.</td>
</tr>
</tbody>
</table>

### Application Classification Code

The following table lists the ready-to-use application classification codes that the application recognizes. The list of application classifications can be modified using Functional Setup Manager.

<table>
<thead>
<tr>
<th>Application Classification Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_HRHD</td>
<td>Default classification for Human Resources Help Desk related setup for Lookup rules and Screen Pop rules.</td>
</tr>
<tr>
<td>ORA_SALES</td>
<td>Default classification for sales-related setup for Lookup rules and Screen Pop rules.</td>
</tr>
<tr>
<td>ORA_SERVICE</td>
<td>Default classification for service-related setup for Lookup rules and Screen Pop rules.</td>
</tr>
</tbody>
</table>
Channel Type Data

The following table lists the channel types, which are predefined lookups identified by the ORA_SVC_CHANNEL_TYPE_CD lookup type.

<table>
<thead>
<tr>
<th>Channel Code</th>
<th>What is it used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_SVC_EMAIL</td>
<td>E-mail channel</td>
</tr>
<tr>
<td>ORA_SVC_PHONE</td>
<td>Phone channel</td>
</tr>
<tr>
<td>ORA_SVC_SOCIAL</td>
<td>Social channel</td>
</tr>
<tr>
<td>ORA_SVC_WEB</td>
<td>Web channel</td>
</tr>
<tr>
<td>ORA_SVC_NONE</td>
<td>None</td>
</tr>
</tbody>
</table>

Configure Screen Pop Pages

Configure Business Objects

You can specify the business objects for reverse lookup and screen pop using business object configuration. This includes configuring a standard business object or a user business object.

A standard object is based on an out-of-the-box business object. A user business object is based on a user-defined business object that’s created using the Application Composer. For more information about creating user business objects using Application Composer, see the Oracle Applications Cloud Configuring Applications Using Application Composer guide.

To configure a business object:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Screen Pop Configuration

   The Screen Pop Configuration page is displayed.
2. Select the tab, Business Objects. The Manage Business Objects Configuration page is displayed.
3. View the business objects that are read only, and user objects that can be created, modified, and deleted.
Create a Standard User Business Object

A standard business object is based on a previously configured business object, such as Service or Queue. To create a standard business object:

1. Click the add icon.
2. Select object type as **Standard**.
3. Type a previously configured object name. For example, type **ServiceRequest**.
4. Specify the full object path.
   
   **Note:** The object path is the **Page Path** for the task flow. In commonly used pages, these are pre-seeded. However, if you create a new object, you must contact support to obtain your object path.
5. Click **Add**.
6. Click **Save** or **Save and Close**.

Create a User Business Object

To create a user business object, you must first create a user object in the application by using the Application Composer. Create the fields, pages, and security settings for the new object. For example, create an object called **SRTickets** in the Service application. For more information about creating a user business object, see Oracle Applications Cloud Configuring Applications Using Application Composer guide. To create a user business object:

1. Click the add icon.
2. Select object type as **User-Defined**.
3. Select the application in which you created an object. For example, select **Service** application.
4. Type the name of the user-defined object that you created and click **Validate**. For example, type **SRTickets**.
   
   If the object name is valid, the object full path is displayed.
5. Click **Add**.
6. Click **Save** or **Save and Close**.

Related Topics

- How You Configure the Media Toolbar
- Overview of Computer Telephony Integration (CTI)
- How You Configure Screen Pop Pages
- Configure Screen Pop Pages
- Update Existing Setup Data

How You Configure Screen Pop Pages

You can configure screen pop pages to display pages of information that can aid an agent to start a customer interaction efficiently. For example, you can configure a screen pop page to display information about an open ticket logged by the call-in customer.

You can create screen pop pages for ready-to-use standard business objects or for user-defined objects. To create screen pop for user-defined objects, you must first create the objects, define the fields, pages, and other elements using Application Composer. For more information about creating user-defined business objects using Application Composer, see Oracle Applications Cloud Configuring Applications Using Application Composer guide.
Configuring a screen pop page includes the following steps to be performed in Setup and Maintenance.

1. **Configure business objects.** These business objects are associated with standard or user-defined objects. Standard objects include ready-to-use objects, such as Service Requests or Queues, and the user-defined objects are created by the user.

2. **Create tokens.** Tokens are associated with the attributes of a business object. For example, you can create a token called `SVC_INVOICE_DATE` and associate it with the `Invoice_Date` field of the `Invoices` business object.

3. **Map pages.** Mapping associates a screen pop page with the pages of the underlying standard or user-defined object.

4. **Create rules.** Rules determine the page that's displayed when passing a token. Rules are defined in order of priority. For example, create rules that, if a service request number is available, display the service request page. If no service request number is available, but there is a contact identified, display the **Edit Contact** page. If no service request or contact information is available, display the **Create Contact** page.

The following figure illustrates the process of configuring screen pop pages:
Configure Screen Pop Pages

This topic describes how to configure screen pop pages.
Configuring a screen pop page includes the following steps:

1. Configuring a business object
2. Creating a token
3. Mapping a page
4. Defining rules

To configure a screen pop page:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Manage Screen Pop Configuration

   **Note:** You may have to select All Tasks from the Show drop down list to view this task.

The Screen Pop Configuration page is displayed.

Create a Business Object

Business object configuration enables you to specify the business objects that can be used for reverse lookup and for screen pop. You can configure a standard business object or a user business object. A standard object is based on a ready-to-use business object and a user business object is based on a user-defined business object that’s created using the Application Composer. For more information about creating user business objects using Application Composer, see Configuring Applications Using Application Composer guide.

A standard business object is based on a preconfigured business object, such as Service or Queue.

To view a standard business object:

1. Click the **Business Objects** tab.
   - Business Objects tab lists standard and user-defined business objects. The standard or the predefined objects cannot be modified or deleted.
2. Click the **Systems Objects** tab.
3. View the mapped system objects.
4. Click **Save** or **Save and Close**.

To create a user business object, you must first create a user object in the application by using the Application Composer. Create the fields, pages, and security settings for the new object. For example, create an object called SRTickets in the Service application. For more information about creating a user business object, see Configuring Applications Using Application Composer guide.

To create a user business object:

1. Click the **Business Objects** tab.
   - Business Objects tab lists standard and user-defined business objects. The standard or the predefined objects cannot be modified or deleted.
2. Click the **User Business Objects** tab.
3. Click the add icon.
4. Select object type as **User-Defined**.
5. Select the application in which you created an object. For example, select **Service** application.
6. Type the name of the user-defined object that you created and click **Validate**. For example, type **SRTickets**.
If the object name is valid, the object full path is displayed.

7. Click Add.
8. Click Save or Save and Close.

Create a Token

To create a token:

1. Click the Tokens tab.
   Tokens tab lists standard and user-defined tokens. The standard or the predefined tokens cannot be modified or deleted.
2. Click the User-Defined Tokens tab.
3. To add a token, click the add icon.
   A token consists of the following details:
   - **Name**: Any alphanumeric value that represents the token
   - **Token Code**: Unique code that's used to represent a token
   - **Description**: String to provide extra information about the token
   - **Object Name**: Business object to which the token is associated. Object Name is an optional value.
   - **Object Attribute**: Attribute of a business object that's associated with the token. Attribute is an optional value.
4. Specify the values for the token and click Save.

Map Screen Pop Page

After creating the token, map a screen pop page to an existing page of the associated business object.

1. On the Screen Pop Page Configuration page, click the Pages tab.
2. To create a page mapping, click the add icon.
3. Click the User Interface Type drop down list and select Application Development Framework.
4. Select a Standard or a User-Defined type.
5. Select an Object Name.
6. Enter a Page Name.
7. Enter a Page Title for the screen pop page. A title can contain a title prefix, the name of the token, and a title suffix. One of these values is mandatory.
8. If you have selected a User-Defined type of mapping, the Page Path is displayed automatically when you select the page. However, for a standard mapping, you must specify the page path. After specifying a page path, click Inspect to validate the page path and to list the page parameters.
9. In the Page Parameters Mapping section, associate required parameter with a token or a user-defined value.
   Based on the input that's passed to one or more page parameters, the information is displayed in the page. For example, based on the invoice number parameter, the invoice details screen is displayed.
10. Click Save.

The Show Only Used check box lists only those pages that are specified in a rule.

Define Screen Pop Rules

Screen pop configuration rules determine which set of rules must be applied when a screen pop logic is invoked. Different screen pop rules can be invoked based on a number of different variables, such as application classification and channel. Based on the input parameters, you can choose from a number of different pages to screen pop to the agent. For example, pages such as the Contact Edit, Account Edit, and Service Request edit pages can be displayed to
the customer. Additionally, you can choose to create an object, such as a service request. This framework also allows for user-defined objects to be presented to the agent as part of the screen pop process.

Define rules in order of priority to display a screen pop page, when an associated token value is available. If a rule in a higher priority isn’t satisfied, the next in the order is checked. To define rules:

1. On the **Screen Pop Page Configuration** page, click the **Rules** tab.
2. First, create a rule set. A rule set consists of one or more rules that are defined in an order of priority. To create a rule set:
   a. Click the add icon. You can also select **Duplicate** from the **Actions** menu to duplicate an existing rule set.
   b. Enter a **Rule Set Name**.
   c. Select an **Application Classification** to which the rule set belongs.
   d. Click the **User Interface Type** drop down list, and select either **Application Development Framework** or **Redwood** depending on your implementation.
   e. A rule set is **Active** by default. To deactivate a rule set, clear the **Active** option.
   f. Enter a description for the rule set.
3. Next, add rules to the rule set. To add rules:
   a. Click the add icon.
   b. The priority column displays the order of priority in which the rules are checked. You can change the priority by clicking up arrow and down arrow icons.
   c. A rule is enabled by default. Clear the **Enable** option to disable a rule.
   d. Select the communication channel to which the rule is applied. You can add or modify the channels list by modifying the associated lookup values.
4. Select a **Token** name.
5. Select a page to display, when a token value is available.
6. Click **Save**.
7. When you’re finished creating the rule sets, click **Done**.

**Related Topics**
- How You Configure Screen Pop Pages
- How You Configure the Media Toolbar
- Overview of Computer Telephony Integration (CTI)
- Update Existing Setup Data

### Create Lookup Filters

Lookup sets are grouped by application classification. They contain one or more lookup filters defined in an order of priority, and each lookup filter is associated with a token.

When customers make service calls, they provide information such as Customer ID, Date of Birth, and First Name through an Interactive Voice Response (IVR) tool. Customer details are extracted from the database based on the availability of the token value, starting from the token of highest priority.

Use this page to configure reverse lookups and lookup filters for channel driven interactions with customers. Order the filters by the priority in which the tokens are evaluated. To create a new lookup filter, you can duplicate an existing one and make modifications. To create a new lookup filter from scratch, perform the following steps:

1. On the **Screen Pop Page Configuration** page, click the **Lookup Filters** tab.
2. Click the Add icon to create a lookup set.
   a. Enter a name.
   b. Select an Application Classification from the drop-down list.
   c. Select the Active option to activate a lookup set.
   d. Enter a Description.

3. Add filters within the newly created lookup set. To add filters, click the add icon.
   a. Enter a name.
   b. Select the interaction channel from the Channels drop-down list. The filter is applied to the selected interaction channel.
   c. Select a Token from the drop-down list. When you select a token, the associated object name is displayed in the Object Name column.
   d. Add more filters if required.

   You can reorder the filters by clicking the up and down arrow icons. Alternatively, click the Actions drop-down list or select Move Up or Move Down option.

4. Click Save or Save and Close.

Related Topics
- How You Configure Screen Pop Pages
- How You Configure the Media Toolbar
- Overview of Computer Telephony Integration (CTI)
- Update Existing Setup Data

System Tokens

System tokens include the following tokens types.

- Data tokens: Represent data values in the Multichannel Application
- Control tokens: Control the flow of an interaction

The following table lists the data tokens.

<table>
<thead>
<tr>
<th>Data Token Name</th>
<th>Token Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Id</td>
<td>SVCMCA_ASSET_ID</td>
<td>Asset Identifier.</td>
</tr>
<tr>
<td>Asset Name</td>
<td>SVCMCA_ASSET_NAME</td>
<td>Asset Name.</td>
</tr>
<tr>
<td>Asset Number</td>
<td>SVCMCA_ASSET_NUM</td>
<td>Asset Number.</td>
</tr>
<tr>
<td>Channel Id</td>
<td>SVCMCA_CHANNEL_ID</td>
<td>Channel Identifier which is populated from Channel Name to be passed for page parameters.</td>
</tr>
<tr>
<td>Data Token Name</td>
<td>Token Code</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Communication direction</td>
<td>SVCMCA_COMMUNICATION_DIRECTION</td>
<td>Communication direction, which can either be inbound or outbound. Set the value to ORA_SVC_INBOUND for inbound and ORA_SVC_OUTBOUND for outbound direction. These values are defined in the ORA_SVC_IM_DIRECTION_CD Lookup Type.</td>
</tr>
<tr>
<td>Communication Reason</td>
<td>SVCMCA_WRAPUP_COMM_REASON</td>
<td>Communication Reason of the Interaction</td>
</tr>
<tr>
<td>Contact First Name</td>
<td>SVCMCA_CONTACT_FIRST_NAME</td>
<td>Contact’s first name.</td>
</tr>
<tr>
<td>Contact ID</td>
<td>SVCMCA_CONTACT_ID</td>
<td>Contact person identifier. This ID value may be available on the customer documentation or it can be retrieved from the application for use.</td>
</tr>
<tr>
<td>Contact Job Title</td>
<td>SVCMCA_CONTACT_JOB_TITLE</td>
<td>Contact’s job title.</td>
</tr>
<tr>
<td>Contact Last Name</td>
<td>SVCMCA_CONTACT_LAST_NAME</td>
<td>Contact’s last name.</td>
</tr>
<tr>
<td>Contact Name</td>
<td>SVCMCA_CONTACT_NAME</td>
<td>Contact name. Obtained from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Contact Organization ID</td>
<td>SVCMCA_CONTACT_ORG_ID</td>
<td>Contact’s primary organization ID.</td>
</tr>
<tr>
<td>Contact Organization Name</td>
<td>SVCMCA_CONTACT_PRIM_ORG_NAME</td>
<td>Contact’s primary organization name.</td>
</tr>
<tr>
<td>Contact Phone Number</td>
<td>SVCMCA_CONTACT_PRIMARY_PHONE</td>
<td>Contact’s primary phone number.</td>
</tr>
<tr>
<td>Display Name</td>
<td>SVCMCA_DISPLAY_NAME</td>
<td>Contact name or other identifying contact information to be displayed in supplier toolbars.</td>
</tr>
<tr>
<td>Email</td>
<td>SVCMCA_EMAIL</td>
<td>Contact email. Can be obtained from IVR or from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Interaction identifier</td>
<td>SVCMCA_INTERACTION_ID</td>
<td>Interaction identifier. Obtained from the application for use. Can be sent from the application using the APIs to prevent creating duplicate interactions.</td>
</tr>
<tr>
<td>Interaction Notes</td>
<td>SVCMCA_WRAPUP_INTERACTION_NOTES</td>
<td>Notes of the Interaction</td>
</tr>
<tr>
<td>Lead ID</td>
<td>SVCMCA_LEAD_ID</td>
<td>Lead Id. Can be obtained from IVR system or from FA module and reused subsequently.</td>
</tr>
<tr>
<td>Lead Name</td>
<td>SVCMCA_LEAD_NAME</td>
<td>Lead name. Usually, will be obtained from FA module and reused subsequently.</td>
</tr>
<tr>
<td>Data Token Name</td>
<td>Token Code</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Loyalty Member ID</td>
<td>SVCMCA_LOYALTY_MEMBER_ID</td>
<td>Loyalty Member Identifier</td>
</tr>
<tr>
<td>Loyalty Member Name</td>
<td>SVCMCA_LOYALTY_MEMBER_NAME</td>
<td>Loyalty Member Name</td>
</tr>
<tr>
<td>Loyalty Member Number</td>
<td>SVCMCA_LOYALTY_MEMBER_NUMBER</td>
<td>Loyalty Member Number</td>
</tr>
<tr>
<td>Mobile Phone Area Code</td>
<td>SVCMCA_MOBILE_AREA</td>
<td>Mobile Phone Area Code. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Mobile Phone Country Code</td>
<td>SVCMCA_MOBILE_CC</td>
<td>Mobile Phone Country Code. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Mobile Phone Local Number</td>
<td>SVCMCA_MOBILE_LOCAL</td>
<td>Mobile Phone Local Number. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Object ID List</td>
<td>SVCMCA_OBJ_ID_LIST</td>
<td>Object Id List for filtered display of specific objects.</td>
</tr>
<tr>
<td>Opportunity ID</td>
<td>SVCMCA_OPPORTUNITY_ID</td>
<td>Opportunity Id. Can be obtained from IVR system or from FA module and reused subsequently.</td>
</tr>
<tr>
<td>Opportunity Name</td>
<td>SVCMCA_OPPORTUNITY_NAME</td>
<td>Opportunity name. Usually, will be obtained from FA module and reused subsequently.</td>
</tr>
<tr>
<td>Organization ID</td>
<td>SVCMCA_ORG_ID</td>
<td>Account or organization ID. The ID may be available on the customer documentation. The ID can be identified by Interactive Voice Response (IVR) or can be retrieved from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Organization Name</td>
<td>SVCMCA_ORG_NAME</td>
<td>Account name. Obtained from Oracle Service Center for use.</td>
</tr>
<tr>
<td>Phone Area Code</td>
<td>SVCMCA_PHONE_AREA</td>
<td>Work Phone Area Code. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Phone Country Code</td>
<td>SVCMCA_PHONE_CC</td>
<td>Work Phone Country Code. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
<tr>
<td>Phone Extension</td>
<td>SVCMCA_PHONE_EXT</td>
<td>Work Phone Extension. Token value from the call data that can be passed to the contact picker when creating a contact.</td>
</tr>
</tbody>
</table>
### Data Token Name | Token Code | Description |
--- | --- | --- |
Phone Local Number | SVCMCA_PHONE_LOCAL | Work Phone Local Number. Token value from the call data that can be passed to the contact picker when creating a contact. |
Phone Number | SVCMCA_ANI | Automatic Number Identification value sent from telephony provider. |
Resolution Code | SVCMCA_WRAPUP_RESOLUTION_CODE | Resolution Code of the Interaction |
Service Request Identifier | SVCMCA_SR_ID | Service request identifier. Obtained from Oracle Service Center for use. |
Service request Number | SVCMCA_SR_NUM | Service request number to be passed whenever the number is available. |
Service Request Title | SVCMCA_SR_TITLE | Service request title. Obtained from the application for use. |
Task ID | SVCMCA_TASK_ID | Task ID. |
Transfer Reason | SVCMCA_WRAPUP_TRANSFER_REASON | Transfer Reason of the Interaction |
Universal Work Object Identifier | SVCMCA_UWO_ID | Specifies the universal work object identifier. |
Work Order Id | SVCMCA_WORK_ORDER_ID | Work Order Identifier. |
Work Order Number | SVCMCA_WORK_ORDER_NUM | Work Order Number. |

The following table lists the data tokens for HR HelpDesk use.

### Data Token Name | Token Code | Description |
--- | --- | --- |
Person Email | SVCMCA_PER_EMAIL | Person Email address |
Person Id | SVCMCA_PER_PERSON_ID | Person Unique Identifier |
Person List Name | SVCMCA_PER_LIST_NAME | Person last name, first name |
Person Name | SVCMCA_PER_NAME | Person display name |
Person National Id Number | SVCMCA_PER_NAT_ID_NUM | Person's National Id Number |
Person Number | SVCMCA_PER_NUMBER | Person Number |
### Data Token Name

<table>
<thead>
<tr>
<th>Data Token Name</th>
<th>Token Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Phone</td>
<td>SVCMCA_PER_PHONE</td>
<td>Person Phone number</td>
</tr>
</tbody>
</table>

The following table lists the control tokens.

### Control Token Name

<table>
<thead>
<tr>
<th>Control Token Name</th>
<th>Token Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent interaction identifier</td>
<td>SVCMCA_PARENT_INTERACTION_ID</td>
<td>Parent interaction identifier in the case of a transfer. Expected to be sent along a new communication event data of the second call.</td>
</tr>
<tr>
<td>Secondary Call Type</td>
<td>SVCMCA_2NDARY_CALL_TYPE</td>
<td>A type of secondary party call, which can be one of Transfer, Conference, and Consult. This value must be sent by the toolbar on a new communication event when transferring to the second agent.</td>
</tr>
<tr>
<td>Skip customer identification step</td>
<td>SVCMCA_BYPASS_IDENTIFY_CONTACT</td>
<td>Skips automatic customer identification upon receiving an inbound interaction. This token can be used with the <code>startCommEvent()</code> call.</td>
</tr>
<tr>
<td>Skip customer verification step</td>
<td>SVCMCA_BYPASS_CUSTOMER_VERIFICATION</td>
<td>Skips automatic customer verification screen to be made available to the agent. This token can be used with the <code>startCommEvent()</code> call.</td>
</tr>
<tr>
<td>Skip Reverse Lookup</td>
<td>SVCMCA_BYPASS_REVERSE_LOOKUP</td>
<td>Skip automatic reverse lookup of contact.</td>
</tr>
<tr>
<td>Skip the auto screen pop engine</td>
<td>SVCMCA_BYPASS_AUTO_SCREEN_POP</td>
<td>Skips the automatic run of screen pop engine upon accepting the interaction by the agent. This token can be used with the <code>startCommEvent()</code> call.</td>
</tr>
<tr>
<td>Timeout</td>
<td>SVCMCA_WRAPUP_TIMEOUT</td>
<td>Specify the time, in seconds, before the Wrap Up window is automatically closed, by adding the following pair to this parameter: SVCMCA_WRAPUP_TIMEOUT, #OFSECONDS. Replace the #OFSECONDS value with the actual number of seconds before the wrap up is automatically closed. This token can be used with the <code>newCommEvent()</code> call.</td>
</tr>
</tbody>
</table>
## System Pages

The following table lists the pages that are available for screen pop. Use the page codes with the invokeScreenPop() method to open a screen pop page. For more information about the method, see "Interaction API."

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Page Code</th>
<th>What does it do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Account</td>
<td>Create_Account</td>
<td>Accepts details of an account.</td>
</tr>
<tr>
<td>Create Contact</td>
<td>Create_Contact</td>
<td>Accepts details of a contact.</td>
</tr>
<tr>
<td>Create Lead</td>
<td>Create_Lead</td>
<td>Accepts details for a lead.</td>
</tr>
<tr>
<td>Create Opportunity</td>
<td>Create_Opportunity</td>
<td>Accepts details for an opportunity.</td>
</tr>
<tr>
<td>Create Service Request</td>
<td>Create_Service_Request</td>
<td>Accepts details of a service request.</td>
</tr>
<tr>
<td>Create Work Order</td>
<td>Create_Work_Order</td>
<td>Accepts details of a work order.</td>
</tr>
<tr>
<td>Edit Account</td>
<td>Edit_Account</td>
<td>Displays the details of an account or organization information. The displayed page information can be changed based on the rights associated with agent role.</td>
</tr>
<tr>
<td>Edit Asset</td>
<td>Edit_Asset</td>
<td>Displays details of an asset.</td>
</tr>
<tr>
<td>Edit Contact</td>
<td>Edit_Contact</td>
<td>Displays details of a contact or customer information. The displayed information can be changed based on the rights associated with agent role.</td>
</tr>
<tr>
<td>Edit Contact - Leads</td>
<td>Edit_Contact_Leads_Tab</td>
<td>Displays details of a lead for a given contact or customer.</td>
</tr>
<tr>
<td>Edit Contact - Opportunities</td>
<td>Edit_Contact_Opportunities</td>
<td>Displays details of an opportunity for a given contact or customer.</td>
</tr>
<tr>
<td>Edit Contact - Service Requests</td>
<td>Edit_Contact_Service_Requests</td>
<td>Displays details of a service request for a given contact or customer.</td>
</tr>
<tr>
<td>Edit Lead</td>
<td>Edit_Lead</td>
<td>Displays details of a lead.</td>
</tr>
<tr>
<td>Edit Loyalty Member</td>
<td>Edit_Loyalty_Member</td>
<td>Displays details of a Loyalty member.</td>
</tr>
</tbody>
</table>
### Page Name | Page Code | What does it do
--- | --- | ---
Edit Service Request | Edit_Service_Request | Shows details of a service request. Page information can be edited according with the rights associated with agent role.
Edit Service Request - Work Order | Edit_Work_Order_From_SR | Shows details of a work order for a given service request.
Edit Work Order | Edit_Work_Order | Shows details of a work order.
Opportunity List | Opportunity_List | Shows details of an opportunity.
Service Request List | Service_Request_List | Shows details of a service request.
Work Order List | Work_Order_List | Shows details of a work order.

**Related Topics**
- Overview of Interaction APIs

### System Business Objects
The following table lists the business objects.

<table>
<thead>
<tr>
<th>What would you like to do?</th>
<th>How to do it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Describe account or organization information.</td>
<td>Select Account</td>
</tr>
<tr>
<td>Describe activity information</td>
<td>Select Activity</td>
</tr>
<tr>
<td>Describe asset information.</td>
<td>Select Asset</td>
</tr>
<tr>
<td>Describe the contact or customer information.</td>
<td>Select Contact</td>
</tr>
<tr>
<td>Describe lead information.</td>
<td>Select Lead</td>
</tr>
<tr>
<td>Describe loyalty member information.</td>
<td>Select Member</td>
</tr>
</tbody>
</table>
## Channels Code

Channels are configured using the Functional Setup Manager within Oracle Service Center. The following table lists the channel codes:

<table>
<thead>
<tr>
<th>Channel Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHONE</td>
<td>Phone channel.</td>
</tr>
<tr>
<td>EMAIL</td>
<td>Email channel.</td>
</tr>
</tbody>
</table>

## Application Classification Code

The following table lists the ready-to-use application classification codes that the application recognizes. The list of application classifications can be modified using Functional Setup Manager.

<table>
<thead>
<tr>
<th>Application Classification Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_HRHD</td>
<td>Default classification for Human Resources Help Desk related setup for Lookup rules and Screen Pop rules.</td>
</tr>
<tr>
<td>ORA_SALES</td>
<td>Default classification for sales-related setup for Lookup rules and Screen Pop rules.</td>
</tr>
<tr>
<td>ORA_SERVICE</td>
<td>Default classification for service-related setup for Lookup rules and Screen Pop rules.</td>
</tr>
</tbody>
</table>
Error Messages

The following table lists the codes for error messages that are returned in case of an exception while running Oracle Service Center functionality in response to toolbar requests.

<table>
<thead>
<tr>
<th>Error Message Code</th>
<th>When is the error message returned?</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVCMCA_ERR_NOTIMPLEMENTED</td>
<td>Specified functionality isn’t implemented.</td>
</tr>
<tr>
<td>SVCMCA_ERR_MISSING_CONFIGURATION</td>
<td>Specified functionality is based on a configuration information that’s missing. For example, call for invokeScreenPop() method with a pageCode attribute that’s not present in screen pop pages configuration in Setup and Maintenance.</td>
</tr>
<tr>
<td>SVCMCA_ERR_INVALID_DIMENSIONS</td>
<td>Specified dimension of the toolbars is invalid.</td>
</tr>
<tr>
<td>SVCMCA_ERR_INVALID_CONFIGTYPE</td>
<td>Specified configuration is of an invalid type.</td>
</tr>
<tr>
<td>SVCMCA_ERR_UNKNOWN_METHOD</td>
<td>Unknown method invoked on the API.</td>
</tr>
</tbody>
</table>

Channel Type Data

The following table lists the channel types, which are predefined lookups identified by the ORA_SVC_CHANNEL_TYPE_CD lookup type.

<table>
<thead>
<tr>
<th>Channel Code</th>
<th>What is it used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_SVC_EMAIL</td>
<td>E-mail channel</td>
</tr>
<tr>
<td>ORA_SVC_PHONE</td>
<td>Phone channel</td>
</tr>
<tr>
<td>ORA_SVC_SOCIAL</td>
<td>Social channel</td>
</tr>
<tr>
<td>ORA_SVC_WEB</td>
<td>Web channel</td>
</tr>
<tr>
<td>ORA_SVC_NONE</td>
<td>None</td>
</tr>
</tbody>
</table>
Call Flow Parameter Settings

The call flow parameters determine the default and administrator-defined actions to be performed for a customer interaction. Customer interactions are calls with the customer in Digital Sales and calls in Service Center. Administrator-defined settings override the default settings.

You can specify the settings listed in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Required</td>
<td>Yes/No</td>
<td>Specifies whether the contact details of a customer must be displayed. Select <strong>No</strong>.</td>
</tr>
<tr>
<td>Contact Verification</td>
<td>Yes/No</td>
<td>Specifies whether the customer details must be verified at the beginning of the call. The default value is Yes, but select <strong>No</strong>.</td>
</tr>
<tr>
<td>Screen Pop</td>
<td>Yes/No</td>
<td>Specifies whether a screen pop page must be displayed. Select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>Wrap Up</td>
<td>Yes/No/Server Driven</td>
<td>Specifies whether a customer interaction requires wrap up. Select the <strong>Server Driven</strong> option to get notified by the toolbar if an interaction must be wrapped up.</td>
</tr>
</tbody>
</table>

**Note:**
For Digital Sales implementations, this setting must always be enabled.

Deactivate Contact Verification

Contact verification allows a user to verify a caller against records already set up in the database prior to the exchange of sensitive information. In Digital Sales however, most inbound calls are related to sales opportunities where, for instance, a new lead may be calling about an inquiry. Given that the majority of calls are of this type, call verification isn't required.

1. Sign in to Service Center as an administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Configure Call Flow Parameters
3. In the **Default Settings** work area, click the following drop-down lists, and change the value of both to **No**.
   - Contact Required
   - Contact Verification

4. Click **Save and Close**.

### Configure Call Flow Parameters

Here’s how you configure call flow parameters:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Functional Area: Communication Channels
   - Task: Configure Call Flow Parameters

2. Specify default settings for all interaction channels in the **Default Settings** section.

3. In the **Administrator-Defined Settings** section, specify the settings for the individual interaction channels. These settings override the default settings. For example, the default setting is to verify the contact.

4. Click **Save and Close**.

### Related Topics
- How You Configure Screen Pop Pages
- Update Existing Setup Data

### Configure Wrap Up

### Populate Wrap Up Parameters Automatically

You can now receive wrap up data including standard attributes as well as user-defined attributes from the toolbar. You must expose these in the Create Wrap Up page to pre-populate these fields for the agent.

This topic describes how to configure a wrap up screen pop page. Configuring a wrap up screen pop page includes the following steps:

1. Creating a token
2. Mapping a page
3. Defining rules

To configure a wrap up screen pop page:

1. Sign in to Oracle Cloud applications as a Service Administrator.
2. Navigate to **Setup and Maintenance**.
3. Click the **Setup** drop-down list and select **Service**.
4. Select the **Communication Channels** functional area, and then select **Manage Screen Pop Configuration** task.
The Screen Pop Configuration page is displayed.

Create a Wrap Up Token

To create a wrap up token:

1. Click the **Tokens** tab.
   
   Tokens tab lists standard and user-defined tokens. The standard or the predefined tokens cannot be modified or deleted.

2. Click the **User-Defined Tokens** tab.

3. To add a token, click the add icon.

   A token consists of the following details:

   - **Name**: Any alphanumeric value that represents the token
   - **Token Code**: Unique code that's used to represent a token
   - **Description**: String to provide extra information about the token
   - **Object Name**: Business object to which the token is associated. Select Wrap Up from the drop-down list.
   - **Object Attribute**: Attribute of the wrap up business object that's associated with the token. Object Attribute is an optional value.

4. Specify the values for the token and click **Save**.

**Related Topics**

- Overview of Sandboxes
- Create and Activate Sandboxes
- Publish Sandboxes
14 Interactions

Overview of Interactions

An interaction is recorded when a communication occurs with customer contacts by means of any communication channel such as email, or phone.

Web isn't a ready-to-use supported channel for Interactions. Currently, there is limited support for custom objects and channels.

Interactions help you track inbound and outbound communications with your users across any channel. An interaction is typically created for each outbound and inbound communication. An outbound communication is initiated by a company employee such as a salesperson by a phone call, or marketing manager by means of an email. An inbound communication is initiated by a prospect or contact by means of inbound phone call or email.

An interaction tracks whether a communication happened, the channel used for communicating, and any associated business objects that were created or edited during that communication. You can use the Interaction History view to access past wrap up records.

Interactions help track the following ready to use attributes:

- Contact
- Account
- Channel
- Start Time
- End Time
- Resource
- Duration
- Direction
- Associated Business Objects
- Parent Interactions

An interaction can be associated to the following objects:

- Account
- Contact
- Service Request
- Activity
- Work Order
- Lead
- Opportunity
In the Fusion Service Classic UI, the interaction history view subtab displays for the following objects by default: Service Request, Account, and Contact objects.

You can enable the Lead and the Opportunity object to display in the Interaction History subtab using Application Composer. The Digital Sales guide has details.

The View Interactions privilege (SVC_VIEW_INTERACTIONS_PRIV) is required for users to view interactions. This privilege is available by default to the Sales and Service Representative, Manager and Administrator roles.

To display the Service Request and Interactions History subtabs under the Account and Contact details pages, the implementation status of the Service offering must be Implemented.

If you need to check your implementation status, here's how you do it:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
2. Click Actions > Edit Implementation Status.
3. In the Edit Implementation Status: Service dialog box, select the Implemented option.
4. Click Done.

Related Topics

- Configure Cross-Channel Interactions
- Overview of a Service Request Lifecycle
- How you View Interaction History for the Service Request

Configure Cross-Channel Interactions

Overview of Cross-Channel Interactions

Cross-channel interactions enable the administrators to track and manage inbound and outbound interactions that cross from one channel to another.

The administrator can also identify and associate the business objects that have been edited or created during this communication, and configure the business objects that are available for association with the interaction model. The administrator can also turn on cross channel interaction tracking for service requests.

Note: For cross channel connections to function properly, the account, contact, and resource must be a match with the associated record. For example, if you have a service request where the primary contact isn't the same as the person on the phone, the record won't connect through interactions.

Configure Cross-Channel Interactions

This topic describes how to set up and configure cross-channel interactions.
The **Manage Setup and Configuration for Cross-Channel Interactions** page provides the administrator with a single page to associate business objects, setup all the associated profile options pertaining to cross-channel interactions, and set the date and time periods that qualify objects for automatic association to an interaction.

To set up and configure for cross-channel interactions, do the following:

1. In the Setup and Maintenance work area, select the **Tasks** icon.
2. Search for the following string:
   Manage Setup and Configuration for Cross-Channel Interactions
3. Click the **Manage Setup and Configuration for Cross-Channel Interactions** link.
4. The **Enable Automatic Association of Objects with Interactions** field is selected as **Yes** by default. This enables automatic association of the objects with interactions. When you select **No**, business objects aren’t associated with interactions automatically.
5. Select the period, in minutes, to go back from the current time while finding a potential interaction based on the creation date in the **Search Retrieval Range Prior to the Creation Time** field. The default time is set to 5 minutes. You can set the time between 1 minute and 120 minutes. If the **Enable automatic association option** is set to **No**, setting the time here is irrelevant.
6. Select the period, in minutes, to go back from the current time while finding a potential interaction based on last updated date in the **Search Retrieval Range Prior to the Last Update Time** field. The default time is set to 5 minutes. You can set the time between 1 minute and 120 minutes. As with the previous setting, if the **Enable automatic association option** is set to **No**, setting the time here is irrelevant.

   **Note:** When you set both the periods **Search Retrieval Range Prior to the Creation Time** and **Search Retrieval Range Prior to the Last Update Time**, then a query is run and an association is made for one or both the periods based on the match.

   **CAUTION:** Once you start an interaction, it’s bound by the time settings you have configured. In other words, if you’ve set the interaction time period to be five minutes and the call lasts ten minutes, the last five minutes of the interaction will not be recorded.

7. In the **Automatically Associated Objects** section, you can configure whether to automatically associate service requests with interactions. These are set to **Yes** by default.

   Out of the box, you can select the objects shown in the table in the Cross-Channel Options topic which follows this topic.
8. Click **Save** or **Save and Close**.

### Cross-Channel Options

The following table describes the types of cross-channel options that you can configure.

<table>
<thead>
<tr>
<th>Cross-channel Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_INTERACTION_AUTO_ASSOCIATION_ENABLE</td>
<td>Enables automatic association of objects to an interaction. It is set to Off by default.</td>
</tr>
<tr>
<td>Cross-channel Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>During bulk importing of data, enabling this option to Yes may result in associating multiple objects to the open interactions. This results in a large number of imported CRM objects getting associated with a single interaction, and leads to distorted data. To avoid this situation, the option may be set to N.</td>
</tr>
<tr>
<td>SVC_INTERACTION_CREATION_DATE_</td>
<td>Sets the period, in minutes, to go back from the current time while finding a potential interaction based on creation date.</td>
</tr>
<tr>
<td>INTERVAL_FOR_AUTO_ASSOCIATION</td>
<td></td>
</tr>
<tr>
<td>SVC_INTERACTION_LAST_UPD_DATE_</td>
<td>Sets the period, in minutes, to go back from the current time while finding a potential interaction based on last updated date.</td>
</tr>
<tr>
<td>INTERVAL_FOR_AUTO_ASSOCIATION</td>
<td></td>
</tr>
<tr>
<td>SVC_INTERACTION_ENABLED_OBJECTS -</td>
<td>For Service Requests, set this to the value SVC_SERVICE_REQUESTS.</td>
</tr>
<tr>
<td>(for service request)</td>
<td>For Activities, set this to the value ZMM_ACTIVITIES.</td>
</tr>
<tr>
<td></td>
<td>For Opportunities, set this to the value MOO_OPTY.</td>
</tr>
<tr>
<td></td>
<td>For Work Orders, set this to the value SVC_WORK_ORDERS.</td>
</tr>
<tr>
<td></td>
<td>For Leads, set this to the value MKL_LM_LEADS.</td>
</tr>
</tbody>
</table>
15 Action Plans

Set Up Action Plans

Overview of Action Plans

Action plans are used to complete a series of steps or a sequence of events to resolve different types of requests. You can associate action plans to if you need to complete a series of steps or a sequence of events to resolve the .

You can attach action plans to a using an administrator-defined template, or by adding individual actions. Actions can be required or optional tasks, activities, or appointments.

You can add Action Plans to the following objects:

- Internal Help Desk Requests
- HR Help Desk Requests

Agents can add either solo actions, or action plans. Actions can be required or optional tasks, activities, or appointments.

- **Solo Actions** are individual actions added to an object.
- **Action Plans** are added from an administrator-defined template. Action plans are made up of multiple actions.

By using actions and plans, users have:

- A visual aid to see the progress of a solo action or an action plan
- Any warnings on actions or plans

To use the Action Plans feature, set up actions, templates, and categories in Setup and Maintenance.

In Setup and Maintenance, navigate to > Action Plan. If Action Plan isn't displayed, use the **Change Feature Opt In** to activate Action Plans.

The following table shows the name and description of each action plan setup task.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Action Plan Profile Options</td>
<td>Manage profile options for the Action Plans feature.</td>
<td>Yes</td>
</tr>
<tr>
<td>Manage Action Plan Actions</td>
<td>Create actions that can be used for solo actions or in action templates. You can specify the category, type, duration, and visibility for each action.</td>
<td>Yes</td>
</tr>
<tr>
<td>Manage Action Plan Templates</td>
<td>Create templates to group similar actions to be added to an action plan.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Manage Action Categories for Action Plans

Action categories are used to facilitate finding actions to add to templates or directly to an action plan.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Action Categories for Action Plans</td>
<td>Action categories are used to facilitate finding actions to add to templates or directly to an action plan.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Manage Template Categories for Action Plans

Template categories are used by agents to filter and find templates to apply to an action plan.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Template Categories for Action Plans</td>
<td>Template categories are used by agents to filter and find templates to apply to an action plan.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Manage Mapping of Action Plan Status Values

Manage the global setup for status configuration.

You can map task, appointment, or request attributes to an action status at a global level. Action status mapping can also be done at the individual action level.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Mapping of Action Plan Status Values</td>
<td>Manage the global setup for status configuration. You can map task, appointment, or request attributes to an action status at a global level. Action status mapping can also be done at the individual action level.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Related Topics
- Manage Action Plan Actions
- Manage Action Plan Templates
- Map Action Plan Status Values

### Manage Action Plan Profile Options

The following are the available action plan profile options and their descriptions.

Manage the Action Plan profile options in Setup and Maintenance. Navigate to:

- Offering:
  - Functional Area: Action Plans
  - Task: Manage Action Plan Profile Options

The following table shows the action plan profile options and their descriptions.

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_ENABLE_ACTION_PLAN</td>
<td>Specify if Action Plan is enabled for.</td>
</tr>
<tr>
<td>SVC_ENABLE_SUBSCRIPTION_SCHEDULES_IN_ACTION_PLANS</td>
<td>Enable calculation for action plan estimated completion times based on schedules defined in Subscription Cloud.</td>
</tr>
</tbody>
</table>
### Manage Relationships for Action Plans

Action plans can have relationships to other objects. For example, an action can be blocked by another object, or a duplicate of another object.

#### About Relationships

Agents can create business-driven relationships between and leverage them to make updates across SRs. You must enable this feature in Functional Setup Manager.
Enable Relationships

To enable the Relationships feature:

In the Setup and Maintenance work area go to the following:

- Offering: Service
- Functional Area: Action Plans
- Task: Manage Action Plan Profile Options

1. Select the profile value `ORA_SVC_AP_ENABLE_OBJECT_LINK`.
2. In the drop-down list of the value, select Yes.
3. Click Save and Close.

Now, you can set the type of object link that's used for the relationship. For example, blocked, or duplicate.

1. Click the profile value `ORA_SVC_AP_DEFAULT_OBJECT_LINK_TYPE`.
2. Select the relationship type from the Profile Value drop-down list.
3. Click the Add (+) icon to continue adding the relationship types you want to use.
4. When you have finished, click Save and Close.
5. Click Done.

Manage Link Types

You can manage link types in the Manage Object Link Types task.

In the Setup and Maintenance work area go to the following:

- Offering: Service
- Functional Area: Service Request
- Task: Manage Object Link Types

To edit or disable the predefined object link type:

1. Click the link type in the list.
2. Make your changes. To disable, deselect the disable check box.
3. Click Save and Close.

To create a link type:

1. Click Create Link Type.
2. Enter all the required information:
   - Name
   - Short Name
   - Outward Value
   - Inward Value
3. Select the check box to enable the type.
4. Click Save and Close.
Manage Action Plan Actions

Use the Manage Action Plan Actions task to create and edit actions for action templates or individual actions used in . In this task, you specify the category, type, duration, visibility, and attribute mappings for each action.

To manage action plan actions, in the Setup and Maintenance work area go to the following:

Create a New Action

Here's how to create a new action:

1. Click **Create Action**.
2. Enter the action name.
3. If you enabled business units or stripe codes, use the drop down lists to select the stripe code and BU.
4. Select **Category**.
   Select **Class**.
5. Select the **Action Type**.
   Depending on the features you're using, Action types can include:
   - Appointment
   - Article
   - Case
   - Dynamic Process
   - HR Help Desk Request
   - Internal Service Request
   - Task

   **Note:** You can create an Action of type Article. You must select Stripe Code of the action and then select Sub Type of the action. Attribute mapping section needs to be populated as it's required for any other type of actions.

   - Also, the administrator must be added to the Process Application Administrator role in the process workspace UI so they can see all processes.
6. Click the **Edit** icon in the **Process Name** field.
7. Search for and select the process you want to add to the action.
   Processes must already be created in Oracle Process Cloud and your connections to Oracle Process Cloud must be working.

   **Note:** When you create processes, you must define the following case-sensitive input parameters - objectName, objectType, actionPlanId, actionPlanActionId, and processParentObjectType when configuring dynamic processes. For Solo Actions, input parameter processParentObjectType will have value ‘ActionPlan’ while for Plan based actions it will have ‘ActionPlanAction’.
8. Click OK.
9. Select to use the default version of the process, if you want to use the default process version instead of the version specific process.

**CAUTION:** Once a process is deployed, overriding it will remove all running instances. Oracle recommends that you create a new version for additional changes and mark it as default, if it’s required. An action which has **Use default version** selected will ensure that only the version which is default in Oracle Process Automation is used to create process instances. For processes whose inputs are form based, make sure the interface argument is the same.

10. Select the **Action Visibility**.

Visibility options include:

- Not Published - Only visible to the administrator. The action isn't available to add to a template and can't be added by an agent as an additional action.
- Customer Visible - Optional. Used only for user interface configurations to display or hide Actions.
- Internal Only - Visible internally only.

11. Enter a context for the action.

Context options include:

- Internal Help Desk Request
- HR Help Desk Request
- Case

12. Enter a numeric value for the **Duration** of how long the task should take. Select a unit of measure for the numeric value (days, hours, or minutes).
13. Select a **Stripe Code** from the drop down list.
14. Select a **Category** from the drop down list.
15. You can define a specific relationship to be created for the action by selecting an **Object Link Type** from the drop down list. If you don't select a specific object link type, the global setting is used.
16. Enter a description of the action and any pertinent details.
17. If necessary, make edits on the **Attribute Mapping** or **Status Mapping** tabs. These are explained next.
18. Click **Save and Close**.

**Attribute Mapping Tab**

Every action in an action plan has a related object (as in a task, appointment, opportunity, case, or request) that's automatically created when the action starts.

The attribute mapping tab is where you setup the mapping of information from the action, parent, and user-defined values into the related object when it's created.

**Note:** There are no attributes to map for Dynamic Processes. If you're creating a Dynamic Process Action, there isn't anything to do on this tab.

Mapped attributes come from the fields in the related object. Required attributes are automatically listed, and you can add optional attributes. The **Mapped To** columns show where the information comes from that populates the field on the related object.
CAUTION: If you map attributes incorrectly, the creation of the business objects during orchestration in Action Plans will fail.

Mandatory fields are shown in the Required column. Additional fields may also be listed that can’t be changed. For example, Activity Type displays Task if that action type is Task or defaults to Appointment if the action type is Appointment.

Here’s how you add an attribute mapping:

1. Click the Add icon.
2. Select the field to be populated from the Attribute choice list.
3. In the Mapped To column, select from where the fields must be populated. Choices are: service request, action, or a user-defined value.
4. Depending on the attribute you selected in the previous step, enter free-form text to the box for free-form values. For service request or action, select the field from the choice list in the last column.

For more information about mappings for an article, see the topic Attribute Mappings for Knowledge Articles in this chapter.

Status Mapping Tab

The related business objects created for actions can have different user-defined status values. However, they must be mapped into a new set of status codes for an action in an action plan. You can do this at a global level for all actions, or individually for one action if it has unique attributes. When a user updates an object, the status mapping rules determine how the status of an action updates on an action plan. For example, when a task is set to closed or completed, then the action status is completed.

Note: If you don’t define the status mapping at the action level, then the default is the global status mapping. Also, there are no statuses to map for Dynamic Processes. If you’re creating a Dynamic Process Action, there isn’t anything to do on this tab. There are however, predefined status value mapping that can’t be changed.

For more information about the global action status configuration, see the topic Manage Mapping of Action Plan Status Values.

The following table shows the predefined Process Automation status values that are mapped with Action Plan status values.

<table>
<thead>
<tr>
<th>Process State</th>
<th>Action Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>ORA_SVC_IN_PROCESS</td>
</tr>
<tr>
<td>Completed</td>
<td>ORA_SVC_COMPLETED</td>
</tr>
<tr>
<td>Terminated</td>
<td>ORA_SVC_COMPLETED</td>
</tr>
<tr>
<td>Closed</td>
<td>ORA_SVC_COMPLETED</td>
</tr>
</tbody>
</table>

For more information about the global action status configuration, see topic Manage Mapping of Action Plan Status Values.
You can use the **Status Mapping** tab on an action to override the global status mappings. For example, if the global rule is set to an action being closed when the status is complete, but instead you want it to be closed when it’s canceled, you can override the global mapping so that the action closes when both conditions are met.

1. Click the **Status Mapping** tab.
2. Click the **Add** icon.
3. Select a status from the **Status** choice list. This becomes the status that ends up on the action.

   Status options include:
   - Blocked
   - Completed
   - In progress

   **Note:** Apart from these three status values, you should not set up rules for any other status.

4. Select an attribute from the choice list.
5. Select an operator.

   Operators include:
   - Contains
   - Equals
   - Is null
   - Is not null

6. Select a value for the status.

**Example of a Status Mapping**

Let’s say you want an action to be marked completed when a service request’s status is completed or canceled. The following table shows the values to enter on the Status Mapping tab.

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Completed</td>
</tr>
<tr>
<td>This is the status you want the action to be.</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Status</td>
</tr>
<tr>
<td>This attribute comes from the SR.</td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>is one of</td>
</tr>
<tr>
<td>Value</td>
<td>Completed, Canceled</td>
</tr>
<tr>
<td>This is the request’s status. You can select multiple values from the list.</td>
<td></td>
</tr>
</tbody>
</table>
Dependencies Tab

When an action is added to a template, the Dependencies tab shows the template name. You use this to know what templates are impacted by a change to an action. If the action is in a template, you can also view and edit the template from this tab.

**Note:** Edits made to templates don’t affect active action plans that use the template.

Action Errors Tab

The Action Errors tab lets you recreate actions for users when there are errors in action attribute mapping. For example, if the attribute in an attribute mapping is mapped incorrectly, the Action Errors tab is displayed. From the tab, you can see all the action plans that the action is used in, and once fixed, the action plan actions can be recreated directly from this tab.

This tab isn’t used for Dynamic Process actions.

The Action Errors tab shows a table with the action plan number, action plan name, and the status details of the action.

Review the attribute mappings the action and correct the error. Once attribute mapping for the action is corrected, you can return to the Action Errors tab and click **Recreate**.

Edit an Existing Action

To edit an existing action:

1. In the Manage Action Plan Actions task, select the template you want to edit.
2. Edit the action.
3. Click **Save and Close**.

Related Topics

- Manage Action Plan Templates
- Map Action Plan Status Values
- Update Existing Setup Data

Manage Action Plan Templates

The Manage Action Plan Templates task is used to create or edit templates that include multiple actions that must be completed to close an SR.

In the Setup and Maintenance work area, go to the following:

- Offering: Service
- Functional Area: Action Plan
- Task: Manage Action Plan Templates
Create a New Action Plan Template

To create a new action plan template:

1. Click **Create Template**.
2. Enter a name for the template.
3. Select the type of business calendar for the duration and end dates of the actions.

   **Note:** The calendar comes from the list of schedules defined under Subscription Management in the Manage Availability page. For more information about calendars, see the Create a Coverage Schedule topic in this guide.

4. Enter a start date for the template.
5. Enter an end date for the template (optional).
6. Check **Published** to publish the template when it's ready for agents to use.
7. Enter a **Description**.
8. Select a **Category**. Categories are available only if you set them up in the Manage Action Categories for Action Plan task.
9. Select a **Context** from the list of values. Context values include:
   - Article
   - Case
   - HR Help Desk Request (If you're using the Help Desk offering)
   - Internal Service Request (If you're using the Help Desk offering)
   - Service Request
10. If business units are enabled, select the business unit for the template.
11. If stripe codes are enabled, select the stripe code for the template.
12. Select **Auto Start** to designate the action plan template to start automatically.

   Any Templates with this setting, once assigned using the Action Plan REST API, are started either on the next execution of the action plan scheduled job (Monitor Action Plan Actions), or a REST call to refresh the action plan.

   **Note:** You may need to create the action plan with **create_&_Initiate** status using the REST API. If you create it using just the Create status, it won't consider it for Auto Start on the REST scheduled job or refresh the REST action call.

13. Add actions to the template by clicking the **Add** icon in the **Action Flow** region of the page.
14. On the **Add Actions to Template** page, search for the action to add by entering a name, category, or action type.
15. Click **Search**.
16. From the search results, add an action by clicking the Add icon for the action you want to add.
17. Now, search and add all the actions you want to place on the template.

**Tip:**
- You may not see all actions. Actions can be limited by stripe and business unit.
- You can delete actions from the **Actions to Add** pane by clicking the delete icon.
- You can add the same action multiple times. For example, if the action is to obtain approval from two managers, add the action twice.
- You can reorder actions using the arrow icons.
- If you can't find an action, you can create actions. Click **Create New Action**.

18. When you have added all the actions you want on the template, click **Add to Template**.

   On the Template page, the actions display in a list view. You can also view the template in a graphical view by selecting the graphic icon.

19. In the **Prerequisite** column, set any prerequisites for each action in the template. Select the action row in the **Prerequisites** column and click the **Add Prerequisites** icon.

20. Select the check box next to the actions that you want to make a prerequisite for the action.

   **Tip:**
   - For actions that have prerequisites, mouse over the prerequisite to show the names of the prerequisite actions.
   - Use the graphical view to see the order of completion for the actions.

21. Actions are automatically set to mandatory in the **Mandatory** column. Deselect the check box to make an action optional.

   If an action is identified as Optional, the agent has the ability to skip the action if it does not apply to her specific action plan. Mandatory actions can't be skipped.

22. Click **Save and Close** to complete the template.

**Edit an Existing Template**

To edit an existing template:

1. In the **Manage Action Plan Templates** task, select the template you want to edit.
2. Make your edits.
3. Click **Save and Close**.

**Related Topics**
- Manage Action Plan Actions
- Create a Coverage Schedule
- Update Existing Setup Data
Map Action Plan Status Values

Use the Manage Mapping of Action Plan Status task to create or edit global status mappings from related action business objects to an action plan.

The global mapping can be overridden at the individual action level. For example, you can set an action status as complete when the related status is resolved or closed.

To manage mapping of action plan statuses, in the Setup and Maintenance work area, go to the following:

On the Action Status Configuration page, select from the following action types.

- Appointment
- Case
- HR Help Desk Request
- Internal Service Request
- Opportunity
- Service Request
- Task

You can edit the existing status, or click the Add icon to add additional status configurations.

**Note:** When assigning user-defined values, you can enter any value as a user defined value during attribute mapping. There's no validation performed on that value.

Related Topics
- Overview of Action Plans
- Manage Action Plan Actions
- Update Existing Setup Data
- Overview of Opportunities

Use Oracle Process Automation with Action Plans

Overview of Using Oracle Process Automation with Actions and Plans

You can use Oracle Process Automation with the Action Plans feature to design processes that:

- Automate your Actions and Plans. You can add automated steps to your Actions and Plans based on conditions you create in Oracle Process Automation.
- Leverage Oracle Process Automation capabilities to:
Connect to any system over REST APIs
Implement workflow into your actions and plans

The topics in this section take you through the process of enabling and configuring the Run Processes through Action Plans feature.

**Note:** A subscription to Oracle Process Automation is required in order to take advantage of this feature.

## Configure Oracle Identity Cloud Service and Oracle Process Automation

To access the Oracle Process Automation Designer, Workspace, and REST APIs, you must first enable user synchronization in IDCS and assign user roles.

**Use Oracle Process Automation with Fusion-Based Oracle Cloud Applications**

Refer to the steps in the topic Use Oracle Process Automation with Fusion-Based Oracle Cloud Applications in the Using Oracle Process Automation guide.

As an IDCS administrator, make the following role assignments:

- Assign the ServiceAdministrator role to the following groups:
  - Sales Administrator
  - Case Worker
  - Human Resource Help Desk Agent (if using the Help Desk product)
  - Internal Help Desk Manager (if using the Help Desk product)

- Assign the Service Developer role to the following groups:
  - Customer Service Representative
  - Case Worker
  - Human Resource Help Desk Agent (if using the Help Desk product)
  - Internal Help Desk Agent (if using the Help Desk product)

In the Oracle Process Automation Workspace interface (see *Get the Oracle Process Automation Instance URL*), add the following groups to the Oracle Process Application Administrator Global role:

- Sales Administrator
- Case Worker
- Human Resources Help Desk Agent (if using the Help Desk product)
- Internal Help Desk Manager (if using the Help Desk product)
Configure Oracle Process Automation with Oracle Fusion Service

Enable the Run Processes through Action Plans Feature

You can use Oracle Process Automation in Actions and Plans in Fusion Sales and Service version 21.04 or later.

To enable the feature, go to Setup and Maintenance and do the following:

1. Go to the Service offering.
2. Click Change Feature Opt In.
3. If it's not already done, select the Enable check box for Action Plans.
4. Click the Edit icon for Action Plan Features.
5. Select the Enable check box for Run Processes through Action Plans.
6. Click Done.
7. Click Done on the Opt In page.

Ensure all users of your process-based Actions and Plans have:

- The SVC_ACTION_PLAN_PROCESS_PRIV privilege provisioned in Sales and Service.
- The required permissions to view and edit their processes in Process Automation.

Manage Oracle Process Automation Integration

To configure authentication from Oracle Service Center to the Oracle Process Automation instance:

1. In Setup and Maintenance, go to the following:
   - Offering: Service
   - Functional Area: Action Plans
   - Task: Manage Process Integration for Action Plans
   The Configure Process Integration for Action Plan page displays. This is where you add the proxy user who initiates processes for jobs.
2. Enter the credentials for a user who has the Process Application Administrator role in Oracle Process Automation.
3. Click Save.
   If successful, the following confirmation messages display.
   - Process credentials saved.
   - Process credential validation is successful.
4. Once credentials save and successfully validate, click Save and Close.

Related Topics

- Use Oracle Process Automation with Fusion-Based Oracle Cloud Applications
Manage Action Plan Process Metadata

With this task, you can see what current processes are available to be mapped to actions.

In Setup and Maintenance, go to the following:

- Offering: Service
- Functional Area: Action Plans
- Task: Manage Action Plan Process Metadata

In the Process Metadata page, enter search criteria and click the **Search** icon.

There's no action needed for this page. This is a read-only list of processes where you can see all processes by name, their versions and which versions are the default.

Export and Import Action and Plan Configurations

If you need to, you can export and import action plan configurations from your test environment to your production environment.

For export and import of Actions and Plans, refer to *Import Your Action Plan Data* in the *Oracle Fusion Understanding Import and Export Management for Sales and Service* guide.

For export and import of Process Automation processes, refer to the *Process Automation documentation*.

*Related Topics*

- Import Your Action Plan Action Data
## 16 Integrate with Intelligent Advisor

### Oracle Intelligent Advisor

Oracle Intelligent Advisor helps service agents deliver enriched, personalized, and precise customer service.

Intelligent Advisor can be connected to Fusion Sales and Service Center for use by agents. Intelligent Advisor interviews can be used for:

- Service requests across a range of industries
- Knowledge streaming by helping agents and contacts identify the most appropriate knowledge article or advice for their needs
- Any multi-page information gathering in Oracle Visual Builder
- Personalized self-service advice with Sales and Service

Using Intelligent Advisor within the Fusion Sales and Service Center interface:

- Agents must be logged in to use Intelligent Advisor interviews
- Specific Sales and Service Center objects can be created and updated

There’s desktop modeling software for building interviews called Oracle Policy Modeling. The Intelligent Advisor Hub connects Policy Modeling to Fusion Sales and Service Center.

This shows how Policy Modeling, Intelligent Advisor Hub and Fusion Sales and Fusion Service work together.

The steps to integrate Fusion Sales and Service Center with Intelligent Advisor are:

1. Create an Intelligent Advisor Hub.
2. Create a Fusion Sales and Service Center connection in Intelligent Advisor Hub.
3. Download and install Policy Modeling.
4. Create a project in Policy Modeling.
5. Connect the Policy Modeling project to Intelligent Advisor Hub.
6. Map data to and from Fusion Sales and Service Center in Policy Modeling.
7. Deploy and activate the Intelligent Advisor interview.
8. Embed the interview in a Fusion Sales and Service Center agent interface.

### Related Topics

- Intelligent Advisor Documentation Library
Create a Fusion Sales and Fusion Service Connection in Intelligent Advisor

The next step is to create the Fusion Sales and Service Center web service connection in the Intelligent Advisor Hub that your team can use for new or existing interviews. This connection enables the two applications to work together and share information.

The installation administrator should have set up access for the Sales Administrator, or a similar role that administers Intelligent Advisor for your organization. Once you sign in, you create a connection to your Fusion Sales and Fusion Service web services to get access to data for creating or editing interviews.

Related Topics
- Create a connection to Fusion Sales and Fusion Service

Download and Install Policy Modeling

Once the connection to the web service is established, the next step is to download and install Policy Modeling.

Policy Modeling is the desktop tool modelers use to create and edit interviews, and to map data from Fusion Sales and Service Center to Intelligent Advisor.

Policy Modeling can be downloaded from Intelligent Advisor Hub.

Related Topics
- Install Policy Modeling

Connect the Policy Modeling Project to Intelligent Advisor Hub

The next step is to connect the Policy Modeling project to Intelligent Advisor Hub which provides access to the Fusion Sales and Fusion Service data model.

In other words, Intelligent Advisor receives data model information from the Intelligent Advisor Hub which in turn receives the data model information from Fusion Sales and Fusion Service. This enables Intelligent Advisor to load and save data to Fusion Sales and Fusion Service.

To connect your Policy Modeling project to Fusion Sales and Fusion Service via Intelligent Advisor Hub:

1. In Intelligent Advisor, connect the project to Intelligent Advisor Hub.
2. Choose the Fusion Sales and Fusion Service connection you created previously.
Map Data to and from Fusion Sales and Fusion Service to Policy Modeling

Modelers can then map the data in the policy model Intelligent Advisor project to the appropriate tables, objects, and fields in Fusion Sales and Fusion Service.

Data mapping lets you load data into an Intelligent Advisor interview from Oracle Fusion Sales and Fusion Service, and to save outcomes, including creating new records, from the interview back to Fusion Sales and Fusion Service. The input mappings are used to load values, and the output mappings are used for updating and saving values.

Related Topics
- Deploy a Project
- Activate a Project
17 Set Up Agent Insights

Overview of the Insights Panel

The Insights panel enables agents to have access to the most commonly used tools, at any time, within the context of each service request they’re working on.

Here’s some benefits of setting up this feature:

• Increased consistency in response
• Increased Efficiency
• Reduced Redundancy
• Best practices and standardization can be enforced by deploying companies.
• Agents can access the next-best action quickly to help resolve an SR.

Here’s how it works:

An agent working within a service request can view the Insights panel while viewing SR details. The Insights panel displays entries which you configure prior to use. After the Insights panel is enabled, once an agent has selected an SR, the Insights button (callout 1) is enabled allowing the agent to click and view the Insights panel at any point in the SR process.
The remainder of the configurable cards are described in the following table:

<table>
<thead>
<tr>
<th>Callout</th>
<th>Card Type</th>
<th>Actions</th>
<th>VB Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Suggested Knowledge</td>
<td>• <strong>Link.</strong> Links the article to the current SR.</td>
<td>knowledgeInsightsCardEnabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Share.</strong> Links and opens the Compose Email with the article link added.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Title Click.</strong> Open the article in a new browser tab.</td>
<td><strong>Note:</strong> This card is displayed only if the <strong>View Knowledge Within Service Request</strong> role privilege is enabled for the user.</td>
</tr>
</tbody>
</table>
Set Up the Agent Insights Panel

You set up the Insights Panel in VB Studio.

Here's how you enable it:

1. In the Service Center application, open an SR to view the Service Request detail layout.
2. Click the **Settings and Actions** menu, and select **Edit Page in Visual Builder**.
3. Choose your project.
4. Expand the Oracle Fusion Service UI Extension App list, and select the **Service** node.
5. In the **Constants** list, select **agentInsightsEnabled**, then in the properties window, change the default value from False to True.
6. Now, to configure which cards are displayed within the in the service folder, expand the ec folder, and then expand the sr node.
7. Make sure the following Constants are set to true.
   - actionPlanInsightsCardEnabled
   - knowledgeInsightCardEnabled
   - launchInterviewInsightsCardEnabled
   - similarSrInsightsCardEnabled

---

<table>
<thead>
<tr>
<th>Callout</th>
<th>Card Type</th>
<th>Actions</th>
<th>VB Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Suggested Action Plans</td>
<td><strong>Add.</strong> Adds the suggested action plan to the current SR.</td>
<td>actionPlanInsightsCardEnabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> This card is displayed only if the <strong>Create Action</strong> role privilege is enabled for the user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If the SR doesn’t have a category, no action plans are displayed.</td>
</tr>
<tr>
<td>4</td>
<td>Suggested Interview</td>
<td><strong>Launch.</strong> Opens the Interview page of the current SR, where the SR can be edited using the configured interview.</td>
<td>launchInterviewInsightsCardEnabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> This card is displayed only if the Interview is configured.</td>
</tr>
<tr>
<td>5</td>
<td>Similar Service Request</td>
<td>- <strong>Link.</strong> Links the suggested SR to the current SR&lt;br&gt;- <strong>Title Click.</strong> Opens the suggested SR in a new browser tab&lt;br&gt;- <strong>Title Click.</strong> Opens the suggested SR in a new browser tab</td>
<td>similarSrInsightsCardEnabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> This card is displayed only if the SVC_ENABLE_SIMILAR_SR profile option is enabled for the site.</td>
</tr>
</tbody>
</table>
8. Now preview your changes and note the **Insights** button displayed below the Settings and Actions menu.
18 Enable Productivity Tools

Enable Productivity Tools

Productivity tools show as features on request create or edit pages.

The following table lists productivity tools that are available for requests.

<table>
<thead>
<tr>
<th>Productivity tool</th>
<th>Description</th>
<th>Profile Option Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartText</td>
<td>A reusable fragment of text that you can insert in messages and fields</td>
<td>SVC_ENABLE_STD_TEXT_IN_SR</td>
</tr>
</tbody>
</table>

Productivity tools are disabled by default. Here's how you enable them:

Now, you can set up and configure each tool according to your requirements.

Update the Status List Order

The status list on the Summary Details page shows a list of statuses that can be assigned to. The order of statuses displayed in the list depends on their assigned ranking. Here's how you update the status ranking:

1. In the Setup and Maintenance work area, go to the following:
2. Update the Ranking column to position the status in the status list according to your requirements.
3. Click Save and Close.

Related Topics
- Add Severity Values to Requests
- Manage Keyboard Shortcuts
- How You Manage SmartText Entries
- View Service Request Audit History
- Update Existing Setup Data

How You Manage SmartText Entries

A SmartText entry is a reusable fragment of text that you or your users can create and use in request messages.

As an administrator, you can create public SmartText entries that all users can use. Users can't edit these entries.

You can create SmartTexts in multiple languages. You can use rich-text to create SmartText entries in message fields by enabling HTML. Other request fields, such as Problem Description and Solution Description only support plain text.
You can define where to save the SmartText entry, insert variables in the entry, and choose to share the SmartText entry by using the following availability options:

- **Always**: Select this option to make the SmartText entry available to users at all times.
- **Interval**: Select this option and define the period during which this entry is available to users.
- **Disabled**: Select this option to disable the SmartText entry and display it in the public folders for the users.

### Required Privileges

The following table shows the different privileges you grant to allow your users SmartText access.

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use SmartText</td>
<td>SVC_USE_STD_TXT_PRIV</td>
<td>Allows a user to view, search and insert SmartText.</td>
</tr>
<tr>
<td>Manage SmartText</td>
<td>SVC_MANAGE_STD_TXT_PRIV</td>
<td>Allows a user to create, update, and delete SmartText for their own use.</td>
</tr>
<tr>
<td>Publish SmartText</td>
<td>SVC_PUBLISH_STD_TXT_PRIV</td>
<td>Allows a user to set the scope of SmartText to GLOBAL which allows any user with the correct privilege to view and use that entry.</td>
</tr>
<tr>
<td>Administer SmartText</td>
<td>SVC_ADMIN_STD_TXT_PRIV</td>
<td>Allows the user to administer SmartText.</td>
</tr>
</tbody>
</table>

### Create and Edit Private SmartText Entries

Create your own SmartText entries. They’re only visible to you, and they’re saved in the Private Set tab.

**Note:** In previous releases, there was a **New SmartText (+) icon** in the Right Panel that enabled you to quickly create a new private SmartText. From release 21D onward, the + icon no longer exists. To quickly create a new, private SmartText, simply click the **Manage SmartText** (pencil) icon.

1. On the Create or Edit Service Request page, open the SmartText pane by clicking the **Restore Pane** arrow.
2. Click the **SmartText** tab, then click the **Manage SmartText** icon.
3. Click the **Create** icon on the Private Set tab.

**Note:** If you’re a Help Desk administrator with SmartText privileges, select Help Desk from the drop down list to indicate your application. For information on HR Help Desk, refer to the guide on Oracle Help Center.

4. On the **Manage SmartText** page, click the **Private** tab.
5. Make sure the default value of **Service** appears in the **Domain** drop down list.
6. Make a selection from the **Business Unit** drop down list (if available).

   If the HZ_ENABLE_MULTIPLE_BU_CRIM profile option is enabled (set to Y) you will have access to this drop down list.
If you're an administrator, the drop down list displays all BUs in your organization. If you're not you're shown only the BUs that you’re assigned to along with the Null "No associated business unit" value which is visible to administrators and agents across your organization.

**Note:** A default business unit is assigned whether you have multiple BUs enabled or not. The default BU is set up when you configure the HZ_DEFAULT_BU_CRM profile option. For more information on both profile options, see the "Manage Common CRM BU Profile Options for Service BUs" topic.

7. Select a folder in which you want to create the public SmartText entry. You can either select an existing folder, or create a new folder to save your SmartText entry.

**Note:** Root is a reserved folder name and administrators can’t create a folder with this name.

8. Click the **Create (+)** icon and select **New SmartText**.

9. On the **Manage SmartText** page, enter the following details:
   - Enter a name for the SmartText entry. There are some restrictions on special characters, so see "SmartText Naming Conventions" in Related Topics.
   - Select **Use HTML** to use rich text formatting in your SmartText entry. You can insert tables and images here.
   - Enter the text you want to insert.
   - Insert a variable, if you want, by typing the @ symbol followed by the variable name. Click the Tab key to automatically complete the variable, or use the navigation arrows on your keyboard, then press the Enter key. The variable is inserted where the cursor stands in your text.
   - Click **Save as Personal**.

10. To edit the Private SmartText entry, do the following:
   - Select the SmartText entry you want to edit.
   - Select the **Language** of the SmartText entry from the drop-down list.
   - You can also create in a new language by clicking the **Add** icon.
   - Edit the Private SmartText entry and click **Save as Personal** to publish the SmartText entry.

You can view and manage all your Private SmartText entries from the Private SmartText tab. You can add, duplicate, and delete your private set SmartText entries.

### Create and Edit Public SmartText Entries

Create your own Public SmartText entries. Public entries are available to all users.

To create a Public SmartText entry, do the following:

1. On the Create or Edit Service Request page, open the SmartText pane by clicking the **Restore Pane** arrow.
2. Click the **SmartText** tab, then click the **Manage SmartText** icon.
3. Click the **Create** icon on the Public tab.

   **Note:** If you’re a Help Desk administrator with SmartText privileges, select Help Desk from the Domain drop down list to indicate your application. For information on HR Help Desk, refer to the guide on Oracle Help Center.

4. On the **Manage SmartText** page, click the **Public** tab.
5. Make sure the default value of **Service** appears in the **Domain** drop down list.
6. Make a selection from the **Business Unit** drop down list (if available).

   If the HZ_ENABLE_MULTIPL E_BU_CRM profile option is enabled (set to Y) you will have access to this drop down list.

   If you’re an administrator, the drop down list displays all BUs in your organization. If you're not you're shown only the BUs that you're assigned to along with the Null "No associated business unit" value which is visible to administrators and agents across your organization.

   **Note:** A default business unit is assigned whether you have multiple BUs enabled or not. The default BU is set up when you configure the HZ_DEFAULT_BU_CRM profile option For more information on both profile options, see the "Manage Common CRM BU Profile Options for Service BU s" topic.

7. Select a folder in which you want to create the public SmartText entry. You can either select an existing folder, or create a new folder to save your SmartText entry.

   **Note:** **Root** is a reserved folder name and administrators can't create a folder with this name.

8. Click the **Create (+)** icon and select **New SmartText**.
9. On the **New SmartText** page, do the following:
   - Enter the name for the SmartText entry. There are some restrictions on special characters, so see "SmartText Naming Conventions" in Related Topics.
   - Select **Use HTML** to use rich text formatting in your SmartText entry. You can insert tables and images here.
   - Enter the text you want to insert.
   - Insert a variable, if you want, by typing the @ symbol followed by the variable name. Click the **Tab** key to automatically complete the variable, or use the navigation arrows on your keyboard, then press the **Enter** key. The variable is inserted where the cursor stands in your text.

10. Select **Publish** to save this entry in the **Public** tab for all users. If you don't select **Publish**, the SmartText entry is saved in your **Private** folder and is available only to you.
11. Verify the location where you're saving the SmartText.
12. Select the availability of the SmartText entry from the list of **Availability** options.
13. Click **Publish** to publish the SmartText entry.

To edit a Public SmartText entry, do the following:

1. Select the SmartText entry you want to edit.
2. Select the **Language** of the SmartText entry from the drop-down list
3. You can also create a new language by clicking the **Add** icon.
4. Edit the Private SmartText entry and click **Publish** to publish the SmartText entry.
SmartText Naming Conventions

The following restrictions on special characters are applicable when you create a Public or Private SmartText:

- You can’t include the following Trigger keys such as # and @ in the name, as these may cause interaction problems.
- The following special characters aren’t allowed:
  - Tilde
  - Number sign
  - Percent
  - Ampersand
  - Asterisk
  - Flower Bracket
  - Backslash
  - Colon
  - Angle Bracket
  - Slash
  - Plus sign
  - Question mark
  - Pipe
  - Quotation mark
  - Double Square Bracket
- You can’t use the following special characters:
  - Exclamation mark
  - Pound
  - Dollar
  - Round Bracket
  - Euro
  - Caret
  - Underscore
  - Equal to
  - Semi-colon
  - Comma
  - Dot
19 Channels for Collaboration

Control the Display of Channels Used Only for Internal Conversations

You can disable the channels that you don’t want to be displayed in the application when an agent composes a response message or captures a customer message.

1. Sign in to Service Center as a setup user or administrator.
2. In the Setup and Maintenance work area, go to the Tasks panel tab.
3. Search for and click the Manage Service Request Channel Type Visibility task.
4. On the Manage Service Request Channel Type Visibility page, if you don’t see the channels you want to disable, click Sync on the toolbar of the table.
5. For any channel that you select, you see two rows with different values for Property Name:
   - **Enabled for Collaboration**: To enable the selected channel to collaborate with internal users to resolve customer issues, set the Property Value for this property name to Yes.
   - **Enabled for Customer Interaction**: To enable using the selected channel for interaction of your service agents with your customers, set the Property Value for this property name to Yes.

   **Note:** You can also use the drop-down list in the toolbar for the Property Name field to filter the list by each property name.

6. Set the Property Value to No to disable the selected channel.

   **Note:**
   - For messages of type Customer Entry and Response:
     - SMS and Slack channels are disabled by default because they aren’t supported for customer communications. You can enable or disable the other channels.
   - For internal conversations, only the Email, Microsoft Teams, Slack, Web, and custom channel types that you created are supported. You have the option to disable the channel types that you want to hide when starting an internal conversation. For example, if you don’t use Slack in your organization, you can disable Slack for collaboration.

7. Click Save and Close.

   The disabled channels aren't displayed when an agent composes a message.
Create an Email Channel for Collaboration or Internal Conversations

Let's say an agent needs to reach out to a subject matter expert (SME) to resolve a customer issue.

To facilitate this type of internal conversation, you must create a separate email channel and set the **Purpose** field for the channel to **Collaboration**. And the agents must use this channel for their internal conversations. To communicate with the SME, the agent starts an internal conversation. They select a channel and the SME as the recipient, and compose a message. When the SME replies, their message comes into this conversation.

For internal conversations, Service Center has the Conversation Message object. When an SME replies, that message is posted as a Conversation Message because the SME replied to the agent’s internal conversation. When a customer replies, the message is posted as an SR Message. This feature is built into the processing of the incoming email.

For this process to happen, you must ask the agents to select the appropriate email channel:

- While communicating with an SME, the agent must use the channel that you have created for internal conversations. For example: `internal@mycompanydomain.com`. Now when the SME replies, this reply is captured as a Conversation Message. That’s because the SME replied to the agent’s internal conversation.
- While communicating with a customer, the agent must use the channel that you have created for conversations with customers. For example: `support@mycompanydomain.com`. Now when the customer replies, this reply is captured as an SR Message.

**Related Topics**

- Configure an Email Channel

Translate the Communication Channel Display Names

Translate Display Name of Communication Channels into Installed Languages

By default, the display name for each of your communication channels is the same in the base language and in all the installed languages. However, the names are translatable, so you can provide language-specific display names in all the installed languages in the application.

To translate the display name of a communication channel into all the installed languages:

1. In the Setup and Maintenance work area, go to the following:
   - **Offering**: Service
   - **Functional Area**: Communication Channels
   - **Task**: Manage Communication Channels
2. On the Service Channels page, in the **Account Name** column, click the link to the channel whose display name you want to translate.

   The **Edit Channel** window is displayed.

3. Click the Translation Editor.

   The **Edit Translations** window is displayed, showing different rows for the channel display name in the base language and the installed languages.

4. Click the row for the first installed language.

5. In the **Display Name** field, specify the selected channel display name in the corresponding installed language.

6. Click **OK**.

7. Starting from step 2, repeat all the steps for each channel.
20 Slack Channels

Overview

Use the Slack Channel for Collaboration

Slack is a team communication tool that facilitates synchronous communication across different devices. People across departments can use Slack to work together to make better and faster business decisions.

You can set up the integration of Slack with Oracle Service Center, and this helps your company in the following ways:

- Service agents can collaborate with subject matter experts to resolve customer questions and issues faster.
- Notifications are triggered to Slack users and channels when certain events occur on an object. For example, when a service request is set to critical or when an opportunity is closed.

Related Topics
- How You Set Up a Slack Channel for Your Fusion Application: Method 2

Overview of Setting Up a Slack Channel for Your Fusion Application

You can integrate your application with Slack in two ways. Depending on your company’s requirement, you must follow the steps listed in one of the following sections:

- Set Up a Slack Channel: Method 1: If you plan to use only the predefined slash commands and you don't plan to modify existing commands or create your own commands in Slack.
- Set Up a Slack Channel: Method 2: If you plan to create your own slash commands in Slack.

Set Up a Slack Channel: Method 1

How You Set Up a Slack Channel for your Fusion Application: Method 1

How you integrate your sales and service application with Slack depends upon your company’s requirement. Let’s say you plan to use only the predefined slash commands and you don’t need to modify the existing commands or create commands in Slack. Then you must complete the steps listed in the following table.
Note: Each of these steps is described in a separate topic, and you must complete them in the given order.

<table>
<thead>
<tr>
<th>Step no.</th>
<th>Name of topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Install the Fusion Sales and Service App from the Slack Marketplace</td>
</tr>
<tr>
<td>2</td>
<td>Update Your Slack App Credentials in Functional Setup Manager</td>
</tr>
<tr>
<td>3</td>
<td>Create a Slack Channel in Your Fusion Application</td>
</tr>
<tr>
<td>4</td>
<td>Enable Notifications to Slack</td>
</tr>
<tr>
<td>5</td>
<td>Add a Slack Contact Point for Your Sales Representatives Who Use Slack</td>
</tr>
<tr>
<td></td>
<td>(Required for your Sales application, Not Required for your Service application)</td>
</tr>
<tr>
<td>6</td>
<td>Set Up a Scheduled Process to Synchronize Slack Users</td>
</tr>
<tr>
<td></td>
<td>(Required for your Service application, Not Required for your Sales application)</td>
</tr>
</tbody>
</table>

Install the Fusion Sales and Service App from the Slack Marketplace

You can install a preconfigured Fusion Sales and Service Slack app to your workspace.

1. Navigate to: `slack.com/apps`
2. Ensure that you’re signed in to your Slack workspace.
4. Search for and click **Oracle Fusion Sales and Service**.
5. On the Fusion Sales and Service page in the Slack App Directory, click **Add to Slack**.
6. On the page that requests permission to access your Slack workspace, click **Allow**.
7. On the next page, do the following:
   a. Provide a name for the app.
   b. Provide a description for the app.
   c. Change the application icon if required.
   d. Set the Fusion Sales and Service web address to: `https://pod_name:443`

Here, `pod_name` is the name of the Fusion Sales and Fusion Service instance provisioned for you.
8. Copy the contents of the text box located in the **Add your Slack credentials to your app** region.

Note: These details are used in updating Functional Setup Manager (FSM) with credentials of your Slack app.
Update Your Slack App Credentials in Functional Setup Manager

To update the credentials of your Slack app in the Functional Setup Manager (FSM) in Fusion Sales and Service:

1. Sign in to your Fusion application as a setup user or administrator.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Click Search from the list of displayed tasks.
4. Search for and select Manage Collaboration Network Credentials.
   
   **Note:** This is the same text that you copied in the last step of the "Install the Fusion Sales and Service App from the Slack Marketplace" topic.

   6. Click Save and Close.

Create a Slack Channel in Your Fusion Application

*This is a required step from "How You Set Up a Slack Channel for Your Fusion Application".*

For each of your Slack workspaces, you must create a Slack channel in Fusion Sales and Service. So if you have multiple Slack workspaces, you have multiple Slack channels in Fusion Sales and Service.

To create a Slack channel in the Fusion application:

1. Sign in to the Fusion application as a setup user or administrator.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Click Search from the list of displayed tasks.
4. Search for and select Manage Communication Channels.
5. In the Service Channels page, click Create Channel.
6. In the Create Channel window:
   - The Stripe Code is set as CRM by default.
   - Select the Purpose as Collaboration.
   - Select the Channel Type as Slack.
   - Click Authorize.

   A new browser tab opens and the following page is displayed in Slack: Sign in to your workspace.
7. In the space provided below the Enter your workspace's Slack URL prompt, enter the workspace for which you want to create the Slack channel.
8. Click Continue.
9. Sign in to your Slack workspace as an administrator.
10. Complete the next steps on Slack to provide permissions.
11. Click Authorize.
    
    A message is displayed, stating that the authorization is complete.
12. Close this browser tab and return to the channel creation page in Fusion Sales and Fusion Service.
Notice that the **Account Name**, **Channel Code**, and **Display Name** are prepopulated.

13. Click **Save and Close** to save the Slack channel.

**Related Topics**
- How You Set Up a Slack Channel for Your Fusion Application: Method 2
- Use the Slack Channel for Collaboration

### Enable Notifications to Slack

**This is a required step from "How You Set Up a Slack Channel for Your Fusion Application".**

All outbound messages from Fusion Sales and Fusion Service to Slack use the notifications framework. So, for outbound messages to be delivered to Slack, you must enable notifications.

For more information about how to enable notifications, see "Enable Notifications for Service Requests".

**Related Topics**
- Enable Notifications
- How You Set Up a Slack Channel for Your Fusion Application: Method 2
- Use the Slack Channel for Collaboration

### Add a Slack Contact Point for Your Sales Representatives Who Use Slack

**This is a required step for Sales from "How You Set Up a Slack Channel for Your Fusion Application".**

*(Required for your sales application, Not Required for your service application)*

Every Slack user has a unique Slack user ID. When a sales representative executes a slash command in Slack, his information needs to be retrieved from Fusion Sales and displayed in Slack. For this to happen, you must add a Slack contact point in Fusion Sales for every sales representative who uses Slack. This way, you map the unique Slack user ID of each sales representative to his resource record in Fusion Sales.

1. In the Navigator for Fusion Sales, click **Resource Directory**.
2. Click the Tasks panel tab.
3. In the Resources region, click **View Resources**.
4. On the View Resources page, navigate to the **Resource Name** field.
5. Type the name of the resource to whom you want to give the capability to execute Slash commands.
6. Click **Search**.
7. In the Search Results area, click the record of the sales representative.
8. On the Resource page of the sales representative, click the Additional Contact Information tab.
9. Click the plus icon to create a new contact point.
10. In the **Create Contact Point** dialog box, in the **Contact Point Type** drop-down list, select **Social network**.
11. In the **Purpose** field, select **Work**.
12. In the **Social Network** drop-down list, select **Slack**.
13. In the **User ID** field, find and enter the Slack user ID of the service representative as follows:
In the Slack workspace, in the Direct Messages area, select the name of the sales representative.

b. In the adjacent pane, click the name of the sales representative.

c. Click View profile.

d. In the Workspace Directory panel that's displayed, click the ellipsis symbol.

e. Select Copy member ID along with the ID.

f. Paste this member ID in the User ID field in the Create Contact Point dialog box.

g. Click OK.

When the sales representative now executes a slash command in Slack, his resource record in Fusion Sales is identified based on his Slack user ID. And the query is executed on his behalf. The information from his record in Fusion Sales is then displayed in Slack.

Related Topics
- How You Set Up a Slack Channel for Your Fusion Application: Method 2
- Use the Slack Channel for Collaboration

Set Up a Scheduled Process to Synchronize Slack Users

This is a required step for Service from "How You Set Up a Slack Channel for Your Fusion Application".

(Required for your service application, Not Required for your sales application)

To set up a scheduled process to synchronize Slack users:

1. In the Navigator for your Fusion application, click Scheduled Processes.

2. In the Overview page, click Schedule New Process.

3. Specify the name as Sync All Slack Resources.

4. Click Advanced.

5. Schedule the job to execute on a recurring basis.

You have now completed the setup of the Slack channel for collaboration. While composing messages in the Messages tab of an SR, all the Slack channels and users for a corresponding workspace appear in the To drop-down list.

Related Topics
- How You Set Up a Slack Channel for Your Fusion Application: Method 2
- Use the Slack Channel for Collaboration

Set Up a Slack Channel: Method 2

How You Set Up a Slack Channel for Your Fusion Application: Method 2

How you integrate your sales and service application with Slack depends upon your company's requirement. If you want to create your own slash commands in Slack, you must follow the steps listed in the following table:
Oracle Fusion Service
Implementing Service Center with the Redwood User Experience

Chapter 20
Slack Channels

Note: Each of these steps is described in a separate topic, and you must complete them in the given order.

<table>
<thead>
<tr>
<th>Step no.</th>
<th>Name of topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a Slack App for Fusion Sales and Service</td>
</tr>
<tr>
<td>2</td>
<td>Update the Display Information for Your Slack App</td>
</tr>
<tr>
<td>3</td>
<td>Add a Redirect URL for Your Slack App</td>
</tr>
<tr>
<td>4</td>
<td>Add Scopes to Your Slack App</td>
</tr>
<tr>
<td>5</td>
<td>Set Up Interactive Components for Your Slack App</td>
</tr>
<tr>
<td>6</td>
<td>Set Up Slash Commands in Slack for Opportunities, Leads, and Accounts (Required for your Sales application, Not Required for your Service application)</td>
</tr>
<tr>
<td>7</td>
<td>Update Functional Setup Manager with Credentials of Your Slack App</td>
</tr>
<tr>
<td>8</td>
<td>Create a Slack Channel in Your Fusion Application</td>
</tr>
<tr>
<td>9</td>
<td>Enable Notifications to Slack</td>
</tr>
<tr>
<td>10</td>
<td>Add a Slack Contact Point for Your Sales Representatives Who Use Slack (Required for your Sales application, Not Required for your Service application)</td>
</tr>
<tr>
<td>11</td>
<td>Set Up a Scheduled Process to Synchronize Slack Users (Required for your Service application, Not Required for your Sales application)</td>
</tr>
</tbody>
</table>

Create a Slack App for Fusion Sales and Service

To create a Slack app for Oracle Fusion Sales and Service:

1. Navigate to: https://api.slack.com/apps
2. Click Create an App.
3. In the Create a Slack App dialog box, in the App Name field, type a suitable app name.
4. From the Development Slack Workspace drop-down list, select the workspace where you want the Fusion Sales and Fusion Service integration to be deployed.
5. Click Create App.
Update the Display Information for Your Slack App

This is a required step from "How You Set Up a Slack Channel for Your Fusion Application".

To update the display information for your Slack app:

1. Navigate to the Settings region of your Slack app.
2. Click Basic Information.
3. On the Basic Information page, scroll down to the Display Information region.
   - The name of your Slack app is prefilled in the App Name field.
4. Provide a short description, app icon, and background color for your Slack app.
5. Click Save Changes.

Add a Redirect URL for Your Slack App

This is a required step from "How You Set Up a Slack Channel for Your Fusion Application".

After a Slack channel is authorized, the redirect URL is used by Slack to provide OAuth tokens to Fusion Sales and Fusion Service.

To add a redirect URL for your Slack App:

1. In the Features region of your Slack app, click OAuth & Permissions.
2. On the OAuth & Permissions page, in the Redirect URLs region, click Add New Redirect URL.
3. In the Redirect URLs field, set the redirect URL.
   - Note: The URL must be in the following format: https://pod_name:443/crmUI/faces/AuthenticateSlack, where pod_name is the name of the Fusion Sales and Fusion Service instance provisioned for you.
4. Click Add.
5. Click Save URLs.
Add Scopes to Your Slack App

The capabilities and permissions of a Slack app are governed by the scopes that it requests.

To add the scopes to your Slack app:

1. In the Features region of your Slack app, click **OAuth and Permissions**.
2. On the OAuth and Permissions page, navigate to the Scopes region.
3. In the Bot Token Scopes section, click **Add an OAuth Scope**.
4. Add the following scopes to your app:
   - `channels:manage`
   - `channels:read`
   - `Commands`
   - `groups:read`
   - `groups:write`
   - `im:write`
   - `im:read`
   - `mpim:read`
   - `mpim:write`
   - `users:read`

   **Note:** A bot user is created in your app.

5. (Optional) Rename the bot user by navigating to the App Home region of your Slack app.

Set Up Interactive Components for Your Slack App

**This is a required step from "How You Set Up a Slack Channel for Your Fusion Application".**

Interactive components are action buttons that are displayed on Slack messages. Users can take these actions on the messages in Slack, which are sent from Fusion Sales and Service.

For example: When an SR is forwarded to a Slack channel, users can click Reply to reply to an SR. They can then add their response in the resulting dialog.

To set up interactive components for your Slack app:

1. In the Features region of your Slack app, click **Interactivity and Shortcuts**.
2. In the Interactivity region, turn on the interactivity.
3. In the **Request URL** field, set the request URL to `https://pod_name:443/crmRestApi/collaborationResources/latest/actions`, where pod_name is the name of the Oracle Fusion Sales and Service instance provisioned for you.
4. Click **Save Changes**.
Set Up Slash Commands in Slack for Opportunities, Leads, and Accounts

This is a required step for Sales from "How You Set Up a Slack Channel for Your Fusion Application".

(Required for your sales application, Not Required for your service application)

Because sales representatives travel quite often, sometimes it's not easy for them to sign in to Fusion Sales on their different devices. With the integration of Fusion Sales with Slack, they can view their top five opportunities, leads, and accounts from Slack on any of their devices. They can also take actions on their opportunities.

They can navigate to a workspace in Slack and use the respective slash commands to get their top five opportunities, leads, and accounts. The slash commands use the Sales Cloud RESP API to retrieve the opportunities, leads, and accounts. The results are only visible to the Slack user who executes the command. You first need to set up the slash commands for opportunities, leads, and accounts in Slack.

Here's a list of slash commands in Slack and their corresponding results.

<table>
<thead>
<tr>
<th>Slash Command in Slack</th>
<th>What this command retrieves from Fusion Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ec-my-opportunities</td>
<td>Top five opportunities with the close date in the current quarter and owned by the sales representative who executes the command.</td>
</tr>
<tr>
<td>/ec-my-leads</td>
<td>First five leads owned by the sales representative who executes the command. They are selected from only the qualified and unqualified leads owned by the sales representative in the last three months.</td>
</tr>
<tr>
<td>/ec-my-accounts</td>
<td>First five accounts owned by the sales representative who executes the command.</td>
</tr>
</tbody>
</table>

To set up the slash commands in Slack for opportunities, leads, and accounts:

1. In the Features region of your Slack app, click **Slash Commands**.
2. In the Slash Commands region, click **Create New Command**.
3. In the **Command** field, enter the following commands:
   - For opportunities: /ec-my-opportunities
   - For leads: /ec-my-leads
   - For leads: /ec-my-accounts

   **Note:** Ensure that the commands exactly match the given commands. If you modify the commands, they don't work.

4. In the **Request URL** field, enter the following URL: https://pod_name/crmRestApi/collaborationResources/latest/commands

   Here, pod_name is the name of the Fusion Sales and Service instance provisioned for you.
5. Provide an appropriate **Short Description**. For example: **Get my first 5 opportunities**
6. You can leave the **Usage Hint** field blank, as additional parameters aren’t supported.
7. Click **Save** to save the command or click **Cancel** to discard it.

### Limitations for Activity Type When a Slash Command Is Used

For each opportunity returned by the `/ec-my-opportunities` slash command, the user can create a task, log a call, or schedule an appointment. These activities are created on the opportunities. In Fusion Sales and Service, you can add a custom lookup as the parent of the Activity Type lookup to further constrain the list of activity types.

But the Slack integration is unable to constrain the list of values for the activity type based on custom parent lookup type. So the users see an error if they select an activity type that isn’t available for the activity they’re creating.

### Update Functional Setup Manager with Credentials of Your Slack App

**This is a required step from “How You Set Up a Slack Channel for Your Fusion Application”.**

To update the Functional Setup Manager (FSM) in the Fusion application with the credentials of your Slack app:

1. In the Settings region of your Slack app, click **Basic Information**.
2. From the App Credentials section of the Basic Information page, copy the values of the **Client ID**, **Client Secret**, and **Signing Secret**.
3. Sign in to your Fusion application as a setup user or administrator.
4. Navigate to the **Setup and Maintenance** work area and open the **Tasks** panel tab.
5. Click **Search** from the list of displayed tasks.
6. Search for and select **Manage Collaboration Network Credentials**.
7. In the Manage Collaboration Network Credentials page, specify the **Client Identifier**, **Client Secret**, and **Signing Secret** that you copied from your Slack app.
8. Click **Save and Close**.

**Related Topics**
- How You Set Up a Slack Channel for Your Fusion Application: Method 2
- Use the Slack Channel for Collaboration

### Create a Slack Channel in Your Fusion Application

**This is a required step from “How You Set Up a Slack Channel for Your Fusion Application”.**

For each of your Slack workspaces, you must create a Slack channel in Fusion Sales and Service. So if you have multiple Slack workspaces, you have multiple Slack channels in Fusion Sales and Service.

To create a Slack channel in the Fusion application:

1. Sign in to the Fusion application as a setup user or administrator.
2. Navigate to the **Setup and Maintenance** work area and open the **Tasks** panel tab.
3. Click **Search** from the list of displayed tasks.
4. Search for and select **Manage Communication Channels**.
5. In the Service Channels page, click **Create Channel**.
6. In the Create Channel window:
   - The **Stripe Code** is set as **CRM** by default.
   - Select the **Purpose** as **Collaboration**.
   - Select the **Channel Type** as **Slack**.
   - Click **Authorize**.

   A new browser tab opens and the following page is displayed in Slack: Sign in to your workspace.

7. In the space provided below the **Enter your workspace's Slack URL** prompt, enter the workspace for which you want to create the Slack channel.

8. Click **Continue**.

9. Sign in to your Slack workspace as an administrator.

10. Complete the next steps on Slack to provide permissions.

11. Click **Authorize**.

   A message is displayed, stating that the authorization is complete.

12. Close this browser tab and return to the channel creation page in Fusion Sales and Fusion Service.

   Notice that the **Account Name**, **Channel Code**, and **Display Name** are prepopulated.

13. Click **Save and Close** to save the Slack channel.

**Related Topics**
- How You Set Up a Slack Channel for Your Fusion Application: Method 2
- Use the Slack Channel for Collaboration

---

**Enable Notifications to Slack**

This is a required step from "How You Set Up a Slack Channel for Your Fusion Application".

All outbound messages from Fusion Sales and Fusion Service to Slack use the notifications framework. So, for outbound messages to be delivered to Slack, you must enable notifications.

For more information about how to enable notifications, see "Enable Notifications for Service Requests".

**Related Topics**
- Enable Notifications
- How You Set Up a Slack Channel for Your Fusion Application: Method 2
- Use the Slack Channel for Collaboration

---

**Add a Slack Contact Point for Your Sales Representatives Who Use Slack**

This is a required step for Sales from "How You Set Up a Slack Channel for Your Fusion Application".

(Required for your sales application, Not Required for your service application)
Every Slack user has a unique Slack user ID. When a sales representative executes a slash command in Slack, his information needs to be retrieved from Fusion Sales and displayed in Slack. For this to happen, you must add a Slack contact point in Fusion Sales for every sales representative who uses Slack. This way, you map the unique Slack user ID of each sales representative to his resource record in Fusion Sales.

1. In the Navigator for Fusion Sales, click **Resource Directory**.
2. Click the Tasks panel tab.
3. In the Resources region, click **View Resources**.
4. On the View Resources page, navigate to the **Resource Name** field.
5. Type the name of the resource to whom you want to give the capability to execute Slash commands.
6. Click **Search**.
7. In the Search Results area, click the record of the sales representative.
8. On the Resource page of the sales representative, click the Additional Contact Information tab.
9. Click the plus icon to create a new contact point.
10. In the **Create Contact Point** dialog box, in the **Contact Point Type** drop-down list, select **Social network**.
11. In the **Purpose** field, select **Work**.
12. In the **Social Network** drop-down list, select **Slack**.
13. In the **User ID** field, find and enter the Slack user ID of the service representative as follows:
   a. In the Slack workspace, in the Direct Messages area, select the name of the sales representative.
   b. In the adjacent pane, click the name of the sales representative.
   c. Click **View profile**.
   d. In the **Workspace Directory** panel that's displayed, click the ellipsis symbol.
   e. Select **Copy member ID** along with the ID.
   f. Paste this member ID in the **User ID** field in the **Create Contact Point** dialog box.
   g. Click OK.

When the sales representative now executes a slash command in Slack, his resource record in Fusion Sales is identified based on his Slack user ID. And the query is executed on his behalf. The information from his record in Fusion Sales is then displayed in Slack.

**Related Topics**
- How You Set Up a Slack Channel for Your Fusion Application: Method 2
- Use the Slack Channel for Collaboration

**Set Up a Scheduled Process to Synchronize Slack Users**

This is a required step for Service from "How You Set Up a Slack Channel for Your Fusion Application".

(Required for your service application, Not Required for your sales application)

To set up a scheduled process to synchronize Slack users:

1. In the Navigator for your Fusion application, click **Scheduled Processes**.
2. In the Overview page, click **Schedule New Process**.
3. Specify the name as **Sync All Slack Resources**.
4. Click **Advanced**.
5. Schedule the job to execute on a recurring basis.

You have now completed the setup of the Slack channel for collaboration. While composing messages in the Messages tab of an SR, all the Slack channels and users for a corresponding workspace appear in the **To** drop-down list.
Slack Notifications

Send Notifications to Slack Using Groovy Triggers or Object Workflow

Notifications can be sent from Fusion Sales and Service to Slack by using groovy triggers or object workflow.

To understand how you can use groovy triggers to send notifications to Slack, see the following topics:

- Define a Groovy Trigger to Send Notifications to Slack
- Examples of Groovy Scripts for Sending Notifications to Slack

To send notifications to Slack by using object workflow, you must create the object workflow and select the Groovy Script action. For more information and examples, see "Object Workflows and Groovy Scripts: How They Work Together".

Define a Groovy Trigger to Send Notifications to Slack

Before writing the groovy scripts, ensure that you complete these steps:

- Create a Slack Channel. For more information, see "Create a Slack Channel in Your Fusion Application".
- Enable notifications for service requests. For more information, see "Enable Notifications for Service Requests".

To define a groovy trigger to send notifications to Slack:

1. Sign in to the application as an administrator.
2. Ensure that you’re in a sandbox.
3. Navigate to Application Composer.
4. In the Application field, select CRM Cloud from the drop-down list.
5. In the Object Tags region, select the Service check box.
   
   Note: If you’re writing a groovy trigger on a Sales object, select the Sales check box.
6. Expand the Service Request object.
7. Click Server Scripts.
8. Select the Triggers tab.
10. Define your groovy trigger as described in "Examples of Groovy Scripts for Sending Notifications to Slack".

### Related Topics
- Create a Slack Channel in Your Fusion Application
- Enable Notifications
- Examples of Groovy Scripts for Sending Notifications to Slack

### Examples of Groovy Scripts for Sending Notifications to Slack

Here are some examples of groovy scripts for sending notifications from Fusion Service to Slack:

#### Trigger Example: SR Critical Check Box Change
Use the following code to trigger a notification to be sent to Slack when the Critical check box on the service request (SR) is updated:

```
// TRIGGER TYPE: AFTER CHANGES POSTED TO DATABASE
// Notify #support channel in OraSvc workspace when the Critical check box in an SR is selected or deselected
int indexOfCF = adf.oldValue.getAttributeIndexOf('CriticalFlag')
def oldValue = adf.oldValue.getAttribute(indexOfCF, oracle.jbo.server.EntityImpl.TRANS_ORIGINAL_VERSION)
def newValue = getAttribute('CriticalFlag')
if (oldValue != newValue) {
    println("Triggering notification...")  // For debugging purpose only
    try {
        def map = new HashMap()
        map.put("Channels", ["ORA_SVC_SLACK"])
        map.put("MessageText", "Test Message for a change to the Critical check box on the SR")
        map.put("ChannelAccountName", "A1B2C3D4F5")  // This is a very important step to send notifications to Slack. Pass the Account Name field for the Slack channel that you created
        map.put("SlackChannels", ["@kanyuev", "#general", ...])  // This is also an important step. You can provide one or more Slack channels or users here
        adf.util.sendNotification(adf, map)
        println("Success.")  // For debugging purpose only
    } catch (e) {
        throw new oracle.jbo.ValidationException('Failure: ' + e.getMessage())
    }
}
```

#### Trigger Example: SR Created
Use the following code to trigger a notification to be sent to Slack when an SR is created:

```
// TRIGGER TYPE: BEFORE INSERT TO DATABASE
// Notify #support channel in OraSvc workspace when an SR is created
try {
    def map = new HashMap()
    map.put("Channels", ["ORA_SVC_SLACK"])
    map.put("MessageText", "Service Request created")
    map.put("ChannelAccountName", "A1B2C3D4F5")
    map.put("SlackChannels", ["@kanyuev", "#general", ...])
    adf.util.sendNotification(adf, map)
    println("Success.")  // For debugging purpose only
}
```

Note: All the steps to set the HashMap in these examples are required to send notifications to Slack. Currently, Slack notifications don't use the Notification Preferences Manager. So it's necessary to pass the HashMap to the sendNotification method.
map.put("Channels", ["ORA_SVC_SLACK"])  
map.put("MessageText", "An SR is created")  
map.put("ChannelAccountName", "A1B2C3D4E5") // This is a very important step to send notifications to  
Slack. Pass the Account Name field for the Slack channel that you created  
map.put("SlackChannels", ["@kanyuev", "#general", ...]) // This is also an important step. You can provide  
one or more Slack channels or users here  

df.util.sendNotification(df, map)  
} catch (e) {  
  throw new oracle.jbo.ValidationException('Failure: ' + e.getMessage())  
}

**Related Topics**
- Define a Groovy Trigger to Send Notifications to Slack

### Validate Whether Notifications Are Sent to Slack

You can validate if the notifications are sent to Slack by updating a service request (SR) in Oracle Fusion Service.

**Note:** Notifications to Slack can be sent for other objects as well, such as opportunity and custom objects.

**Validation Example: When You Use the Critical SR Check Box Change Trigger**

If you use the Critical SR Check Box Change trigger, here's how you validate if a notification is sent from Oracle Fusion Service to Slack:

1. Sign in to Fusion Service.
2. Create and save an SR.
3. In the SR Summary tab, select the **Critical** check box and save the SR.
4. Verify whether you have received a notification in Slack.

### User Credentials for Executing Commands

**Set Up User Credentials for Executing Commands from a Collaboration Network**

To execute the Oracle Fusion Sales and Service REST API commands from a collaboration network such as Slack, you can use a predefined Application ID user. The predefined Application ID user has many privileges.

You also have the option to set up the user credentials instead of using a predefined user. The user that you set up can have only those privileges required to execute the commands from a collaboration network such as Slack.

To set up the user credentials to execute the commands from a collaboration network such as Slack:

1. Sign in as a setup user or administrator.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Search for and select the Manage Collaboration Network Credentials task.
4. On the Manage Collaboration Network Credentials page, navigate to the Fusion Sales and Service Application Credentials region.
5. Enter the appropriate user ID and password.

FAQs About Slack Integration

Frequently Asked Questions (FAQs) for Slack Integration

This section contains some frequently asked questions (FAQs) when setting up and maintaining slack integration. Scroll or search to find answers to common questions.

Why is there a banner recommending I update the permission scopes for my Slack app?

When you're editing a Slack app, you may see a banner recommending you to update the permission scopes for your app. If you see this banner, then it means that you're using the classic version of the app, which uses a coarser permission scope.

The latest version uses fine-grained permission scopes, and you can request only the specific scopes required by your app. If you prefer to continue using the coarser scope, you don't have to do anything. But if you prefer to use the fine-grained permission scopes, then here's what you must do:

1. On the Slack website, navigate to the page where you manage your applications.
   
   **Note:** You must be an administrator of your Slack application.

2. You should see a banner indicating that you can start using a finer-grained scope.
3. Click the link in the banner and follow the steps to upgrade your Slack app.
4. In your Fusion application, navigate to the **Setup and Maintenance** work area.
5. Open the **Tasks** panel tab.
6. Click Search from the list of displayed tasks.
7. Search for and select the **Manage Communication Channels** task.
8. Reauthorize your Slack channel.

After the channel is authorized, the integration starts using the finer scope.

**Related Topics**
- Add Scopes to Your Slack App
21 Collaborate with Slack

How You Collaborate with Slack

Using Slack, your service agents can collaborate with subject matter experts to quickly resolve customer questions and issues.

You can integrate your sales and service application with Slack using two different methods. These methods are described in detail in the Slack Channels chapter of the Oracle Fusion Service Implementing Service guide.

**Note:** The Send Additional SR Fields to Slack section isn't applicable for Redwood Service Center. So you can ignore the following topic in that section: Send Additional Fields When an SR Is Forwarded to Slack.

**Related Topics**
- Overview of Setting Up a Slack Channel for Your Fusion Application
- How You Set Up a Slack Channel for Your Fusion Application: Method 2

Create a Collaboration Action for Slack

Using the Administration UI, you can set up or create different collaboration actions.

Let's see how to set up a collaboration action to start an internal conversation in a service request (SR) with a user in Slack. You can also define which attributes of the business object can be shared with Slack as part of the internal conversation.

**Note:** This example is for starting an internal conversation in an SR. You can also use any other suitable action names different from those given in the examples. For this example:
- A child action would be to create a **Reply to Service Request** button. It's a child of the first message received in Slack from Service Center.
- Further, a child of the **Reply to Service Request** child action would be to create a **Submit Reply** action. When a Slack user enters a message and clicks **Submit Reply**, the message goes to Service Center.

These two child actions have been described in the two subsequent topics.

To set up a collaboration action using the Administration UI:
1. Sign in as an administrator.
2. Navigate to the **Setup and Maintenance** work area and open the **Tasks** panel tab.
3. Search for and click the **Manage Collaboration Actions** task.
   The All Collaboration Actions page opens in a new tab.
4. Click **Create Collaboration Action**.
5. In the Action Details region, specify the following details:
a. **Action Name**: Specify a name. For example: Start Internal Conversation in SR.
b. The **Action** field is automatically populated.
c. **Description**: Add a suitable description.
d. **Action Code**: Specify an action code of your choice. For example: start-collab-on-SR.
e. **Business Object**: Select the business object on which you’re creating the collaboration action. For example, Service Request, Opportunity, Lead, and so on.
f. **Action Type**: From this drop-down list, select **Start a Collaboration Conversation**.

**Note**: For this Start a Collaboration Conversation action, the following fields aren’t required: Action Method, Display Sequence, and User Interface Component.

6. Click **Next**.

7. In the Request Details region, specify the following details:

   a. **Request Content Type**: This field is automatically populated.
   b. **Request End Point**: Enter the following end point: /crmRestApi/resources/latest/serviceRequests?
      q=SrId=[SrId]
      The /crmRestApi/resources/latest/serviceRequests part is automatically populated in the field. To facilitate querying the SR object using the primary key field, you're appending the following at the end: ?
      q*Srid*|[Srid]|
   c. **Request Payload**: You can skip this field.

8. Click **Next**.

9. In the Response Details region, specify the following details:

   a. **Response Visibility**: From this drop-down list, select **Public**.
   b. **Response Type**: From this drop-down list, select **Action Attributes**.
   c. **Response Content Type**: This field is automatically populated.
   d. **Response Payload**: You can skip this field.

10. Click **Next**.

11. In the Add Action Attribute region, you must add some SR attributes that you would like to share with Slack users when starting an internal conversation.

   a. Click **Add Attribute**.
   b. In the **Add Action Attribute** dialog box, enter the following details:

   **Note**: See the table at the end of this step for some specific details that you must set for some attributes.

   - **Attribute Name**: Select a name from the drop-down list.
   - **Display Name**: Specify a suitable display name.
   - **Data Type**: Select the appropriate value from the drop-down list.
   - **Default Value**: Specify a default value.
   - **User Interface Component**: This field can have the following values: List, Text Area, or Text Box. The default value is Text Box.
   - **Display Sequence**: Specify a high or low number depending on where you want the UI component to be displayed. For example: You can specify a higher number such as 12 if you want it to be displayed lower down on the page.
   - **Business Object Identifier**: If it’s a field that’s used for identifying a record, then you must select this switch.
Note: Let's say a to and fro message thread about a particular SR exists between Slack and Service Center. Then the linking of the messages is done through this field. You can select SR ID or SR number as the Business Object Identifier, because they both uniquely identify as an SR.

- **Included in Request**: If information is being sent from Slack to Service Center, then select this switch.
- **Included in Response**: If you're sending a response message from Service Center to Slack, then select this switch.
- **End Point**: This field is applicable only if you select the User Interface Component as List.
- **Option Label**: This field is applicable only if you select the User Interface Component as List.
- **Option Value**: This field is applicable only if you select the User Interface Component as List.
- **Deep Link**: If required, provide a deep link that uniquely identifies the SR. For example: Link to SR number that shows up in the Slack UI: `crmUI/service/vp/ec/container/sr/edit?srNumber=[[SrNumber]]` . If you want one of the other attributes to be a link, you can add the deep link to the SR by editing that attribute. For example, you can add the deep link to the SR for the title attribute.

Here's a list of some specific details that you must set for the following common action attributes:

<table>
<thead>
<tr>
<th>Action Attribute</th>
<th>Required Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SrId</td>
<td>Select the Business Object Identifier switch.</td>
</tr>
<tr>
<td>SrNumber</td>
<td>Select the Include in Response switch.</td>
</tr>
<tr>
<td>SrNumber</td>
<td>Provide the following deep link in the Deep Link field: <code>crmUI/service/vp/ec/container/sr/edit?srNumber=[[SrNumber]]</code></td>
</tr>
<tr>
<td>Title</td>
<td>Select the Included in Response switch.</td>
</tr>
<tr>
<td>Problem Description</td>
<td>Select the Included in Response switch.</td>
</tr>
</tbody>
</table>

12. Click **Save**.

Create a Child Action for a Collaboration Action for Slack

A child action is an action within the main collaboration action.

For example: For the Collaboration on Service Request action, you would create a **Reply to Service Request** button as the child. The **Reply to Service Request** button is a child of the first message received in Slack from Redwood Service Center about needing help with an SR. Along with the message, some basic information about the SR is shared.
To create a child action for a collaboration action:

1. Sign in as an administrator.
2. Navigate to the Setup and Maintenance work area and select the Service offering.
3. Open the Tasks panel tab.
4. Search for and click the Manage Collaboration Actions task.

The All Collaboration Actions page opens in a new tab.
5. From the displayed list of existing collaboration actions, click the collaboration action for which you want to create a child action.

The collaboration action opens, and its name is displayed in the navigation pane.
6. Click the plus symbol next to the name of the collaboration action.
7. Specify all the details for the child action as explained in Create a Collaboration Action. Considering the example of the Reply to Service Request button, you would specify the following details:

   a. Action Details region:
      - **Action Name**: Reply to Service Request
      - **Action Code**: Specify a value of your choice. For example: reply-to-sr
      - **Business Object**: Select Conversation Message from the drop-down list.
        That’s because we’re creating a conversation message under the request.
      - **Action Type**: Select Open a Dialog from the drop-down list.

   b. Request Details region:
      The Request End Point is populated automatically, so you don’t have to change anything here.

   c. Response Details region:
      You can leave this page blank. That’s because clicking the Reply to Service Request button would show a message text box in Slack. And you’re not sending a response message from Redwood Service Center to Slack.

   d. Add Action Attribute region:
      Here, you would add only one attribute, which is Message Content.
      - **Attribute Name**: Select MessageContent from the drop-down list.
      - **Data Type**: Select String from the drop-down list.
      - **User Interface Component**: Select Text Area from the drop-down list.
      - Select the Included in Request switch.

8. Click Save.

**Note:** Instead of clicking the Reply to Service Request button, the subject matter expert (SME) can also reply by clicking the native Reply action. The SME must mention the app in the format @AppName in the native Reply. Here, AppName is the name of your company’s Slack app created for Oracle Fusion Service. When the SME mentions your app in this format, your app adds their reply as a message on the request.
Create a Second-Level Child Action for a Collaboration Action for Slack

The child of the Reply to Service Request action in Slack would be the Submit Reply action. When a Slack user enters a message and clicks Submit Reply, the message goes to Redwood Service Center.

**Note:** You can use any other suitable action name instead of **Submit Reply**. Whatever action name you use is displayed in the Slack interface.

To create the **Submit Reply** child action to the **Reply to Service Request** action:

1. Specify all the details for the child action as explained in Create a Collaboration Action. Considering the example of the **Reply to Service Request** button in the previous topic, you would specify the following details:
   a. **Action Details region:**
      - **Action Name**: Submit Reply
      - **Action Code**: You can type any value of your choice here.
      - **Business Object**: Select **Conversation Message** from the drop-down list.
      - **Action Type**: Select **Call an API** from the drop-down list because it's calling a Redwood Service Center API.
      - **Action Method**: Select **Post** from the drop-down list because you're creating a new message.
      - **Display Sequence**: Select 1.
   b. **Request Details region:**
      - **Request Content Type**: This field is populated automatically.
      - **Request End Point**: This field is populated automatically.
      - **Request Payload**: Add the following payload in this field:

        ```json
        {"MessageContent": ":[[MessageContent]]","MessageTypeCd": "ORA_SVC_INBOUND","ParentMessageId": ":[[ConversationMessageId]]","SenderAlternateId": ":[$system.CollabResourceId],"SenderFreeFormAddress": 271
        ```
Add an Event to Capture Messages Mentioning Your Slack App

Let's say an agent needs help with resolving a service request (SR), and they post a question on Slack. A subject matter expert (SME) can reply to their question by clicking either the Reply to Service Request button or the native Reply action.

When the SME clicks the native Reply, they must mention the app in the format @AppName in the native Reply. Here,AppName is the name of your company's Slack app created for Redwood Service Center. When the SME mentions your app in this format, their reply is captured as a message on the SR. But for this to happen, you must add an event in your Slack app to capture such replies.

To add an event that captures messages mentioning your Slack app as conversation messages in Redwood Service Center:

1. Open your Oracle app in Slack.
2. In the Features section of the navigation pane, click Event Subscriptions.
3. On the Event Subscriptions page, in the Enable Events area, turn on the switch to enable events.
4. In the Request URL field, type the following:

   https://{URL}/crmRestApi/collaborationResources/latest/slackAppMention

   **Note:** Remember to replace {URL} in this link with the base URL of your pod.

5. In the Subscribe to bot events area, click Add Bot User Event.
6. Click app_mention.

   The app_mention event name is displayed in the Subscribe to bot events area, along with the description and scope.
7. Click Save Changes.
Prerequisites for Setting Up a Microsoft Teams Channel for Fusion Service

Before you set up the integration of your service application with Microsoft Teams, you must ensure that you have the following:

- The appropriate access or subscription to Microsoft Teams that permits you to use Apps Studio to create an app for Fusion Service.
- Administrator privileges that permit you to sign in to the Azure portal.

Related Topics
- How You Set Up a Microsoft Teams Channel

How You Set Up a Microsoft Teams Channel

Using Microsoft Teams, your service agents can collaborate with subject matter experts to resolve customer questions and issues faster. Here’s the sequence of steps that you must complete to set up the integration of your service application with Microsoft Teams:

| Note: Each of these steps is described in a separate topic, and you must complete them in the given order. |

<table>
<thead>
<tr>
<th>Step no.</th>
<th>Name of topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a Microsoft Teams App for Redwood Service Center</td>
</tr>
<tr>
<td>2</td>
<td>Set Up a Bot User for Your Microsoft Teams App</td>
</tr>
<tr>
<td>3</td>
<td>Register Your Microsoft Teams App in the Azure Portal</td>
</tr>
<tr>
<td>4</td>
<td>Enable Collaboration With Microsoft Teams in FSM</td>
</tr>
<tr>
<td>5</td>
<td>Update FSM with Credentials of Your Microsoft Teams App</td>
</tr>
<tr>
<td>6</td>
<td>Create a Microsoft Teams Channel in Redwood Service Center</td>
</tr>
<tr>
<td>7</td>
<td>Enable Notifications to Microsoft Teams</td>
</tr>
</tbody>
</table>
## Create a Microsoft Teams App

To create a Microsoft Teams app for Redwood Service Center:

1. In Microsoft Teams, click **Apps** in the navigation pane.
2. On the Apps page, search for and add **App Studio**.
3. In the **Manifest editor** tab of **Apps Studio**, click **Create a new app**.
4. On the **App details** page, specify the details in the following sections:
   a. **App names**: Enter the short and full names for your app. The short name that you specify automatically appears in the navigation pane.
   b. **Identification**: Remember to click **Generate** below the **App ID** field to generate the app ID.
   c. **Descriptions**: Enter the short and full descriptions for your app.
   d. **Developer information**: Enter your company name and website.
   e. **Partner information**: If a partner organization is building the app for you, you must enter their Microsoft Partner Network ID. This section is optional and isn't applicable if your company is building the app.
   f. **App URLs**: Provide the links to your policy statement and terms of use.
   g. **Branding**: Upload the two icons for your app as required, and follow the instructions to select an app accent color.
5. Go to the **Capabilities** section of the navigation pane to set up a bot user for your Microsoft Teams app.

   For more details, see Set Up a Bot User for Your Microsoft Teams App.
6. Go to the **Finish** section of the navigation pane and click **Test and distribute**.
7. Click **Download**.

   The Microsoft Teams app that you created for Redwood Service Center is downloaded as a compressed file.

<table>
<thead>
<tr>
<th>Step no.</th>
<th>Name of topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Create a Collaboration Action</td>
</tr>
<tr>
<td>9</td>
<td>Create a Child Action for a Collaboration Action</td>
</tr>
<tr>
<td>10</td>
<td>Create a Child Action for the Reply to Service Request Child Action</td>
</tr>
<tr>
<td>11</td>
<td>Configure the FND_IDP_PROXY_USER_WHITELIST Profile Option</td>
</tr>
<tr>
<td>12</td>
<td>Upload Your Microsoft Teams App</td>
</tr>
<tr>
<td>13</td>
<td>Install Your Microsoft Teams App and Add It to Your Team</td>
</tr>
</tbody>
</table>
Set Up a Bot User for Your Microsoft Teams App

To set up a bot user for your Microsoft Teams app:

1. In Microsoft Teams, go to the **Capabilities** section of the navigation pane.
2. Click **Bots**.
3. The **Set up a bot** dialog box displays two tabs:
   - **New bot**: Click this tab to create a new bot user for your app.
     i. In the **Name** field, enter a name for your new bot.
     ii. In the **Messaging bot** and **Calling bot** regions, select the check boxes that are relevant for your company.
     iii. In the **Scope** region, select the **Personal**, **Team** check boxes.
     iv. Click **Create bot**.
   - **Existing bot**: Click this tab to configure an existing bot user for your app.
     i. In the **Bot** dialog box, in the **Bot ID** region: You can either select from an existing bot or connect to a different bot ID by specifying the ID.
     ii. In the **Messaging bot** and **Calling bot** regions, select the check boxes that are relevant for your company.
     iii. In the **Scope** region, select the **Personal**, **Team** check boxes.
     iv. Click **Save**.
4. On the **Bots** page, in the **App passwords** region, click **Generate new password**.
   **Note**: You must save this generated password. This password is used later as the client secret when you configure the MS Teams credentials in Service Center.
5. In the **Messaging endpoint** region, enter the bot endpoint address. For example: `https://environment-name/crmRestApi/collaborationResources/latest/activities`
   Here, environment-name refers to the environment where you have deployed Oracle Service Center.

Register Your Microsoft Teams App in the Azure Portal

Ensure that have an Azure account before you register your Microsoft Teams app in the Azure portal.

To register your app in the Azure portal:

1. Go to the Azure Portal at: `portal.azure.com`
2. Navigate to the Manage Azure Active Directory region and click **View**.
3. In the navigation pane, click **App registrations**.
   In the App registrations page, you can see the new Microsoft Teams app that you created.
4. Click your app.
5. Copy the following information from the **Essentials** region:
Oracle Fusion Service
Implementing Service Center with the Redwood User Experience

Chapter 22
Collaborate with Microsoft Teams

- **Application (client) ID**: You must enter this application client ID while updating FSM with the credentials of your Microsoft Teams app.
- **Directory (tenant) ID**: You use this ID as the account name of the Microsoft Teams channel that you create in Fusion Service.

Enable Collaboration With Microsoft Teams in Functional Setup Manager

You can enable collaboration of Service Center with Microsoft Teams by turning on the administration UI.

After the administration UI is turned on, you can see all the tasks related to Microsoft Teams integration in Functional Setup Manager (FSM). For example: Manage Microsoft Teams Credentials, Manage Collaboration Network Credentials, and Manage Collaboration Actions. The Manage Collaboration Actions task takes you to all the actions in the administration UI.

To enable collaboration of Service Center with Microsoft Teams in FSM:

1. Sign in as an administrator or a setup user.
2. Navigate to the Setup and Maintenance work area and select the Service offering.
3. Select the Communication Channels functional area.
4. Click the Change Feature Opt In link.
6. Ensure that the Enable check box is selected and click Edit in the Features column.
8. For Microsoft Teams, select the Enable check box.
9. Click Done.

Update Functional Setup Manager with Credentials of Your Microsoft Teams App

To update the Functional Setup Manager (FSM) in Fusion Service with the credentials of your Microsoft Teams app:

1. Sign in to Service Center as a setup user or administrator.
2. In the Setup and Maintenance work area, go to the Tasks panel tab.
3. Search for and click Manage Microsoft Teams Credentials.

   The Manage Collaboration Network Credentials page is displayed.
4. In the Collaboration Network Application Credentials region, enter the required information in the following fields:
   - **Client ID**: Enter the Application Client ID that you copied from the Azure portal. For more information, see Register Your Microsoft Teams App in the Azure Portal.
   - **Client Secret**: Enter the password that you generated in the App passwords region of the Bots page. For more information, see step 3 in Set Up a Bot User for Your Microsoft Teams App.
Create a Microsoft Teams Channel

To create a Microsoft Teams channel in Redwood Service Center:

1. Sign in as an administrator or a setup user.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Click Search from the list of displayed tasks.
4. Search for and select Manage Communication Channels.
5. In the Service Channels page, click Create Channel.
6. In the Create Channel window, select CRM in the Stripe Code field.
7. Select the Purpose as Collaboration.
8. Select the Channel Type as Microsoft Teams.
9. Search for and select Manage Communication Channels.
10. In the Account Name field, enter the directory tenant ID that you copied from the Azure portal.
    - For more information, see Register Your Microsoft Teams App in the Azure Portal.
11. The Channel Code field is autogenerated.
    - The channel code uniquely identifies a communication channel when exporting or importing channels from one environment to another.
    - If the autogenerated channel code is unique, you can leave it unchanged.
    - If the autogenerated channel code isn't unique, add a set of characters to the code to make it unique.
12. Enter a Display Name for the Microsoft Teams channel.
13. Select the Business Unit from the drop-down list.
    - Note: You can see this field only if you have enabled multiple business units for your deployment.
14. Select the Active check box.
15. Click Save and Close.

Related Topics
- Register Your Microsoft Teams App in the Azure Portal

Send and Receive Attachments from Microsoft Teams Channel Users

You can send and receive attachments when communicating with users in a Microsoft Teams channel.

To send a file as an attachment to a specific Microsoft Teams channel, you must request access to the following Microsoft privileged APIs. You can find these APIs listed under List channel messages > Permissions:

- ChannelMessage.Read.All
Here's how you request access to these protected APIs:

1. Navigate to Protected APIs in Microsoft Teams.
2. Click Request Form.
3. Complete the request form and submit.

Enable Notifications to Microsoft Teams

All outbound messages from Redwood Service Center to Microsoft Teams use the notifications framework. So, for outbound messages to be delivered to Microsoft Teams, you must enable notifications.

For more information about how to enable notifications, see "Enable Notifications for Service Requests".

Related Topics
- Enable Notifications for Service Requests

Create a Collaboration Action

Using the Administration UI, you can set up or create different collaboration actions.

Let's see how to set up a collaboration action to start an internal conversation in an SR with a user in Microsoft Teams. You can also define which attributes of the business object can be shared with Microsoft Teams as part of the internal conversation.

Note: This example is for starting an internal conversation in an SR. You can also use any other suitable action names different from those given in the examples. For this example:

- A child action would be to create a Reply to Service Request button. It's a child of the first message received in Microsoft Teams from Redwood Service Center.
- Further, a child of the Reply to Service Request child action would be to create a Submit Reply action. When a Microsoft Teams user enters a message and clicks Submit Reply, the message goes to Service Center.

These two child actions have been described in the two subsequent topics.

To set up a collaboration action using the Administration UI:

1. Sign in as an administrator.
2. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
3. Search for and click the Manage Collaboration Actions task.
4. Click Collaboration Actions.
5. In the Action Details region, specify the following details:
a. **Action Name**: Specify a name. For example: Start Internal Conversation in SR.

b. The **Action** field is automatically populated.

c. **Description**: Add a suitable description.

d. **Action Code**: Specify an action code of your choice. For example: start-collab-on-SR.

e. **Business Object**: Select the business object on which you're creating the collaboration action. For example, Service Request, Opportunity, Lead, and so on.

f. **Action Type**: From this drop-down list, select Start a Collaboration Conversation.

**Note**: For this Start a Collaboration Conversation action, the following fields aren’t required: Action Method, Display Sequence, and User Interface Component.

6. Click **Next**.

7. In the Request Details region, specify the following details:

   a. **Request Content Type**: This field is automatically populated.

   b. **Request End Point**: Enter the following end point: /crmRestApi/resources/latest/serviceRequests?q=SrId=[SrId]

   The /crmRestApi/resources/latest/serviceRequests part is automatically populated in the field. To facilitate querying the SR object using the primary key field, you're appending the following at the end: ?q*Srid*=[Srid]

   c. **Request Payload**: You can skip this field.

8. Click **Next**.

9. In the Response Details region, specify the following details:

   a. **Response Visibility**: From this drop-down list, select Public.

   b. **Response Type**: From this drop-down list, select Action Attributes.

   c. **Response Content Type**: This field is automatically populated.

   d. **Response Payload**: You can skip this field.

10. Click **Next**.

11. In the Add Action Attribute region, you must add some SR attributes that you would like to share with Microsoft Teams users when starting an internal conversation.

   a. Click **Add Attribute**.

   b. In the **Add Action Attribute** dialog box, enter the following details:

   **Note**: See the table at the end of this step for some specific details that you must set for some attributes.

   - **Attribute Name**: Select a name from the drop-down list.

   - **Display Name**: Specify a suitable display name.

   - **Data Type**: Select the appropriate value from the drop-down list.

   - **Default Value**: Specify a default value.

   - **User Interface Component**: This field can have the following values: List, Text Area, or Text Box. The default value is Text Box.

   - **Display Sequence**: Specify a high or low number depending on where you want the UI component to be displayed. For example: You can specify a higher number such as 12 if you want it to be displayed lower down on the page.

   - **Business Object Identifier**: If it’s a field that’s used for identifying a record, then you must select this switch.
Note: Let’s say a to and fro message thread about a particular SR exists between Microsoft Teams and Service Center. Then the linking of the messages is done through this field. You can select SR ID or SR number as the Business Object Identifier, because they both uniquely identify an SR.

- **Included in Request**: If information is being sent from Microsoft Teams to Service Center, then select this switch.
- **Included in Response**: If you’re sending a response message from Service Center to Microsoft Teams, then select this switch.
- **End Point**: This field is applicable only if you select the User Interface Component as List.
- **Option Label**: This field is applicable only if you select the User Interface Component as List.
- **Option Value**: This field is applicable only if you select the User Interface Component as List.
- **Deep Link**: If required, provide a deep link that uniquely identifies the SR. For example: Link to SR number that shows up in the Microsoft Teams UI: `crmUI/service/vp/ec/container/sr/edit?srNumber=[[SrNumber]]`. If you want one of the other attributes to be a link, you can add the deep link to the SR by editing that attribute. For example, you can add the deep link to the SR for the title attribute.

Here’s a list of some specific details that you must set for the following common action attributes:

<table>
<thead>
<tr>
<th>Action Attribute</th>
<th>Required Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SrId</td>
<td>Select the Business Object Identifier switch.</td>
</tr>
<tr>
<td>SrNumber</td>
<td>Select the Include in Response switch.</td>
</tr>
<tr>
<td>SrNumber</td>
<td>Provide the following deep link in the Deep Link field: <code>crmUI/service/vp/ec/container/sr/edit?srNumber=[[SrNumber]]</code></td>
</tr>
<tr>
<td>Title</td>
<td>Select the Included in Response switch.</td>
</tr>
<tr>
<td>Problem Description</td>
<td>Select the Included in Response switch.</td>
</tr>
</tbody>
</table>

12. Click **Save**.

Create a Child Action for a Collaboration Action

A child action is an action within the main collaboration action.

For example: For the Collaboration on Service Request action, you would create a **Reply to Service Request** button as the child. The **Reply to Service Request** button is a child of the first message received in Microsoft Teams from Redwood Service Center about needing help with an SR. Along with the message, some basic information about the SR is shared.
Note: You can use any other suitable action name instead of Reply to Service Request. Whatever action name you use is displayed in the Microsoft Teams interface.

To create a child action for a collaboration action:

1. Sign in as an administrator.
2. Navigate to the Setup and Maintenance work area and select the Service offering.
3. Open the Tasks panel tab.
4. Search for and click the Manage Collaboration Actions task.

   The All Collaboration Actions page opens in a new tab.
5. From the displayed list of existing collaboration actions, click the action for which you want to create a child action.

   The collaboration action opens, and its name is displayed in the navigation pane.
6. Click the plus symbol next to the name of the collaboration action.
7. Specify all the details for the child action as explained in Create a Collaboration Action. Considering the example of the Reply to Service Request button, you would specify the following details:

   a. Action Details region:

      - **Action Name**: Reply to Service Request
      - **Action Code**: Specify a value of your choice. For example: reply-to-sr
      - **Business Object**: Select Conversation Message from the drop-down list.

         That’s because we’re creating a conversation message under the SR.
      - **Action Type**: Select Open a Dialog from the drop-down list.

   b. Request Details region:

      The Request End Point is populated automatically, so you don’t have to change anything here.

   c. Response Details region:

      You can leave this page blank. That’s because clicking the Reply to Service Request button would show a message text box in Microsoft Teams. And you’re not sending a response message from Service Center to Microsoft Teams.

   d. Add Action Attribute region:

      Here, you would add only one attribute, which is Message Content.

      - **Attribute Name**: Select MessageContent from the drop-down list.
      - **Data Type**: Select String from the drop-down list.
      - **User Interface Component**: Select Text Area from the drop-down list.
      - Select the Included in Request switch.

8. Click Save.

Note: Instead of clicking the Reply to Service Request button, the subject matter expert (SME) can also reply by clicking the native Reply action. The SME must mention the app in the format @AppName in the native Reply. Here, AppName is the name of your company’s Microsoft Teams app created for Service Center. When the SME mentions your app in this format, your app adds their reply as a message on the request.
Create a Child Action for the Reply to Request Child Action

The child of the Reply to Service Request action in Microsoft Teams would be the Submit Reply action. When a Microsoft Teams user enters a message and clicks Submit Reply, the message goes to Redwood Service Center.

**Note:** You can use any other suitable action name instead of **Submit Reply**. Whatever action name you use is displayed in the Microsoft Teams interface.

To create the Submit Reply child action to the Reply to Service Request action:

1. Specify all the details for the child action as explained in Create a Collaboration Action. Considering the example of the **Reply to Service Request** button in the previous topic, you would specify the following details:
   
   **Action Details region:**
   
   - **Action Name:** Submit Reply
   - **Action Code:** You can type any value of your choice here.
   - **Business Object:** Select **Conversation Message** from the drop-down list.
   - **Action Type:** Select **Call an API** from the drop-down list because it's calling a Service Center API.
   - **Action Method:** Select **Post** from the drop-down list because you're creating a new message.
   - **Display Sequence:** Select **1**.

   **Request Details region:**

   - **Request Content Type:** This field is populated automatically.
   - **Request End Point:** This field is populated automatically.
   - **Request Payload:** Add the following payload in this field:

     ```json
     {"MessageContent": "[[MessageContent]]", "MessageTypeCd": "ORA_SVC_INBOUND", "ParentMessageId": [[ConversationMessageId]], "SenderAlternateId": [[$system.CollabResourceId]], "SenderFreeFormAddress": 282}
     ```
c. Response Details region:

- **Response Visibility**: Select Public from the drop-down list.
- **Response Payload**: Set the value to: 
  ```
  { "text": "[MessageContent]" }
  ```
  This message content is also echoed to all the other SMEs in Microsoft Teams, so they all can view the reply given by the first SME. And they can add on to it if required.
- **Response Type**: Select **User-Defined JSON Formatted Result** from the drop-down list.
- **Response Content Type**: This field is populated automatically.

d. Add Action Attribute region:

This page has only one attribute, which is **Message Content** because that's the only attribute for Submit Reply.

- Ensure that you select the **Included in Request** switch.

2. Click **Save**.

### Configure the FND_IDP_PROXY_USER_WHITELIST Profile Option

Let's say your agent sends a message to a Microsoft Teams user, seeking help to resolve a customer issue. When the Microsoft Teams user replies, their reply reaches Redwood Service Center only if the FND_IDP_PROXY_USER_WHITELIST profile option is set to the default value FUSION_APPS_CRM_SOAP_APPID.

That's because the FUSION_APPS_CRM_SOAP_APPID user's credentials are used to create all messages sent from Microsoft Teams to Redwood Service Center.

**Note**: Typically, the profile option is automatically set to the default value. But sometimes, it may have a blank value. If the value isn't set to FUSION_APPS_CRM_SOAP_APPID, you can follow these steps to set the value.

(Optional) To configure the FND_IDP_PROXY_USER_WHITELIST profile option:

1. Sign in as a setup user or administrator.
2. Navigate to the **Setup and Maintenance** work area.
3. Open the **Tasks** panel tab and click **Search**.
4. Search for and select the **Manage Administrator Profile Values** task.
5. On the Manage Administrator Profile Values page, navigate to the Search region.
6. In the **Profile Option Code** field, type FND_IDP_PROXY_USER_WHITELIST.
7. Click **Search**.

The FND_IDP_PROXY_USER_WHITELIST profile option is displayed in the Search Results: Profile Options region.

8. In the FND_IDP_PROXY_USER_WHITELIST: Profile Values region, ensure that the **Profile Value** for the Site **Profile Level** is set to **FUSION_APPS_CRM_SOAP_APPID**.
9. Click **Save**.
Upload Your Microsoft Teams App

To upload the Microsoft Teams app that you created for Redwood Service Center:

1. In the Microsoft Teams navigation pane, click Apps.
2. In the Apps page, click Upload a custom app from the list.
3. Click Upload for app name.

   Here, app name stands for the name of the Microsoft Teams app that you created for Redwood Service Center.

4. In the Open dialog box, search for the compressed file for your Microsoft Teams app. You downloaded this compressed file in the last step in Create a Microsoft Teams App for Redwood Service Center.
5. Click Open.

   The app that you created is now uploaded to Microsoft Teams.

Related Topics
• Create a Microsoft Teams App

Install Your Microsoft Teams App and Add It to Your Team

After you upload your app, you must install the app and add it to your team in Microsoft Teams.

1. In Microsoft Teams, go to the Apps tab and click More apps.

   In the Built by your org region of the Apps page, you can see the Microsoft Teams app that you created for Redwood Service Center.

   Note: If you have created multiple apps, you can see all of them here.

2. Click the app that you want to install.
3. From the Open drop-down list, click Add to a team.

   In the Type a team or channel name region, your channel is selected by default.
4. If you have created multiple apps, you can select the app of your choice by clicking the cross mark.
5. Click Set up a bot.

   Your Microsoft Teams app is now installed for the team associated with the channel selected in step 3.
6. Navigate to Teams in the navigation bar.
7. Click the ellipsis next to your app name.
8. Click Manage teams.

   A page with your team name is displayed.
9. Click the Apps tab.
Your Microsoft Teams app is now displayed in the list of apps.
Configure Notifications

Set Notification Triggers and Preferences

Enable Notifications

A notification is an alert for users such as agents and, to notify them about an event on the request, and enable them to take the necessary actions.

Enabling notifications is a global setup and feature opt-in step. Here's how you enable the notifications feature for requests:

1. Sign in to the application as a setup or administrator user.
2. Navigate to Setup and Maintenance.
3. Select the offering.
4. In the Functional Areas section, select Change Feature Opt In.
5. Select the Enable check box for in the Productivity Tools row.

   When the Notifications feature is enabled, bell notifications are automatically enabled for requests.

6. Click the Edit icon in the Features column of the Productivity Tools row.
7. Enable your required notification delivery channels:
   - To enable email notifications, select the Enable check box for Use Email as a Notification Delivery Channel.
8. Click Done on the Edit Features Productivity Tools page.
9. Click Done.

How You Set Up Groovy Notification Triggers

As an administrator, here's how you configure notifications after you have enabled the notifications feature:

1. Define notification triggers as Groovy scripts in Application Composer, containing the conditions that must be met for each notification. Notifications are triggered when the defined conditions are met. For example, a trigger can be defined to send a notification when a high severity has been assigned to an agent.

   For more information about defining notification triggers, see the "Define Notification Triggers" section.

2. Configure the notification preferences using the Notification Preferences page. For example, to specify the notification message using SmartText, and the notification recipient.

   For more information about notification preferences, see the "Set Notification Preferences" section.
Configure Notifications

Note:

- You can temporarily disable all notifications using the profile option SVC_DISABLE_BO_NOTIFICATIONS. Oracle recommends to use this option when you're doing a bulk import of data, so that you don't get multiple notifications.
- You can temporarily enable or disable specific notifications from the Notification Preferences page.

Define Notification Triggers

Here's how you define a Groovy script for a notification trigger:

1. Sign in to the application as a setup or administrator user.
2. Click Navigator > Configuration > Sandboxes.
3. Create a sandbox or select an existing one, and click Enter Sandbox to activate the sandbox. Your sandbox is activated, and you can see its name on the sandbox bar over the global header.
4. In the Navigator, click Application Composer. The Application Composer page is displayed.
5. Select . The section is displayed.
6. Click the Triggers tab.
7. From the Action menu, click Add. The Create Object Trigger section is displayed.
8. Create a Groovy trigger:
   a. Specify the Name, Error Message, and Trigger Definition details.
      - Oracle recommends you to use the trigger type After Changes Posted to Database. This trigger type enables you to stop potential issues if the Groovy script is accidentally written to run indefinitely. If the trigger type is set to Before Update to Database, with a bad script, there may be some issues.
      - If you're creating a new object, and you want to trigger a notification when the object is created, Oracle recommends you to use the trigger type Before Insert to Database. However, some of the Before trigger types don't have all attributes exposed yet, resulting in some fields being blank. To debug your triggers if you're not getting the expected results, follow the steps in the section "Debug Groovy Triggers".
      - The isAttributeChanged() function works only for the Before trigger types. The workaround for the After trigger types involves retrieving the old value before the database is updated, then retrieving the new value after the update, and then comparing the two values to see whether the attribute is changed. However, this workaround works only for high-level attributes such as CriticalFlag and Status. This workaround may not work for the ViewRow attribute, for example, when you're retrieving the team from .

When you create a Groovy script, you need the API names of the fields you're trying to access. To create your triggers based on parent/child fields, do the following:
   i. In the Trigger Definition section, click Show/Hide Expression Palette.
   ii. Click the Fields tab.
   iii. Select an Object.
   iv. Click the Maximize Edit Script arrow. The fields for the selected object are displayed.
   v. Select the API you want, and click Insert.
   vi. To close the expression palette, click the Restore Edit Script arrow, and then click Show/Hide Expression Palette.
b. Click **Save and Close**.

9. Navigate to the Notification Preferences page to configure your preferences for the notifications.

For more information about configuring notification preferences, see the "Set Notification Preferences" topic.

| Note: | You can reuse a Groovy notification trigger if no other notification uses it. |

**Related Topics**

- Overview of Sandboxes
- Create and Activate Sandboxes
- Publish Sandboxes

Set Notification Preferences

The Notification Preferences page enables administrators to configure the notification rules. Users who have the duty roles can access this page.

Here's how you configure the notification rules:

| Note: | Ensure that your triggers are published. |

1. Sign in to the application as an administrator.
2. In the **Navigator**, click **Tools > Notification Preferences**.

   The Notification Preferences page is displayed.

3. From the **Object** drop-down list, select .

| Note: | Other supported objects are also displayed in the **Object** drop-down list. |

a. Click **Add**. A blank row is added in the table.

b. To enable the notification trigger, select **Yes** from **Enabled** drop-down list.

c. To prevent users from personalizing this notification through the User Notification Preferences page, select **No** from the **OverrideFlag** drop-down list.

| Note: | To clean up the user notification preferences data, in case the resource leaves your company or is no longer active, run the **Purge Obsolete User Preferences** scheduled process. This scheduled process lets your organization ensure that your data on user notification preferences isn't stale. |

d. Select a Groovy notification trigger from the **Triggering Event** drop-down list.

e. Enter the **Notification Name** and **Description**.

f. In the **Recipients** column, click **Edit**.

   The **Configuration for Trigger Name** dialog box is displayed.

g. Select the notification delivery options for the respective recipients.

   For an enabled triggering event, notifications are sent to the specified recipients only if you select at least one delivery option. If any delivery method is selected for a specific recipient, that recipient will
also receive bell notifications. Additionally, if you do not select the **Bell Notifications** option, then no notifications will be sent to the specified recipients.

The following tables describe the recipients and delivery options for the request object:

<table>
<thead>
<tr>
<th>Recipients for Service Request Object</th>
<th>Delivery Options for Service Request Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>- <strong>Assigned To</strong>: Resource to whom the request is assigned.</td>
<td>- <strong>Bell Notifications</strong>: Sends a bell notification to the web application.</td>
</tr>
<tr>
<td>- <strong>Manager of Assigned To</strong>: Manager of the resource to whom the request is assigned.</td>
<td>- <strong>Email Notifications</strong>: Sends an email notification to the selected internal recipients’ primary work email ID saved in the application.</td>
</tr>
<tr>
<td>- <strong>Resource Team</strong>: Additional resources that have been added to a request on the Team subtab.</td>
<td><strong>Note:</strong> The from email address is configured through the SVC_OUTBOUND_EMAIL_FROM profile option. If that isn't specified, the default from email address <a href="mailto:noreply@oracle.com">noreply@oracle.com</a> is used.</td>
</tr>
<tr>
<td>If you have a team of resources collaborating on a request, and a trigger such as the request escalating to Critical status happens, the entire team can be informed.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Queue Owner</strong>: Owner of the queue.</td>
<td></td>
</tr>
<tr>
<td>If your organization uses manual assignment, the queue owner can be notified when a new request is associated with a queue owned by the queue owner. For information about the setup steps required to send a notification to a queue owner,</td>
<td></td>
</tr>
</tbody>
</table>
Configure Notifications

Recipients for Service Request Object

<table>
<thead>
<tr>
<th>Delivery Options for Service Request Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>see the “Trigger a Notification to the Queue Owner” section.</td>
</tr>
</tbody>
</table>

**h.** To let users follow a specific and receive all notifications for that request, select the **Enable Followers** check box.

When enabled, users with the correct permissions will see the **Follow** option in the **Actions** menu of the Details page.

The notification followers receive notifications for all supported channels, when any notification event is triggered for the requests they follow.

To enable this feature for the site, set the ORA_ENABLE_FOLLOW_NOTIFICATIONS profile option to **Yes**.

To follow a, users must have the SVC_GET_SR_FOLLOW_NOTIFICATIONS permission. This privilege is added to the following ready-to-use duty roles:

**Note:** To evaluate whether a resource is still valid and enabled to follow specific requests, run the Purge Obsolete Notification Followers scheduled process. This scheduled process removes inactive and end-dated users from following the request, so that the application doesn't get overloaded with stale data. This scheduled process lets your organization ensure that your data on notification followers isn't stale.

**i.** Click the **New SmartText** link and enter the **Notification Text** for the selected object.

For more information about using SmartText, see the "Using SmartText" topic.

4. *(Optional)* To delete a notification preference, select the row and click **Delete**. The associated notification text is also deleted.

**Note:** If you delete a notification that uses a Groovy notification trigger, you can create a new notification using the same trigger, if no other notification uses it.

5. *(Optional)* To modify an existing notification text, click the **Update SmartText** icon for the selected row.

6. Click **Save**.

Define Notifications for Custom Objects

The Notification Preferences page lets you define notifications not only for standard objects, but for custom objects too. First, use Application Composer to create triggers on the relevant custom objects for which you want to initiate user notifications. Then, use the Notification Preferences page to specify the recipients and delivery channels for these custom objects.

Here’s how you set up notifications for custom objects:

1. Sign in to the application as a setup or administrator user.
2. Click **Navigator > Configuration > Sandboxes**.
3. Create a sandbox or select an existing one, and click **Enter Sandbox** to activate the sandbox. Your sandbox is activated, and you can see its name on the sandbox bar over the global header.
4. Publish the selected sandbox.
5. In the Navigator, click Application Composer. The Application Composer page is displayed.
6. Select Objects > Custom Objects.
7. Select an existing custom object or create a new custom object with default fields and pages.

For more information on working with custom objects and tags, see Add Objects and Fields in the Configuring Applications Using Application Composer guide.
8. On the Object Overview page, click Manage Tags.

The Object Tags window is displayed.
9. Select the Notifications check box and click Ok.
10. Navigate to Server Scripts for the selected custom object.

The Server Scripts page for the selected custom object is displayed.
11. Click the Triggers tab, and create a new trigger.
12. Click Navigator > Tools > Notification Preferences.

The Notification Preferences page is displayed, where you can configure your notification preferences for the selected custom object.
   a. From the Object drop-down list, select the custom object.
   b. Select the custom object triggering event, and specify the notification recipients and delivery options.
   c. Click Save.

Trigger a Notification to the Queue Owner

Here’s how you trigger a notification to the queue owner:

1. Add the Owner field to the Queue pages as described in the "Add the Queue Owner to the Page Layouts for Queues" topic.
2. Define the notification preference for the object:
   a. Click .

      The Server Scripts Service Request page is displayed.
   b. Create an object trigger for service request escalated. For a sample Groovy script, see the “Sample Groovy Scripts for Notifications” section.
   c. In the Navigator, click Tools > Notification Preferences.

      The Notification Preferences page is displayed.
   d. Create a notification preference using the service request escalated trigger. For the Recipients option, select only Queue Owner.
3. 
4. On the Create or Edit Request page, from the Queue drop-down list, select the queue name you specified in the previous step.
5. Trigger a notification to the specified queue owner by enabling or disabling the Critical status.
Debug Groovy Triggers

Within your Groovy scripts, all your println statements go to the runtime messages. Here's how you view the runtime log and debug your Groovy script:

1. Within a sandbox, navigate to Application Composer.
2. Select Common Setup > Run Time Messages. The Run Time Messages section is displayed.
3. Select the Enable Application Script Logging check box.
4. Trigger your notifications.
   If the Groovy script has appropriate println statements, you receive runtime messages when you navigate back to the Run Time Messages section in Application Composer.

Sample Groovy Scripts for Notifications

Service Request Assigned

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when the service request (SR) is assigned.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Service Request > Server Scripts.

```java
/* DISCLAIMER: This trigger is provided only as a reference.
 * TRIGGER TYPE: Before Update in Database
 * OBJECT: Service Request
 * Use Case: Send a notification when an existing SR is reassigned.
 * Note: You can override the Notification Text and Recipients using the Notification Preferences page.
 */

if (isAttributeChanged('AssigneeResourceId')) {
    try {
        def recipientPartyId = AssigneeResourceId
        def messageText = 'An SR notification (default message).'
        if (recipientPartyId) {
            // Additional code...
        }
    }
} else {
    // Additional code...
}
```
Service Request Escalated

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when the SR is escalated.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Service Request > Server Scripts.

```java
/* DISCLAIMER: This trigger is provided only as a reference.  
 * TRIGGER TYPE: Before Update in Database  
 * OBJECT: Service Request  
 * Use Case: Send a notification when an SR is escalated.  
 * Note: You can override the Notification Text and Recipients using the Notification Preferences page.  
 */

if (isAttributeChanged('CriticalFlag') && CriticalFlag=='Y') {
    try {
        def recipientPartyId = AssigneeResourceId
        def messageText = 'An SR notification (default message).'

        if (recipientPartyId) {
            //Call to send notification
            adf.util.sendNotification(adf, messageText, recipientPartyId)
            //Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
            println("Notification sent to " + recipientPartyId + " because the SR was escalated.")
        } else {
            println("No Assignee associated with this SR")
        }
    } catch (e) {
        println("Failure to trigger notification from Groovy Script " + e.getMessage());
        // Throwing validation exception will show the message on the UI. This is not recommended for published sandboxes.
        // The following code is one of many to illustrate identifying an error in trigger from the UI.
        // Replace <triggerName> with the trigger name you specified when creating this trigger.
        // throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy Script: ' + e.getMessage())
    }
}
```
Customer Replies to a Message

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when a customer replies to a message.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Service Request > Message > Server Scripts.

```groovy
/* DISCLAIMER: This trigger is provided only as a reference.
* TRIGGER TYPE: Before Insert to Database
* OBJECT: Message (child of Service Request)
* Use Case: Send a notification to the assignee when a customer entry is created.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.
*/
if (MessageTypeCd == 'ORA_SVC_CUSTOMER_ENTRY') {
    try {
        def messageText = "A customer entry was received for " + ServiceRequest?.SrNumber
        def recipientPartyId = ServiceRequest?.AssigneeResourceId
        if (recipientPartyId) {
            def messageText = "A customer entry was received for " + ServiceRequest?.SrNumber
            def recipientPartyId = ServiceRequest?.AssigneeResourceId
            // Call to send notification
            adf.util.sendNotification(adf, messageText, recipientPartyId)
            // Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
            println("Notification sent to " + recipientPartyId + " because a customer entry was received.");
        } else {
            println("No Assignee associated with this SR")
        }
    } catch (e) {
        println("Failure to trigger notification from Groovy Script "+ e.getMessage());
    }
}
```

Expired Milestone

This is sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when a milestone expires.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Service Request > Milestone > Server Scripts.

**Note:** This example uses WarnedFlag. However, you can also use ComplianceFlag for similar results.
Configure Notifications

/* DISCLAIMER: This trigger is provided only as a reference.
* TRIGGER TYPE: Before Update in Database
* OBJECT: Milestone (child of Service Request)
* Use Case: Send a notification to the assignee when an SR milestone is expiring.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.
*/

if (isAttributeChanged('WarnedFlag') && WarnedFlag=='Y') {
    try {
        def recipientPartyId = SrAssigneePartyId
        def messageText = 'An SR milestone notification (default message).'
        if (recipientPartyId) {
            //Call to send notification
            adf.util.sendNotification(adf, messageText, recipientPartyId)
            //Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
            //println("Notification sent to " + recipientPartyId + " because the SR was escalated.")
        } else {
            println("No Assignee associated with this SR")
        }
    } catch (e) {
        //Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
        println("Failure to trigger notification from Groovy Script " + e.getMessage());
        // Throwing validation exception will show the message on the UI. This is not recommended for published sandboxes.
        // The following code is one of many to illustrate identifying an error in trigger from the UI.
        // Replace <triggerName> with the trigger name you specified when creating this trigger.
        // throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy Script: ' + e.getMessage())
    }
}

Work Order Assigned

This is sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page when a work order is created.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Work Order > Server Scripts.

/* DISCLAIMER: This trigger is provided only as a reference.
* TRIGGER TYPE: Before Insert to Database
* OBJECT: Work Order
* Use Case: Send a notification when a work order is created.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.
*/

try {
    def messageText = WoId.toString() + ':' + WoNumber + ' - This Work Order has been assigned to you'
    def recipientPartyId = AssigneeResourceId
    def recipientName = AssigneePersonName
    if (recipientPartyId) {
        adf.util.sendNotification(adf, messageText, recipientPartyId)
        //Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
        //println("Notification sent to " + recipientName + " because Work Order assigned to them")
    } else {
        println("No Assignee associated with this Work Order")
    }
} catch (e) {
    //Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
}
Work Order Complete

This sample code triggers a notification to be sent to the recipient specified in the Notification Preferences page when a work order status is updated to complete.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Work Order > Server Scripts.

```groovy
/* DISCLAIMER: This trigger is provided only as a reference.
* TRIGGER TYPE: Before Update to Database
* OBJECT: Work Order
* Use Case: Send a notification when a work order is completed.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.
* When WO_STATUS_CD is exposed in Application Composer, this script can be changed. Change everywhere that says 'WoStatusCdMeaning' to 'WoStatusCd'
* and change the comparison in the if statement to 'ORA_SVC_WO_COMPLETE' instead of 'Complete'. */

if (isAttributeChanged('WoStatusCdMeaning') && WoStatusCdMeaning == 'Complete') {
  try {
    def messageText = WoId.toString() + ':' + WoNumber + ' - This Work Order has been Completed'
    def recipientPartyId = AssigneeResourceId
    def recipientName = AssigneePersonName
    if (recipientPartyId) {
      adf.util.sendNotification(adf, messageText, recipientPartyId)
      //Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
      //println("Notification sent to " + recipientName + " because status of WO is Complete")
    } else {
      println("No Assignee associated with this Work Order")
    }
  } catch (e) {
    //Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
    println("Failure to trigger notification from Groovy Script " + e.getMessage());
  }
}
```

// Throwing validation exception will show the message on the UI. This is not recommended for published sandboxes.
// The following code is one of many to illustrate identifying an error in trigger from the UI.
// Replace <triggerName> with the trigger name you specified when creating this trigger
// throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy Script: ' + e.getMessage())
}
Set Push Notifications

Configure Push Notifications

With the push notification framework users, such as service agents and managers, can get push notifications about service request events delivered to their mobile devices. Once an agent is signed in to the mobile application, they can view a list of their notifications by

You define notifications in Application Composer with your unique conditional logic. This lets you decide when to raise each notification. For example, you can define alerts for upcoming SLA milestones, reassignments, or escalations. The administrator can also decide whether to enable mobile push notifications for certain alerts, or to deliver the alerts only to the Bell notifications on the desktop application. Note that bell notifications are always delivered, even if mobile notifications are disabled. Clicking a notification and navigating to the record details marks the notification as read, and it's cleared from the notification list.

You define notification triggers as a groovy expression in Application Composer using conditions that must be met for each notification. For example, a trigger can be defined to send a notification when a high-severity service request is assigned to a user. When the Service Notifications feature is enabled, Bell notifications are automatically enabled.

Push notifications are supported in iOS and Android devices.

Here's what you do to enable push notifications:

1. Log in as an administrator, click Setup and Maintenance, and then from the Setup menu, select Service.
2. In the Functional Areas section, select Productivity Tools, and then select Change Feature Selection.
3. Select Service Notifications, then click the Enable check box to enable Service Notifications and Mobile Notifications.
Overview of Service Request Similarity

Service Request (SR) Similarity enables an agent to troubleshoot issues accurately and efficiently, by finding similar SRs that may have been previously resolved.

SR Similarity uses adaptive intelligence (AI) for similarity computation, by considering the key standard or custom fields of an SR. The feature is seamlessly integrated within the SR review and edit workflow on the agent-facing user interface (UI).

The feature is currently applicable for English language implementations only.

Before deploying the feature, administrators and power users can test and evaluate similarity computation using the Administrator UI provided specifically for this purpose.

Configure Users for the Administrator's Application

An application is available for testing and administration purposes. To access this application, you need to first configure the users.

You may want to define 2 types of users:

- Power users who will be using the application to test and evaluate the feature.
- Administrators who will be performing administrative operations such as scheduling the data ingestion job.
Here’s how you map the users to similarity roles in Oracle Identity Cloud Service:

1. Navigate to the **Identity Cloud Service Administrator Console** and select **Oracle Cloud Services**.

   For more information on accessing the Identity Cloud Service Administrator Console, see *How to Access Oracle Identity Cloud Service*.

   If the **Oracle Cloud Services** option isn’t available, click **Applications**.
2. From the list of services, select **AI Apps**.
3. Click **Application Roles**.

You’ll see two roles:

- CRM SVC Similarity Administrator, meant for the administrator to perform various configurations, such as, scheduling the data ingestion job, and viewing the similarity service version.
- CRM SVC Similarity User, meant for the power user to test SR Similarity with no data restrictions.

4. From the menu, select **Assign Users**.

This takes you to a page from where you can select users and associate them to the corresponding role, based on what role you want to assign to them.

After the role is granted, that user will be able to use the service.

**Note:** All users created in the application should be replicated in Identity Cloud Service. So, you should be able to assign existing users to the above 2 roles. However, if that’s not the case, you can create new users by clicking on the + icon in the **Users** region, and then assign them to the roles.
Schedule the Processing Job

Here's how you schedule the job that reads the ingested data and sends it to the indexing engine.

1. Sign in to https://<your_host>/crm-svc/ai-similarity/ (where <your_host> is the link to the administrator application), with your administrator credentials.

   The link to the administrator application is available at Identity Cloud Service Administrator Console > Oracle Cloud Services (or Application) > AI Apps > Configuration > Primary Audience.

2. Click Similarity Configuration.
3. If the feature isn't yet activated, the **Activate** button will be displayed, along with the option to add the connection details at this point or later on (Ingestion Configuration switch). If you choose to only start the activation process, click the **Activate** button and wait until completed.

4. If you choose to add the connection details at the Activate step, then click on the switch and enter the username, password, and URL needed to connect to the application, and afterwards click **Activate**.

Username is the one having access to BI Publisher (extraction tool), and the URL is your application host. For example, if the application link is `https://host-fusionappsqa.fa.ocs.oc-test.com/homePage/faces/FuseWelcome`, then the URL to enter on the page is `https://host-fusionappsqa.fa.ocs.oc-test.com`.

Step 2 of the 3-step train is displayed, where you can review the ready-to-use fields considered in the similarity calculation.

a. If you haven't provided the connection details during the activation step, then go to step 1 (Setup) and add the username, password, and URL. Otherwise, skip step 1.

b. Click Validate and Save.

Note: You may want to check if the username and password are correct before entering them. Try to access BI Publisher with these credentials by navigating to https://<your_host>/xmlpserver. For the previous example, it would be https://host-fusionappsqa.fa.ocs.oc-test.com/xmlpserver.

6. In step 2 (Configuration), by default, the ready-to-use fields considered in the similarity calculation are displayed, along with their importance. Importance implies how much significance a field has in the calculation, and consequently has a bearing on what similar SRs are returned and the ranked order of their display in the results list.
a. If you want custom or other standard fields to be ingested and taken into account by the algorithm, click *Edit*.

b. From the *Add Field* drop-down list, select the *Service Request* or *Message* object.

c. Start typing or select a field from the drop-down list. You can select the ready-to-use or customer fields.

d. Select an importance from the drop-down list.

e. Click *Add*.

   **Note:** Adding or removing fields from the configuration impacts the accuracy of the results (similar SRs list). Add additional fields only if those fields contain relevant information that would make the list of similar SRs more accurate. As a recommendation, a few more fields added or replaced should be enough to influence the precision. Do not add multiple fields with the hope of improving the accuracy. On the contrary, it may have an adverse impact on accuracy, since an additional field means it’s cannibalizing the importance of other fields.

f. Double click on a row if you want to change the importance of an already added field in the table.

   ![Image of configuration settings]

   **Note:** Changing the importance of a field alone doesn't need a full re-ingestion. An incremental ingestion is enough.

g. Save the changes when ready. A full re-ingestion is needed for the changes to take effect.
7. In Step 3 (Ingestion), if the activation was done with the Ingestion Configuration switch on, you will see the job is already enabled and runs on a daily basis. Otherwise, click Enable Processing Job. By default, the job will run every 30 minutes.

Also, there's an option for full re-ingestion in case this operation is needed. For example, in a test pod after a refresh from production when data has been deleted and created again.

Here's how the page should look like after enabling both the jobs:

---

**Test and Evaluate Service Request Similarity**

Before the SR Similarity feature is enabled for the application users, power users and administrators should test and evaluate the feature in the test application. After the feature is configured, administrators can optionally verify and test it in the test application.

Here's how power users and administrators test and evaluate the feature in the test application.

1. Sign in to `https://<your_host>/ai-similarity/` with your credentials and click Similar SRs Computation.
2. Evaluate the feature by entering known phrases, words, or strings for the SR field such as Title, Description, Message, or SR Reference Number (if known), and view the results displayed.
3. If the similar SRs displayed are not along expected lines, tweak the importance or the fields configured for similarity computation. However, an addition of a new field or removal of an existing field entails full re-ingestion of data.

Enable Service Request Similarity

You must enable the SR Similarity feature before you can start using it in the application.

Here’s how you do it.

1. Create a sandbox in the application (Configurations > Sandboxes) and add Application Composer as a tool.
2. Go to Application Composer and click Smart Actions.
3. Search for and enable Find Similar Service Requests by selecting the Enabled check box.
4. Publish the sandbox.

The Find Similar Service Requests action will be available on the Service Request Overview page, in the Action Bar.

5. (Optional) Verify and test the feature in the application:
   a. Navigate to the Service Request Overview page for any service request in the application.
   b. Enter Find Similar or Similar in the Action Bar.

      The Find Similar Service Requests action should be displayed.
   c. Select the Find Similar Service Requests action.

      The list of similar SRs should be displayed in a new browser tab.

      You can test and start using this feature.
25 Set Up Service Work Orders

Enable Work Orders

To expose the Redwood User Interface for Service, including Work Orders, you must enable the feature using the Opt-In page.

Refer to the Enable Service Center topic in Related Topics. Follow those steps to expose the Work Orders (Next Generation) tile, and the My Open Work Orders quick action on the home page.

For general information on work orders, refer to the Set Up Work Orders chapter in the Implementing Fusion Service guide.

Related Topics
• Enable Service Center

Extend Work Orders UI Elements

You extend UI elements in your Redwood application using Visual Builder Studio.

You can make changes to the user interface, such as displaying custom fields in your work order forms, creating dynamic layouts for a form, or embedding custom content in a dynamic container page.

For information about extending your Work Order UI elements, including setting up Visual Builder Studio, refer the Extend Service Center chapter. The examples in that chapter pertain to the Service Request layouts, but the basics are the same.
26 Set Up Survey Integration

Overview of Survey Framework

The survey integration framework lets you initiate survey requests based on any object.

You can send surveys from your preferred third-party supplier to your customers based on your chosen rules. You can define who receives a survey, what survey should be sent, and when to send a survey.

The survey integration framework connects with your survey supplier using Oracle Integration Enterprise Edition.

This chapter talks about the steps to enable the survey integration framework, and takes you through example configuration steps using SurveyMonkey and the service requests object. For a successful survey configuration, you must follow the steps as they appear in this chapter. The following graphic shows the set up steps.

Survey Requirements and Licensing

You must have subscriptions to the following cloud services to implement the Survey Integration Framework:

- Oracle Fusion Service 11.13.20.01 and higher
- Oracle Integration Enterprise Edition version 19.4.3.0.0
- Third-party survey product supplier such as a paid account with SurveyMonkey.
Use the Survey Framework with Oracle Integration

Oracle Integration synchronizes Oracle Fusion Service with your third-party survey supplier. Do the following tasks to set up the secure integration between customer-specific instances:

- Create a user with the Setup Survey privilege to connect to Oracle Integration
- Download the Oracle Integration Flows
- Configure Integration Connections

Create the Fusion Service Administrator User for Connecting to Oracle Integration

You must create a user that's used to connect from Oracle Integration to Fusion Service. Follow the steps in the Create Setup Users topic to create the user.

Grant the following roles to the new administrator user:

- Customer Service Manager (if using the Service Request object)
- Human Resource Help Desk Manager (if using HR Help Desk)
- SOA Operator
- Internal Help Desk Administration (if using Internal Help Desk)

Download and Save the Oracle Integration Mapping Package

The first step in setting up the Oracle Integration-based integration is to install the Oracle Integration mapping package from Oracle Marketplace.

1. Sign in to Oracle Marketplace.
2. Select Products from the drop-down list.
3. Enter Survey in the Search field.
4. Click Go.
5. Select the integration package Oracle Fusion Service Survey Integration Framework Sample Integration.
6. Click Get App.
7. Review and accept the Terms and Restrictions.
8. Click Next.
   The package has two files with the following extensions:
   - .dmn
9. Select the `.par` file.
10. Save the file to a local computer.

**Note:** The files in the package are specific examples for using SurveyMonkey as a third-party survey supplier. If you use another supplier, you can use the files as a reference example to create your own.

### Related Topics
- Oracle Cloud Marketplace

## Configure the Integration Connections

Complete the integration between Oracle Fusion Service and your third-party survey supplier in the following order. The steps in this procedure use SurveyMonkey as the example.

1. Import the package into Oracle Integration
2. Configure a connection to the Oracle Fusion Service Instance
3. Configure the Connection. In this example, the connection is configured for SurveyMonkey.
   **Note:** If you're using SurveyMonkey, be sure to review the SurveyMonkey API information at the end of this chapter.
4. Configure the Survey Oracle Integration connection

### Import the Package

The Oracle Integration administrator imports the package.

1. Sign in to Oracle Integration.
2. On the home page, click **Integrations**.
3. Click **Packages**.
4. On the Packages page, click the **Import** button.
5. On the Import Package window, browse for the `.par` file that you downloaded from Oracle Marketplace.
6. Click the **Import** button.
7. The `.par` file is now listed on the Packages page.
   To view what's in the package, click the package in the **Name** column.
8. Click **Close**.
   **Note:** The files in the package are specific examples for using SurveyMonkey as a third-party survey supplier. If you use another supplier, you can use the files as a reference example to create your own.

### Configure the REST Connections

REST connections allow Oracle Integration to connect to the Survey Integration connection for your third-party survey supplier using API calls. Your supplier must have public APIs.

1. From the Oracle Integration home page, navigate to the Integrations page.
2. Click **Connections**.
3. Enter "Survey" in the **Search** field to narrow the search results.
4. On the Connections page, find and click the REST connection. In this example, we use SurveyMonkey. Find the REST connection **Survey Integration SurveyMonkey Connection**.
5. Click on Configure Connectivity and enter the value for Connection URL that’s appropriate for your site. For example, https://api.surveymonkey.com.
6. Click **OK**.
7. On the Detail page, enter the required values for **Security**.

**Note:** You need your Client ID and Client Secret values to continue. These values are provided by your third-party supplier. In this example, SurveyMonkey. In the Settings tab in SurveyMonkey, change the OAuth Redirect URL to:

- https://<Your OIC host>:443/icsapis/agent/oauth/callback

This is the OIC URL you got from the browser. Here's how you get it.

- **a.** Log in to Oracle Integration.
- **b.** Copy and paste the OIC host from your browser. For example, it looks like https://oicapps-oicdevqa.integration.ocp.oraclecloud.com.

For the supplier SurveyMonkey, you must have the following scopes selected in SurveyMonkey under the settings tab:

- View Responses
- View Response details
- View Users
- View Surveys
- View Contacts
- View Collectors
- Create/modify Contacts
- Create/modify Collectors

**Tip:** You can find your SurveyMonkey Client ID and Client Secret values by viewing the details of your SurveyMonkey Private App at https://developer.surveymonkey.com/apps.

Continuing from the previous step, enter the required values for Security. The following table shows the values.

<table>
<thead>
<tr>
<th>Required Security Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Policy</td>
<td>Select OAuth Custom Three Legged Flow from the drop-down list</td>
</tr>
<tr>
<td>Authorization Request</td>
<td>Enter the Authorization Request that's appropriate for your site. For example, <a href="https://api.surveymonkey.com/oauth/authorize?response_type=code&amp;redirect_uri=$%7Bredirect_uri%7D&amp;client_id=xxx">https://api.surveymonkey.com/oauth/authorize?response_type=code&amp;redirect_uri=${redirect_uri}&amp;client_id=xxx</a></td>
</tr>
</tbody>
</table>
Oracle Fusion Service
Implementing Service Center with the Redwood User Experience

Chapter 26
Set Up Survey Integration

<table>
<thead>
<tr>
<th>Required Security Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Where xxx is the Client ID you received from SurveyMonkey.</td>
</tr>
</tbody>
</table>

| Access Token Request       | Enter the Access Token Request that’s appropriate for your site. For example, -X POST -H "Content-Type: application/x-www-form-urlencoded" -d "code=${auth_code}&redirect_uri=${redirect_uri}&grant_type=authorization_code&client_id=xxx&client_secret=yyy" https://api.surveymonkey.com/oauth/token |
|                           | Where xxx is Client ID and yyy is Client Secret |

8. Click **Provide Consent**. For more information, see the FAQs in this chapter.

Before continuing, make sure you receive a success message (access allowed).

9. When you’re prompted, enter your Oracle Integration User Name and Password.

   **Note:** If you encounter the error "The authorization request failed: Invalid redirect uri," copy the redirect_uri parameter value from the browser URL and update the same OAuth Redirect URL as you did in the previous note.

10. Enter your SurveyMonkey User Name and Password.

11. Click **Save** on the Provide Consent window.

12. Click **Test**.

    You see a message saying the test was successful.

13. Click **Save**.

    You see a window listing the integrations that are using the connection.

14. Click **Save** on window.

15. Click **Close** on the Survey Integration Oracle Integration Connection page.

   **CAUTION:** For the integration to access the API for specific functionality of the survey, you must have active scope requirements in your SurveyMonkey Private App.

Configure the Oracle Fusion Service Instance Connection

This connection is used by Oracle Integration to get survey details from Fusion Service

1. On the Oracle Integration home page, click **Connections**.

2. On the Connections page, find Survey Integration Engagement Cloud Connection.

3. Go to the Survey Integration Engagement Cloud Connection Detail page.
4. In the Connection Properties window, enter the values as shown in the following table.
The values in the tables in the following steps are located in the email you receive when Oracle Integration in provisioned.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSC Service Catalog</td>
<td>Enter the service catalog URL for your Oracle Fusion Service instance. For example: https://&lt;CRM domain WSDL URL host&gt;/fndAppCoreServices/ServiceCatalogService?wsdl</td>
</tr>
<tr>
<td>OSC Event Catalog URL</td>
<td>Optionally, enter the event catalog URL for your Oracle Fusion Service instance. For example: https://&lt;CRM domain host&gt;/soa-infra</td>
</tr>
<tr>
<td>Interface Catalog URL</td>
<td>Enter the interface catalog URL for your Oracle Fusion Service instance. For example: https://&lt;CRM domain host&gt;/helpPortalApi/otherResources/latest/ interfaceCatalogs</td>
</tr>
</tbody>
</table>

5. In the Security region, enter the values as shown in the following table.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>&lt;FUSION SERVICE USER NAME&gt;</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Reenter the password.</td>
</tr>
</tbody>
</table>

6. Click the Test button.
   It may take some time for the user <FUSION SERVICE USER NAME> to synchronize with the directory.
   A message appears saying the test was successful.

7. Click Save.
   A window appears listing the integrations that are using the connection.

8. Click Save.
9. Click Close on the Survey Integration Oracle Integration Connection page.

Configure the Survey Integration Oracle Integration Connection
This connection is used by Fusion Service to connect to Oracle Integration.

1. On the Oracle Integration home page, click Connections.
2. On the Connections page, find Survey OIC Connection.
3. Click Survey OIC Connection.
4. Enter the values as shown in the following table.

<table>
<thead>
<tr>
<th>Connection Property</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Type</td>
<td>REST API Base URL</td>
</tr>
<tr>
<td>Connection URL</td>
<td>Enter the Oracle Integration host name URL shown in your browser's address bar. For example: <a href="https://oicapps-oicdevqa.integration.ocp.oraclecloud.com">https://oicapps-oicdevqa.integration.ocp.oraclecloud.com</a></td>
</tr>
</tbody>
</table>

5. In the Security region, enter your Oracle Integration User Name and Password values.
6. Verify your password is correct and click Test.
   A message appears saying the test was successful.
7. Click Save.
   A window appears listing the integrations that are using the connection.
8. Click Save on the window.
9. Click Close on the Survey Integration Oracle Integration Connection page.

Related Topics
- Creating Decisions

Configure the Decision Model

Configure the decision model to determine when a survey is sent.

There are two files in the integration package you downloaded in an earlier step. The .par file, which you already used to import the integration package, and the other is a file with the extension .dmn.

You use the .dmn file to configure the PCS decision model. The file is an example of a decision model that uses the service request object. If you don’t have the same conditions, use the file as a reference and make changes that suit your needs.

If you want to have multiple decision models for the same object, download the file once and import it multiple times to keep the same type definition. For example, for predefined SRs you can import the .dmn file multiple times with a different name. Otherwise, you must manually copy over all the fields of the SR to each new decision model.

Import and Create the Decision Model

Here’s how to import the decision model.

1. On the Oracle Integration home page, go to Decision Models.
2. Click Create.
3. Click Import a Decision Model.
4. Browse for the .dmn file that you downloaded with the integration package.
5. Enter the Name, Space, and Description.
6. Make sure the Open Immediately check box is checked.
Once you import the decision model, click the model to begin configuring the rules for the survey.

7. Activate the decision model.

For more information about creating and testing decision models, refer to the Creating Decisions chapter of the Using Oracle Process Cloud Service guide.

Related Topics
- Creating Decisions

Activate the Survey Integration Flow

After importing the integration package and successfully connecting Oracle Fusion Service, you can now activate the integration flow.

Activate the Integration Flow

Follow these steps to activate the integration flow.

1. Sign in to Oracle Integration.
2. On the home page, click Integrations.
3. Click Packages.
4. Search for the EC_SAMPLE_SURVEY_INTEGRATION package.
5. Click the package name.
   A window appears that lists the integrations in the package.
6. You must activate each integration individually, so take note of the names of each integration in the package.
7. Click Integrations in the menu.
8. Find each integration in the package, and click the Activate icon in the status column.
   For example:
   - Click the Activate icon in the Status column for your integrations package.
   - Click Activate on the confirmation dialog window.
   CAUTION: Oracle doesn't recommended enabling tracing when activating the integration flow in production. If for some reason you enable tracing, you should not select the include payload option.
   - Make sure the flow was activated successfully.
9. Verify that the integration synchronization is working.

Note Your Integration Endpoints

After activating and testing your integration flows, you must note your activation endpoints. You need your endpoints later when you configure your third-party supplier’s survey in Fusion Service.
Endpoints connect your surveys from your survey supplier to Fusion Service so when you’re creating a survey template, all your surveys are visible in Fusion Service.

For example, to find the endpoints using SurveyMonkey as your supplier:

1. Navigate to Integrations in Oracle Integration.
2. Click the Link icon in the Status column of the Get SurveyMonkey Surveys integration.
3. Click the Metadata URL link.

A new tab that contains your Endpoint URL opens. Note the Endpoint URL for later when you set up survey configuration in Fusion Service.

Create Your Survey

Once you have completed the previous steps, continue setting up Survey in Fusion Service, by creating a survey using your third-party survey supplier. Your survey is created, maintained, and sent by that supplier. To create your survey, refer to your supplier’s documentation.

Follow the steps in your supplier’s documentation for Summary, Design, Preview and Score, and Collect Responses. Optionally, follow the steps for Analyze and Present Results.

Note: If you’re using SurveyMonkey as your supplier, Create a Collector and Create a Message are required steps. When you create a Collector, remember that Fusion Service only supports an email channel for collecting survey responses.

Service Request Attributes Used in Templates

If you’re using SRs as your survey object, you can use any SR attribute as a part of your survey’s email template.

For SR’s add attributes to your template by adding the attribute inside double brackets.

Here’s a sample email template using the two most common SR attributes from Fusion Service.

Hi {{PrimaryContactPartyName}},

We’re conducting a survey and your input is appreciated. Click the button below to start the survey. Your SR: {{SrNumber}}

You can get the SR attribute values from the API Name in Application Composer or from REST API.

Most predefined SR fields are already mapped. Here’s how you can see the previously mapped fields:

For this case, we will continue using SurveyMonkey as the example.

1. Log in to Oracle Integration.
2. Search for SurveyMonkey Survey Request Job.
3. Select the job.
4. Find the Map to TestQualifySR in the flow.
   
   Note: The icon next to Map to TestQualifySR is actually the link to the Decision Model in Process Cloud.

    5. Click Map to TestQualifySR and click Edit.
The mapping appears.

Attributes that have a line mapping from the $CurrentSR source are pre-mapped. You can add those attributes to your template by framing them with double brackets as shown in the sample.

To use attributes in your template that aren't pre-mapped, or a non-predefined field that you have created, follow the steps in the Create Mappings topic.

Related Topics
- Survey Monkey Developer Documentation
- Create Mappings

Supported Survey Question Types

When creating your survey questions in the third-party survey supplier tool, you can base them on certain question types.

Here are the types of surveys that are supported with the survey framework:

- Text
- Check box (single select)
- Multiple select check box
- Slider
- Drop down
- Multiple line text
- Option

Enable Surveys in Fusion Service

Follow these steps to enable and set up the Survey feature in Fusion Service.

**Note:** You must be a Fusion Service Administrator with the Setup Survey privilege and all prior tasks in this chapter must be completed before you can proceed.

To opt in to the Survey feature:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Change Feature Opt in link
2. Select **Enable** for Surveys.
3. Click **Done**.

The Survey feature now appears in the Functional Area of the Setup Service page.
Manage Survey Products

Here's how you add your third-party survey supplier to the integration.

**Note:** The predefined product is SurveyMonkey. If that's your third-party survey supplier, there's no need to follow these steps.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Feature: Surveys
   - Task: Manage Survey Products
2. In the Lookup Codes section, click the **Add** icon.
3. In the Lookup Code field, enter a lookup code for your supplier. For example, CUST_SUPPLIER_NAME.
4. Enter the name of your supplier in the **Meaning** field.
5. Enter a description in the **Description** field.
6. Click **Save and Close**.

Manage Survey Objects

In this chapter, we use service requests as the object used for the Survey Framework feature. You can use different objects for surveys.

If you're also using the service request object, there's no need to follow these steps. Otherwise, here's how you add survey objects.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Feature: Surveys
   - Task: Manage Survey Objects
2. In the Lookup Codes section, click the **Add** icon.
3. In the Lookup Code field, enter a lookup code for the object. The predefined object is service requests. If you're using a different object, enter something like CUST_SVC_ACCOUNT.
4. Enter the name of the object in the **Meaning** field. For example, Service Request.
5. Enter a description in the **Description** field. For example, The lookup value for the Service Request.
   - This object is used later when you create a survey template using the Manage Survey Templates task.
6. Click **Save and Close**.
Manage Survey Configurations

You can now configure Survey in Fusion Service. This configuration is used to map the third-party survey supplier (in this example SurveyMonkey), the Oracle Integration URL, User Name, and Password to Fusion Service.

Follow these steps to enable and set up Survey:

SurveyMonkey is used in this example.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Feature: Surveys
   - Task: Manage Survey Configurations
2. In the Survey Products region, click Add.
3. Select your supplier from the Survey Product drop down list. This is the supplier you created in the Manage Survey Products task. In this example, we are using SurveyMonkey.
4. Enter a name for the configuration.
   The configuration name is used later when you create the survey template.
5. Enter the values as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the configuration.</td>
</tr>
<tr>
<td>Integration User</td>
<td>Enter your Oracle Integration User Name</td>
</tr>
<tr>
<td>Integration Password</td>
<td>Enter your Oracle Integration Password</td>
</tr>
<tr>
<td>Integration Endpoint URL</td>
<td>Paste the endpoint URL that you noted earlier.</td>
</tr>
</tbody>
</table>
  
  For example: https://oicapps-oicdevqa.integration.ocp.oraclecloud.com:443/ic/api/integration/v1/flows/rest/GET_SURVEYMONKEY_SURVEYS/1.0/surveys? [Page-value]&PerPage=[PerPage-value]&Name=[Name-value]

**Note:** When you paste the URL, remove everything starting from (and including) the question mark in the Endpoint URL.

6. Click Save and Close.
Manage Survey Templates Task

Survey templates are used to map your survey with decision rules you use to send the survey.

To create and manage survey templates:

In this example, we use SurveyMonkey.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Feature: Surveys
   - Task: Manage Survey Templates (to create and manage general SR survey templates)
   Or
   - Task: Manage Survey Templates for HR Help Desk (to create and manage survey templates for HR Help Desk surveys)
2. To create a template, click Add.
3. Enter a Name and Description for the template.
4. Select the SurveyMonkey Configuration Name from the drop-down list. This name comes from the configuration you created in the Manage Survey Configurations task.
5. Enter a Start Date for the survey.
6. Optionally, enter an End Date.
7. Select Service Request from the Object Type drop-down list. If you're using an object different from a service request, here's where you choose it. For example, in the Manage Survey Objects task you completed earlier, we used the example of entering CUST_SVC_ACCOUNT as the object type.
8. Select the External Survey Name from the drop-down list. The list is of all the surveys you have in SurveyMonkey.
9. Enter the External Survey URL. This is the direct link to your third-party survey.
10. Select a Decision Model Space. The decision model space is the one you created earlier.
11. Select a Decision Model Name. The decision model name is the one you created earlier.
12. Click Save and Close.
Schedule Jobs for Sending Surveys and Collecting Survey Responses

In this task, you schedule and manage jobs. A job identifies all the service requests that are applied to decision rules that you configure.

For example, send a survey to the primary contact of all service requests that have been closed since the last job run. In this example, SurveyMonkey is used as the sample job.

1. From the Integrations page in Oracle Integration, search for the survey job SurveyMonkey Optimized Survey Request Job.
2. Select Schedule from the hamburger menu under Status.
3. On the Schedule page, click the Edit icon.
   You can edit the type, frequency, effective dates, and so on.
   **Note:** To schedule a survey, your survey must be active in Fusion Service.
4. Click Start Schedule.
5. Click Start Schedule on the Scheduled Run window.

**Note:** Scheduled jobs can use a lot of resources. Consider scheduling your jobs for off-hours, or only once or twice a day. If you’re using SurveyMonkey, activate the schedule for both of the following jobs using the steps in this procedure.

- SurveyMonkey Optimized Survey Request Job locates the records that match the rules and sends the requests to the third-party supplier.
- SurveyMonkey Survey Response Sync Job goes out to the third-party supplier, gets the survey responses, and brings them into Fusion Service so BI reports can be run to view the data.

**Related Topics**
- Scheduling Integration Runs

Verify the Survey Integration is Working

You can now test the integration flows.

Verify the Integration is Working

Follow these steps to verify that the integration is working. In this example, we verify the integration for the third-party supplier SurveyMonkey.

1. If you haven’t already done so, create a test survey in SurveyMonkey with a corresponding message. For more information, see the topic Create your SurveyMonkey Survey.
2. Create a test rule. Refer to the topic in this chapter about configuring the Process Cloud decision model.
3. Go to Manage Survey Templates task and create a test survey.
4. Make sure that:
   - The SurveyMonkey survey is visible under External Survey.
   - The Decision Model Space and Decision Model Name display the test rule.
5. You can test the survey by creating a test Primary Contact and test SR that satisfies the rule you created.
6. Wait for the job to run.
7. You should receive the test survey in the test primary contact's inbox.

### How to Include an Administrator-Defined Attribute in the Decision Model

If you have an administrator-defined attribute in your service request and you want to include it in your decision model follow the steps in this topic. This example uses service requests as the object.

For example, you may have created an administrator-defined attribute to capture the level of service based on the Account on the service request such as, Gold, Silver, and Bronze. Let's say you want to include that field to help identify only the Gold Accounts that have a closed SR and send them a different survey than Silver and Bronze. In order to do this, you must to expose the administrator-defined attribute in your decision model.

#### Add the Administrator-Defined Attribute to Your Decision Model

Once you add your administrator-defined attribute to your service request object using Application Composer, here's how you can add the attribute to your decision model.

1. Navigate to Oracle Integration > Processes > Decision Models.
2. Select the Decision Model you want to edit.
3. Expand Service Request in the **Type Definition** region.
4. Edit the **Type Definition** to include the new fields by clicking the menu and selecting **Edit**.
5. In the **Edit Type Definition** dialog box, click the **Add** icon in the Define Type Attributes section.
6. In the **Add Component** dialog box, enter the Name of the administrator-defined attribute.
7. Use the drop-down list to select the **Mode**.
8. Click Close.

You can now include the attribute in the decision model.

9. Click **Activate**.
10. On the **Create Snapshot and activate** dialog window, click **Activate**.

**Note:** There may be characters that were appended to the decision model Name. Make sure the Name is an exact match to the name of your decision model in the Manage Survey Configurations task in Functional Setup Manager.

Don't forget to test the decision model to make sure it works.
Change the Integration to Include the Administrator-Defined Field

Now that you have added the attribute to the decision model, you must change the integration so that the new field can be used in the decision model.

1. Navigate to Oracle Integration > Integrations.
2. Find the integration you want to edit.
   If the job is scheduled, you must pause or stop the job before you continue.
3. Now, deactivate the job by clicking the **Deactivate** icon.
4. Click the job name to edit.
   First, you update the initial query of SRs to pull the new attribute from Fusion Service.
5. On the Scheduled Orchestration page, navigate to **Invoke GetSRPage using Survey Integration Engagement Cloud Connection connection of type Oracle Engagement Cloud**.
   *Invoke GetSRPage...* is where the fields of the SR are being picked up.
6. Click the **Invoke GetSRPage...** Three buttons appear and then click the **Regenerate** link.
   This regenerates the SR fields to include the administrator-defined field.
7. Click **Regenerate** on the Regenerate Artifacts dialog box.
   Next, you update the mapping to include the administrator-defined field in the decision model.
   **Tip:** In between actions, it's a good idea to click **Save**.
8. On the Scheduled Orchestration page, navigate to the **Invoke TestQualifySR using Survey Integration OIC Connection connection of type REST**.
   *Invoke TestQualifySR...* is the actual call to the decision model.
9. Click the icon and select **Edit**.
10. On the Configure REST Endpoint dialog window, select the **Request** tab.
11. In the Select the request payload format section, click the **<<<inline>>>** link.
12. Scroll to the end.
13. Use valid JSON script. Add a comma and press enter on your keyboard.
14. Add the name of the administrator-defined field in quotes.
15. Add a colon after the quotes.
16. After the colon, enter an example value.
   - If the value is true or false, type either true or false.
   - If the value is a number, you can type any number.
   - If the value is text or date time, you can type any value in quotes. It doesn't matter what you type inside the quotes.

The following table shows examples of the last few lines of the sample JSON payload.

<table>
<thead>
<tr>
<th>JSON Syntax</th>
<th>Sample (last few lines of the sample JSON payload)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original:</td>
<td>&quot;CaseNumber&quot; : &quot;ABCDEFGH&quot;, &quot;CaseId&quot; : &quot;ABCDEFGHIJK&quot;, &quot;PrimaryContactPersonId&quot; : &quot;ABCDEFGHIJKLMNOPQRSTUVWXYZ&quot;</td>
</tr>
</tbody>
</table>
## JSON Syntax

<table>
<thead>
<tr>
<th>Sample (last few lines of the sample JSON payload)</th>
</tr>
</thead>
<tbody>
<tr>
<td>)</td>
</tr>
</tbody>
</table>

### Adding a **true/false** field:

```
"CaseNumber" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"CaseId" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"PrimaryContactPersonId" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"MyBooleanField": true
}
```

### Adding a **text** field:

```
"CaseNumber" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"CaseId" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"PrimaryContactPersonId" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"MyTextField": "blahblahblah"
}
```

### Adding a **date/time** field:

```
"CaseNumber" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"CaseId" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"PrimaryContactPersonId" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"MyDateField": "2020-06-01"
}
```

### Adding a **number** field:

```
"CaseNumber" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"CaseId" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"PrimaryContactPersonId" : "ABCDEFGHIJKLMNOPQRSTUVWXYZ",
"MyNumberField": 1234
}
```

17. If you're adding multiple fields, repeat the last steps. Add a comma after the last field, press enter, and so on.
18. Click **OK**.
19. Click the **Summary** tab.
20. Click **Done**.
21. Click **Update** on the Update Configuration dialog box.
   
   **Tip:** Remember to save between actions.

Now, you can edit the mapping.

22. On the Scheduled Orchestration page, navigate to **Map from Schedule to TestQualifySR**.

   The icon for **Map from Schedule to TestQualifySR** is the mapping from the SR to the decision model.
23. Click the icon and select **Edit**.

   The Map page opens.
24. In the **Target** panel, expand the items until you see Service Request.

   The Target panel represents the decision model.
25. Scroll through the Target list to find the new administrator-defined field.
26. In the Sources panel, expand **$CurrentSR**.
27. Scroll down the **$CurrentSR** list until you find the same administrator-defined field.
28. Click the administrator-defined field in the Sources panel and drag it to the same field in the Target panel.
This action creates a line linking the field.

29. After mapping the new field from Source to Target, expand the field (on the Target side of the page) to expose a nil row.

30. Right click on the word nil and select Create Target Node.
   An Expression for: nil dialog window opens.

31. Click the Switch to Developer View icon on the Expression for: nil dialog window.

32. In the Expression for: nil dialog window, enter true().

33. To save your changes, click the Check mark icon on the Expression for: nil dialog window.
   An icon is now displayed in the Mapping Canvas panel that shows a mapping to the word nil.

34. Click Validate.

35. You see a message saying that mapping is valid and ready to use.

36. Click Close.

37. Click Save on the Scheduled Orchestration page.

38. Click Close.
   The final step is to reactivate the integration.

39. Click the Activate icon in the Status column of the integration row.

40. On the Activate Integration dialog window, make sure Enable Tracing is deselected and click Activate and Schedule.

Related Topics
- Creating Decisions
- Working with Decision Models
- Adding and Ordering Decisions

Export and Import the Functional Setup Data for Surveys

If you create the functional setup for the Survey feature in your test environment, you can export the data and import it into your production environment.

You can do this using either the implementation method based on an offering, or from an implementation project. For more information about how to export and import your setup data, see the links at the end of this topic.

Whichever method you use, when the import is complete, you must reconnect the integration by reentering your Endpoint Password and URL (if the URL is different from your test environment).

Here's what to do after your setup data import is complete:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Feature: Surveys
   - Task: Manage Survey Configurations

2. Select the row for the survey configuration.

3. In the Survey Product API Properties region, enter the **Survey Integration User**.
4. Reenter the **Survey Integration Password**.
5. If you have multiple integrations, verify the URL in the **Survey Endpoint URL** field is correct.
   For more information about configuration, see the Manage Survey Configuration topic earlier in this chapter.
6. Verify the survey integration is working.
   For more information about verifying the integration, see the Verify the Survey Integration is Working topic earlier in this chapter.

   **Note:** Be sure to stop your jobs in the test environment before you start the production integration connection. After you verify the integration is working in the production environment, start your jobs again.

### Related Topics
- Setup Data Export and Import Using Implementation Project
- Export Setup Data Using Implementation Project
- Setup Data Export and Import Using an Offering or a Functional Area

### How to Change an Active Decision Model

To change the rules for an active decision model where a job is already running, there are a series of additional steps you must take.

The steps in this example change a current, active decision model where a job is already running. In this example, the decision is set to send surveys when the SR status is Resolved. We want to change it so that surveys are sent when the SR status is Closed.

To do this, you must deactivate and delete the active decision snapshot and then create and activate it again. Here’s how:

#### Pause the Schedule

Before you start, pause the scheduled job for the active rule.

1. Sign in to OIC (Integration Cloud).
2. Search for the survey integration and click the **Pause Schedule** icon on the active job.

#### Change the Rule

Now, let’s change the rule.

1. On the Integration page, go to **Decision Models** and select "EC_SAMPLE_SURVEY_DECISION_MODEL".
2. Select the Decision **SR Status is Resolved** and change the if clause to `ServiceRequest.StatusTypeCd="ORA_SVC_CLOSED"`.
3. Click **Save**.
4. Click **Snapshots** from the Menu bar.
5. In the Manage Snapshots window, click the hamburger menu and select **Deactivate**.
6. Click **Yes** on the **Deactivate** window.
7. Click the hamburger menu and select **Delete**.
8. Click **Yes** on the **Delete Snapshot** window.
9. Click the **Activate** on the menu bar.
10. Add the rule again with the same name as the one you deleted.

   **Note:** The application shows the previous name, but is appended with "-s1". The next two steps help you make sure the new snapshot name and version number match the old name and version number.

11. Make sure the snapshot **Name** is exactly the same as the old name.
12. Enter the same **Version** number as the original snapshot.
13. Check the **Override** check box to override the old version.
14. Click **Activate**.
15. Verify the snapshot is created by clicking the hamburger icon of the **Snapshots** menu and click **View**.

You should see the new snapshot.

---

**Resume the Schedule**

Don't forget to resume the job. Follow the steps at the start of this procedure, but click **Resume Schedule** instead of **Pause Schedule**.

---

**Prerequisites for Survey Integration Using SurveyMonkey**

Throughout this chapter, we used SurveyMonkey as the example for the third-party survey supplier. If you're using SurveyMonkey, you must follow these steps prior to using the Survey Integration Framework with SurveyMonkey.

**Create a paid SurveyMonkey account and create a Private App**

You can create a free account and then upgrade to a paid plan, or upgrade your existing free account.

2. Log in to SurveyMonkey.
4. Review the credentials and select the scope items used in your scenario. You can change this at any time.

**Check your current API call limits**

SurveyMonkey imposes a daily limit on the number of API calls. Therefore, there is a limit to the number of surveys you can send in a day. SurveyMonkey's documentation explains API call maximums. You must license your SurveyMonkey account appropriately for all connections over their defined limits, so make sure you have purchased enough API calls.

**Note:** SurveyMonkey monitors your API calls and if you exceed your limit, you're notified through email to upgrade your plan.

To check your API call limits:

1. Log in to SurveyMonkey.
2. Find your App and click the App name.
3. Click the Overview tab to see your API limits.
FAQs About Survey Integration

Frequently Asked Questions (FAQs) for Survey Integration

This section contains some frequently asked questions (FAQs) when setting up and maintaining survey integration. Scroll or search to find answers to common questions.

What happens if there are failures with Oracle Integration jobs?

You can investigate job failures in Oracle Integration. Sign in your Oracle Integration account and on the home page click Monitoring. On the integration tab, go to Runs. You can see your survey job run log.

What happens if there is a failure testing one of the Oracle Integration connections?

Check to make sure all the credentials you entered are correct. For example, the endpoint connection and your User ID and Password.

What happens if there is a failure with the Oracle Integration activation?

If there is a failure with the Oracle Integration activation, a link for the log that shows the reason for the failure is provided.

Isn't there a built-in survey tool in Fusion Service?

No. You must use a third-party survey supplier.
Can I use the survey integration feature without a paid SurveyMonkey account?

No. You must have a paid account with SurveyMonkey with the appropriate number of allotted API calls in your plan.

Where can I find a sample survey package for Fusion Service?

You can find the sample survey framework integration package on Oracle Marketplace.

Which survey template is sent if an SR qualifies for more than one decision model?

The survey is sent for the most recently updated survey template in Fusion Service.

Can I have more than one decision model?

Yes. You can have as many decision models as you want.

Can I have more than one Friendly Enough expression in a decision model?

You can have as many Friendly Enough expressions as you want.

Can a decision model be based on any object?

Yes. For example, you can base the decision model on the object Active Account. You must make sure the object is passed to the decision model.
How can I deactivate a decision model?

In the Oracle Integration decision model, click on Snapshots (next to Activate) and then find the snapshot you want to deactivate. Click the hamburger menu on the snapshot and click Deactivate.

How can I map a nonstandard attribute to my email template?

To use attributes in your email template that aren't predefined, follow the steps to *Create Mappings* in the Oracle Integration documentation.

Which SR attributes are mapped ready to use?

Most predefined SR fields are already mapped. You can find pre-mapped fields in Oracle Integration.

Can I have multiple survey templates when I set up surveys in Fusion Service?

Yes. Each template corresponds to one survey within your third-party survey supplier.

What happens if I don't specify an end date on a survey template?

Your survey is sent as long as there are SRs that match the decision model rule.

What happens if a job doesn't run?

If a job doesn't run, or if you think there was an error, go to Track Runs in Oracle Integration. To access Track Runs, click Runs from the Integrations menu in Oracle Integration.
What happens if a job fails?

Both the request job and response job have Schedule Parameters that determine the time frame to consider for sending surveys and recording responses.

- **Request Job**: `StartSurveyFromDate`: If the value of `StartSurveyFromDate` is X, then the job will only test SRs that were resolved after X, where X is a date and time.
- **Response Job**: `LastStartTime`: If `LastResponseTime` is Y, then it only pulls responses to the survey submitted after Y.

If a job fails or errors occur when sending surveys or collecting responses, you can submit an ad hoc run outside of the normal schedule to cover the time frame in which the error occurred.

- **Request Job**: If you find that some surveys weren't sent since 1:00pm on March 14th, you can provide this date and time to an ad hoc run (2020-03-14T13:00:00). Then you can restart the normal schedule.
- **Response Job**: If you find that some error occurred and new survey responses weren't collected since 1:00pm on March 14th, you can provide this date and time to an ad hoc run (2020-03-14T13:00:00). Then you can restart the normal schedule.

**Note**: Date and time must be in ISO 8601 format. For example, (2020-03-14T13:00:00).

How can I extend the survey object?

You can extend two survey objects using Application Composer:

- Survey Response
- Survey Request

**Note**: There are no out of the box UI pages for these objects. To view the extended objects, you must build your own VB pages or use REST calls to access the extended objects.

Are there pre-built BI reports for Surveys?

Yes. Survey integration framework comes with pre-built, role-based, best-practice reports. The reports are located in the BI Catalog area at: Shared/Service/Embedded Content/Customer Service Manage/Survey Analysis. For a list of pre-built reports visit: Review prebuilt analytics for Fusion Service.

In addition, you can perform ad hoc analyses of your survey data using purpose-built subject areas. For more information, see the Service - CRM Survey Requests Real Time topic in the Subject for Transactional Business Intelligence guide.
Related Topics
- CRM Survey Requests Summary
- Service-Reports.xls
27 Service Analytics

How to View Analyses Using OTBI

Oracle Transactional Business Intelligence (OTBI) is a real time, self-service reporting solution bundled with your application. It provides prepackaged analytic content built on the Oracle Business Intelligence (BI) platform. These include subject areas for building your own dynamic analyses using an intuitive interface, industry standard metrics, and role-based, best practice reports and dashboards that deliver up-to-the-minute business insight across the entire extent of your service-related business operations.

Here’s how you can view the analyses:

- To access BI Catalog, select Navigator > Tools > Reports and Analytics. The Reports and Analytics page is displayed.
  - Click the Hierarchical Selector >> icon and select My Folders or Shared Folders from the menu. Alternately, you can click the Browse Catalog button. The BI Catalog is displayed, where you can view your personal and shared analyses. You can also create your own analyses based on your business requirements using subject areas. You need to have the necessary privilege for authoring analyses.
- To access the Analytics page, from the Home page, click the Service group icon, and then click the Analytics icon. The Analytics page is displayed. You can search for the analyses available in BI Catalog, and mark your favorites. These favorites stay on the Analytics page as long as they remain favorites. This page also shows the analytics recently viewed by the signed in user.

Related Topics
- Analytics Resources

Service Analytics Roles

The Service analyses are visible for the customer service representative, customer service manager, sales administrator, help desk agent, help desk manager, and help desk administrator job roles. Analyses and the underlying data is secured through a set of delivered OTBI transaction analysis duty roles.

The user with a BI Administrator role defines which users, application roles, and catalog groups have the following privileges:

- Receive the delivery content of an agent.
- Have permission to access a section or alert section in a dashboard.
- Have permission to use a saved modification.
- Have permission to add or edit an existing catalog group.
- Assign permissions to a catalog object.
The OTBI transactional analysis duty roles for your service application are described in detail in the related topic "About Security Roles".

<table>
<thead>
<tr>
<th>Infolet Name</th>
<th>Job Role</th>
<th>OTBI Transactional Analysis Duty Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Agents with Most Pending Service Requests</td>
<td>• Customer Service Manager</td>
<td>• Service Managerial Transaction Analysis Duty</td>
</tr>
<tr>
<td>• Long Wait on Agent</td>
<td>• Sales Administrator</td>
<td>• Service Administrative Transaction Analysis Duty</td>
</tr>
<tr>
<td>• Queues by Unassigned Service Requests</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Team Resolve Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Critical Service Requests</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• My Resolve Time</td>
<td>• Customer Service Representative</td>
<td>• Service Transaction Analysis Duty</td>
</tr>
<tr>
<td>• Pending Tasks</td>
<td>• Sales Administrator</td>
<td>• Service Administrative Transaction Analysis Duty</td>
</tr>
<tr>
<td>• Waiting on Me</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Waiting on Customer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Inbound Social Posts</td>
<td>• Customer Service Manager</td>
<td>• Service Managerial Transaction Analysis Duty</td>
</tr>
<tr>
<td>• Omnichannel Agent Assignments</td>
<td>• Sales Administrator</td>
<td>• Service Administrative Transaction Analysis Duty</td>
</tr>
<tr>
<td>• Omnichannel Assignments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Omnichannel Queue Assignments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Team Open Work Orders</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Team Completed Work Orders</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Team SRCompliance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Team Action Plan Actions Past Due</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• My Open Work Orders</td>
<td>• Customer Service Manager</td>
<td>• Service Managerial Transaction Analysis Duty</td>
</tr>
<tr>
<td>• My Completed Work Orders</td>
<td>• Sales Administrator</td>
<td>• Service Administrative Transaction Analysis Duty</td>
</tr>
<tr>
<td>• My SR Compliance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• My Action Plan Actions Past Due</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• My SR Work Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• My SR Work Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• SR Movement in Queues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related Topics
• About Security Roles

Analytics Subject Areas

Creating analyses begins with subject areas. A subject area is a functional grouping of the contextual entities (also called dimensions) by which the metrics (also called facts) can be analyzed.
Subject areas are the building blocks of analytic content in OTBI. For example, the columns in a tabular report showing the number of open (metric or fact) by Agent Name (context or dimension) are sourced from one of the subject areas. Multiple subject areas can be joined to produce reports, when cross-functional analysis is needed.

The service application comes with a variety of standard subject areas for you to select from when you're building or editing your analytics.

Overview of Parent and Child Interactions in Analytics

With the support for cross-channel interactions, there is the prospect of an initiated interaction crossing channels and agents. Additionally, the ability to associate multiple business objects is also introduced as part of this functionality.

When a communication is initiated with a customer, an interaction is created that contains the channel, contact, resource, and multiple other attributes. Each interaction can have only one reference to each of these attributes. In the case of business objects, an interaction can be associated with one of each type of business object. In the case where a communication adds additional attributes, the application automatically generates a child interaction, and associates it to the original parent.

Here's a few examples of such cases:

- A communication crosses channels (the child interaction would store the new channel).
- A communication is transferred between agents (the child interaction would store the second agent).
- More than one type of business object is associated. For example, an interaction can be associated with one service request. However, if during the conversation, a second service request is created or updated, the second interaction would have to be stored in a child interaction.

For metric calculations in BI, it's often necessary to count the entire set of these atomic interactions, as a single interaction. This single interaction is referred to as the parent interaction. The atomic interactions are referred to as child interactions. The parent interaction count isn't the summation of child interaction count. In any cross-channel or cross-agent interaction, there's always a single parent interaction, and more than one child interactions.

Service Analytics Saved Queries

Saved queries are canned analyses that enable you to construct reports efficiently. The saved queries are pre-calculated data filters that can be conveniently applied on any analyses that you want to build. They're also useful in cross-subject-area reporting.

Here's how you access the saved queries:

1. Click Navigator > Tools > Reports and Analytics.
2. Click Browse Catalog.
   The Oracle Business Intelligence Catalog page is displayed.
3. In the Folders pane, click Shared Folders > Service > Subject Area Contents > Saved Queries - OTBI.

Here's a table that provides details about the available saved queries:
<table>
<thead>
<tr>
<th>Analyses Name</th>
<th>Description</th>
<th>Job Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRs assigned to me</td>
<td>Saved query to retrieve the list of SRs assigned to the signed in user. Apply this on the Service Request ID column when used in analyses.</td>
<td>• Customer Service Representative</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Sales Administrator</td>
</tr>
<tr>
<td>SRs where I am on the team</td>
<td>Saved query to retrieve the list of SRs where the signed in user is part of the SR team. Apply this on the Service Request ID column when used in analyses.</td>
<td>• Customer Service Representative</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Sales Administrator</td>
</tr>
<tr>
<td>SRs assigned to me or my subordinates</td>
<td>Saved query to retrieve the list of SRs assigned to the signed in user or the user’s subordinates. Apply this on the Service Request ID column when used in analyses.</td>
<td>• Customer Service Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Sales Administrator</td>
</tr>
<tr>
<td>SRs where I am or my subordinates are on the</td>
<td>Saved query to retrieve the list of SRs where the signed in user or the user’s subordinates are part of the SR team. Apply this on the Service Request ID column when used in analyses.</td>
<td>• Customer Service Manager</td>
</tr>
<tr>
<td>team</td>
<td></td>
<td>• Sales Administrator</td>
</tr>
<tr>
<td>Queues where I am a resource</td>
<td>Saved query to retrieve the list of queues where the signed in user is a resource. Apply this on the Queue ID column when used in analyses.</td>
<td>• Customer Service Representative</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Sales Administrator</td>
</tr>
<tr>
<td>Queues where I am or my subordinates are</td>
<td>Saved query to retrieve the list of queues where the signed in user or the user’s subordinates are resources. Apply this on the Queue ID column when used in analyses.</td>
<td>• Customer Service Manager</td>
</tr>
<tr>
<td>resources</td>
<td></td>
<td>• Sales Administrator</td>
</tr>
</tbody>
</table>

### Analytics Resources

Here's the resources that provide additional information on the Fusion Sales and Fusion Service analytics:

- [Prebuilt Fusion Service analytics](#) spreadsheet.
- [Creating and Administering Analytics](#) guide.
- [Subject Areas for Transactional Business Intelligence in Fusion Sales and Fusion Service](#) guide.
- [Administering Knowledge Management](#) guide.
- [Security for Sales Analytics and Reports](#) guide.
- [Oracle Transactional Business Intelligence](#) guides.
- [Fusion Service Report Sharing Center](#) cloud customer connect.
- [Analytics and Reporting Best Practices](#) support resource center.
28 Set Up Additional Service Features

Installed Base Assets

Enable Installed Base Assets for Service Requests and Work Orders

If you're an Oracle Cloud customer that uses Installed Base Assets for processes such as Supply Chain, Service Logistics, Service Contracts, or IOT, you can opt-in to use the same asset model for your service request and work order processes.

Once you opt-in, the Installed Base Asset fields can be added to the Service Request and Work Order page layouts in Application Composer. From here, the installed base asset ID can then be passed to downstream processes such as Field Service or Service Logistics.

Enable Installed Base Assets

To opt in, do the following:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Change Feature Opt in link
2. Click the Features icon for Service in the first row.
4. Click Done.
5. Click Done on the Opt In page.

Note: This is a global setting where you choose whether to use Installed Base Assets or the default Asset object for the Service Request and Work Order process. You can't use both asset objects in Fusion Service so you should carefully consider the impact if you have requirements to support asset management outside these processes. For example, Installed Base Asset doesn't currently support sales processes in Fusion Sales and Service and has limited support for extensibility.

FAQs About Installed Base Assets

Frequently Asked Questions (FAQs) for Installed Base Assets

This section contains some frequently asked questions (FAQs) when setting up and maintaining installed base assets. Scroll or search to find answers to common questions.
Can I add Installed Base Asset as a subtab on the SR?
IB Asset is a single choice field on SR. It's not a subtab where you can associate many assets.

Where's the Installed Base Asset object in Application Composer?
The installed base asset object in Application Composer is called Installed Base Asset. It's located under the SCM/ERP drop-down list (not CRM).

How can I query Installed Base Asset-related fields in and SR from a particular object?
A few Installed Base asset fields are already part of the SR object.
There's a picker to choose which asset is the subject of the SR. It's possible to create formula fields and use groovy to access other fields from the IB Asset object.

Case Management

About Case Management
Case Management is a professional and collaborative process that provides the ability to manage long running processes to meet an organization’s needs related to managing escalations, investigations, problems, applications, and other issues. For example, a case is created whenever an application for specific services is requested by an applicant. Applications are typically assessed for eligibility of services, and upon successful assessment, a Case is created and managed. Unlike service requests, cases typically stretch over a long period of time, involve multiple parties as well as multiple documents and messages to deliver a solution or service, and often require complex business processes for successful completion.

The overall case management process is iterative, non-linear, and cyclical, with its phases being revisited as necessary, until the intended outcome is achieved. A Case can be different than a Service Request, as Cases are often employee, client, citizen, or student focused, and the outcome is often difficult to predict or measure. A case can be a process that ties together one or more services (benefits) delivered by an institution to a person (individual), group (household), or organization (customer account) to fulfill the specific intent and needs of the recipient.

If your organization is using the Cases feature, see the Using Case Management guide to learn how to create and manage cases.

For more information about implementing case management, see the Implementing Case Management Guide.

Opt Out of Case Management
Case Management comes ready to use with Fusion Service. If you don't wish to use Case Management, you can disable it.
To Disable the Case Feature

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Service
   - Change Feature Opt in link
2. Click the Features icon for the Service offering.
3. Select Disable for Case.

Service Request Parts Ordering for Service Oracle Service Logistics Cloud Users

Give Users Access to Create Parts Orders Using Service Requests

Service Logistics users access the Fusion Service UIs to order parts to complete a service request or work order. See related topic for instructions on granting users access to the Service Request and Work Order UIs so that they can create parts orders.

To view the table and column details which carry part details from the SR page, see the related link for the Parts Requirements Lines table.

Related Topics
- Give Users Access to Fusion Service UIs
- Parts Requirement Lines

Configure the Cancel and Delete Behavior for Service Requests with Parts Orders

If a service request is canceled or deleted before the parts on an order are sent, it’s likely that the parts order should also be canceled to avoid unnecessary costs.

With the Manage Service Request Parts Order Disposition Options task, you can configure what happens when a user attempts to delete a service request that has parts on order. You can also specify which service request status values indicate the cancellation of a service request. The application prompts the user to confirm what they want to do before the status can be changed.

To configure the delete and cancel processing behavior:

In the Setup and Maintenance work area, go to the following:
- Offering: Service
- Functional Area: Service Request
To configure the processing for if a user tries to delete an order with parts:

1. **Task: Manage Service Request Parts Order Disposition Options**
   - **Step 1:** Click the **Execute part order delete processing** check box if you want the application to check to see if there are parts orders when the user tries to delete a service request.
   - If you do not check this box, a service request with parts orders is not affected if it's deleted. If you check this box, service requests that contain parts orders will be evaluated based on whether the next check box is checked.
   - **Step 2:** Click the **Allow deletion of service request with noncancelable part orders** check box if you want to allow users to delete a service request even if there are parts orders that have already been sent to the customer.
   - If parts order delete processing is turned on, but this box is not checked, users can't delete a service request that has parts orders, unless all the parts orders are canceled. If this box is checked, users can delete the service request anyway. In this case, the application will also try to cancel the remaining parts orders that can still be canceled.

To configure the processing for when a user tries to cancel an order with parts:

Use the Service Request Resolved Status Type region of the page configure how the application responds when a user tries to set certain status values on a service request with parts orders that have already been sent to the customer.

Status values with a resolution type of Resolved suggest the assistance is no longer required. Some status values also might indicate that a problem was fixed. In cases where parts were ordered to help the customer fix the issue, but the status value suggests the customer might not need the parts anymore, you can configure the cancel processing to determine how the application responds.

1. Check the check box in the Cancel Part Order Process column for the status you want the application to run cancel processing. This means if the user tries to cancel an SR that's in that status, the application checks to see if there are any parts on the SR that have already been sent out. The user is then notified so they can decide if want to continue.

### Copy Maps

#### Create a Copy Map

Copy maps enable you to create objects by copying existing object entities. You use the copy maps feature to map child objects and attributes in the source object (From object) to objects and attributes in the object you're creating (To object).

To create a copy map:

1. **Sign in as a user with Application Composer access and verify that you have an active sandbox.**
2. **Access Application Composer by selecting Application Composer from the Navigator menu, under the Configuration category.**
3. **Go to Advanced Setup, and select Copy Maps.**
4. **Under the Copy Service Request section, select one of the following options:**
   - Copy Service Request Map
   - Standard Copy Service Request Map
5. If you select **Standard Copy Service Request Map**, a read-only page comes up where the attribute mapping, application module mapping, and entity mapping sections are already mapped.

6. If you select **Copy Service Request Map**, you can modify the attribute mapping, application module mapping, and entity mapping sections.

7. The **Attribute Mapping** section contains all the OOTB attributes that are copied automatically. In this map, you can add the following types of fields to be copied:
   - other standard/OOTB fields,
   - custom fields,
   - fields from other objects.

8. In the **Application Module Mappings** section, enter the field you want to copy. You enter the following information about the mapping as outlined in this table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the copy map. The name is displayed in the Copy Maps window. You can use the name to locate and search for copy maps that you want to edit or delete.</td>
</tr>
<tr>
<td>Map Group</td>
<td>Select the required mapping group for the new copy map from the drop-down list.</td>
</tr>
<tr>
<td>To</td>
<td>Select the application module that you're copying to. For example, if you're copying leads to opportunities, then select the application module that includes leads.</td>
</tr>
<tr>
<td>From</td>
<td>Select the attribute or field name that you're copying from. For example, if you're copying responses to leads, then select the application module that includes responses.</td>
</tr>
</tbody>
</table>

8. In the **Entity Mappings** section, add a record for each view object that you're copying by completing these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Select the new object that you're copying to.</td>
</tr>
<tr>
<td>From</td>
<td>Select the existing view object that you're copying from.</td>
</tr>
<tr>
<td>Query Type</td>
<td>Select one of the three query types: Unique Identifier, Join, or All Records. If you select All Records, then don’t enter any information in the remaining fields.</td>
</tr>
<tr>
<td>Query Attribute</td>
<td>If you selected either Unique Identifier or Join in the Query Type field, then select an attribute to use during runtime. The attribute is used to filter the records that are copied to the new object. For example, if you select LeadId, then during runtime, only the records matching the Lead ID passed to the copy map engine are copied.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Joined View Object and Joined Attribute | If you selected Join in the **Query Type** field, then use these two fields to specify:
 ◦ The view object to which this object is joined
 ◦ The attribute used as the basis of the join

9. Select each line in the **Entity Mappings** section, and add or update records to the **Attribute Mappings** section for each of the attributes by completing these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td>Select the attribute to which the selected entity is copied.</td>
</tr>
<tr>
<td><strong>Referenced View Object</strong></td>
<td>If this attribute is a foreign key, select the view object joined by this foreign key. The application generates new foreign keys that keep the reference intact.</td>
</tr>
<tr>
<td><strong>Primary Key</strong></td>
<td>If this attribute is a primary key, select this check box. Instead of copying the value in the <strong>From</strong> object, the application generates a unique value for this key field in each record in the <strong>To</strong> object.</td>
</tr>
<tr>
<td><strong>From</strong></td>
<td>Select the attribute from which the selected entity is copied.</td>
</tr>
<tr>
<td><strong>From Expression</strong></td>
<td>Optionally, you can enter a Groovy expression to change the value in this attribute. For example, you want to change the value of the <strong>From</strong> object to some new value in the attribute of the <strong>To</strong> object. You can also enter a constant to fill this attribute with a constant value in every record of the <strong>To</strong> object.</td>
</tr>
</tbody>
</table>

10. Click **Save and Close**.
29 Integrate Oracle Internet of Things Service Monitoring for Connected Assets

Overview of Oracle Internet of Things Service Monitoring for Connected Assets

Oracle Fusion Service and Oracle Internet of Things Service Monitoring for Connected Assets integration is designed to support customers who want to use the application to service customers, while using Internet of Things Service Monitoring for Connected Assets to monitor connected assets.

With the integration, assets connected to the internet periodically report information back to the Internet of Things Service Monitoring for Connected Assets application. This data is constantly monitored to detect problems indicating a failure has occurred or is imminent, and reports the issue to the service application for customer service follow-up. The synchronization is executed using Oracle Integration Cloud as the backbone for mapping and information exchange.

The integration supports the following:

- Creation of an Internet of Things Service Monitoring for Connected Assets incident when business rules detect that a failure has occurred or is imminent, which triggers creation of a service request.
- Closing the Internet of Things Service Monitoring for Connected Assets incident when the corresponding service request is resolved.
- Viewing information about the connected asset directly from the service request pages in the service application. This enables the service agent to retrieve both historical and the most current diagnostic information from the device, and take remote actions against the device (for example, restart), for troubleshooting and issue resolution.

For more information about Internet of Things Service Monitoring for Connected Assets, see Related Topics.

Related Topics

Integrate Engagement Cloud with Internet of Things Service Monitoring for Connected Assets

How You Integrate the Applications

Here's a brief overview of the steps required to integrate Fusion Service with Internet of Things Service Monitoring for Connected Assets.

1. Create an integration user with privileges to perform the integration with Internet of Things Service Monitoring for Connected Assets.
2. Import the integration package from Oracle Marketplace.
3. Import SSL certificates for Fusion Service and Internet of Things Service Monitoring for Connected Assets, if the instances use self-signed certificates.
5. Activate the integrations.
6. Enable the **Connected Asset** tab.
7. Import the Internet of Things connected assets.

For more information about configuration and integration steps for Internet of Things Service Monitoring for Connected Assets, see Related Topics.

**Related Topics**

### Create an Integration User

To integrate Fusion Service with Internet of Things Service Monitoring for Connected Assets, Oracle recommends that you create a user specifically for the integration. The integration user can call the Fusion Service service catalog or event catalog web services from Oracle Integration Cloud.

Here’s how you create an integration user and the privileges you must provide to the role:

1. Sign in to the service application as an administrator.
2. Select **Navigator > My Team > Users and Roles**. The Search Person page is displayed.
3. Click **Create**. The Create User page is displayed.
4. Enter the following details for the new user:
   - **Last Name**: Enter a last name for the user.
   - **Email**: Enter a valid email ID for the user.
   - **Hire Date**: Select today’s date.
   - **User Name**: Enter a user name for the user.
   - **Person Type**: Select **Employee** from the drop-down list.
   - **Legal Employer**: Select the legal employer from the list.
   - **Business Unit**: Select a valid business unit.
   - **Send user name and password**: Select this option.
   - **User Log in**: Enter the user name that you created.
   - **Password**: Enter the password for the user.
5. Save the user details. An email is sent to the address after the user has been created.
6. Check the user credentials sent in the email, sign in as the new user, and reset the password. After creating the user, sign in to the security console and provide the following roles to the integration user.
   - **SOA Operator**
     - The SOA Operator is a duty role and duty role can’t be directly assigned to a login using security console. Create an enterprise role as a parent of SOA Operator and associate that enterprise role to the integration user.
   - **Customer Service Representative**
   - **Resource**
Chapter 29
Integrate Oracle Internet of Things Service Monitoring for Connected Assets

Import the Integration Package

You can set up the Integration Cloud integration package after you set up Fusion Service and create the integration user with the required privileges.

Before you start setting up Integration Cloud, go to the Oracle Marketplace (https://cloudmarketplace.oracle.com/marketplace/en_US/homePage) and search and download the Fusion Service to Internet of Things Service Monitoring for Connected Assets integration package. For more information about Oracle Marketplace, see the Related Topics link for Oracle Cloud Marketplace documentation.

The Integration Cloud integration package supports the following:

- Inbound: Create an SR in Fusion Service for an Internet of Things Service Monitoring for Connected Assets incident.
- Outbound: Respond to Internet of Things Service Monitoring for Connected Assets on the SR status.

Import SSL Certificates

If the instances use self-signed certificates, you must import the SSL certificates before you configure and activate the connections.


Activate the Connections

After you download the package and import the SSL certificates, connect to Fusion Service using the sales adapter. The procedure for importing the adapter is described in the topic "Creating an Oracle Sales Cloud Adapter Connection", available at https://docs.oracle.com/en/cloud/paas/integration-cloud-service/icssc/index.html.

Configure the Connection to the Fusion Service Instance

Here's how you configure the connections to your Fusion Service instance:

1. Sign in to the Integration Cloud application using your integration user credentials.
2. Click the Connections icon on the home page.
3. Ensure that Oracle Fusion Service is listed on the connections page.
4. Click Oracle Fusion Service to view the details.
5. Click **Configure Connectivity** and enter the following information in the **Connection Properties** dialog box:
   - OSC Service Catalog WSDL URL: Enter the service catalog URL on your Fusion Service instance.
   - (Optional) OSC Event Catalog URL: Enter the event catalog URL on your Fusion Service instance.

6. Click **OK**.

7. Click **Configure Security** and enter the following information:
   - **Security Policy**: Enter **Username Password** Token.
   - **User name**: Enter the integration user name.
   - **Password**: Enter the password for the integration user.
   - **Confirm Password**: Reenter the password.

8. Click **OK**.

9. Click **Test** on the **Actions** bar of the service application page.

10. Ensure that the connection test is successful and the status meter shows 100%.

11. Click **OK**.

---

### Configure the Connection to the Internet of Things Service Monitoring for Connected Assets instance

Here's how you configure the connection to the Internet of Things Service Monitoring for Connected Assets instance:

1. Sign in to the Integration Cloud application using your integration user credentials.
2. Select **Connections** and then create a new connection for **Internet of Things Service Monitoring for Connected Assets**.
3. Select **Rest Adapter Connection**.
4. Click **Configure Connectivity** and enter the following information:
   - **Connection Type**: REST API base URL
   - **Connection URL**: Internet of Things Service Monitoring for Connected Assets instance base URL
6. Save the configuration and test the connection.

---

### Activate the Integrations

After you configure your connections, you must then activate these integrations:

- **Autocreate SR for IoT Incident**: Creates or updates an SR in Fusion Service from an Internet of Things Service Monitoring for Connected Assets incident by mapping the object attributes of the two applications.
- **Push SR Status to IoT**: Updates the Internet of Things Service Monitoring for Connected Assets incident with the SR status from Fusion Service.

Here's how you activate the integrations:

1. Sign in to the Integration Cloud application using your integration user credentials.
2. Click the **Integrations** icon on the home page.
3. Search for each integration by its name.
4. Click the **Activate** button on each integration.
5. Select the **Enable detailed tracing** option, and click **Activate** on the confirmation dialog box.
6. Ensure that the flow has been activated successfully.
7. Repeat the previous steps for each integration.

### Enable the Connected Asset Tab

Here’s how you enable the Connected Asset tab on the user interface.

1. Import the SSL certificate from the Internet of Things Service Monitoring for Connected Assets instance to the Fusion Service server.
2. Sign in to the service application as a setup or administrator user.
3. On the Setup and Maintenance page, search for the **Manage Service to IoT Cloud Integration** task.
4. Enter the Internet of Things Service Monitoring for Connected Assets instance URL, user name, and password.
5. Click **Verify Connection** to verify the connection.
6. Save the configuration details.
7. (Optional) To configure the roles and users who can perform the actions in the Actions and Attributes section of the Connected Asset tab of the Edit Service Request page, do the following:
   a. In the **Service Roles to IoT Users Mapping** section, click **Create**.
      
      A blank row is added in the table, which enables you to map the Service roles to the Internet of Things application users.
   b. Enter the **Role**, **Priority**, **User Name**, and **Password**.
      
      If a user has multiple roles assigned, then the role with the highest priority is considered. Lowest number indicates highest priority.
   c. Click **Verify Connection** to verify the connection.
   d. Click **Save**.

   On the **Connected Asset** tab, the actions are displayed in the **Asset Actions** drop-down list based on the signed in user’s role that’s used to connect to the Internet of Things Service Monitoring for Connected Assets instance.

### Import Internet of Things Connected Assets

You can import Internet of Things connected assets from an external data source into Fusion Service using the Import and Export Management feature.